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RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
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Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
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How to Use This Manual

This manual describes the role of the CS+ integrated development environment for developing applications and sys-
tems for RL78 family, and provides an outline of its features.

CS+ is an integrated development environment (IDE) for RL78 family, integrating the necessary tools for the develop-
ment phase of software (e.g. design, implementation, and debugging) into a single platform.

By providing an integrated environment, it is possible to perform all development using just this product, without the
need to use many different tools separately.

Readers

Purpose

Organization

How to Read This Manual

Conventions

This manual is intended for users who wish to understand the functions of the CS+ and
design software and hardware application systems.

This manual is intended to give users an understanding of the functions of the CS+ to use
for reference in developing the hardware or software of systems using these devices.

This manual can be broadly divided into the following units.
1.GENERAL

2.FUNCTIONS
A.WINDOW REFERENCE

It is assumed that the readers of this manual have general knowledge of electricity, logic
circuits, and microcontrollers.

Data significance: Higher digits on the left and lower digits on the right
Active low representation: XXX (overscore over pin or signal name)

Note: Footnote for item marked with Note in the text
Caution: Information requiring particular attention

Remarks: Supplementary information

Numeric representation: Decimal ... XXXX

Hexadecimal ... OxXXXX
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CS+V8.10.00 1. GENERAL

1. GENERAL

CS+ is a platform of an integrated developing environment for RH850 family, RX family, V850 family, RL78 family,
78KOR microcontrollers, 78K0 microcontrollers.

CS+ can run all the operations needed for developing the programs such as designing, cording, building, debugging,
and flash programming.

In this manual, the debugging is explained out of those operations needed for the program development.

Caution When the E2 emulator Lite (abbreviated name: E2 Lite) is used, please read references to "E1" in this
manual as also meaning "E2 Lite".
When the E2 emulator (abbreviated name: E2) is used, please read references to "E1" in this manual as
also meaning "E2".

In this chapter, an overview of debugging products that CS+ provides is explained.

1.1 Summary

You can effectively debug/simulate the program developed for the RL78 family, using the debugger which CS+ provides.

1.2 Features

The following are the features of the debugger provided by CS+.

- Connecting to the various debug tools
A pleasant debugging environment for target systems is provided by connecting to the full-spec emulator (IECUBE),
the on-chip debugging emulator (E1/E20/EZ Emulator), COM Port and Simulator.

- C/C++ source text and disassembled text are shown mixed
The C/C++ source text and the disassembled text are shown mixed on the same panel.

- Source level debugging and instruction level debugging
The source level debugging and the instruction level debugging for a C/C++ source program can be done.

- Support of flash self programming emulation (Code flash)
Flash self programming emulation can be performed with IECUBE.

- Data flash memory writing function
When the selected microcontroller incorporates the data flash memory, the contents of data flash memory can be dis-
played and modified by the same access method as an ordinary memory operation (except for Simulator).

- Real-time display update function
The contents of memory, registers and variables are automatically updated not only when the program execution is
stopped, but also in execution.

- Save/restore the debugging environment
The debugging environment such as breakpoints, event configuration information, file download information, display
condition/position of the panel, etc. can be saved.

R20UT5301EJ0100 Rev.1.00 ENESAS Page 9 of 413
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CS+V8.10.00 2. FUNCTIONS

2. FUNCTIONS

This chapter describes a debugging process of CS+ and main functions for debugging.

2.1 Overview

The basic debugging sequence for programs using CS+ is as follows:

(1) Start CS+
Launch CS+ from the [Start] menu of Windows.

Remark For details on how to start CS+, see "CS+ Integrated Development Environment User's Manual:
Project Operation".

(2) Seta project
Create a new project, or load an existing one.

Remark For details on "Set a project”, see "CS+ Integrated Development Environment User's Manual: Proj-
ect Operation".

(3) Create aload module
Create a load module by running a build after setting of the active project and the build tool to be used.

Remark For details on "Create a load module" with CC-RL, see "CS+ Integrated Development Environment
User's Manual: Project Operation”.

(4) Confirm the connection to a host machine
Connect the debug tool to be used to a host machine.

(5) Select the debug tool to use
Select the debug tool to be used in a project.

(6) Configure operating environment of the debug tool
Configure the operating environment of the debug tool selected in steps (5).

- [IECUBE]

- [E1]

- [E20]

- [EZ Emulator]
- [COM Port]

- [Simulator]

(7) Connect to the debug tool
Connect the debug tool to CS+ to start communication.

(8) Execute downloading
Download the load module created in steps (3) to the debug tool.

(9) Display source files
Display the contents of the downloaded load module (source files) on the Editor panel or Disassemble panel.

(10) Execute programs
Execute the program by using the operation method corresponding to a purpose.
If you wish to stop the program at the arbitrary position, set a breakpoint/break eventN°® pefore executing the pro-
gram (see "2.9.3 Stop the program at the arbitrary position (breakpoint)", "2.9.4 Stop the program at the arbitrary
position (break event)", or "2.9.5 Stop the program with the access to variables/SFRs").

Note These functions are implemented by setting events to the debug tool used.
See "2.16.7 Notes for setting events", when you use events.

(11) Stop the program manually
Stop the program currently being executed.
Note that if a breakpoint or a break event has been set in steps (10), the program execution will be stopped auto-
matically when the set break condition is met.

(12) Check the result of the program execution
Check the following information that the debug tool acquired by the program execution.

R20UT5301EJ0100 Rev.1.00 ENESAS Page 10 of 413
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CS+V8.10.00 2. FUNCTIONS

(13)

(14)

(15)

- Display/Change the Memory, Register and Variable
- Display Information on Function Call from Stack

- Collect Execution History of ProgramsNete

- Measure Execution Time of ProgramsNote
- Measure Coverage [[ECUBE][Simulator]
Note These functions are implemented by setting events to the debug tool used.
See "2.16.7 Notes for setting events", when you use events.
Debug the program, repeating steps (9) to (12) as required.
Note that if the program is modified during debugging, steps (3) and (8) also should be repeated.

Remark 1. Other than the above, you can also check the result of the program execution by using the following
functions.

- Set an Action into Programs

- Use Hook Function

- Use the Simulator GUI [Simulator]
Remark 2. The acquired information can be saved to a file.

- Save the disassembled text contents

- Save the memory contents

- Save the CPU register contents

- Save the SFR contents

- Save the contents of local variables

- Save the contents of watch-expressions

- Save the contents of call stack information

- Save the contents of execution history

Execute uploading
Save the program (the memory contents) to a file in the arbitrary format (e.g. Intel HEX file, Motorola S-record file,

binary file, and etc), as required.

Disconnect from the debug tool
Disconnect the debug tool from CS+ to terminate communication.

Save the project file
Save the setting information of the project to the project file.

Remark For details on "Save the project file", see "CS+ Integrated Development Environment User's Man-
ual: Project Operation”.

R20UT5301EJ0100 Rev.1.00 ENESAS Page 11 of 413
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CS+V8.10.00 2. FUNCTIONS

2.2 Preparation before Debugging

This section describes the preparation to start debugging the created program.

2.2.1 Confirm the connection to a host machine

Connection examples for each debug tool are shown.

2.2.1.1 [IECUBE]
2.2.1.2 [E1]

2.2.1.3 [E20]

2.2.1.4 [EZ Emulator]
2.2.1.5 [COM Port]
2.2.1.6 [Simulator]

2.2.1.1 [IECUBE]

Connect a host machine and IECUBE. If required, connect a target board, too.
See IECUBE User's Manual for details on the connection method.

Figure 2.1 Connection Example [IECUBE]

ﬁﬁ&ﬂmﬁ
% - = 'i—-—l- ;E_..- n“'a-"tk,d- §
Ded?cated adapter “‘__‘_-._ " USB interface cable : "-'_'F,J
Dedicated probe o Host machine ™
’ IECUBE CS+
Target board

2.2.1.2 [E1]

Connect a host machine and E1. If required, connect a target board, too.
See E1 User's Manual for details on the connection method.

Figure 2.2  Connection Example [E1]

. M o *"E
Dedicated probe - USB interface cable

’ ue:;J Host machme
E1
Target board CS+

Caution Only serial communications are supported as the communication method with the target board (JTAG
communications is not available).

2.2.1.3 [E20]

Connect a host machine and E20. If required, connect a target board, too.
See E20 User's Manual for details on the connection method.
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Figure 2.3  Connection Example [E20]

G’M

w u@m‘ﬁ‘d

r |

Dedicated probe = USB interface cable
\"—"'f'-‘ Host machlne
E20 s
+
Target board
Caution Only serial communications are supported as the communication method with the target board (JTAG

communications is not available).

2.2.1.4 [EZ Emulator]

Connect a host machine and an evaluation kit
See EZ Emulator User's Manual for details on the connection method.

Figure 2.4  Connection Example [EZ Emulator]

—

Evaluation kit

5

USB interface cable

A ==

Host machine @

CS+

2.2.1.5 [COM Port]

Connect the host machine to the target board via a commercially available USB serial converter.

2.2.1.6 [Simulator]

A host machine is only needed for debugging (emulators are not needed).

Figure 2.5 Connection Example [Simulator]

@
Host machine

CS+
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2.3 Configuration of Operating Environment of the Debug Tool

This section describes the configuration of the operating environment for each debug tool.

2.3.1 Select the debug tool to use

You can configure the operating environment in the Property panel corresponding to the debug tool to use.

Therefore, first, select the debug tool to be used in a project (the debug tool to be used can be specified in the individual
main projects/subprojects).

To select or switch the debug tool, use the context menu shown by right clicking on the [RL78 Debug tool name (Debug
Tool)] node on the Project Tree panel.

Figure 2.6  Select/Switch Debug Tool to Use

Project Teee | % |
- e - W
2% Sarnple [Project)

E RSFIM0LE {Microcantraller)

AL CC-RL (Bustd Teaed)
J PLTE Simulator (Debun Too

s [ File | Liing Debug Tasl rl
B Property

L7B [ECLEE

R

RLTE £ Lie
RL7E Ed[Serial)
[

R

LTE E2D(S=nal)
LTE EL Ermualator

[»] ra7e simulate

If the Property panel is already open, click the [RL78 Debug tool name (Debug Tool)] node again. The view switches to
the Property panel of the selected debug tool.
If the Property panel is not open, double-click the above mentioned node to open the corresponding Property panel.
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2.3.2 [IECUBE]

Configure the operating environment on the Property panel below when using IECUBE.

Figure 2.7  Example of Property Panel [IECUBE]

Property E3
23, RL78 IEGUBE Property 2| =)+
4 {Internal ROM/RAM
Size of mternsl ROMEBwies] Bl
Size of mternal Ra[Eyvtes] 4095
Size of DataFlash memory [KByte=s] L]
d Clock
Man clock sowrce Cignerate by emulator
blain chck frequercy [FEE] 400
Sub clock source Generate by amulator
Sub clock freguency[kHz] 22768
4 Gonnectionwith Tareet Boand
Caormectng with target board o
Internal ROMARAM
\iConnec.... | Debug T.. [ FlashSel. | DataFlas..  Downloa.. [Hook Tra.. /=

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab

[Flash Self Emulation Settings] tab [[ECUBE]
[DataFlash Emulation Settings] tab [I[ECUBE]
[Download File Settings] tab

[Hook Transaction Settings] tab
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2.3.3 [E1]

Configure the operating environment on the Property panel below when using E1.

Figure 2.8  Example of Property Panel [E1]

Property |
Sul BLTR EWSarial) Property & =+
Size aof internsl FROMEEvtes] 12
Size of internal RAM[Bries] g192
Size of DataFlazh mamory[KBytas) ]
w  Glock
fsir chack frequency [MHz] Usme miemal chck
Sub chok frequencylkHz] Uzne mdemal chick
onitar clock Swetem

Gonneclion with Emulator
Ermulator zerial Ha
*  Cronnection with Tanget Board
Possar tarmet from the smulator DM 200ma) Ma

w Flazh
Security 10 noanodanooo0oaa00Nman
Permit flash programming ez
Lee wide vollage mode e
Eraze {lazh ROM wihen sterling Ma
¥ Hot Plug-n
Intemal ROMARAM

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab
[Download File Settings] tab
[Hook Transaction Settings] tab
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2.3.4 [E20]

Configure the operating environment on the Property panel below when using E20.

Figure 2.9  Example of Property Panel [E20]

08T Ed
cul RLTE E20(Serial) 7 OMT 4 8 -+
ize of mbernal FOMIEEvies] 156
Size of intarnal RAK[Byiez] JnLan
Size of DataFlach me mory[KBytes) ]
w  Glock
Pelair chack frequency [MHz] Lzng miemal chick
Sub clok frequencykHz] Iking mtermal chck
Manitar clock Swstem

w  Connecton with Emulsbor
Ermulator serial Mo

 Flash
Secwrilty 1D [heE] DO@0DOSO00G000@00 K00
Fermt tlash programming Tes
Uze wide vollage mode ez
Erzze flash ROM wiben starling Ia
» Hot Plug=n
Internal ROMARAM

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab
[Download File Settings] tab
[Hook Transaction Settings] tab
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2.3.5 [EZ Emulator]

Configure the operating environment on the Property panel below when using EZ Emulator.

Figure 2.10 Example of Property Panel [EZ Emulator]

Property E
S5 RLTE EZ Emulator Property B -
s {Tnternal ROM/RAM
Size of inlerna F'.'TI-':'_.“'E:}'::*:.'] 4
Sipe of internal BAMIEyt=z] LOgE
Size of DataFlash mamory[EBybes] ¥
a Glock
Main clock frequency [MHz] sire miternal clack
Sub chck frequencyllHz] lzing mtemal chck
Mionitor clock Systam

2 Conneclion with Tanget Board
Paveer tareet from the amulsior (MSH 200m&) Mo

4 Flash
Sacurity [0 [FE=] 00000000000000000000
Permil {lash pragramming hCH
Llze wide wolisze mods ez
Eraze flagh ROM when starting i
Internal ROM/RAM

\Connect Setti... ! Debug Tool Set . ¢ Download Ale 5. 4 Hook Tranzacti_. / =

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab
[Download File Settings] tab
[Hook Transaction Settings] tab
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2.3.6 [COM Port]
Configure the operating environment on the Property panel below when using COM Port.
Figure 2.11 Example of Property Panel [COM Port]
Property [
2 ALT3COM Port Property = ||
| Internal ROMAAM
Size of internal ROMKEyias] 128
Size of internal FLAM|Byies] 16324
Size of DataFlash memaory[KBytes] 8
w Clock
Main clock frequency [MHz] Laing intemal clock
Sub clock freguency(kHz] Laing intemal clock
Monitor chock Symtesm
+ Connectionwith Tangel Baard
Commumication port
Fesed control pin DTR
+ Flash
Sacurity D "] 00000000000000000000
Permat flash programming Yea
Lise wide voltags mode Yea
Erase flash ROM when starting Mo
Liging the flash salf programming Na
Internal ROMRAM
| [ Connect Settings, | Debug Tool Settings | Download File Settings I.J' Hook Transaction Settings J."' -

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab
[Download File Settings] tab
[Hook Transaction Settings] tab
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2.3.7 [Simulator]

Configure the operating environment on the Property panel below when using Simulator.

Figure 2.12 Example of Property Panel [Simulator]

Property ]
il RL78 Simulator Property 2| [=][+]
4 {Internal ROM/RAM

Size of mternal FOKKEyies) hid
Size of intarnal BAM[Bytes] 4005
4 Clock
Plain clack frequarcy [MHz] Lno
Sub clock frequencykHz] 2270
Select Timer/ Trace chok frequeancy CPU clock frequency
il af Times# Trace clack frequency MHz

Timerd Trace clock frequency
4 Configuration
Uee simulator configusation Tile o

Internal ROM/RAM

/ Download Flle 5./ Hook Transactl. . | =

Follow the steps below by selecting the corresponding tab on the Property panel.

[Connect Settings] tab

[Debug Tool Settings] tab
[Download File Settings] tab
[Hook Transaction Settings] tab

Remark 1. When the simulator of the selected microcontroller supports peripheral function simulation, it simulates
the peripheral functions for the given type of microcontroller.When Simulator to be used corresponds to
peripheral function simulations, you can use the Simulator GUI. See "2.19 Use the Simulator GUI [Simu-
lator]" for details on the Simulator GUI. Refer to the release note for details on the peripheral function
simulation.

Remark 2. Refer to the 2.22 RL78 Instruction Simulator [Simulator] for details on the Instruction simulation.

Remark 3. When the selected microcontroller incorporates a flexible application accelerator (FAA), the RL78
instruction simulator also simulates the FAA. For details on the function of simulating the FAA, refer to the
release note for the RL78 simulator which handles simulation of the peripheral functions.
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2.4 Applicable Debugging Methods

This section describes debugging methods which are applicable to debugging specific facilities of RL78 family devices.

2.4.1 Debugging the FAA

2.4.1 Debugging the FAA

This section describes how to enable this debugging facility, operation of its various functions, and points for caution on
using the FAA debugging facility when the selected microcontroller incorporates an FAA.

Some descriptions include reference to the state of the FAA in the following ways, which are similar to the state
indicators in the Main window.

Table 2.1 FAA States

Item FAA state
Standby A clock signal is not being supplied to the FAA.
Disable FAA operation disabled
Sleep Low power consumption mode

- Enabling FAA debugging
Make the following settings when debugging is to cover code for the FAA.

- [FAA] category on the [Connect Settings] tabbed page of the [Property] panel
Select [Yes] for the [Debug FAA] property.
Making the above setting enables selecting the FAA as the target for debugging on the status bar or in the

[Debug Manager] panel of the Main window.

- [Download] category on the [Download File Settings] tabbed page of the [Property] panel
Specify the name defined for the code section in the source file containing the FAA code as the [Specify code
section name defined in FAA source file] property.
Specify the name defined for the data section in the source file containing the FAA code as the [Specify data
section name defined in FAA source file] property.

Making the above settings enables selecting the FAA as the target for debugging and allows debugging opera-
tions such as stepped execution at the FAA source level with the FAA source code displayed in the [Editor]
panel and address information displayed in the address column.

- Operation of the various functions
When the FAA is selected as the target for debugging, each facility behaves as described below.

(1) Controlling the execution of programs
- When the execution of a program is started or stopped, only execution by the FAA is started or stopped.
- Synchronous execution by the CPU is not started or stopped.

- However, when [Yes] is selected for the [Stop FAA when stopping] property in the [Break] category on the
[Debug Tool Settings] tabbed page, you can specify whether the FAA is or not to be stopped when the CPU is
stopped.

- Step execution is only applicable to the FAA.

- If a clock signal is not being supplied to the FAA or its operation is prohibited by the FAA setting of the operation
enable bit (SYSC.ENB), starting execution of the program is not possible. Other forms of debugging operation
such as step execution also become impossible.

- A software reset is only applicable to the FAA, not to the MCU as a whole.
(2) Events

- Hardware breaks (four points) and an action event
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- If the FAA is stopped after detecting a hardware break, the CPU is not synchronously stopped.
(3) Memory
- The [Instruction code space] and [Data space] of the FAA can be displayed in the [Memory] panel.
- The display is not updated during execution of a program.
- You can specify the spaces for display in the [Memory 1] to [Memory 4] panels by making the following settings.

- [Memory] category on the [Debug Tool Settings] tabbed page of the [Property] panel
Specify the spaces which are to be displayed as [Memory n] in the [FAA memory space] property.

- Values are displayed in the [Watch] panel as follows.

- Specifying the address of an immediate value
The [Watch n] panels are displayed in accordance with the [FAA memory space] property.

- Specifying a label
A label is displayed in accordance with the memory space (instruction code space or data space) to which the
label belongs.

(4) SFR
Only those SFRs which are accessible by the FAA are displayed.
The FAA pointer and the FAA address are displayed in the address field.

(5) CPU registers
A list of CPU registers is displayed in the [CPU Register] panel according to the CPU selected as the target for
debugging.

(6) Measuring execution times

- The time from the start to the end of execution by the FAA as the target for debugging is displayed in the [Event]
panel or the status bar.

- Measuring the time executed by the FAA starts when the execution is started by the CPU or the debugger.
- The simulator only supports the display of Run-Break times for the FAA.

- Points for caution on using the debugging functions

(1) If FAA debugging is not in use, the FAA is handled in a similar way to other peripheral IP modules. In this case,
FAA debugging is not available.

(2) Programs for the FAA cannot be downloaded by using a debugger. Transfer those programs in the instruction
code area by the program of the CPU.

(3) Do not proceed with debugging of the FAA during execution of a CPU program that includes operations with the
WIND register.
Since the debugger temporarily rewrites the WIND register in the debugging operations for the FAA, the use of
FAA debugging may make operation of the program being executed by the CPU incorrect.

(4) If this facility is used, the following facilities are not available.
- Set an Action into Programs
(5) The following functions are not available for the FAA.
- Software breaks
- Measurement of the execution time for a desired range of the program
- Collecting the history of execution
- Access-related events
- Go to Here
- Step over
- Return out
- Coverage function [Simulator]

(6) When the tracing and timer functions of the CPU are enabled, the target for debugging cannot be changed during
the execution of a program in the simulator.
The target for debugging cannot be changed during the execution of a program in the E2, E2 Lite or COM port.
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(7) Since the CPU and FAA are not run in synchronization by the simulator, the Run-Break times for the CPU that
include the ranges where the CPU starts execution of the FAA are not correct.

(8) Editing instruction codes in the [Disassembly] panel is not possible.

2.5 Connect to/Disconnect from the Debug Tool

This section describes how to connect to/disconnect from the debug tool.

2.5.1 Connect to the debug tool

By selecting [Connect to Debug Tool] from the [Debug] menu, CS+ starts communicating with the debug tool selected in

the active project.
After succeeding in the connection to the debug tool, the Statusbar of the Main window changes as follows:

For details on each item displayed on the Statusbar, see the section of the "Main window".

Figure 2.13 Statusbar Indicating Successful Connection to Debug Tool

| % DISCONNECT ]

v

| ® | EREAK [ (x00lbe | @®RL7E Simulator (7 Mot measured [Ny (53] 3 |
]

I
The information of the debug tool appears at this area.

Caution If the version of compiler being used is not supported by CS+, [Connect to Debug Tool] will be disabled.

Remark 1. When the button on the Debug toolbar is clicked, the specified file is downloaded automatically after
connecting to the debug tool (see "2.6.1 Execute downloading").
When the ﬂ button on this toolbar is clicked, the project is built automatically, and then the buiilt file is
downloaded after connecting to the debug tool.

Remark 2. [Simulator]
When a microcontroller whose Simulator supports peripheral function simulations is selected, the Simu-

lator GUI window is automatically opened after connecting to the debug tool (default).

2.5.2 Disconnect from the debug tool

By clicking the button on the Debug toolbar, CS+ cuts off the communication with the connected debug tool.
After disconnecting from the debug tool, the Statusbar of the Main window changes as follows:

Figure 2.14 Statusbar Indicating Disconnection from Debug Tool

| m | EREAK »Ox00lbe  |=®RL7E Simulator (7 Not measured [¥y] (1] (23 |

v

| % DISCONNECT ]

| —

This area is left blank. "DISCONNECT" is displayed.
Caution The debug tool cannot be disconnected from CS+ while the program is running.
Remark Disconnecting the debug tool will close all the panels and dialog boxes that can be displayed only during

the connection.

2.5.3 Connect to the debug tool using hot plug-in [E1][E20]
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With hot plug-in function, you can connect the debug tool to the target board during execution of a program (without
having to turn off the system) and debug the program while it is in execution.
Follow the steps below to establish hot plug-in connection.

Caution 1.  The hot plug-in connection is enabled only when the selected microcontroller incorporates the hot plug-in

function.

Caution 2. When a hot plug-in connection is made, the settings of the following properties are ignored (i.e. the pro-

gram operates as if the specification for them is [No]). The settings of them become valid again after
reconnection with CS+.

- [Mask TARGET RESET signal]

- [Mask INTERNAL RESET signal]

- [Power target from the emulator (MAX 200mA)]

- [Erase flash ROM when starting]

Caution 3.  When a hot plug-in connection is made, events currently being set in the project are ignored.

(1)

(a)

(b)

(2)

@)

(4)

®)

(6)

They become valid again after reconnection with CS+.

Set the number of times and interval to retry

Set the interval and number of times to retry connection when the emulator fails to communicate with the micro-
controller on the target board.

You can configure this settings in [Hot Plug-in] category on the [Connect Settings] tab of the Property panel.

Figure 2.15 [Hot Plug-in] Category

4 Hot Plug-in
Retrying mitervallms] 1000
Mumber of times af relrving 3

[Retrying interval[ms]]
Specify an interval in 1 ms unit to retry the connection.
Directly enter the decimal number between 0 and 60000 (default: [1000]).

[Number of times of retrying]
Specify the number of times to retry the connection.
Directly enter the decimal number between 0 and 3 (default: [3]).

Execute the program
Execute the program which has been downloaded onto the microcontroller on the target board without connecting
to the emulator.

Select the debug tool
In the active project, select the debug tool which supports hot plug-in connection (E1/ E20).

Connect the debug tool to CS+ using hot plug-in
Select [Hot Plug-in] from [Debug] menu to initiate the preparation for hot plug-in connection.

Connect to the target board

Following message will appear once you are ready to start hot plug-in connection. Connect the emulator to the
target system and click [OK]. This will start the communication with the debug tool which is selected in the cur-
rently active project.

Figure 2.16 Message Indicating that Hot Plug-in Connection Is Ready to Be Started

[ Question(Q0204001) |

L~ Hot Plug+n is prepaned.
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ok || Coneet || Hel

Hot plug-in connection completed
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Once the connection to the debug tool is successfully completed, the Statusbar on the Main window will change as
shown below. For details on each item displayed on the statusbar, see the section of the "Main window".

Figure 2.17 Statusbar Indicating Successful Hot plug-in Connection to Debug Tool

| | i | RLIPS
A

v

JRunning @3 RL7E E1(Serial) () Measuring Ny 2 |

=% DISCONNECT ]

“RUN* indicates that the program is running.

This area shows information on the currently active debug tool.
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2.6 Download/Upload Programs

This section describes how to download programs (such as load module files) to debug to CS+ and how to upload the
memory contents being debugged from CS+ to files.

2.6.1 Execute downloading

Download the load module file to be debugged to the debug tool that is currently connected.
Follow the steps below on the [Download File Settings] tab in the Property panel for the downloading, and then execute
the downloading.

Caution By default, CPU reset automatically occurs after downloading the file, and then the program is executed
to the specified symbol position. If this operation above is not needed, specify [No] with both of the [CPU
Reset after download] and [Execute to the specified symbol after CPU Reset] property.

(1) [Download] category setting

Figure 2.18 [Download] Category

4 Downdoad
4 Dawnload files [
a [0] DatsuHBurldvbast shs
File DeiautBuilditest ahs
File type Load module file
Devenlozd phject feg
Dornloed symbol infarmatian Yes
Generate the infarmation for input completion  Yes
CPU Fezet after download ‘fag
Davnlead Mode Spesd proariy
Eraze tlazh HOM before download L]
fuiomatic change mathod of event satting pozition Suspend avant
Check rezarved area overeriting ag
Caution Properties displayed in this category differ depending on the debug tool used in the project.

(@) [Download files]
The names of files to be downloaded and download conditions are displayed (the number enclosed with "[ ]"
indicates the number of files to be download).
Files that are specified as build target files in the main project or subprojects will automatically be selected as
the files to be downloadedN°t®,
However, you can manually change the download files and the condition. In this case, see "2.6.2 Advanced

downloading".

Note To download the load module files created by an external build tool (e.g., compilers and assem-
blers other than the build tools supplied with CS+), a debug-dedicated project needs to be cre-
ated.

If you use a debug-dedicated project as the subject to debug, add your a download file to Down-
load files node on project tree. The file to be downloaded will be reflected in this property.

See "CS+ Integrated Development Environment User's Manual: Project Operation" for details on
the using an external build tool and a debug-dedicated project.

(b) [CPU Reset after download]
Specify whether to reset the CPU after downloading.
Select [Yes] to reset the CPU (default).
Note, however, that this property does not appear if the selected microcontroller always resets the CPU after
downloading.

(c) [Download Mode] (except [Simulator])
Specify the download mode for downloading to the flash ROM.
Select one of the options from the following drop-down list.

Speed priority Fills free space between the first data and the final data with FFH (the previous value in
free space before the first data and after the final data is retained).
Download speed will be faster because the writing data is reduced (default).
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(d)

(e)

()

(2)

(@)

(b)

Data priority Retains the previous value in free space.
Download speed will be very slow because data in free space are read once.

[Erase flash ROM before download] (except [Simulator])

This property is valid only when the [Download Mode] (except [Simulator]) property is set to [Speed priority]
(default).

Specify whether to erase the flash ROM before downloading.

Select [Yes] to erase the flash ROM (default: [No]).

Note that the erase operation differs depending on the emulator when [Yes] is selected.

- [IECUBE]
The internal ROM area will be always erased. For the other area, an erase will be performed in the area
where the downloaded data exists.

- [E1][E20][EZ Emulator][COM Port]
For all flash area, an erase will be performed in the area where the downloaded data exists.

Caution Flash ROM is erased by writing FFH so the flash ROM will not be blank.

[Automatic change method of event setting position]

If the file is downloaded again during debugging then the location (address) set for the currently configured
event may change to midway in the instruction.

Specify with this property how to handle the target event in this circumstance.

Select one of the options from the following drop-down list.

Move to the head of instruction | Resets the subject event at the beginning address of the instruction.

Suspend event Leaves the subject event pending (default).

Note, however, that this property setting only applies to the location setting of events without debugging infor-
mation. The location setting of events with debug information is always moved to the beginning of the source
text line.

[Check reserved area overwriting when downloading] [E1][E20][EZ Emulator][COM Port]

Specify whether to output a message when overwriting to an area reserved for use by the emulator is attempted
at the time of downloading.

Select [Yes] to output a message (default).

[Debug Information] category setting

Figure 2.19 [Debug information] Category

4 Debug Information
Execule fo the specified symbal after GPL Fased i
Specified symbol _Hain
The upper limit size of the memary uszee [Mbvtes] 500

[Execute to the specified symbol after CPU Reset]

Specify from the drop-down list whether to execute the program to the specified symbol position after CPU reset
or downloading (for only when the [CPU Reset after download] property is set to [Yes]).

Select [Yes] to execute the program to the specified symbol position after CPU reset (default).

Remark When the [CPU Reset after download] property is set to [Yes], the operation after downloading is
as follows:
If [Yes] is selected for this property, the Editor panel will open automatically with displaying
source text of the position specified with the [Specified symbol] property after downloading.
If [No] is selected for this property, the Editor panel will open with displaying source text of the
reset address (when if the source text has not been allocated to the reset address, the contents
of the reset address is displayed in the Disassemble panel).

[Specified symbol]

This property appears only when the [Execute to the specified symbol after CPU Reset] property is set to [Yes].
Specify the position at which the program is stop after CPU reset.

Directly enter an address expression between 0 and "last address in address space" (default: [_main]).

Note, however, that the program will not be executed if the specified address expression cannot be converted
into an address.
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Remark Normally, specify the following.
For assembler source: Start label corresponding to main function
For C source: Symbol assigned to the start of the main function name

(c) [The upper limit size of the memory usage [Mbytes]]
Specify the upper limit on the amount of memory to be used in reading the debug information.
When the amount of memory being used exceeds the upper limit specified here, memory is made available by
discarding debug information that has been read until the amount of memory in use is reduced to half of this
upper limit (lowering the upper limit might improve the situation when shortages of memory are arising).
Directly enter a decimal number between 100 and 1000 (unit: Mbyte) (default: [500]).

Caution In some cases, lowering the upper limit may lead to poorer responsiveness since it leads to more
frequent discarding and re-reading of debug information.

(3) Execute download
Click the button on the Debug toolbar.
If this operation is performed while disconnecting from the debug tool, the application automatically connects to
the debug tool, and then performs the download.

Remark When a program that has been modified during debugging is re-downloaded, you can easily build
and download it by selecting [Build & Download] from the [Debug] menu on the Main window.

(4) Canceling a download
To cancel a download, click the [Cancel] button on the Progress Status dialog box, which displays the progress of
downloading, or press the [Esc] key.

If the load module file is successfully downloaded, the Editor panel opens automatically, and the contents of the down-
loaded file's source text are displayed.

Remark You can automatically overwrite the value of SFR/CPU register with the specified values before and after
performing the download (see "2.17 Use Hook Function" for details).

2.6.2 Advanced downloading

You can change the download files and the condition to download.
With CS+, the following file types can be downloaded.

Table 2.2 Downloadable File Formats

Downloadable File Extension File Format
Load module file .abs Load module format
Intel Hex file .hex Intel Hex file format
Motorola S-record file .mot Motorola S-record file format

- (S0, S1, S9 - 16 bit-address)
- (S0, S2, S8 - 24 bit-address)
- (S0, S3, S7 - 32 bit-address)

Binary file .bin Binary format

You can change the download files or download conditions in the following Download Files dialog box.

The Download Files dialog box is opened by clicking the [...] button that appears at the right edge in the column of the
[Download files] property when you select it in the [Download] category on the [Download File Settings] tab of the Property
panel.
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Figure 2.20 Opening Download Files Dialog Box
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This section describes how to configure on the Download Files dialog box above when the following cases.

For details on the contents and function in each area, see the section for the Download Files dialog box.

2.6.2.1 Change download conditions for load module files
2.6.2.2 Add download files (*.hex/*.mot/*.bin)
2.6.2.3 Perform source level debugging with files other than the load module file format

2.6.2.1 Change download conditions for load module files

Follow the steps below in the Download Files dialog box to change the download conditions (object information and

symbol information) for load module files.

(1) Select a load module file

Select a load module file to download in the [Download file list] area.

(2) Change download conditions

Current download conditions for the selected load module file are displayed in the [Download file property] area.
Change each items displayed in the property.

Download object

Specify whether to download the object information from the specified file.

Default Yes
Modifying Select from the drop-down list.
Available Yes Downloads object information.
values
No Does not download object information.
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Download symbol | Specify whether to download the symbol information from the specified fileNote 1.
information

Default Yes

Modifying Select from the drop-down list.

Available Yes Downloads symbol information.
values

No Does not download symbol information.

Generate the infor- | Select whether to generate the information for the Symbol name completion function
mation for when downloadingN° 2,
input completion

Default Yes

Modifying Select from the drop-down list.

Available Yes Generates the information for the symbol name completion
values function. (i.e. uses the symbol name completion function.)
No Does not generate the information for the symbol name com-

pletion function. (i.e. does not use the symbol name comple-
tion function.)

Note 1. If the symbol information have not been downloaded, the source level debugging cannot be per-
formed.
Note 2. When [Yes] is selected, the time taken for downloading and the memory usage on the host machine

will increase. We recommend selecting [No] in this item if you do not intend to use the symbol
name completion function.

(3) Click the [OK] button
Enable all the configuration in this dialog box and change the download conditions.

2.6.2.2 Add download files (*.hex/*.mot/*.bin)

Follow the steps below to add download files other than the load module format (Intel HEX file (*.hex), Motorola S-
record file (*.mot) or binary file (*.bin)) in the Download Files dialog box.

(1) Click the [Add] button
When the [Add] button is clicked, a blank list item "-" is displayed in the last line of the [Download file list] area.

(2) Property configuration of the download files to add
Configure the download conditions for the download file to add in the [Download file property] area.
Configure each item displayed with the following condition.
When the configuration is completed, the file name specified in this property is displayed in the blank list of the
[Download file list] area.

File Specify the download file (Intel HEX file (*.hex), Motorola S-record file (*.mot) or binary file
(*.bin)) to download (up to 259 characters).

Default Blank

Modifying Directly enter from the keyboard, or specify with the Select Download File
dialog box that is opened by clicking the [...] button.

Available See "Table 2.2 Downloadable File Formats".
values
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File type Specify the type of the file to download.
Select [Hex file] or [Binary data file].

Default Load module file

Modifying Select from the drop-down list.

Available Either one of the following
values - Load module file

- Hex file

- S record file

- Binary data file

Offset Specify the offset from the address at which the file's download is to start.
Note that this item appears only when [File type] or [S record file] is set to [Hex file].

Default 0

Modifying Directly enter from the keyboard.

Available 0x0 to OxFFFFF in hexadecimal number
values
Start address Specify the address at which to start the file's download.

Note that this item appears only when [File type] is set to [Binary data file].

Default 0

Modifying Directly enter from the keyboard.

Available 0x0 to OxFFFFF in hexadecimal number
values
Remark The settings of whether to download the object information or symbol information can be made only

when the type of the file to download is load module files.

(3) Check the order of download
The order of the download is the display order of the files displayed in the [Download file list] area.
If you want to change the order, use the [Up]/[Down] button.

(4) Click the [OK] button
Enable all the configuration in this dialog box and add a download file (the file name is displayed in the [Download]
category on the [Download File Settings] tab of the Property panel).

2.6.2.3 Perform source level debugging with files other than the load module file format

Even when an Intel HEX file (*.hex), Motorola S-record file (*.mot) or binary file (*.bin) is specified to be the subject file
to download, it is possible to do source level debugging by downloading symbol information for the load module file from
which the subject file was created, along with the subject file that you download.

To do so, follow the steps below on the Download Files dialog box.

(1) Click the [Add] button
When the [Add] button is clicked, a blank list item "-" is displayed in the last line of the [Download file list] area.

(2) Property configuration of the load module file to add
Configure each item displayed with the following condition in the [Download file property] area.

File Specify a load module file from which the Intel HEX file (*.hex), Motorola S-record file
(*.mot) or binary file (*.bin) that you want to download was created.

Directly enter from the keyboard, or specify with the Select Download File dialog box that
is opened by clicking the [...] button that appears at right by selecting this property.

File type Select [Load module file] (default).

Download object Specify [No].
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Download symbol | Select [Yes] (default).
information

Generate the infor- | Select whether to generate the information for the Symbol name completion function
mation for when downloading™N°t€.
input completion

Default Yes

Modifying Select from the drop-down list.

Available Yes Generates the information for the symbol name completion
values function. (i.e. uses the symbol name completion function.)
No Does not generate the information for the symbol name com-

pletion function. (i.e. does not use the symbol name comple-
tion function.)

Note When [Yes] is selected, the time taken for downloading and the memory usage on the host machine
will increase. We recommend selecting [N0] in this item if you do not intend to use the symbol
name completion function.

(3) Click the [OK] button
Enable all the configuration in this dialog box and add the specified load module file (Only the symbol information
included in the load module file will be downloaded).

2.6.3 Execute uploading

The contents of the memory of the debug tool currently connected can be saved (uploaded) in an arbitrary file.
You can upload the data in the Data Save dialog box that is opened by selecting the [Debug] menu >> [Upload...].
In this dialog box, follow the steps below.

Figure 2.22 Execute Uploading (Data Save Dialog Box)
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(1) Specify [File Name]
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history
via the drop-down list (up to 10 items). You can also specify the file by clicking the [...] button, and selecting a file
via the Select Download File dialog box.

(2) Specify [File Type]
Select the format in which to save the file from the following drop-down list.
The following file formats can be selected.

Table 2.3 Type of Files That Can be Uploaded

Displayed List ltems File Format
Intel Hex format (*.hex) Intel Hex format
Motorola Hex format (*.hex) Motorola S type format
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Displayed List Iltems File Format

Binary data (*.bin) Binary format

(3) Specify [Save Range Address/Symbol]
Specify the range of addresses to save via "start address" and "end addresses".
Directly enter hexadecimal number/address expression in each text box or select from the input history displayed
in the drop-down list (up to 10 items).

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.20.2 Symbol name completion function").

(4) Click the [Save] button
Save the contents of the memory in the specified file in specified format as upload data.
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2.7 Display/Change Programs

This section describes how to display and change programs when a load module file with the debug information is
downloaded to a debug tool.
Downloaded programs can be displayed in the following panels.

- Editor panel
The source file is displayed and can be edited.
Furthermore, the source level debugging/instruction level debugging (see "2.8.3 Execute programs in steps") and the
display of the code coverage measurement result (see "2.14.2 Display the coverage measurement result") can be
performed in this panel.

- Disassemble panel
The result of disassembling the downloaded program (the memory contents) is displayed and can be edited (line
assemble).
Furthermore, the instruction level debugging (see "2.8.3 Execute programs in steps") and the display of the code cov-
erage measurement result (see "2.14.2 Display the coverage measurement result") can be performed in this panel.
In this panel, the disassemble results can be displayed with the corresponding source text (default).

Remark It is normally necessary to download a load module file with debugging information in order to perform
the source level debugging, but it is also possible to do so by downloading an Intel HEX file (*.hex),
Motorola S-record file (*.mot) or binary file (*.bin) (see "2.6.2.3 Perform source level debugging with files
other than the load module file format").

2.7.1 Display source files

The source file is displayed in the Editor panel below. The Editor panel automatically opens with displaying source text
of the specified position (see "2.6.1 Execute downloading") when a load module file is successfully downloaded.

If you want to open the Editor panel manually, double-click on the source file in the Project Tree panel.

For details on the contents and function in each area, see the section for the Editor panel.

Figure 2.23 Display Source File (Editor Panel)
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2.7.2 Display the result of disassembling

The result of disassembling the downloaded program (disassembled text) is displayed in the Disassemble panel below.

Select [View] menu >> [Disassemble] >> [Disassemble? - 4].

The maximum of 4 Disassemble panels can be opened. Each panel is identified by the names "Disassemble1”,
"Disassemble2", "Disassemble3" and "Disassemble4" on the titlebar.

For details on the contents and function in each area, see the section for the Disassemble panel.
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Figure 2.24 Display Result of Disassembling (Disassemble Panel)
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Remark

You can set the scroll range of the vertical scroll bar on this panel via the Scroll Range Settings dialog

box that is opened by clicking the button from [View] on the toolbar.

This section describes the following.

2.7.2.1 Change display mode
2.7.2.2 Change display format

2.7.2.3 Move to the specified address
2.7.2.4 Move to the symbol defined location
2.7.2.5 Save the disassembled text contents

2.7.2.1 Change display mode

You can change the display mode of the Disassemble panel by clicking the button (toggle) on the toolbar.

(1) Mixed display mode

In this display mode (default), the disassembled text is displayed combined with the source text.

Figure 2.25 Mixed Display Mode (Disassemble Panel)
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(2)

Disassemble display mode

In this display mode, the source text is hidden and only the disassembled text is displayed.
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Figure 2.26 Disassemble Display Mode (Disassemble Panel)

_funel:

107 dl ol PLEH HL

107 el 1§ GLR® AN

101 d [ HIWE HL . B

101 d4 I HOYE AL HL

101 441400 CVPN A, 1AM

101 de 7 BNG 3_funci+0x10
¥ 001 ds fcedd 100  CALL 'T funcla

101 da a7 INGK HL

101 df aff3 BR $_funcl+0x3

1] &l ch POP HC

101 e fmnfnﬁ RET Disassembled text

001 &3 |~ 7 PLEH HL

01 e & CLR A%

2.7.2.2 Change display format

The display format of the disassemble area can be changed using buttons below on the toolbar.

View The following buttons to change the display format are displayed.

Show Offset Displays the offset value of the label. The offset value from the nearest label is dis-
played when a label is defined for the address.

Show Symbol Displays the address value as the result of disassembling in the format "symbol + off-
set value" (default).

Note that when a symbol has been defined as the address value, only the symbol is
displayed.

Show Function Name | Displays the name of the register by its function name (default).

Show Absolute Name | Displays the name of the register by its absolute name.

2.7.2.3 Move to the specified address

You can move to the specified address in the disassembled text in the Go to the Location dialog box which opens when
selecting [Go to...] from the context menu.
In this dialog box, follow the steps below.

Figure 2.27 Move to Specified Address in Disassembled Text (Go to the Location Dialog Box)
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(1) Specify [Address/Symbol]
Specify the address you want to move the caret to.
You can either type an address expression directly into the text box (up to 1024 characters), or select them from
the input history via the drop-down list (up to 10 items).

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in this text box (see "2.20.2 Symbol name completion function").

(2) Click the [OK] button
Caret is moved to the specified address.

2.7.2.4 Move to the symbol defined location

You can move the caret to the address where the symbol is defined.
Click the button on the toolbar after moving the caret to the instruction which refers to the symbol.
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Furthermore, click the button on the toolbar following the previous operation returns the caret to the instruction
which refers to the symbol at previous caret is defined.

2.7.2.5 Save the disassembled text contents

Contents of the disassembled text can be saved in text files (*.txt)/CSV files (*.csv).

When saving to the file, the latest information is acquired from the debug tool, and it is saved in accordance with the dis-
play format on this panel.

The Data Save dialog box can be opened by selecting the [File] menu >> [Save Disassemble Data As...] (when this
operation takes place with the range selected on the panel, the disassembled data can be saved only for the selected
range).

In this dialog box, follow the steps below.

Figure 2.28 Save Disassembled Text Contents (Data Save Dialog Box)
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(1) Specify [File Name]
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history
via the drop-down list (up to 10 items).
You can also specify the file by clicking the [...] button, and selecting a file via the Select Data Save File dialog box.

(2) Specify [File Type]
Select the format in which to save the file from the following drop-down list.
The following file formats can be selected.

List Item Format
Text files (*.txt) Text format (default)
CSV (Comma-Separated Variables)(*.csv) CSV formatNote
Note The data is saved with entries separated by commas (,).
If the data contains commas, each entry is surrounded by double quotes " in order to avoid illegal
formatting.

(3) Specify [Save Range Address/Symbol]
Specify the range of addresses to save via "start address" and "end addresses".
Directly enter hexadecimal number/address expression in each text box or select from the input history displayed
in the drop-down list (up to 10 items).
If a range is selected in the panel, that range is specified as the default. If there is no selection, then the range
currently visible in the panel is specified.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.20.2 Symbol name completion function").

(4) Click the [Save] button
Disassembling data is saved in the specified file with the specified format.
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Figure 2.29 Output Example of Disassembling Data
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Remark 1. When the contents of the panel are overwritten and saved by selecting the [File] menu >> [Save

Disassemble Data], the Disassemble panels (Disassemble1-4) are handled individually for these
respectively. In addition, saving range is same as the previously specified address range.

Remark 2. You can print the current screen image of this panel by selecting the [File] menu >> [Print...].

2.7.3 Run a build in parallel with other operations

CS+ can automatically start a build when one of the following events occurs (rapid build function).
- For other than the debug-only project

- When any one of the following files that are added to the project is updated:
(C source file, C++ source file, assembler source file, header file, link directive file, symbol information file,
object module file, and library file)

- When a build target file has been added to or removed from the project
- When the link order of object module files and library files is changed

- When the property of the build tool or the build target file is changed

- For the debug-only project

- When you have edited and saved the C source file, C++ source file, assembler source file and header file that
are added to the debug-dedicated project

- When a C source file, C++ source file, assembler source file, or header file has been added to or removed from
the debug-dedicated project

- When the property of the debug-dedicated project is changed
If a rapid build is enabled, it is possible to perform a build in parallel with the above operations.
To enable/disable a rapid build, select [Rapid Build] from the [Build] menu. A rapid build is enabled by default.

Caution When an external text editor is used, check the [Observe registered files changing] check box on the
[General - Build] category in the Option dialog box to enable this function.

Remark 1. After editing source files, it is recommend to save frequently by pressing the [Ctrl] + [S] key.
Remark 2. Enable/Disable setting of the rapid build applies to the entire project (main project and subprojects).

Remark 3. If you disable a rapid build while it is running, it will be stopped at that time.

2.7.4 Perform line assembly

Instructions and code displayed in the Disassemble panel can be edited (line assembly).
This section describes the following.

2.7.4.1 Edit instructions
2.7.4.2 Edit code

2.7.4.1 Editinstructions

Follow the steps below to edit instructions.
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(1) Switch to edit mode
Double-click the instruction to edit or select [Edit Disassemble] from the context menu after moving the caret to the
instruction to edit.

(2) Edit instructions
Use keyboard to directly edit the instructions.

(3) Write to memory
Press the [Enter] key to line assemble the edited instructions after editing. The code is automatically written to the
memory.
If the edited instruction is invalid, the instruction is shown in red and will not be written to the memory.

If there is a space because of overwriting the displayed result of disassembling by another instruction, its byte number is
automatically compensated with NOP instruction as follows:

Example 1.  MOVW instruction (4-byte instruction) in the second line is overwritten by DEC instruction (1-byte instruc-

tion).

Before editing 0461CF ADDW AX, #0CF61H
CBF820FE MOVW SP, #0FE20H
FC8E1800 CALL !'l funcA
53C0 MOV B, #0COH

After editing 0461CF ADDW AX, #0CF61H
93 DEC B
00 NOP
00 NOP
00 NOP
FC8E1800 CALL !'l funcA
53C0 MOV B, #0COH

Example 2.  ADDW instruction (3-byte instruction) in the first line is overwritten by MOVW instruction (4-byte instruc-

tion).
Before editing 0461CF ADDW AX, #0CF61H
CBF820FE MOVW SP, #0FE20H
FC8E1800 CALL !'l funcA
53C0 MOV B, #0COH
After editing CBF820FE MOVW SP, #0FE20H
00 NOP
00 NOP
00 NOP
FC8E1800 CALL !'!l funcA
53C0 MOV B, #0COH

2.7.4.2 Edit code

Follow the steps below to edit code.

(1)  Switch to edit mode
Double-click the code to edit or select [Edit Code] from the context menu after moving the caret to the code to edit.

(2) Editcode
Use keyboard to directly edit the code.

(3) Write to memory
Press the [Enter] key to write the code to the memory after editing.
If the edited instruction is invalid, the instruction is shown in red and will not be written to the memory.
When the code is written to the memory, the result of disassembling is also updated.
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2.8 Execute Programs

This section describes how to execute programs.
Main operations in this section are taken place from the debug toolbar or the [Debug] menu in the Main window, where
commands to control the execution of programs are included.

Caution Items of the debug toolbar and the [Debug] menu are valid only while connected to the debug tool.

Figure 2.30 Debug Toolbar
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2.8.1 Reset microcontroller (CPU)

To reset CPU, click the button on the debug toolbar.
When CPU is reset, the current PC value is set to the reset address.

Remark You can automatically overwrite the value of SFR/CPU register with the specified values after CPU reset
under breaking (see "2.17 Use Hook Function" for details).

2.8.2 Execute programs

The following types of CS+ execution functions are provided.
Select any of the following operations according to the purpose of debugging.
See "2.9 Stop Programs (Break)" for details on how to stop the program in execution.

2.8.2.1 Execute after resetting microcontroller (CPU)
2.8.2.2 Execute from the current address
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2.8.2.3 Execute after changing PC value
Remark You can automatically overwrite the value of SFR/CPU register with the specified values before starting

program execution (see "2.17 Use Hook Function" for details).

2.8.2.1 Execute after resetting microcontroller (CPU)

Click the button on the debug toolbar.
Reset CPU and start execution of the program from the reset address.
When this operation is performed, the program continues to be executed until either of the following occurs:

- The button has been clicked (see "2.9.2 Stop the program manually").
- The PC has reached a breakpoint (see "2.9.3 Stop the program at the arbitrary position (breakpoint)").

- A break event condition has been met (see "2.9.4 Stop the program at the arbitrary position (break event)" or "2.9.5
Stop the program with the access to variables/SFRs").

- A fail-safe break has occurred (see "2.9.6 Stop the program when an invalid execution is detected [[IECUBE]").

- Other break causes have occurred.
Remark This operation is the same as when the button is clicked after clicking the button.

2.8.2.2 Execute from the current address

Perform any of the following operations to start executing the program from the address at the current PC value.

(1)

(2)

@)

Normal execution

Click the button on the debug toolbar.
When this operation is performed, the program continues to be executed until either of the following occurs:

- The button has been clicked (see "2.9.2 Stop the program manually").
- The PC has reached a breakpoint (see "2.9.3 Stop the program at the arbitrary position (breakpoint)").

- A break event condition has been met (see "2.9.4 Stop the program at the arbitrary position (break event)" or
"2.9.5 Stop the program with the access to variables/SFRs").

- A fail-safe break has occurred (see "2.9.6 Stop the program when an invalid execution is detected [[IECUBE]").

- Other break causes have occurred.

Execution ignoring break-related events

Click the button on the debug toolbar.
When this operation is performed, the program continues to be executed until either of the following occurs:

- The button has been clicked (see "2.9.2 Stop the program manually").
- A fail-safe break has occurred (see "2.9.6 Stop the program when an invalid execution is detected [I[ECUBE]").

- Other break causes have occurred.
Remark If you have started the execution with this operation, the occurrence of Action event will also be
ignored.

Execution to the caret position
To start this operation, move the caret to the line/instruction to stop the program in the Editor panel/Disassemble

panel, then select [Go to Here] from the context menu.
When this operation is performed, the program continues to be executed until either of the following occurs:

- The PC has reached the address of the caret position.

- The button has been clicked (see "2.9.2 Stop the program manually").
- A fail-safe break has occurred (see "2.9.6 Stop the program when an invalid execution is detected [[IECUBE]").

- Other break causes have occurred.

Caution When the corresponding address of the line at the caret position does not exist, the program is exe-
cuted to the corresponding address of the lower valid line (if the corresponding address does not

exist, an error message will appear).
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Remark If you have started the execution with this operation, the occurrence of Action event will also be
ignored.

2.8.2.3 Execute after changing PC value

The program is executed after forcibly changing the current PC value to an arbitrary address.

To start this operation, move the caret to the line/instruction to start the program in the Editor panel/Disassemble panel,
then select [Set PC to Here] from the context menu (the current PC value is set to the address of the line/instruction where
the caret currently exists).

Then execute either one of the execution method described in "2.8.2.2 Execute from the current address".

2.8.3 Execute programs in steps

When either of the following operation has occurred, the program will stop automatically after conducting step execution
in the source level (1 line of source text) or in the instruction level (1 instruction).

Once the program is stopped, the contents of each panel will be updated automatically. As such, step execution is
suited for debugging the program execution in transition either in source or instruction level.

The unit in which the program is step-executed depends on the setting of the Editor panel as follows:

- When the button on the toolbar is invalid (default):
Step execution is conducted in source level.
Note, however, that when the focus is in the Disassemble panel or the line information does not exist in the address

specified by the current PC value, the step execution is conducted in instruction level.

- When the button on the toolbar is valid:
Step execution is conducted in instruction level.

Remark The button is only enabled if the mixed display mode is selected on the Editor panel (see "CS+ Inte-
grated Development Environment User's Manual: Editor").

Step execution is divided into the following types:

2.8.3.1 Step in function (Step in execution)
2.8.3.2 Step over function (Step over execution)
2.8.3.3 Execute until return is completed (Return out execution)

Caution 1.  Breakpoints, break events, and action events that have been set do not occur during step execution.

Caution 2.  [f an instruction to move to standby mode (HALT/STOP) is executed during step execution, the program
will break at the next instruction after the standby mode instruction.
This behavior differs depending on the debug tool used.

- For other than [Simulator]
It will not go into standby mode during step execution.

- [Simulator]
It will go into standby mode during step execution.
It will appear that standby mode has been released. Check the CPU status on the Main window's sta-

tusbar to see if standby mode has been released.

Caution 3.  For other than [Simulator]
Interrupts are not acknowledged and fail-safe breaks [IECUBE] do not occur during step execution.

Caution 4. [Simulator]
You may jump to an interrupt handler during step execution.

Caution 5.  During source-level stepping, the debugger may appear to be executing instructions that are not sup-
posed to be executed.
However, the reason for these problems is a difference between the debugging information generated by
the compiler and the actual code. The result of executing the code generated by the compiler is correct.

Example In the program code shown below, it seems that the position indicated by the current PC
might be moved to position (*1) after the execution of (*2), although (*1) is never actually
executed in the generated code.
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void main (void) ;
int x, vy, zl, z2, z3;
void func (int 1)
{
if (1 == 0) {
++x; // <-(*1)
t+zl;++z2;++23;
} else {
++y; [/ <=(*2)
++z1;++z2;++23;
}
}
int one = 1;
void main (void)
{
while (1)
{
func (one) ;
}
}

Note that this caution may be eliminated by making either or both of the following settings on the [Com-
pile Options] tab in the Property panel of the build tool.

- Set the [Enhance debug information with optimization] property to [Yes(-g_line)] in the [Debug Informa-
tion] category.

- Set the [Level of optimization] property to [Debug precedence(-Onothing)] in the [Optimization] cate-
gory.

2.8.3.1 Step in function (Step in execution)

When the function is called, the program is stopped at the top of the called function.
Click the button on the debug toolbar to perform Step in execution.

Caution 1.  Step in execution for a function without the debug information is not possible.

Caution 2.  If Step in execution is performed for the longjmp function, program execution may not complete and may
wait for a time-out.

Caution 3.  The beginning of the function (prologue processing) is not skipped. To skip prologue processing, perform
Step in execution again.

2.8.3.2 Step over function (Step over execution)

In the case of a function call by the CALL instruction, all the source lines/instructions in the function are treated as one
step and executed until the position where execution returns from the function (step execution will continue until the same
nest is formed as when the CALL instruction has been executed).

Click the button on the debug toolbar to perform Step over execution.

In the case of an instruction other than CALL, operation is the same as Step in execution.

Caution If Step over execution is performed for the longjmp function, program execution may not complete and
may wait for a time-out.

2.8.3.3 Execute until return is completed (Return out execution)

Step-execute the program so that the program will stop when it returns from the current function to the caller function.
When the execution of source line/instruction that require checking has been completed, you can perform step execution
using this instruction so that you can make the program return to the caller function without step executing the remaining
instructions inside the function.

Click the button on the debug toolbar to perform Return out execution.

Caution 1.  If Return out execution is performed in the main function, the program is stopped in the startup routine.
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Caution 2.  If Return out execution is performed in a function that called the longjmp function, breaks may not occur.

Caution 3.  Return out execution cannot be performed immediately after a function return.

2.9 Stop Programs (Break)

This section describes how to stop the program in execution.
CS+ can stop the program in execution at the arbitrary position by using the following functions.

(1) Forced break function
Stops the program forcibly.

(2) Hardware break function
The debug tool consecutively checks the break condition while the program is in execution and stops the program
when the condition is met. This function is implemented using the debug tool resources.
There are two types of Hardware Break event: "execution type" which stops the program at the arbitrary position;
and "access type" which stops the program when an arbitrary variable and so on is accessed with the specified

type.

Remark 1. [IECUBE]
There are two types of Hardware Break event (execution type): "before execution break" which
breaks before the instruction at the specified address is executed; and "after execution break"
which breaks after the instruction at the specified address is executed. CS+ starts by using "before
execution break" resource to set Hardware Break events, and as soon as that resource becomes
unavailable, uses "after execution break" resource (see "2.16.7.1 Maximum number of enabled
events"). For this reason, you cannot select between before and after execution.

Remark 2. [E1][E20][EZ Emulator][COM Port]
Hardware Break events (execution type) break the program after the instruction at the specified
address is executed.

Remark 3. [Simulator]
For a Hardware Break event (execution type), you can select between "before execution break"
which breaks before the instruction at the specified address is executed and "after execution break"
which breaks after the instruction at the specified address is executed (see "2.9.1.3 [Simulator]").

(3) Software break function (except for [Simulator])
Temporarily replaces the instruction code for a specified address with a break instruction and stops the program
when this instruction is executed.

Caution 1.  If a forced break is performed while in standby mode (HALT/STOP), the current PC position will indicate
the address of the next instruction after the standby mode instruction.
This behavior differs depending on the debug tool used.

- For other than [Simulator]
The forced break will release standby mode.

- [Simulator]
The forced break will not release standby mode.
It will appear that standby mode has been released. Check the CPU status on the Main window's sta-
tusbar to see if standby mode has been released.

Caution 2.  [E1][E20][EZ Emulator][COM Port]
Do not decrease the voltage of the target system during a break. A reset that is generated by the low-
voltage detector (LVI) or by power-on-clear (POC) during a break causes an incorrect operation of CS+
or communication errors.
A break during emulation of power supply off also causes communication errors.

Remark When the program in execution is stopped, a statement of the cause of the break appears on the Status-
bar in the Main window.

2.9.1 Configure the break function

Before the break function can be used, it is necessary to make settings relating to the operation of a break.
This break operation can be configured in the [Break] category on the [Debug Tool Settings] tab of the Property panel.
The setting method differs depending on the debug tool used.
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2.9.1.1 [IECUBE]
2.9.1.2 [E1)/[E20)/[EZ Emulator]/[COM Port]
2.9.1.3 [Simulator]

2.9.1.1 [IECUBE]

Figure 2.32 [Break] Category [IECUBE]
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[First using type of breakpoint]
Specify the type of preferential breakpoint with a single click of the mouse in the Editor panel/Disassemble panel.
Select from the drop-down list below for each use of the breakpoint.

Hardware break Sets hardware breakpoint with priority, by using the Hardware break function.
Once set, it is treated as a Hardware Break event (execution system).

Software break Sets software breakpoint with priority, by using the Software break function (except for
[Simulator]) (default).
Once set, it is treated as a Software Break event.

Caution If the number of the set breakpoints of the specified type exceeds the limit settable (see "2.16.7.1
Maximum number of enabled events"), a breakpoint of another type will be used.

[Stop emulation of timer group when stopping]

Select whether to terminate the peripheral emulation of timers while stopping the program execution (Peripheral
Break).

Select [Yes] to terminate (default: [No]).

[Stop emulation of serial group when stopping]

This property appears only when the selected microcontroller supports the function that terminates the peripheral
emulation of serials (Peripheral Break).

Select whether to terminate the peripheral emulation of serials while stopping the program execution.

Select [Yes] to terminate (default: [No]).

[Use open break function]

This property appears only when the selected microcontroller supports the open break function.
Select from the following drop-down list whether to use the open break function.

The default value depends on the type of the selected microcontroller.

Yes(Hi-Z) The open break target pin becomes the Hi-Z state after the CPU is stopped.

No(Output signal) The open break target pin outputs the signal even after the CPU is stopped.

2.9.1.2 [E1]/[E20)/[EZ Emulator]/[[COM Port]

Figure 2.33 [Break] Category [E1][E20][EZ Emulator][COM Port]
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[First using type of breakpoint]

This property appears only when the selected microcontroller supports multiple types of breakpoint.

Specify the type of preferential breakpoint with a single click of the mouse in the Editor panel/Disassemble panel.
Select from the drop-down list below for each use of the breakpoint.
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Hardware break Sets hardware breakpoint with priority, by using the Hardware break function.
Once set, it is treated as a Hardware Break event (execution system).

Software break Sets software breakpoint with priority, by using the Software break function (except for
[Simulator]) (default).
Once set, it is treated as a Software Break event.

Caution If the number of the set breakpoints of the specified type exceeds the limit settable (see "2.16.7.1
Maximum number of enabled events"), a breakpoint of another type will be used.

(2) [Stop emulation of timer group when stopping]
Select whether to terminate the peripheral emulation of timers while stopping the program execution (Peripheral
Break).
Select [Yes] to terminate (default: [No]).
In the case of the selected microcontroller that provides the open break function, when this property is set to [Yes],
the open break target pin becomes the Hi-Z state after the CPU is stopped (when this property is set to [No], the
open break target pin outputs the signal even after the CPU is stopped).

(3) [Stop emulation of serial group when stopping]
This property appears only when the selected microcontroller supports the function that terminates the peripheral
emulation of serials (Peripheral Break).
Select whether to terminate the peripheral emulation of serials while stopping the program execution.
Select [Yes] to terminate (default: [No]).

(4) [Restore the breakpoint when pin reset occurs]
This property only appears if the selected microcontroller supports the function of restoring breakpoints after a pin
reset and the [Permit flash programming] property in the [Flash] category on the [Connect Settings] tab is set to
[Yes].
Select whether to restore the breakpoints when a pin reset occurs.
When [Yes] is selected, the CPU is briefly halted for restoration of the breakpoints after a pin reset (default).
When [No] is selected, the breakpoints are ignored and not restored after a pin reset, but are restored when the
program is stopped.

2.9.1.3 [Simulator]

Figure 2.34 [Break] Category [Simulator]
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(1) [Execute instruction at breakpoint when break]
You can specify the timing to stop the program execution by breakpoints whether after or before the execution of
the instruction at the breakpoint. Specify in this property whether to break after executing the instruction.
Select [Yes] to break after execution of the instruction (default: [No]).
All set breakpoints are handled as Hardware Break events.

Caution When [Yes] is selected, all of action events currently being set are handled as Hardware Break
events (see "2.15 Set an Action into Programs").

2.9.2 Stop the program manually

The program in execution is forcibly stopped by clicking the button on the debug toolbar.

2.9.3 Stop the program at the arbitrary position (breakpoint)

The program in execution can be stopped at the arbitrary position by setting a breakpoint. A breakpoint can be set by
one-clicking with the mouse.

You need to configure the type of breakpoints to use before setting a breakpoint.

This section describes the following operations.

2.9.3.1 Set a breakpoint
2.9.3.2 Edit a breakpoint
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2.9.3.3 Delete a breakpoint

2.9.3.1 Set a breakpoint

Breakpoints can be set via the Editor panel/Disassemble panel in which the source text/disassembly text is displayed.

Within the Main area (Editor panel) or Event area (Disassemble panel) in which a valid address is displayed, click on the
location where you want to set a breakpoint. A breakpoint whose type is being selected in the [First using type of break-
point] property is set to the instruction at the start address corresponding to the clicked line.

When a breakpoint is set, the following event mark appears at the breakpoint location, and the source text line/disas-
sembled text line is highlighted.

Itis interpreted as if a break event (Software Break or Hardware Break) has been set at the target address, and it is
managed in the Events panel (see "2.16 Manage Events" for details).

Table 2.4

Event Marks of Breakpoint

Type of Breakpoint

Event Type

Event Mark

Hardware breakpoint

Hardware Break eventNote

Software breakpoint
(except [Simulator])

Software Break eventNote

a7

Note

In the [Name] area of the Events panel, "Break" is displayed as the event type name.

Figure 2.35 Breakpoint Setting Example (Disassemble Panel)
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Figure 2.36 Example of Setting Breakpoint in Events Panel
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Caution 1.  Since a breakpoint is set as a break event and managed as a event, restrictions apply to the number of
breakpoints that can be simultaneously set. Also see "2.16.7 Notes for setting events" for details on
breakpoints (e.g. limits on the number of enabled events).

Caution 2.  No software breakpoints can be set to the data flash memory area.

Caution 3.  Breakpoints can only be set at lines that have valid addresses.

Remark 1. Event marks differ depending on the event state (see "2.16.1 Change the state of set events (valid/
invalid)").

When an event is set at the point where other event is already set, the event mark ( h,_.o ) is displayed
meaning more than one event is set at the point.

Remark 2. [Simulator]

The type of breakpoint that can be set is locked to hardware breakpoints.

R20UT5301EJ0100 Rev.1.00
Jun 01, 2023

RENESAS

Page 47 of 413



CS+V8.10.00 2. FUNCTIONS

Remark 3. For other than [Simulator]
You can set hardware breakpoints/software breakpoints without depending on the specification of "2.9.1
Configure the break function" by following the step below.
Note, however, that "Operation 1" is only available in the Disassemble panel.

Type Operation 1 Operation 2

Hardware breakpoint [Ctrl] + mouse click Select [Break Settings] >> [Set Hardware Break]
from the context menu.

Software breakpoint [Shift] + mouse click Select [Break Settings] >> [Set Software Break]
from the context menu.

2.9.3.2 Edit a breakpoint

It is possible to edit a breakpoint you have set.
For details on how to do it, see "2.16.4.1 Edit execution-related events".

Caution This function applies to only a breakpoint whose type is Hardware Break.

2.9.3.3 Delete a breakpoint

Click event marks displayed in the Editor panel/Disassemble panel to delete set breakpoints (the event mark will be
erased).

2.9.4 Stop the program at the arbitrary position (break event)

The program in execution can be stopped at the arbitrary position by setting a break event (execution type).
This section describes the following operations.

2.9.4.1 Set a break event (execution type)
2.9.4.2 Edit a break event (execution type)
2.9.4.3 Delete a break event (execution type)

2.9.4.1 Set a break event (execution type)

Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is displayed.
Follow the operation listed below from the context menu, in accordance with your desired event type, after moving the
caret to the target line that has a valid address.

Event Type Operation Description
Hardware Break Select [Break Settings] >> [Set Hardware | Sets a Hardware Break event by using the Hard-
Break] ware break function.
Software Break Select [Break Settings] >> [Set Software Sets a Software Break event by using the Soft-
(except [Simulator]) | Break] ware break function (except for [Simulator]).

Combination Break | Select [Break Settings] >> [Set Combina- | A combined break event, that is, a break condi-
[E1][E20] tion Break] tion that is a combination of multiple break
events, may be set as the target event condition
on the E1 and E20N°® (see "Edit combination
conditions of events [E1] [E20]").

Note [E1][E20]
This function is enabled only when the selected microcontroller supports a combination break event.

A break event is set to the instruction at the start address corresponding to the line of the caret position. When a break
event (execution type) is set, the following event mark appears at the break event location, and the source text line or dis-
assembled text line will be highlighted.

When you have performed this operation, the set break event is managed in the Events panel as a Hardware Break
event (execution type)/Software Break event (execution type) or a execution-related event in the detailed information on a
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Combination Break event (see "2.16 Manage Events" for details).

Table 2.5 Event Marks of Break Event

Event Type

Event Mark

Hardware Break

Software Break
(except [Simulator])

Combination Break
[E1][E20]

Figure 2.37 Break event Setting Example (Disassemble Panel)
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Figure 2.38 Example of Setting Hardware Break Event (Execution Type) in Events Panel
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Figure 2.39 Example of Setting Combination Break Event (Execution Type) in Events Panel [E1][E20]

[¥] == Uncarnditonal Trace

Events =]
X M| |5| 85 £ 5 @

Harre Detanl Cammeant

== Pun—Ereak Timer bkt measured

G W5 Gombination Break R

Dietail

|-"|ﬂ;|=r Execution UG_mamc 2 025 X

Harre Detail Caomenznt

Caution 1.  When setting a break event (execution type), also see "2.16.7 Notes for setting events" for details (e.g.
limits on the number of valid events).

Caution 2.  No software breakpoints can be set to the data flash memory area.

Remark Event marks differ depending on the event state (see "2.16.1 Change the state of set events (valid/

invalid)"). When an event is set at the point where other event is already set, the event mark ( HI_,@ )is

displayed meaning more than one event is set at the point.
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2.9.4.2 Edit a break event (execution type)

It is possible to edit a break event (execution type) you have set.
For details on how to do it, see "2.16.4.1 Edit execution-related events" or "2.16.4.3 Edit combination conditions of
events [E1] [E20]".

Caution This function applies to only a break event (execution type) whose type is Hardware Break or Combina-
tion Break [E1][E20].

2.9.4.3 Delete a break event (execution type)

To delete a break event (execution type) you have set, click the event mark displayed in the Editor panel/Disassemble
panel.

Also, there is another way to delete a set break event. Select a Software Break event/Hardware Break event, or Com-
bination Break event [E1][E20] in the Events panel, and then click the button in the toolbar (see "2.16.5 Delete
events").

Caution In the Events panel, you cannot delete a break event (execution type) selectively in the combination
breaks. All the break events (including access type) displayed in the detailed information on the combina-
tion break will be deleted.

2.9.5 Stop the program with the access to variables/SFRs

By setting a break event with the access, the program can be stopped when an arbitrary variable or SFR is accessed
with the specified type.

You can also limit the accessed value.

The following types can be specified with the access.

Table 2.6 Types of Accesses to Variables

Access Type Description
Read The program is stopped with the read access to (after reading) the specified variable/SFR.
Write The program is stopped with the write access to (after writing) the specified variable/SFR.
Read/Write The program is stopped with the read access/write access to (after reading or writing) the
specified variable/SFR.

Caution [IECUBE][E1][E20][EZ Emulator][COM Port]
The program is stopped with the access via DMA (Direct Memory Access).

This section describes the following.

2.9.5.1 Set a break event (access type)
2.9.5.2 Edit a break event (access type)
2.9.5.3 Delete a break event (access type)

2.9.5.1 Set a break event (access type)

Use one of the following methods to set a break event (access type) that stops programs with the access to a variable/
SFR.

Caution 1.  Also see "2.16.7 Notes for setting events" for details on breakpoints (e.g. limits on the number of enabled
events).

Caution 2.  For other than [Simulator]
The access break events described here cannot be set for 32-bit (4-byte) variables.
Additionally, accessing a single byte of a 16-bit (2-byte) variable will not be detected as an access.

(1) Seta break event to a variable/SFR in the Editor panel/Disassemble panel
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played.
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Follow the operation listed below from the context menu, in accordance with your desired access type, after
selecting an arbitrary variable or SFR on the source text/disassembled text. Note, however, that only global vari-
ables, static variables inside functions, and file-internal static variables can be used.

Access Type Operation

Read Select [Break Settings] >> [Set Read Break to]/[Set Read Combination Break to]Note, and
then press the [Enter] key.

Write Select [Break Settings] >> [Set Write Break to]/[Set Write Combination Break to]NOte, and
then press the [Enter] key.

Read/Write Select [Break Settings] >> [Set R/W Break to]/[Set R/W Combination Break to]NOte, and then
press the [Enter] key.

Note [E1][E20]
A combined break event, that is, a break condition that is a combination of multiple break events,
may be set as the target event condition on the E1 and E20 (see "2.16.4.3 Edit combination condi-
tions of events [E1] [E20]").
Note, however, that this function is enabled only when the selected microcontroller supports a com-
bination break event.

At this time, if you have specified a value in the text box in the context menu, break will occur only when the spec-
ified value is used for the reading, writing or reading/writing. On the other hand, if no value is specified, reading.,
writing or reading/writing the selected variable by any value will cause the break to occur.

Caution 1.  Variables within the current scope can be specified.

Caution 2.  Variables or SFR at lines that have no valid addresses cannot be used for break events.
Figure 2.40 Example of Setting Break Event (Access Type) on Variable in Editor Panel

| Jump to Function

fl‘ Tag Jump Shifft

From the context menu above the variable "data1"
enter a value in [Break Settings] >> [Set Writ
Break to], then press the [Enter] key.

Here, the program will break when the value "Oxb"
is written to the variable "data1".

= w™ | Colunng 3‘_‘, Jump to Disassemble

o O Bockmarks
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Figure 2.41 Example of Setting Combination Break Event (Access Type) on Variable in Editor Panel [E1][E20]

Jump to Function
From the context menu above the variable "data1",

-
i Tag Jump Shift4 enter a value in [Break Settings] >> [Set Writ Com-
e

= w= | Colummy

bination Break to], then press the [Enter] key.
Here, the program will break when the value "Oxb"
is written to the variable "data1".
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Tr?ﬁ;! Advanced
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BT e - [, Set Write Combination Break to 0xb )
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|~"_‘*r Break Qption
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(2) Seta break event (access type) to a registered watch-expression
You can set break events in the Watch panel.
Follow the operation listed below from the context menu, in accordance with your desired access type, after
selecting the registered watch-expression (multiple selections not allowed).
Note, however, that only global variables, static variables inside functions, file-internal static variables, and SFR

can be used.
Access Type Operation
Read Select [Access Break] >> [Set Read Break to]/[Set Read Combination Break to]N°te, and
then press the [Enter] key.
Write Select [Access Break] >> [Set Write Break to]/[Set Write Combination Break to]N°‘e, and then
press the [Enter] key.
Read/Write Select [Access Break] >> [Set R/W Break to]/[Set R/W Combination Break to]N°te, and then
press the [Enter] key.
Note [E1][E20]

A combined break event, that is, a break condition that is a combination of multiple break events,
may be set as the target event condition on the E1 and E20 (see "2.16.4.3 Edit combination condi-
tions of events [E1] [E20]").

Note, however, that this function is enabled only when the selected microcontroller supports a com-
bination break event.

At this time, if you have specified a value in the text box in the context menu, break will occur only when the spec-
ified value is used for the reading., writing or reading/writing. On the other hand, if no value is specified, reading.,
writing or reading/writing the selected watch-expression by any value will cause the break to occur.

Caution A watch-expression within the current scope can be specified.
To target a watch-expression outside the current scope, select a watch-expression with a specified
scope.
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Figure 2.42 Example of Setting Hardware Break Event (Access Type) on Watch-Expression

Watch1 E
@ @ L U] W | Motation- |[FHe
Watch Yalue Type(Byle Size) Address Mewo |

I\ Trace Output v |46 Set Write Break toa(| 0xb

| From the context menu above the watch-expression "data1",
enter a value in [Access Break] >> [Set Write Break to], then
| ?d press the [Enter] key.
Here, the program will break when the value "0xb" is written to
the watch-expression "data1".

Figure 2.43 Example of Setting Combination Break Event (Access Type) on Watch-Expression [E1][E20]

Watch1 =|

| & L, U] % | Mokation- ||

Fak ch Walue Type(Byie Size) Pddress Nemo |

w ref\J Access Break k|4l Set Read Combination Break to

Trace Qutput » |46 Set Write Combination Break t|0xb [

From the context menu above the watch-expression "data1", Break to
- enter a value in [Access Break] >> [Set Write Combination
m Break to], then press the [Enter] key.
Here, the program will break when the value "Oxb" is written to
the watch-expression "data1".

When you have performed the above operation, the set break event (access type) is managed in the Events panel
as a Hardware Break event (access type) or a execution-related event in the detailed information on a Combina-
tion Break event (see "2.16 Manage Events" for details).

Figure 2.44 Example of Setting Hardware Break Event (Access Type) in Events Panel

Events &
L B R E Y
S Detail  Ciomment
S =2 Fup-Break. Timer Mot measured
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Figure 2.45 Example of Setting Combination Break Event (Access Type) in Events Panel [E1][E20]

Events ]
AL Ll El RS
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2.9.5.2 Edit a break event (access type)

It is possible to edit a break event (access type) you have set.
For details on how to do it, see "2.16.4.1 Edit execution-related events" or "2.16.4.3 Edit combination conditions of
events [E1] [E20]".

2.9.5.3 Delete a break event (access type)

To delete a break event (access type) you have set, select a Hardware Break event, or Combination Break event
[E1][E20] in the Events panel, and then click the button in the toolbar (see "2.16.5 Delete events").

For a Combination Break event [E1][E20], it is also possible to delete a break event (access type) by clicking on the
event mark on the Editor panel/Disassemble panel.

Caution In the Events panel, you cannot delete a break event (execution type) selectively in the combination
breaks. All the break events (including access type) displayed in the detailed information on the combina-
tion break will be deleted.

2.9.6 Stop the program when an invalid execution is detected [IECUBE]

The system forcibly breaks the program execution when unexpected program behavior such as invalid access to inter-
nal ROM/internal RAM/SFR/external memory is detected (fail-safe break function).

This function has various break conditions. Enable/disable each break condition in the [Fail-safe Break] category on the
[Debug Tool Settings] tab of the Property panel.

Caution The fail-safe break function becomes invalid during step execution.

Figure 2.46 [Fail-safe Break] Category
4 Fail-zafe Break

Hap when fetched fram felch profected ares s
stop when wrote fooweite protected area g
Stap when read from read protected SFR Yes
Shap when wrole fo write prelected SFR Yes
stop when overflowed user stack Mo
Stop when widarflomed user stack Mo
Uzar slack saction siack basz
hop when cperated winitalzed stack ponter Yes
Stop when read from uninitialized P Yeg
Stap when accessed (o non-mapping asa Yes
Hop when word miss=alien accessad s
Stop when received fail zafe from peripheral ies
Stop when occurred flash illzgal Mo

In the following property setting, select [Yes] to enable and [No] to disable the function from the drop-down list.
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All the properties are set to [Yes] by default (with some exceptions).
- [Stop when fetched from fetch protected areal
- [Stop when wrote to write protected area]

- [Stop when read from read protected SFR]

- [Stop when wrote to write protected SFR]

- [Stop when overflowed user stack]Nte

- [Stop when underflowed user stack]No®

- [Stop when operated uninitialized stack pointer]
- [Stop when read from uninitialized RAM]

- [Stop when accessed to non-mapping area]

- [Stop when word miss-align accessed]

- [Stop when received fail safe from peripheral]

- [Stop when occurred flash illegal]

Note [No] is selected by default.
To set to [Yes], the [User stack section] property on the bottom must be set to the address of the user
stack section (default: [.stack_bss]).

2.9.7 Other break causes

The cause of the break other than the described above is as follows:
You can confirm the break cause with the Status message on the statusbar in the Main window.

Table 2.7 Other Break Causes

Break Cause Debug Tool to Use
IECUBE E1/E20/ E2 Simulator
EZ Emulator/
COM Port

Full of the trace memory™N°te 1 e - - v

An occurrence of Trace Delay Break Vs - - -
Execution time-over detected Vs - - -

An access to non-mapped area e - - v

A writing to write-protected area v - - v

An access to the odd number address by the word v - - e
width

An occurrence of Temporary BreakNot 2 7 7 v 7

An occurrence of Flash lllegal Break s - - -
lllegal action of program related to the peripheral chip e - - -
functionNote 3

Failure to execute/uncertain cause Vs Ve vy -

Full of the current consumption bufferNote 4 - - - v

E2 expansion function - - « -
Fully used the storage memory - - vy -

Note 1. The operation depends on the setting of the [Operation after trace memory is full] property in the [Trace]
category on the [Debug Tool Settings] tab of the Property panel.
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Note 2. A break that is internally used by CS+. (Users cannot use it.)
Note 3. See the documentation on peripheral emulation board to use.
Note 4. The operation is supported only by the simulator that supports the current consumption measurement.

2.10 Display/Change the Memory, Register and Variable

This section describes how to display/change the memory, register and variable.

2.10.1 Display/change the memory

The contents of the memory can be displayed and its values can be changed in the Memory panel below.
Select the [View] menu >> [Memory] >> [MemoryT - 4].

The maximum of 4 Memory panels can be opened. Each panel is identified by the names "Memory1", "Memory2",
"Memory3" and "Memory4" on the titlebar.
For details on the contents and function in each area, see the section for the Memory panel.

Figure 2.47 Display the Contents of Memory (Memory Panel)

Memory 1 =]
2| @8 | Motaticn- | Size Motation- | Encoding-  View -
[] Whee: wehen Siop | finve |
[ HI +1 +F 45 +4 +5 +5 +7 #0 +3 #a th o\ s=af T AOPTT

00920 BF BT EF C0J&) FC C1 EG|EF BA EF CO|&1 F) Display position specification area
007zl 02 00 FC I7)08 00 FC D1 (07 o0 FC FLIDT e o TACTERE CERECTRE
00740 07 CF F& IG017 44 14 00(DE OF FC E3 |01 00 &F EF M0 0T
00720 | F3 Cs D7 CTIFE 96 17 44|04 00 [E 02 |AF EF F7 CE .0
COTF0 07 CF F6 TSH17 44 04 00|DE OF FC 03 {02 00 &7 EF Y I
0nzon | F3 C= D7 % FE 16 17 44|04 00 DE 03 |AT EF F7 CE B T
0nz10 | oy S 77 FC 43 02 O0|FC 32 02 00 |FC 4E 02 00 T Tl 12 T .
00220 | F5 FO02 F5)79 00 07 71|78 F& FC 11|02 00 71 74 019007, 92
00220 | FA DF FE ADIFF 71 74 AT|71 4B &4 71|64 &1 OF F3 T2k g1t <

| | | 1 I 'l | |
(1) ) @)

(1): Address area

(2): Memory value area

(3): Character strings area

Remark You can set the scroll range (as start and end address) of the vertical scroll bar on this panel via the

Scroll Range Settings dialog box that is opened by clicking the button from [View] on the toolbar.

This section describes the following.

2.10.1.1 Specify the display position

2.10.1.2 Change display format of values

2.10.1.3 Modify the memory contents

2.10.1.4 Display/modify the memory contents during program execution
2.10.1.5 Search the memory contents

2.10.1.6 Modify the memory contents in batch (initialize)

2.10.1.7 Save the memory contents

2.10.1.1 Specify the display position

It is possible to specify the display start position of the memory contents by specifying an address expression in the dis-
play position specification area (starting with address 0x0 by default).

Remark An offset value of the display start position of memory values can be set via the Address Offset Settings
dialog box that is opened by selecting [Address Offset Value Settings...] from the context menu.
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Figure 2.48 Display Position Specification Area (Memory Panel)

| Move when Stop

Lo |

(1) Specify an address expression
Directly enter the address expression of the memory value address to display in the text box. You can specify an
input expression with up to 1024 characters. The result of the expression is treated as the display start position

address.

Note that if an address value greater than the microcontroller address space is specified, the high-order address

value is masked.

An address value greater than the value expressed within 32 bits cannot be specified.

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in this text box (see "2.20.2 Symbol name completion function").

Remark 2. If the specified address expression is the symbol and its size can be recognized, everything from
the start address to the end address of that symbol is displayed selected.

(2) Specify automatic/manual evaluation of the address expression
The timing to change the display start position can be determined by specifying in the [Move when Stop] check

box and the [Move] button.

[Move when Stop]

The caret is moved to the address which is automatically calculated from the
address expression after the program is stopped.

(]

The address expression is not automatically evaluated after the program is stopped.
Click the [Move] button to manually evaluate the address expression.

[Move]

When the [Move when Stop] check box is not checked, click this button to evaluate
the address expression and move the caret to the result address of the evaluation.

2.10.1.2 Change display format of values

The display format of the address area/memory value area/character strings area can be changed using buttons below

on the toolbar.

Notation

The following buttons to change the notation of memory values are displayed.

Hexadecimal

Displays memory values in hexadecimal number (default).

Signed Decimal

Displays memory values in signed decimal number.

Unsigned Decimal

Displays memory values in unsigned decimal number.

Octal

Displays memory values in octal number.

Binary

Displays memory values in binary number.

Size Notation

The following buttons to change the notation of sizes of memory values are dis-
played.

4 Bits

Displays memory values in 4-bit width.

1 Byte

Displays memory values in 8-bit width (default).

2 Bytes

Displays memory values in 16-bit width.
Values are converted depending on the endian of the target memory area.

E 4 Bytes

Displays memory values in 32-bit width.
Values are converted depending on the endian of the target memory area.

8 Bytes

Displays memory values in 64-bit width.
Values are converted depending on the endian of the target memory area.

Encoding

The following buttons to change the encoding of character strings are displayed.
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ASCII Displays character strings in ASCII code (default).

Bid| Shift_JIS Displays character strings in Shift_JIS code.

EUC-JP Displays character strings in EUC-JP code.

["F]| UTF-8 Displays character strings in UTF-8 code.

[“El| UTF-16 Displays character strings in UTF-16 code.

Half-Precision Float Displays character strings as a half-precision floating-point value.

rie|| Float Displays character strings as a single-precision floating-point valugNote,

Double Displays character strings as a double-precision floating-point valueNot.

Float Complex Displays character strings as a complex number of single-precision floating-
pointNote,

Double Complex Displays character strings as a complex number of double-precision floating-
pointNote,

Float Imaginary Displays character strings as an imaginary number of single-precision floating-
pointNote,

Double Imaginary Displays character strings as an imaginary number of double-precision floating-
pointNote,

View The following buttons to change the display format are displayed.

Settings Scroll Range... Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Column Number Settings... Opens the Column Number Settings dialog box to set the number of view col-
umns in the memory value area.

Address Offset Value Settings... | Opens the Address Offset Settings dialog box to set an offset value for
addresses displayed in the address area.

Note For details on the display of a floating-point value, see the section for the Memory panel.

2.10.1.3 Modify the memory contents

The memory values can be edited.

Directly edit from the keyboard after moving the caret to the line to modify in memory value area/characters area.

The color of the memory value changes when it is in editing. Press the [Enter] key to write the edited value to the target
memory (if the [Esc] key is pressed before the [Enter] key is pressed, the editing is cancelled).

However, the character string that can be inputted during the editing is limited to that character string that can be han-
dled by the display notation that has been currently specified. In the character strings area, modification can only be made
with "ASCII" character code.

This operation can be taken place while the program is in execution. See "2.10.1.4 Display/modify the memory con-
tents during program execution" for details on how to operate it.

When you modify the values, be aware of the following examples.

Example 1.  The value exceeds the upper limit of the display bit wide
If you edit the display value "105" as "1" to "3" in the decimal 8-bit display, the value will be changed to
the upper limit of "127".

Example 2.  The symbol, "-" is entered between numbers
If you edit the display value "32768" as "32-68" with signed decimal 16-bit display, "3" and "2" are
changed to the blank and the value is changed to "-68".

Example 3.  The blank symbol (space) is entered between numbers
If you edit the display value "32767" as "32 67", "3" and "2" are changed to the blank and the value is
changed to "67".
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Example 4. The same value is entered
Even if the same value as the current memory value is specified, the specified value is written to the
memory.

2.10.1.4 Display/modify the memory contents during program execution

The Memory panel/Watch panel has the real-time display update function that can update/modify the display contents of
the memory/watch-expression in real-time while executing the program.

Using the real-time display update function allows you to display/modify the value of memory/watch-expression not only
while the program is stopped, but also in execution.

The real-time display update function is realized by the RRM function (reading) [I[ECUBE][Simulator], a RAM monitor
function (reading) (other than [Simulator]) or by the DMM function (modifying). Each function has a different area that can
be used for reading and writing.

Firstly, enable the real-time display update function by making the basic settings below on the [Debug Tool Settings] tab
of the Property panel.

Table 2.8 Basic Settings for Real-time Display Update Function

Category Property Set Value
[Access memory while running] [Update display during the execution] [Yes] (default)
[Display update interval[ms]] except [COM Port]

[Integer number between 100 and
65500]
[COM Port]
[Integer number between 5000 and
65500]

Caution Local variables are not subject to the real-time display update function.

Remark See "2.10.1.3 Modify the memory contents" or "2.10.6.6 Modify the contents of watch-expressions" for

details on how to modify values in the Memory panel/Watch panel.

(1) RRM function (reading) [IECUBE][Simulator]
This function is used to read the contents of the memory or of watch-expressions in real-time during execution of a
program.
The following area can be read by the RRM function.
Memory and watch-expressions allocated to this area can always be displayed in real-time.

Table 2.9 Target Area of RMM Function

Area IECUBE Simulator

Internal ROM g Note 1 v
Internal RAM (except register area) e Ve
Data flash e -
Emulation memory - v
Target memory - v
CPU register v Note2 - Note 3
SFR . - Note 3

Note 1. This refers to data that were in the cache before execution, to the values are not real-time.

Note 2. Possible only for general-purpose registers and PC

Note 3. Impossible during tracer/timer execution

(2) RAM monitor function (reading) (other than [Simulator])
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This function is used to read the contents of memory or a watch-expression through software emulation by briefly
halting the program.
The following area can be read by the RAM monitor function.

Caution If CPU status shifts to the standby mode (HALT/STOP/IDLE) mode, a monitor time-out error will
occur.

Table 2.10  Target Area of RAM Monitor Function

2. FUNCTIONS

Area IECUBE E1/E20/EZ Emulator/COM Port
Internal ROM -Note 1 -
Internal RAM (except register area) Note 1 e
Data flash Note 1 v
Emulation memory - -
Target memory v -
CPU register 7 s Note2
SFR v o Note 3
Note 1. When it is available, priority is given to the RRM function. That is, the RAM monitor function is not
used in such cases.
Note 2. This only applies to the general-purpose registers corresponding to the bank specification.

Note 3. This does not apply to BCDADJ.

Note that to enable the RAM monitor function, the setting below is required in addition to the Basic Settings for
Real-time Display Update Function.

Category Property Set Value

[Access memory while running] [Access by stopping execution] [Yes]

DMM function (modifying)
This function is used to write to the memory or watch-expressions in real-time during execution of a program.
The following area can be modified by the DMM function.

Caution If CPU status shifts to the standby mode (HALT/STOP/IDLE) mode, a monitor time-out error will
occur.

Table 2.11  Target Area of DMM Function

Area IECUBE E1/E20/EZ Emulator/ Simulator
COM Port

Internal ROM - - i
Internal RAM (except register area) A A i
Emulation memory - - i
Target memory A - i
CPU register A P {yNote 2
SFR A *Note 3 I::INote 2

ik Possible by briefly halting execution

i Possible without briefly halting execution

Note 1. This only applies to the general-purpose registers corresponding to the bank specification.

Note 2. Impossible during tracer/timer execution

Note 3. Possible only for standard SFRs
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To enable the DMM function, the setting below is required in addition to the Basic Settings for Real-time Display

Update Function.

Debug Tool Property Set Value
Simulator No setting is required.
Other than above | [Access memory while running] category [Yes]
>> [Access by stopping execution]
Caution When a 2-, 4-, or 8-byte variable is to be read through the RRM or RAM monitor function, the process of

assigning a value to the variable may be divided into two steps.

If reading of the variable takes place between the two steps, an incorrect value may be read out because

the assignment is not completed.
Example)

In the following example, if reading takes place before "(2)" is executed, the value of variable "value_a" in
which only the assignment to the two lower-order bytes has been completed is read out.

[C source text]

void func (void)

{

}

long int value a = 0; // Definition of a 4-byte variable

value a = 4000000000; // Assignment to a 4-byte variable

[Assembly instructions for the assignment processing above]

MOVW AX, #2800H

MOVW ! value a, AX ; (1) : Assigmment to the two lower—order bytes of variable
"value a"

MOVW AX, #0EE6BH

MOVW ! value a+2, AX ; (2) : Assignment to the two high-order bytes of variable
"value a"

On the Memory panel/Watch panel, the memory values/watch-expressions updated by the real-time display update

function are highlighted in pink.

Figure 2.49 Example of Memory Display by Real-time Display Update Function

Memary | )
[&] & | Motabion- | Size Motation= | Encoding=  View -

| Mave when Siop | s |

S 41 47 +3 49 25 +F 47 #0 40 4m #0 4 o0 to 4F T =
[T Bl | EF BIE BF COJGT Fii G B |EF BA BF COJ6T Fi: EC F5 TR T
A0 el | 02 00 FC IR0 00 FC D100 00 FC FTJ01 00 ZF Fe P R & P P
a0l | DT GF F& IEYTTF 44 14 Q0 |DE OF FC EZJ01 00 47 EF S |
I0ted | F3 25 DY C2YFS 16 17 4408 00 DE 08)A4F EF E7 (% T DL RLTE
pifo | D7 GF F& 1617 44 O OO|DE 0F FC D3J0Z D0 47 EF Y |
a0 | FaCE 07 CTIFS 16 17 44|08 00 DE D2|AT EF F7 (5 1. DL 2T
0210 | b FS 17 DOJFC 49 02 00)FC 42 02 DOJFC 4E Q2 00 ERT N |
nnz 0 | FEOFT 02 FR|7E o0 0F 74|FE FA FC 11|0Z o0 71 74 N ERL T
ALk O 1 1 o O - - " S T T e gk T T

Moreover, on the Memory panel using IECUBE, the background color of the memory values updated by the RRM func-

tion are highlighted as follows in accordance with the access status (character colors and background colors depend on

the configuration in the [General - Font and Color] category of the Option dialog box).

Access Condition Display Example
Read 00 00 00
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Access Condition

Display Example

Write

00 00 00

Read and write

00 00 00

Figure 2.50 Example of Memory Display by Real-time Display Update Function (RRM Function) [IECUBE]
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2.10.1.5 Search the memory contents

Values of memory can be searched in the Memory Search dialog box that is opened by selecting [Find...] from the con-
text menu. The search is operated either in the memory value area or character strings area, in which the caret exists. In
this dialog box, follow the steps below.

Figure 2.51 Search Memory Contents (Memory Search Dialog Box)

Memory Search
Search Datz

Sesrch Baree  Specify addeess ranes

=]
[=]
[=]

Address el [w| = e | =
| Cancel | | Help |
Caution 1.  The contents of the memory cannot be searched during execution of a program.
Caution 2.  Character strings displayed as floating-point values cannot be searched.

(1) Specify [Search Data]
Specify data to search.

You can either type a value directly into the text box (up to 256 bytes), or select one from the input history via the
drop-down list (up to 10 items).
If the search is performed in the memory value area, the value must be entered in the same display format (nota-
tion and size) as that area.
If the search is performed in the character strings area, then the target of the search must be a string. The speci-

fied string is converted into the encoding format displayed in that area, and searched for.

If a memory value was selected immediately prior to opening this dialog box, then that value will appear as default.

(2) Specify [Search Range]

Select the range to search from the following drop-down list.
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Specify address range

Searches in the address range specified in the [Address] area.

Memory mapping

Searches within the selected memory mapping range.
This list item displays individual memory mapping configured in the Memory Map-
ping dialog box (except the non-mapped area).

Display format: <memory type> <address range> <size>

(3) Specify [Address]

This item is only enabled if [Specify address range] is selected in the (2) Specify [Search Range].
Specify the range of memory address to search via the start and end addresses. You can either type address
expressions directly into the text boxes (up to 1024 characters), or select them from the input history via the drop-

down list (up to 10 items).

The results of calculating the address expressions you have entered are treated as start and end addresses,

respectively.

Note that if an address value greater than the microcontroller address space is specified, the high-order address

value is masked.

An address value greater than the value expressed within 32 bits cannot be specified.

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.20.2 Symbol name completion function").

Remark 2. If the start address field is left blank, it is treated as if "Ox0" were specified.

Remark 3. If the end address field is left blank, then it is treated as if the maximum value in the microcon-

troller's address space were specified.

(4) Click the [Search Backward]/[Search Forward] button

When the [Search Backward] button is clicked, search will start in the order from the large address number to

small and the search results are displayed selected in the Memory panel.

When the [Search Forward] button is clicked, search will start in the order from the small address number to small

and the search results are displayed selected in the Memory panel.

2.10.1.6 Modify the memory contents in batch (initialize)

Contents of the memory can be modified in batch (initialize).

When [Fill...] from the context menu is selected, the Memory Initialize dialog box opens to modify the memory value of

the specified address range in batch.
In this dialog box, follow the steps below.

Figure 2.52 Modify Memory Contents in Batch (Memory Initialize Dialog Box)

Mamory Initialize
Siart address/symbal: End address symbol:

the end address or 2
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(1) Specify [Start address/symbol] and [End address/symbol]

Specify the range of memory address to initialize via the [Start address/symbol] and [End address/symbol]. You
can either type address expressions directly into the text boxes (up to 1024 characters), or select them from the

input history via the drop-down list (up to 10 items).

The results of calculating the address expressions you have entered are treated as start and end addresses,

respectively.

Note that address values greater than the microcontroller address space cannot be specified.

Caution

Remark

You cannot specify the range of address aligned across the different endian area.

A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]

key in each text box (see "2.20.2 Symbol name completion function").

(2) Specify [Initialize data]
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Specify the initializing data to write to the memory.

You can either type the initial value into the text box directly in hexadecimal number, or select one from the input
history via the drop-down list (up to10 items).

You can specify more than one initial value. Specify up to 16 values of up to 4 bytes (8 characters) each, sepa-
rated by spaces.

Each initial value is parsed from the end of the string, with each two characters interpreted as a byte.

If the string has an odd number of characters, then the first character is interpreted as one byte.

Note that if a initial value consists of more than one byte, then the target memory is overwritten with the value con-
verted into an array of bytes of the specified address range's endian, as follows.

Input Character Strings How Data is Overwritten (in Bytes)
(Initial Value)
Little Endian Big Endian
1 01 01
012 0012 00 12
00 012 345 00 120045 03 0000 12 03 45
000 12 000345 00 00 12 45 03 00 00 00 12 00 03 45

(3) Click the [OK] button
Click the [OK] button.
The memory area in the specified address range is repeatedly overwritten with the specified initial data pattern. If
the end address is reached in the middle of the pattern, then writing ends at that point.
Note that if an illegal value is specified, a message will appear, and the memory value will not be initialized.

2.10.1.7 Save the memory contents

Contents of the memory can be saved with range selection in text files (*.txt)/CSV files (*.csv).

When saving to the file, the latest information is acquired from the debug tool, and it is saved in accordance with the dis-
play format on this panel.

The Data Save dialog box can be opened by selecting the [File] menu >> [Save Memory Data As...] (when this opera-
tion is taken place with range selection on the panel, the memory data only in the selected range is saved).

In this dialog box, follow the steps below.

Figure 2.53 Save Memory Data (Data Save Dialog Box)
Data Save - Memory Data

File Mame: | ZEITRAI x

File Typer | Teut files{* tat)
Save Raree Address Swmbal:

000000160 [=] - Dx000OD22f -

[ Sawe |: Cancel ] Hela

(1) Specify [File Name]
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history
via the drop-down list (up to 10 items).
You can also specify the file by clicking the [...] button, and selecting a file via the Select Data Save File dialog box.

(2) Specify [File Type]

Select the format in which to save the file from the following drop-down list.
The following file formats can be selected.
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List Item Format
Text files (*.txt) Text format (default)
CSV (Comma-Separated Variables)(*.csv) CSV formatNote
Note The data is saved with entries separated by commas (,).
If the data contains commas, each entry is surrounded by double quotes " in order to avoid illegal
formatting.

(3) Specify [Save Range Address/Symbol]
Specify the range of addresses to save via "start address" and "end addresses".
Directly enter hexadecimal number/address expression in each text box or select from the input history displayed
in the drop-down list (up to 10 items).
If a range is selected in the panel, that range is specified as the default. If there is no selection, then the range
currently visible in the panel is specified.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.20.2 Symbol name completion function").

(4) Click the [Save] button

Saves the memory data to a file with the specified filename, in the specified format.
Figure 2.54 Output Example of Memory Data
- [Text files (*.txt)] (Hexadecimal notation/8-bit width/ASCII code)

+0 +1 +2 +3 +4 +5 +6 +7 +8 +9 +a +b +c +d +e +f
0000 | 00 00O 00 0O 00 00 OO 0O 00O 00 OO OO 00 00 00 00 |
0010 | 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 11 |

- [CSV files (*.csv)] (Hexadecimal notation/8-bit width/ASCII code)

6ooo0,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,00,
oco010,11,11,11,11,11,121,11,11,11,11,11,11,11,11,11,11,

Remark When the contents of the panel are overwritten by selecting the [File] menu>> [Save Memory Datal,
each Memory panel (Memory1-4) is treated as a different panel.
In addition, saving range is same as the previously specified address range.

2.10.2 Display/change the CPU register

The contents of the CPU register (general-purpose register/control register) can be shown and the value can be
changed in the CPU Register panel below.

Select the [View] menu >> [CPU Register].

For details on the contents and function in each area, see the section for the CPU Register panel.

Figure 2.55 Display the Contents of CPU Register (CPU Register Panel)

GPU Register =
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(1): [Register Name] area
(2): [Value] area

This section describes the following.
2.10.2.1 Change display format of values
2.10.2.2 Modify the CPU register contents

2.10.2.3 Display/modify the CPU register contents during program execution
2.10.2.4 Save the CPU register contents

2.10.2.1 Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar.

Notation The following buttons to change the notation of a data value are displayed.
AutoSelect Displays the value of the selected item (including sub-items) in the default notation
(default).
Hexadecimal Displays the value of the selected item (including sub-items) in hexadecimal number.
Signed Decimal Displays the value of the selected item (including sub-items) in signed decimal number.

Unsigned Decimal | Displays the value of the selected item (including sub-items) in unsigned decimal number.

Octal Displays the value of the selected item (including sub-items) in octal number.
Binary Displays the value of the selected item (including sub-items) in binary number.
ASCII Displays the character strings of the selected item (including sub-items) in ASCII code.

If the character size is 2 bytes and above, it is displayed with the characters for each 1
byte arranged side-by-side.

Float Displays the value of the selected item in Float.
Note that when the value is not 4-byte data, displays it in the default notation.

Double Displays the value of the selected item in Double.
Note that when the value is not 8-byte data, displays it in the default notation.

Adds the value in hexadecimal number enclosing with "()" at the end of the value.

2.10.2.2 Modify the CPU register contents

The CPU register values can be edited.

Select the value of the CPU register to edit in the [Value] area, then click on it again to switch the value to edit mode
(press the [Esc] key to cancel the edit mode).

To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key.

Caution This operation cannot be performed during program execution.

2.10.2.3 Display/modify the CPU register contents during program execution

By registering a CPU register to the Watch panel as a watch-expression, the value of the CPU register can be dis-
played/modified not only while the program is stopped, but in execution.
See "2.10.6 Display/change watch-expressions" for details on the watch-expression.

2.10.2.4 Save the CPU register contents

The Save As dialog box can be opened by selecting the [File] menu >> [Save CPU Register Data As...], and all the con-
tents in the CPU register can be saved to a text file (*.txt) or CSV file (*.csv).
When saving to files, retrieve the latest information from the debug tool.
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Figure 2.56 Output Example of CPU Register Data

Register name Value
Category name
-Register name Value
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2.10.3 Display/change the SFR

Contents of the SFR can be displayed and its values can be changed in the SFR panel below.
Select the [View] menu >> [SFR].
For details on the contents and function in each area, see the section for the SFR panel.

Figure 2.57 Display the Contents of SFR (SFR Panel)
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(1): [SFR] area
(2): [Value] area
(3): [Type (Byte Size)] area
(4): [Address] area

This section describes the following.

2.10.3.1 Search for a SFR

2.10.3.2 Organize SFRs

2.10.3.3 Change display format of values

2.10.3.5 Display/modify the SFR contents during program execution
2.10.3.5 Display/modify the SFR contents during program execution
2.10.3.6 Save the SFR contents

2.10.3.1 Search for a SFR

A SFR can be searched for.

Specify the SFR name to search with the text box in the search area (case-insensitive). You can either type character
strings directly from the key board (up to 512 characters), or select one from the input history via the drop-down list (up to
10 items).

Then, click either one of the following button.

Searches up for the SFR name containing the string specified in the text box, and selects the SFR that
is found.

Searches down for the SFR name containing the string specified in the text box, and selects the SFR
that is found.

Remark 1. The hidden SFR name being classified with a category can be searched (the category is opened and the
SFR is selected).

Remark 2. After typing character strings to search, to press the [Enter] key is the same function as clicking the
button, and to press the [Shift] + [Enter] key is the same function as clicking the button.

2.10.3.2 Organize SFRs

The each SFR can be categorized (by folders) and displayed in the tree view.
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Caution 1.  Categories cannot be created within categories.

Caution 2. SFRs cannot be added or deleted.

(1)

(2)

@)

(4)

Create new category
Move the caret to the SFR name to create a new category then click the button in the toolbar and directly
enter the new category name.

Edit category name
Click the category name to edit, and click it again, then directly modify the category name from the keyboard.

Delete categories
Select categories to delete then click the button in the toolbar.
However, the categories that can be deleted are only the empty categories.

Change the display order

SFR name is categorized when SFR is dragged and dropped in the category.

Also, the display order of the categories and the SFR names (upper or lower position) can be changed easily by
drag and drop operation.

Restore the category to its initial state
Click the @ button in the toolbar. The edited category is cleared and displayed with the initial category classifica-
tion.

2.10.3.3 Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar.

Notation The following buttons to change the notation of a data value are displayed.

Hexadecimal Displays the value of the selected item in hexadecimal number (default).

Signed Decimal Displays the value of the selected item in signed decimal number.

Unsigned Decimal | Displays the value of the selected item in unsigned decimal number.

Octal Displays the value of the selected item in octal number.
Binary Displays the value of the selected item in binary number.
ASCII Displays the value of the selected item in ASCII code.

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the
selected item.

2.10.3.4 Modify the SFR contents

The SFR values can be edited.

Select the value of the SFR to edit in the [Value] area, then click on it again to switch the value to edit mode (press the
[Esc] key to cancel the edit mode).

To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key.

Caution 1.  This operation cannot be performed during program execution.

Caution 2.  The value of the read-only SFR cannot be edited.

Remark 1. If a number with fewer digits than the size of the SFR is entered, the higher-order digits will be padded

with zeroes.

Remark 2. If a number with more digits than the size of the SFR is entered, the higher-order digits will be masked.

Remark 3. ASCII characters can be entered to the SFR value.

- When the numeric "0x41" is written to the SFR "DMCOQ"
>> "0x41" is written in the port "DMCO0".

- When the ASCII character "A™ is written to the SFR "DMCO0"
>>"0x41" is written in the port "DMCO0".
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2.10.3.5 Display/modify the SFR contents during program execution

By registering a SFR to the Watch panel as a watch-expression, the value of the SFR can be displayed/modified not
only while the program is stopped, but in execution.
See "2.10.6 Display/change watch-expressions" for details on the watch-expression.

2.10.3.6 Save the SFR contents

The Save As dialog box can be opened by selecting the [File] menu >> [Save SFR Data As...], and all the contents of
the SFR can be saved in a text file (*.txt) or CSV file (*.csv). At this time, the values of all SFRs become targets irrespec-
tive of the setting of display/non-display on this panel.

When saving the contents to the file, the values of the SFR are reacquired and save the latest values acquired.

Note that the values of read-protected SFR are not re-read. If you want to save the latest values of those, select [Force
Read Value] from the context menu then save the file.

Figure 2.58 Output Example of SFR

SFR name Value Type (Byte Size) Address
Category name
-SFR name Value Type (Byte Size) Address

2.10.4 Display/change global variables/static variables

Global variables or static variables are displayed and its values can be changed in the Watch panel.
Register the variables to display/modify their values to the Watch panel as the watch-expressions.
For details, see "2.10.6 Display/change watch-expressions".

2.10.5 Display/change local variables

Contents of local variables can be displayed and its values can be changed in the Local Variables panel below.

Select the [View] menu >> [Local Variable].

Specify the scope in the scope area to display the contents of the target local variable.

In the Local Variables panel, the name of local variables and functions are displayed. The argument of the function is
also displayed as the local variable.

For details on the contents and function in each area, see the section for the Local Variables panel.

Figure 2.59 Display the Contents of Local Variables (Local Variables Panel)
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(1): [Name] area
(2): [Value] area
(3): [Type (Byte Size)] area
(4): [Address] area

Caution Nothing is displayed on this panel during execution of a program.
When the program is stopped, items in each area are displayed.
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This section describes the following.
2.10.5.1 Change display format of values

2.10.5.2 Modify the contents of local variables
2.10.5.3 Save the contents of local variables

2.10.5.1 Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar.

Notation

The following buttons to change the notation of a data value are dis-
played.

AutoSelect

Displays values on this panel in the default notation according to the
type of variable (default).

Hexadecimal

Displays values on this panel in hexadecimal number.

Decimal

Displays values on this panel in decimal number.

Octal

Displays values on this panel in octal number.

Binary

Displays values on this panel in binary number.

Decimal Notation for Array Index

Displays array indexes on this panel in decimal number (default).

Hexadecimal Notation for Array Index

Displays array indexes on this panel in hexadecimal number.

Float

Displays values on this panel in Float.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation.

Double

Displays values on this panel in Double.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation.

Adds the value in hexadecimal number enclosing with "()" at the end
of the value.

Encoding

The following buttons to change the encoding of character variables
are displayed.

ASCII

Displays character variables in ASCII code (default).

Shift_JIS

Displays character variables in Shift_JIS code.

EUC-JP

Displays character variables in EUC-JP code.

[7=] uTF-8

Displays character variables in UTF-8 code.

UTF-16

Displays character variables in UTF-16 code.

2.10.5.2 Modify the contents of local variables

Values and arguments of local variables can be edited.

Select the value of the local variables/arguments to edit in the [Value] area, then click on it again to switch the value to
edit mode (press the [Esc] key to cancel the edit mode).

To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key. At
this time, the edited value is checked and if it is incompatible with the type, the editing is invalidated.

Caution This operation cannot be performed during program execution.

Remark 1. If a number with fewer digits than the size of the variable is entered, the higher-order digits will be padded
with zeroes.

Remark 2. If a number with more digits than the size of the variable is entered, the higher-order digits will be

masked.
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Remark 3. If the display format of a character array (type char or unsigned char) is set to ASCII, then the value can

also be entered as a string (ASCII/Shift_JIS/EUC-JP/Unicode (UTF-8/UTF-16)).
Remark 4. ASCII characters can be entered to values of local variables.

- Entering via an ASCII character
In the [Value] area for the variable "ch", enter "A™
>> "0x41" will be written to the memory area allocated to "ch"

- Entering via a numeric value
In the [Value] area for the variable "ch", enter "0x41"
>> "0x41" will be written to the memory area allocated to "ch"

- Entering via an ASCII string

Set the display format of character array "str" to ASCII, and in the [Value] area, enter ""ABC""
>>"0x41, 0x42, 0x43, 0x00" will be written to the memory area allocated to "str"

2.10.5.3 Save the contents of local variables

The Save As dialog box can be opened by selecting the [File] menu >> [Save Local Variables Data As...], and all the
contents in the local variables can be saved in a text file (*.txt) or CSV file (*.csv).

When saving to files, retrieve the latest information from the debug tool. If arrays, pointer type variables, structures/
unions/class, and CPU registers (only those with the part name) are displayed expanded, the value of each expanded ele-
ment is also saved. When they are not expanded, "+" mark is added on the top of the item and the value becomes blank.

Figure 2.60 Output Example of Local Variables

Scope : Current scope

[V]Variable [P]Parameter [F]Function

Name Value Type (Byte Size) Address

[V]Variable name[1l] Value Type Address
- [V]Variable name[0] Value Type Address

2.10.6 Display/change watch-expressions

By registering C language variables, CPU register, SFR, and assembler symbols to the Watch panel as watch-expres-
sions, you can always retrieve their values from the debug tool and monitor the values in batch.

The values of watch-expressions can be updated during the program is in execution (see "2.10.6.7 Display/modify the
contents of watch-expressions during program execution").

Select the [View] menu >> [Watch] >> [Watch7 - 4] to open the Watch panel.
The Watch panel can be opened up to 4 panels. Each panel is identified by the names "Watch1", "Watch2", "Watch3"

and "Watch4" on the titlebar, and the watch-expressions can be registered/deleted/moved individually, and they are saved
as the user information of the project.

For details on the contents and function in each area, see the section for the Watch panel.

Figure 2.61 Display the Contents of Watch-Expression (Watch Panel)
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(1): [Watch] area

(2): [Value] area

(3): [Type (Byte Size)] area
(4): [Address] area

(5): [Memo] area

This section describes the following.

2.10.6.1 Register a watch-expression

2.10.6.2 Organize the registered watch-expressions

2.10.6.3 Edit the registered watch-expressions

2.10.6.4 Delete a watch-expression

2.10.6.5 Change display format of values

2.10.6.6 Modify the contents of watch-expressions

2.10.6.7 Display/modify the contents of watch-expressions during program execution
2.10.6.8 Export/import watch-expressions

2.10.6.9 Save the contents of watch-expressions

2.10.6.1 Register a watch-expression

There are three ways as follows to register watch-expressions (watch-expressions are not registered as default).

Remark 1. Each watch-expression registered in each watch panel (Watch1 to Watch4) is managed in each panel
and saved as the user information of the project.

Remark 2. More than one watch-expression with the same name can be registered.

(1) Register from other panels
Watch-expressions can be registered from other panel in CS+.
In other panel, drag and drop the watch-expression to register in any watch panel (Watch1 to Watch4).
For the relationship between panels that can use this operation and targets that can be registered as watch-
expressions, see "Table A.5 Relationship between Panels and Targets That Can be Registered as Watch-Expres-
sions".

Figure 2.62 Registering Watch-Expressions from Other Panels

Disassembhe1 EJ
28]

Here, the variable "data1" in the Disassemble panel
will be registered as a watch-expression.

Drag and drop on the Watch panel after selecting
the variable "data1" in the Disassemble panel. —
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Remark You can also add a watch-expression by doing the following. First, select the target for which you

wish to register a watch-expression, or move the caret to one of the target strings (the target is
determined automatically). Next, from the context menu, select [Register Watch1] (but this is limited
to the Watch panel (Watch 1)).

(2) Directly register in the Watch panel
Click the E button in the toolbar in any the Watch panel (Watch1 to Watch4) to display the following entry box in
the [Watch] area.
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Figure 2.63 Entry Box of Watch-Expression
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Directly enter a watch-expression in this area.

Directly input a watch-expression from the keyboard in the entry box then press the [Enter] key.
For the input forms of watch-expressions entered this way, see the tables listed below.

"Table 2.29 Basic Input Format of Watch-expressions"

"Table A.6 Handling of a C/C++ Language Function When Registered in Watch by Specifying Scope"

"Table A.7 Handling of a C/C++ Language Variable When Registered in Watch by Specifying Scope"

"Table A.8 Handling of a CPU Register When Registered in Watch by Specifying Scope"
- "Table A.9 Handling of a SFR when Registered in Watch by Specifying Scope"

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in this area (see "2.20.2 Symbol name completion function").

(3) Register from other application
Select the character strings of C language variables/CPU registers/SFR/assembler symbols from an external edi-
tor and drag and drop it in the Watch panel (Watch 1 to Watch 4).
The dropped character strings are registered as a watch-expression.

2.10.6.2 Organize the registered watch-expressions

Registered watch-expressions can be organized in categories (folders) and displayed in tree view (there is no category
as default).

Caution 1.  Categories cannot be created within categories.
Caution 2.  Up to 64 categories can be created in one watch panel (if this restriction is violated, a message appears).

(1) Create new category
Move the caret to the position to create a new category then click the ||| button in the toolbar and directly enter
the new category name.

(2) Edit category name
Click the category name to edit, and click it again, then directly modify the category name from the keyboard.

(3) Delete categories
Select categories to delete then click the button in the toolbar.

(4) Change the display order
Registered watch-expressions are categorized when they are dragged and dropped in the category.
Also, the display order of the categories and the watch-expressions (upper or lower position) can be changed eas-
ily by drag and drop operation.

Remark Drag and drop the watch-expressions/categories in other watch panel (Watch1 to Watch4) to copy them.

2.10.6.3 Edit the registered watch-expressions

Registered watch-expressions can be edited.

Double-click the watch-expression to edit to switch the watch-expression to edit mode (press the [Esc] key to cancel the
edit mode).

Directly edit from the keyboard and then press the [Enter] key.

2.10.6.4 Delete a watch-expression

To delete watch-expressions, select the one you want to delete in the Watch panel then click the button in the tool-
bar.
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2.10.6.5 Change display format of values

The display format of the [value] area can be changed using buttons below on the toolbar.

Notation

The following buttons to change the notation of a data value are displayed.

AutoSelect

Displays the value of the selected watch-expression in the default notation (see "Table
A.10 Display Format of Watch-Expressions (Default)") according the type of variable
(default).

Hexadecimal

Displays the value of the selected item in hexadecimal number.

Signed Decimal

Displays the value of the selected item in signed decimal number.

Unsigned Decimal

Displays the value of the selected item in unsigned decimal number.

Octal

Displays the value of the selected item in octal number.

Binary

Displays the value of the selected item in binary number.

ASCII

Displays the value of the selected item in ASCII code.

Float

Displays the value of the selected item in Float.

Note that this item becomes valid only when the selected watch-expression value is 4-
byte data.

Double

Displays the value of the selected item in Double.
Note that this item becomes valid only when the selected watch-expression value is 8-
byte data.

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the
selected item (except the item displayed in hexadecimal number).

2.10.6.6 Modify the contents of watch-expressions

The values of watch-expressions can be edited.

Double-click the value of the watch-expression to edit in the [Value] area to switch the value to edit mode (press the
[Esc] key to cancel the edit mode).

To write the edited value to the target memory, directly enter the value from the keyboard then press the [Enter] key.

Note that only those values that correspond one by one to variables of C language, CPU registers, SFR or assembler
symbols can be edited. In addition, read-only SFR values cannot be edited.

This operation can be taken place while the program is in execution. See "2.10.1.4 Display/modify the memory con-
tents during program execution" for details on how to operate it.

Remark 1. If a number with fewer digits than the size of the variable is entered, the higher-order digits will be padded
with zeroes.

Remark 2. If a number with more digits than the size of the variable is entered, the higher-order digits will be
masked.

Remark 3. If the display format of a character array (type char or unsigned char) is set to ASCII, then the value can
also be entered as a string (ASCII/Shift_JIS/EUC-JP/Unicode (UTF-8/UTF-16)).

Remark 4. ASCII characters can be entered to values of watch-expressions.

- Entering via an ASCII character
In the [Value] area for the variable "ch", enter "A™
>> "0x41" will be written to the memory area allocated to "ch"

- Entering via a numeric value
In the [Value] area for the variable "ch", enter "0x41"
>> "0x41" will be written to the memory area allocated to "ch"

- Entering via an ASCII string
Set the display format of character array "str" to ASCII, and in the [Value] area, enter ""ABC™"
>>"0x41, 0x42, 0x43, 0x00" will be written to the memory area allocated to "str"
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2.10.6.7 Display/modify the contents of watch-expressions during program execution

The Memory panel/Watch panel has the real-time display update function that can update/modify the display contents of

the memory/watch-expression in real-time while executing the program.
Using the real-time display update function allows you to display/modify the value of memory/watch-expression not only

while the program is stopped, but also in execution.
See "2.10.1.4 Display/modify the memory contents during program execution" for details on how to operate it.

2.10.6.8 Export/import watch-expressions

This feature is for the export of currently registered watch-expressions to a file and the importing of such files, enabling

the re-registration of watch-expressions.
To do this, follow the procedure described below.

(1) Export watch-expressions
Save watch-expressions currently being registered (including categories) in a file format that is possible to import.

With the Watch panel in focus, select [Save Watch Data As...] from the [File] menu.
On the Save As dialog box that is automatically opened, specify the following items, and then click the [Save] but-

ton.
- [File name]: Specify the name of a file to be saved (the file extension must be "csv").
- [Save as type]: Select "Importable CSV (Comma-Separated Variables)(*.csv)"

Caution Neither values nor the type information of watch-expressions can be saved.
Items that are expanded after analyzing watch-expressions (i.e. an array, structure, and so on) can-

not be saved.

Figure 2.64 Export of Watch-Expressions
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(2) Import watch-expressions
Import the file that exported in (1) to the Watch panel.
On the Watch panel to which you want to import watch-expressions, select [Import Watch Expression] from the
context menu.
On the Open Watch Expression Data File dialog box that is automatically opened, specify the file that exported

previously, and then click the [Open] button.

Remark If watch-expressions have been already registered, then imported watch-expressions will be regis-
tered at the bottom of them.
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Figure 2.65
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2.10.6.9 Save the contents of watch-expressions

By selecting the [File] menu >> [Save Watch Data As...] or selecting [Save Expanded Watch Data...] from the context
menu, the Save As dialog box can be opened, and all the contents of the watch-expression and its value can be saved in

a text file (*.txt) or CSV file (*.csv).

When saving the contents to the file, all the values of the watch-expression are reacquired and save the latest values

acquired.

Note that the values of read-protected SFR are not re-read. If you want to save the latest values of those, select [Force

Read Value] from the context menu then save the file.

Note that for watch-expressions that can be displayed expanded, such as arrays, pointer type variables, structures/
unions/class, and CPU registers (only those with the part name), the behavior differs depending on whether the watch-

expression is saved with [Save Watch Data As...] or [Save Expanded Watch Data...].

- When saved with [Save Watch Data As...]

If arrays, pointer type variables, structures/unions/class, and CPU registers (only those with the part name) are dis-
played expanded, the value of each expanded element is also saved. When they are not expanded, "+" mark is

added on the top of the item and the value becomes blank.

- When saved with [Save Expanded Watch Data...]

The watch-expression is expanded up to the maximum 255 nests regardless of the expanded state, and the value of

each expanded element is also saved.

Figure 2.66 Output Example of Watch Data

Watch-expression Value Type (Byte Size) Address Memo
Watch-expression Value Type (Byte Size) Address Memo
-Category name
Watch-expression Value Type (Byte Size) Address Memo

Remark
watch panel (Watch1 to Watch4) is treated as a different panel.

When the contents of the panel are overwritten by selecting the [File] menu >> [Save Watch Data], each
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2.11 Display Information on Function Call from Stack

This section describes how to show the information on function call from the stack.

The CS+ compiler (CC-RL) pushes function-call information onto the stack, in accordance with the ANSI standard.

It is thus possible to learn the function call depth, the location of the caller, parameters, and other information by analyz-
ing the function-call information.

This "function-call information" is called the call stack information; this term will be used in the rest of this document.

2.11.1 Display call stack information

Call stack information is displayed in the Call Stack panel below.
Select the [View] menu >> [Call Stack].
For details on the contents and function in each area, see the section for the Call Stack panel.

Caution Nothing is displayed on this panel during execution of a program.
When the program is stopped, items in each area are displayed.

Figure 2.67 Display Call Stack Information (Call Stack Panel)
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This section describes the following.

2.11.1.1 Change display format of values

2.11.1.2 Jump to the source line

2.11.1.3 Display local variables

2.11.1.4 Save the contents of call stack information

2.11.1.1 Change display format of values

The display format of this panel can be changed using buttons below on the toolbar.
Note that these buttons are disabled during execution of a program.

Notation The following buttons to change the notation of a data value are displayed.
AutoSelect Displays values on this panel in the default notation according to the type of variable (default).

Hexadecimal | Displays values on this panel in hexadecimal number.

Decimal Displays values on this panel in decimal number.
Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.
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Encoding The following buttons to change the encoding of character variables are displayed.
ASCII Displays character variables in ASCII code (default).
Shift_JIS Displays character variables in Shift_JIS code.
EUC-JP Displays character variables in EUC-JP code.
UTF-8 Displays character variables in UTF-8 code.
UTF-16 Displays character variables in UTF-16 code.

2.11.1.2 Jump to the source line

Double-clicking on the line will open the Editor panel with the caret moved to the source line of the calling function indi-
cated by the selected line (If the panel is already open, the screen will jump to the editor panel).

Remark Selecting [Jump to Disassemble] from the context menu will open the Disassemble panel (Disassemble
1) with the caret moved to address of the calling function indicated by the selected line (If the panel is
already open, the screen will jump to the Disassemble panel (Disassemble 1)).

2.11.1.3 Display local variables

Selecting [Jump to Local Variable at This Time] from the context menu will open the Local Variables panel that displays
the local variables indicated by the currently selected line.

2.11.1.4 Save the contents of call stack information

By selecting the [File] menu >> [Save Call Stack Data As...], the Save As dialog box can be opened, and all the contents
in the call stack information can be saved in a text file (*.txt) or CSV file (*.csv).
When saving to files, retrieve the latest information from the debug tool.

Figure 2.68 Output Example of Call Stack Information

Depth Call stack
0 Call stack information
1 Call stack information
Note If old information has been obtained from stack data that has lost its reliability, the information on that line

is shown in parentheses "( )"
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2.12 Collect Execution History of Programs

This section describes how to collect the execution history of the program.

A history of program execution is generally called a trace; this term will be used in the remainder of this document.

It is nearly impossible to find the cause of runaway program execution from the memory contents, stack information,
and the like after the runaway has occurred. The collected trace data, however, can be used to trace program execution
up to the runaway directly, making this an effective tool for discovering hidden bugs.

Caution 1.  [E1][E20][EZ Emulator][COM Port]
The trace function is supported only when the selected microcontroller incorporates the OCD trace func-

tion.

Caution 2.  [Simulator]
4 bytes of the final address of the code flash area (when a code flash area is 0x0 - Ox1FFFF, Ox1FFFC -

1FFFFF corresponds to it) and the RAM area which can be fetched cannot be fetched (a message of
"Stopped by accessing to no map area." will appear).

2.12.1 Configure the trace operation

When the trace function starts, trace data which has recorded in it an execution history of the currently executed pro-
gram is collected in trace memory (when program execution stops, the trace function also automatically stops).

Before the trace function can be used, it is necessary to make settings relating to the operation of a trace.

Note that the method on how to set differs depending on the debug tool used.

2.12.1.1 [IECUBE]

2.12.1.2 [E1)/[E20)/[EZ Emulator]/[COM Port]
2.12.1.3 [Simulator]

2.12.1.1 [IECUBE]

This trace operation can be configured in the [Trace] category on the [Debug Tool Settings] tab in the Property panel.

Figure 2.69 [Trace] Category [IECUBE]
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(1) [Clear trace memory before running]
Select whether to clear (initialize) the trace memory before tracing starts in this property.
Select [Yes] to clear the memory (default).

Remark You can forcibly clear the trace memory when clicking the button in the toolbar in the Trace
panel.

(2) [Operation after trace memory is full]
Select the operation after the trace memory is full with the collected trace data, from the following drop-down list.
The trace memory size is 128K frames (fixed).

Non stop and overwrite | Continues overwriting the older trace data after the trace memory is full (default).
to trace memory When the [Clear trace memory before running] property is set to [Yes], at the time of
a resumption, trace data is collected after clearing the trace memory.

Stop trace When the trace memory is full, CS+ stops writing trace data (the program does not
stop execution).

Stop When the trace memory is full, CS+ stops writing trace data and the program stops
execution.

(3) [Rate of frequency division of trace time tag]
Specify the frequency division ratio of the counter to be used for time tag display (i.e. display of the [Time] item in

the Trace panel) (default: [1/1(4ns/0.3min)]).

Remark Values in "()" on the drop-down list indicate the resolution and the maximum measurement time.
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Caution An error occurs in trace time tag due to the following causes:
- When the RAM monitor function is used during user program execution
- When a hardware or software breakpoint is set during user program execution
- When a value is written to memory using the DMM function during user program execution

Caution Information on access to the SFRs and memory by the DMAC is also output with information on data to
which access is normal.

2.12.1.2 [E1]/[E20)/[EZ Emulator]/[COM Port]

This trace operation can be configured in the [Trace] category on the [Debug Tool Settings] tab of the Property panel.

Caution This category appears only when the selected microcontroller incorporates the OCD trace function.

Figure 2.70 [Trace] Category [E1][E20][EZ Emulator][COM Port]
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(1) [Use trace function]
Select whether to use trace function.
Select [Yes] to use the trace function (default: [No]).

(2) [Operation after trace memory is full]
Select the operation after the trace memory is full with the collected trace data, from the following drop-down list.

Non stop and overwrite | Continues overwriting the older trace data after the trace memory is full (default).
to trace memory

Stop trace When the trace memory is full, CS+ stops writing trace data (the program does not
stop execution).

(3) [Trace memory size[frames]]
The size of trace memory (i.e. the number of trace frames) is displayed.
You cannot change the value of this property.
The trace frame is a unit of trace data. One trace frame is used for each operation in fetch/write/read.

Operation specifications of the OCD trace function are as follows:

Table 2.12  Operation Specifications of OCD Trace Function

ltem Description
Clearing the trace The trace memory is cleared when:
memory - The program is executed.
- The external reset signal is generated (the internal reset signal does not cause
clearing the trace memory).
Operation after the The trace full break is not supported.

trace memory is full
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ltem Description

Target of trace data Branch origin instructions (internal ROM only)

For a branch instruction with a condition, it will be traced only when the condition is
met. Complement display of instructions between branch instructions cannot be per-
formed.

Note that, for the following instructions, an instruction of the next address of its cor-
rect position will be displayed.

- BT ES:[HL].bit, $addr20
- BF ES:[HL].bit, $addr20

- BTCLR ES:[HL].bit, $addr20
The following items are supported on the Trace panel.

- [Number]
- [Line/Address]

- [Source/Disassemble]

Trace event See "2.16.7 Notes for setting events".

Notes The following items cannot be traced.
- Interrupt vectors

- Instructions during a step execution

- Skip instructions with a condition

2.12.1.3 [Simulator]

This trace operation can be configured in the [Trace] category on the [Debug Tool Settings] tab of the Property panel.

Figure 2.71 [Trace] Category [Simulator]
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(1) [Use trace function]
Select whether to use trace function.
Select [Yes] to use the trace function (default: [No]).

(2) [Clear trace memory before running]
Select whether to clear (initialize) the trace memory before tracing starts.
Select [Yes] to clear the memory (default).

Remark You can forcibly clear the trace memory when clicking the button in the toolbar in the Trace
panel.

(3) [Operation after trace memory is full]
Select the operation after the trace memory is full with the collected trace data, from the following drop-down list.

Non stop and overwrite | Continues overwriting the older trace data after the trace memory is full (default).
to trace memory When the [Clear trace memory before running] property is set to [Yes], at the time of
a resumption, the trace data is collected after clearing the trace memory.

Stop trace When the trace memory is full, CS+ stops writing trace data (the program does not
stop execution).

Stop When the trace memory is full, CS+ stops writing trace data and the program stops
execution.
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(4) [Accumulate trace time]
Select whether to display the trace time with accumulated time.
Specify [Yew] to display trace time with accumulated time. Specify [No] to display the trace time with differential
time (default).

(5) [Trace memory size[frames]]
Select the trace memory size (trace frame number) (default: [4K]).
The trace frame is a unit of trace data. One trace frame is used for each operation in fetch/write/read.

2.12.2 Collect execution history until stop of the execution

In the debug tool, there is a function to collect the execution history from the start of program execution to the stop.

Therefore, the trace data collection is automatically started when the program starts executing and stopped when the
program stops.

See "2.12.6 Display the collected execution history" for how to check the collected trace data.

Remark This function is actuated by an Unconditional Trace event, one of the built-in events that are set in the
debug tool by default.
Consequently, if the Unconditional Trace event is set to Invalid state by clearing the check box in the
Events panel, trace data linked to the start of program execution will not be collected (the Unconditional
Trace event is set to Valid state by default).
Note that Unconditional Trace event and Trace event described later (see "2.12.3 Collect execution his-
tory in a section") are used exclusively of each other. Therefore, if Trace event with Valid state is set,
Unconditional Trace event is automatically set to Invalid state.

2.12.3 Collect execution history in a section

The execution history is collected as trace data only for a section while the program is in execution by setting a Trace
event.

This Trace event consists of a trace start event and a trace end event.
To use this function, follow the procedure described below.

2.12.3.1 Set a Trace event
2.12.3.2 Execute the program
2.12.3.3 Edit a Trace event
2.12.3.4 Delete a Trace event

Caution 1.  Also see "2.16.7 Notes for setting events" for details on Trace events (e.g. limits on the number of
enabled events).

Caution 2.  The event type (execution type/access type) that can be set as trace start and end events differ with each
debug tool used.

Caution 3.  [Simulator]
Trace start events and trace stop events cannot be set/deleted while a tracer is running.

Caution 4.  [Simulator]
If you perform a trace from a trace start event until a trace end event, the simulator will not include the
trace end event in the results of the trace. For this reason, if you are using a simulator, set the trace end
event one line below the range for which you require display of the trace data.

2.12.3.1 Set a Trace event

To set a Trace event, set a trace start event and a trace end event that starts/stops collecting the trace data.
Use one of the following methods to set a trace start event and a trace end event.

(1) For execution-related events
By setting execution-related events for a trace start event and a trace end event, it is possible to start and stop the
collection of trace data at any place.
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played.
Follow the operation listed below from the context menu, in accordance with your desired event type, after moving
the caret to the target line that has a valid address.
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Event Type Operation
Trace start Select [Trace Settings] >> [Start Tracing]
Trace end Select [Trace Settings] >> [Stop Tracing]
Caution [Simulator]

Simulator will not display a trace end event as the results of a trace. For this reason, set a trace
end event to one line below the range that you wish to display as the trace data.

A trace start event or a trace end event is set to the instruction at the start address corresponding to the line of the
caret position.

Once a trace start event or a trace end event is set, the following event mark is displayed in the event area of the
line that an event is set.

Table 2.13  Event Marks of Trace Start Event and Trace End Events

Event Type Event Mark

Trace start

i
=D | D

Trace end

L

Figure 2.72 Trace Start and Trace End Events Setting Example (Disassemble Panel)
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(2) For access-related events [E1][E20]
By setting access-related events for a trace start event and a trace end event, it is possible to start and stop the
collection of trace data when a specified access is made to any variable or SFR.

Remark The types of access that can be set by using methods described here are only a read/write (see
“Table 2.6 Types of Accesses to Variables®).
To change the access type to a read or write, after setting trace start and end events, edit their
[access type] item (see "2.16.4.2 Edit access-related events").

(a) To set events for variables or SFR in the Editor panel/Disassemble panel
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played.
Follow the operation listed below from the context menu, in accordance with your desired event type, after
selecting an arbitrary variable or SFR on the source text/disassembled text.
Note, however, that only global variables, static variables inside functions, and file-internal static variables can

be used.
Event Type Operation
Trace start Select [Trace Settings] >> [Record Start R/W Value], and then press the [Enter] key.
Trace end Select [Trace Settings] >> [Record End R/W Value], and then press the [Enter] key.

At this time, if you have specified a value in the text box in the context menu, collection of trace data is started or
finished only when a read/write is performed with a specified value. On the other hand, if no value is specified,
reading/writing the selected variable or SFR by any value will cause the break to occur.

Caution 1.  Variables within the current scope can be specified.
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Caution 2. Variables or SFR at lines that have no valid addresses cannot be used for trace start events and
trace end events.

(b) To set events for registered watch-expressions
Perform this operation in the Watch panel.
Follow the operation listed below from the context menu after selecting the registered watch-expression (multi-
ple selections not allowed).
Note, however, that only global variables, static variables inside functions, file-internal static variables, and SFR

can be used.
Event Type Operation
Trace start Select [Trace Output] >> [Record Start R/W Value], and then press the [Enter] key.
Trace end Select [Trace Output] >> [Record End R/W Value], and then press the [Enter] key.

At this time, if you have specified a value in the text box in the context menu, collection of trace data is started or
finished only when a read/write is performed with a specified watch-expression. On the other hand, if no value
is specified, reading/writing the selected watch-expression by any value will cause the break to occur.

Caution A watch-expression within the current scope can be specified.
To target a watch-expression outside the current scope, select a watch-expression with a speci-
fied scope.

When a trace start event and a trace end event are set, they are managed collectively on the Events panel as one
instance of a Trace event (see "2.16 Manage Events"). When you click the "+" mark at a Trace event item, detailed infor-
mation on the trace start event and the trace end event you have set is displayed.

Figure 2.73 Example of Trace Start and Trace End Events (Execution Type) in Events Panel
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Remark 1. If either one of a trace start event and a trace end event is set as Valid state, the check box of Uncondi-
tional Trace event in the Events panel is automatically cleared, therefore, trace data collection does not
automatically start with the start of the program execution (the tracer will not run until the condition of the
trace start event that has been set is met).

Remark 2. A trace end event is not indispensable for a Trace event.

Remark 3. Event marks differ depending on the event state (see "2.16.1 Change the state of set events (valid/
invalid)").
When an event is set at the point which other event is already set, the event mark ( h,_.‘:’ ) is displayed
meaning more than one event is set at the point.

Remark 4. [Simulator]
If either one of a trace start event and a trace end event is set to Valid state, the [Use trace function] prop-
erty in the [Trace] category on the [Debug Tool Settings] tab of the Property panel is automatically set to
[Yes] and the trace function will be enabled.
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2.12.3.2 Execute the program

Execute the program (see "2.8 Execute Programs").
Collection of trace data is started or finished when the condition set for a trace start event or a trace end event is met.
See "2.12.6 Display the collected execution history" for how to check the collected trace data.

2.12.3.3 Edit a Trace event

It is possible to edit a trace start event or a trace end event you have set.
For details on how to do it, see "2.16.4.1 Edit execution-related events" or "2.16.4.2 Edit access-related events".

2.12.3.4 Delete a Trace event

To delete a Trace event you have set, on the Editor panel/Disassemble panel, right-click the event mark in the event
area and select [Delete Event] from the context menu that is displayed.

Also, there is another way to delete a set event. Select the Trace event you want to delete on the Events panel, and
then click the button in the toolbar (see "2.16.5 Delete events").

Caution It is not possible to delete only a trace start event or a trace end event (i.e. if either a trace start event or
a trace end event is deleted from the event marks on the event area, all of the corresponding event
marks are deleted).

2.12.4 Collect execution history only when the condition is met [IECUBE][Simulator]

The program execution history can be collected only when a condition is met.

By setting a Point Trace event, the execution history is collected as trace data only when an arbitrary variable or SFR is
accessed with the specified type.

To use this function, follow the procedure described below.

2.12.4.1 Set a Point Trace event
2.12.4.2 Execute the program
2.12.4.3 Edit a Point Trace event
2.12.4.4 Delete a Point Trace event

Caution [E1][E20][EZ Emulator][COM Port]
This function is not supported.

2.12.4.1 Set a Point Trace event

Use one of the following methods to set a Point Trace event.

Caution 1.  Also see "2.16.7 Notes for setting events" for details on Point Trace events (e.g. limits on the number of
enabled events).

Caution 2. [IECUBE]
Point Trace events cannot be set for 32-bit (4-byte) variables.
Additionally, see "(3) For access to a variable/SFR of 16-bit (2-byte) size [[ECUBE]" for setting of Point
Trace events for 16-bit (2-byte) variables.

Caution 3.  [Simulator]
Point Trace events cannot be set/deleted while a tracer is running.

Remark 1. [IECUBE]
Accesses via DMA can be traced.

Remark 2. [Simulator]
When a Point Trace event is set to Valid state, the [Use trace function] property in the [Trace] category on

the [Debug Tool Settings] tab of the Property panel is automatically set to [Yes] and the trace function will
be enabled.

(1) For access to a variable/SFR on the Editor panel/Disassemble panel
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played.

R20UT5301EJ0100 Rev.1.00 RENESAS Page 86 of 413
Jun 01, 2023



CS+V8.10.00 2. FUNCTIONS

Follow the operation listed below from the context menu, in accordance with your desired access type, after
selecting the variable or SFR as the subject to access.
Note, however, that only global variables, static variables inside functions, and file-internal static variables can be

used.

Access Type Operation
Read Select [Trace Settings] >> [Record Reading Value].
Write Select [Trace Settings] >> [Record Writing Value].
Read/Write Select [Trace Settings] >> [Record R/W Value].

Caution Variables within the current scope can be specified.

(2) For access to a registered watch-expression
Perform this operation in the Watch panel.
Select the watch-expression as the subject to access and perform the following operation from the context menu.
Note, however, that only global variables, static variables inside functions, file-internal static variables, and SFR

can be used.
Access Type Operation
Read Select [Trace Output] >> [Record Reading Value].
Write Select [Trace Output] >> [Record Writing Value].
Read/Write Select [Trace Output] >> [Record R/W Value].
Caution A watch-expression within the current scope can be specified.
To target a watch-expression outside the current scope, select a watch-expression with a specified
scope.

(3) For access to a variable/SFR of 16-bit (2-byte) size [IECUBE]
If you want to set a Point Trace event to a variable/SFR of 16-bit (2-byte) size when using IECUBE, register each
address of the higher 8-bit and the lower 8-bit of the variable/SFR in the Watch panel directly as watch-expres-
sions (see "2.10.6.1 Register a watch-expression").
Then, set a Point Trace event to each watch-expression by using the method described in "(2) For access to a
registered watch-expression".

Figure 2.74 How to Set Point Trace Event for 16-bit (2-byte) Variable/SFR [IECUBE]
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This example shows how to set a Point Trace event for the 2-byte SFR (ADCR).
Directly register Oxfff1e (lower 8-bit address) and Oxfff1f (higher 8-bit address) as
watch-expressions, and then set a Point Trace event to each watch-expression.

By performing the above operation, it is interpreted as if a Point Trace event has been set at the target variable/
SFR/watch-expression, and it is managed in the Events panel (see "2.16 Manage Events" for details).
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Figure 2.75 Example of Setting Point Trace Event in Events Panel
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2.12.4.2 Execute the program

Execute the program (see "2.8 Execute Programs").

If the conditions for a Point Trace event that you have set are met while the program is executing, that information is col-
lected as trace data.

See "2.12.6 Display the collected execution history" for details on checking trace data.
Figure 2.76 Example of Point Trace Event Results View
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Figure 2.77 Example of Point Trace Event Results View (For 16-bit (2-byte) Variable/SFR) [IECUBE]
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a defined SFR name or address. each 1 byte.

2.12.4.3 Edit a Point Trace event

It is possible to edit a Point Trace event you have set.
For details on how to do it, see "2.16.4.2 Edit access-related events".
2.12.4.4 Delete a Point Trace event

To delete a Point Trace event you have set, select the Point Trace event you want to delete on the Events panel, and
then click the button in the toolbar (see "2.16.5 Delete events").
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2.12.5 Stop/restart collection of execution history [IECUBE][Simulator]

It is possible to temporarily stop or restart the collection of execution history during program execution.

2.12.5.1 Stop collection of execution history temporarily

By clicking the button on the toolbar in the Trace panel during program execution, it is possible to temporarily stop
collection of trace data without stopping program execution.

Use this function when you want to stop only the trace function without halting the program and check the trace data that
has been collected until you stop it.

2.12.5.2 Restart collection of execution history

If you have halted the trace function during program execution, you can start collection of trace data again by clicking
the button on the toolbar in the Trace panel.
Note that the trace data that has been collected before you restart is cleared once.

2.12.6 Display the collected execution history

The collected trace data is displayed in the Trace panel below.

Select the [View] menu >> [Trace].

The trace data displays by mixing the disassembled text and source text by default, but it is also possible to display
either one of these by selecting the Display mode.

For details on the contents and function in each area, see the section for the Trace panel.

Figure 2.78 Display Trace Data (Trace Panel)
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(1): [Number] area

(2): [Time (h:min:s,ms,us,ns)] area

(3): [Line/Address] area

(4): [Source/Disassemble] area

(5): [Address] area

(6): [Data] area

This section describes the following.
2.12.6.1 Change display mode
2.12.6.2 Change display format of values
2.12.6.3 Link with other panels

2.12.6.1 Change display mode
Display mode can be changed to the purpose when clicking the buttons below in the toolbar.
Note that these buttons are disabled while the tracer is running.
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Table 2.14  Display Modes of Trace Panel

Button Display Mode Displayed Content
Mixed display mode Displays the instruction (disassemble results), labels, source text (corre-

sponding source line), point trace results [IECUBE][Simulator], reset
causes [IECUBE], and break causes (default).

Disassemble display mode | Displays the instruction (disassemble results), labels, point trace results
[IECUBE][Simulator], reset causes [IECUBE], and break causes.

Source display mode Displays the source text (corresponding source line), reset causes
[IECUBE], and break causes.

However, when a place where no debugging information is present is exe-
cuted, "<No Debug Information>" is displayed.

Figure 2.79 Example of Source Display Mode View (Trace Panel)
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2.12.6.2 Change display format of values

The display format of the [Line Number/Address], [Address] [[ECUBE][Simulator] and [Data] [[ECUBE][Simulator]
area can be changed using buttons below on the toolbar.
Note that these buttons are disabled while the tracer is running.

Notation The following buttons to change the notation of a data value are displayed.
Hexadecimal Displays values on this panel in hexadecimal number (default).
. Decimal Displays values on this panel in decimal number.
Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.

2.12.6.3 Link with other panels

Items in the trace panel can be linked to other panels using the currently selected line address as a pointer (window
focus will not move).

Click the button on the toolbar to start linking to the Editor panel. Click the button on the toolbar to start linking
to the Disassemble panel.

If the button is clicked again, the link is disconnected.

Remark The Editor panel/Disassemble panel opens when selecting the [Jump to Source]/[Jump to Disassemble]
from the context menu with moving the caret to the source line/address corresponding to the address of
the currently selected line (focus is moved).
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2.12.7 Clear the trace memory

To clear the collected trace data contents, click the button on the toolbar.
Note that this button is disabled while a tracer is running.

Remark 1. [IECUBE][Simulator]
When [Yes] is specified in the [Clear trace memory before running] property in the [Trace] category on

the [Debug Tool Settings] tab of the Property panel, the trace memory is cleared each time a program is
executed.

Remark 2. [E1][E20][EZ Emulator][COM Port]
The trace memory is cleared each time a program is executed (fixed).

2.12.8 Search the trace data

To search the collected trace data, click the button to open the Trace Search dialog box (note that the search is dis-
abled during execution of a program).

In this dialog box, follow the steps below.

When the tab on the tab selection area is selected, the trace data can be searched in instruction level/source level.

Note however, that if you search the trace data at the instruction level, the display mode must be set in the Trace panel
to the Mixed display mode or Disassemble display mode.

When searching at the source level, the mode must be set to the Mixed display mode or Source display mode.

Figure 2.80 Search Trace Data (Trace Search Dialog Box)
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This section describes the following.
2.12.8.1 Search in the instruction level
2.12.8.2 Search in the source level
2.12.8.1 Search in the instruction level
Search the trace data in the instruction level.
Select the [Instruction Level] tab and then follow the steps below.
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Figure 2.81 Search Trace Data in Instruction Level
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(1) Specify [Fetch Address]
Specify the fetch address if it is a required search parameter.
You can either type address expressions directly into the text boxes, or select it from the input history via the drop-
down list (up to 10 items).
The fetch address can also be specified as a range. In this case, specify a range by specifying address expres-
sions in both the left and right text boxes.
If the right-hand text box is blank or contains the text [(Input when range is specified)], then the fixed address
specified in the left-hand text box will be searched.
Note that if an address value greater than the microcontroller address space is specified, the high-order address
value is masked.
An address value greater than the value expressed within 32 bits cannot be specified.

(2) Specify [Mnemonic]
Specify the mnemonic if it is a required search parameter.
The specified character strings in this area is searched within the [Source/Disassemble] area of the Trace panel.
You can either type a mnemonic directly into the text boxes, or select one from the input history via the drop-down
list (up to 10 items).
Searches are case-insensitive, and partial matches are also allowed.

(3) Specify [Access Address] [IECUBE][Simulator]
Specify the access address if it is a required search parameter.
You can either type the address value directly into the text boxes (in hexadecimal number), or select it from the
input history via the drop-down list (up to 10 items).
The access address can also be specified as a range. In this case, specify a range by specifying address expres-
sions in both the left and right text boxes.
If the right-hand text box is blank or contains the text [(Input when range is specified)], then the fixed address
specified in the left-hand text box will be searched.
Note that if an address value greater than the microcontroller address space is specified, the high-order address
value is masked.
An address value greater than the value expressed within 32 bits cannot be specified.

(4) Specify [Access Status] [IECUBE][Simulator]
This item is only enable if a value for Specify [Access Address] [[ECUBE][Simulator] is specified.
Select the access type (Read/Write, Read, Write, Vector Read and DMA) from drop-down list.
Select [(No Specification)] if you do not wish to limit access types.
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®)

(6)

()

Specify [Data] [[ECUBE][Simulator]

This item is only enable if a value for Specify [Access Address] [[ECUBE][Simulator] is specified.

Specify the access data.

You can either type the data directly into the text boxes (in hexadecimal number), or select it from the input history
via the drop-down list (up to 10 items).

The data can also be specified as a range. In this case, specify a range by specifying data in both the left and
right text boxes.

If the right-hand text box is blank or contains the text [(Input when range is specified)], then the fixed data specified
in the left-hand text box will be searched.

Specify [Number]

Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace
panel.

Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number"
are specified by default).

You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input his-
tory via the drop-down list (up to 10 items).

If the left-hand text box is left blank, it is treated as if "0" were specified.

If the right-hand text box is left blank, it is treated as if the last number were specified.

Click the [Search Backward]/[Search Forward] button

When the [Search Backward] button is clicked, search is taken place in the order from the large number to small
and the search results are shown selected in the Trace panel.

When the [Search Backward] button is clicked, search is taken place in the order from the small number to large
and the search results are shown selected in the Trace panel.

2.12.8.2 Search in the source level

Search the trace data in the source level.
Select the [Source Level] tab.

Figure 2.82 Search Trace Data in Source Level

Trace Search =

Search chject

@ The execution parl iz relrieved cpecilyirg the cawce lire
The execution parl iz relrigved cpecilyirg the funclion
The execution parl iz relrieved specifyirg the global varizble

Search cordidion

Sourca and Line: []

Search range

Mumber E' = E

(1)

Search with specifying the source line (default)
Select the [The execution part is retrieved specifying the source line] item in the [Search object] area and then fol-
low the operation below.
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Specify [Source and Line]

The specified character strings in this area is searched within the [Line/Address] area of the Trace panel.
You can either type the character strings of the source line to be find directly into the text box, or select them
from the input history via the drop-down list (up to 10 items).

Searches are case-insensitive, and partial matches are also allowed.

Example 1.  main.c#40
Example 2. main.c
Example 3. main

Specify [Number]

Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace
panel.

Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number"
are specified by default).

You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input
history via the drop-down list (up to 10 items).

If the left-hand text box is left blank, it is treated as if "0" were specified.

If the right-hand text box is left blank, it is treated as if the last number were specified.

Click the [Search Backward]/[Search Forward] button

When the [Search Backward] button is clicked, search is taken place in the order from the large number to small
and the search results are shown selected in the Trace panel.

When the [Search Backward] button is clicked, search is taken place in the order from the small number to large
and the search results are shown selected in the Trace panel.

Search with specifying the function name

Select the [The execution part is retrieved specifying the function] item in the [Search object] area and then fol-
low the operation below.

Specify [Function Name]

You can either type the function name to be find directly into the text box, or select it from the input history via
the drop-down list (up to 10 items).

Searches are case-insensitive, and only complete matches are retrieved.

Specify [Number]

Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace
panel.

Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number"
are specified by default).

You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input
history via the drop-down list (up to 10 items).

If the left-hand text box is left blank, it is treated as if "0" were specified.

If the right-hand text box is left blank, it is treated as if the last number were specified.

Click the [Search Backward]/[Search Forward] button

When the [Search Backward] button is clicked, search is taken place in the order from the large number to small
and the search results are shown selected in the Trace panel.

When the [Search Backward] button is clicked, search is taken place in the order from the small number to large
and the search results are shown selected in the Trace panel.

Search with specifying the global variable [IECUBE][Simulator]

Select the [The execution part is retrieved specifying the global variable] item in the [Search object] area and
then follow the operation below.

Specify [Variable Name]

You can either type the variable name to be find directly into the text box, or select it from the input history via
the drop-down list (up to 10 items).

Searches are case-insensitive, and only complete matches are retrieved.

Specify [Kind]
Select the access type ([Reference/Substitution], [Reference], or [Substitution]) from the drop-down list.

Specify [Value]

You can either type the accessed variable value directly into the text box, or select one from the input history via
the drop-down list (up to 10 items).

The variable value can also be specified as a range. In this case, specify a range by specifying variable values
in both the left and right text boxes.
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If the right-hand text box is blank, then access locations with the fixed variable values specified in the left-hand
text box will be searched for.

(d) Specify [Number]
Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace
panel.
Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number"
are specified by default).
You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input
history via the drop-down list (up to 10 items).
If the left-hand text box is left blank, it is treated as if "0" were specified.
If the right-hand text box is left blank, it is treated as if the last number were specified.

(e) Click the [Search Backward]/[Search Forward] button
When the [Search Backward] button is clicked, search is taken place in the order from the large number to small
and the search results are shown selected in the Trace panel.
When the [Search Backward] button is clicked, search is taken place in the order from the small number to large
and the search results are shown selected in the Trace panel.

2.12.9 Save the contents of execution history

Contents of the collected trace data can be saved with range selection in text files (*.txt)/CSV files (*.csv).

When saving to the file, the latest information is acquired from the debug tool, and it is saved in accordance with the dis-
play format on this panel.

The following Data Save dialog box can be opened by selecting the [File] menu >> [Save Trace Data As...].

In this dialog box, follow the steps below.

Figure 2.83 Save Execution History (Data Save Dialog Box)

Data Save - Trace Data [
File Mame: | CG:iTestlzamok\Trace Data [=d [
File Type: | Teut fileai®.pat) ':

Soave Bange Mumber

um [=] - | 1508 -

Cancel | | Heb

(1) Specify [File Name]
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history
via the drop-down list (up to 10 items).
You can also specify the file by clicking the [...] button, and selecting a file via the Select Data Save File dialog
box.

(2) Specify [File Type]
Select the format in which to save the file from the following drop-down list.
The following file formats can be selected.

List Item Format

Text files (*.txt) Text format (default)

CSV (Comma-Separated Variables)(*.csv) CSV formatNote

Note The data is saved with entries separated by commas (,).
If the data contains commas, each entry is surrounded by double quotes
formatting.

in order to avoid illegal

(3) Specify [Save Range Number]
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Specify the range of the number to save via "start number" and "end number".

Directly enter decimal number in each text box or select from the input history displayed in the drop-down list (up
to 10 items).

When saving all the trace data, select the [All Trace Data] item in the drop-down list at the left (the right text box
becomes invalid).

If a range is selected in the panel, that range is specified as the default. If there is no selection, then the range
currently visible in the panel is specified.

(4) Click the [Save] button
Trace data is saved in the specified file with the specified format.

Figure 2.84 Output Example of Trace Data

Number Time Line Number/Address Source/Disassemble Address Data
Number Time Line Number/Address Source/Disassemble Address Data
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2.13 Measure Execution Time of Programs

This section describes how to measure the execution time of the program.

2.13.1 Configure the timer operation

Before the timer function can be used, it is necessary to make settings relating to the operation of a timer.
Note that the method on how to set differs depending on the debug tool used.

2.13.1.1 [IECUBE]
2.13.1.2 [Simulator]

2.13.1.1 [IECUBE]

This timer operation can be configured in the [Trace] category on the [Debug Tool Settings] tab in the Property panel.
Figure 2.85 [Timer] Category [[ECUBE]
a Timer
Fate of frequency divizion of timer 1421 T Drin)

(1) [Rate of frequency division of timer]
Select the frequency division ratio of the timer counter (120 MHz) used for timer measurement (default: [1/1(8ns/
0.6min)]).

Caution It is not possible to divide the timer counter for the Run-Break time (see "2.13.2 Measure execution
time until stop of the execution").

2.13.1.2 [Simulator]

This timer operation can be configured in the [Trace] category on the [Debug Tool Settings] tab in the Property panel.
Figure 2.86 [Timer] Category [Simulator]

4 Timer
ke timear function Mo

(1) [Use timer function]
Select whether to use the timer function.
Select [Yes] to use the timer function (default: [No]).

2.13.2 Measure execution time until stop of the execution

In the debug tool, there is a function to measure the program execution time (Run-Break time) from the start to the stop.
Therefore, when the program starts its execution, the execution time is automatically measured.
You can check the result of the measurement by either one of the following.

Caution1. [COM Port]
This function is not supported.

Caution 2.  The execution time cannot be measured when Step In or Step Over is performed.

Remark This function is operated by a Run-Break Timer event, which is one of the built-in events set by default in
the debug tool. The Run-Break timer event is always Valid state (settings not changeable).

(1) Check in the status bar

After the program is stopped, the result of the measurement is displayed in the status bar on the Main window
(when measurements have not been performed yet, "Not measured" is displayed).
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Figure 2.87 Example of Result of Run-Break Timer Event (Status Bar)

(=] BREAK 0x0D20d | @3 RL78 Simulator r_ﬂﬂj |

The result of the measurement

(2) Check on the Events panel
After the program is stopped, the result of the measurement is displayed in the Events panel that is opened by
selecting the [View] menu >> [Event], in event type as "Run-Break Timer".

Figure 2.88 Example of Result of Run-Break Timer Event (Events Panel)

Events B
LB CEEEES

Mame D=t mil Ciomment
(1] =" Run-Eraak Timer Totat536787 10 ns b

¥ = Uncenditional Trace =

2.13.3 Measure execution time in a section [[IECUBE][Simulator]

In the program execution process, the execution time in a section can be measured by setting Timer Result event. This
Timer Result event consists of a timer start event and a timer end event.
To use this function, follow the procedure described below.

2.13.3.1 Set a Timer Result event
2.13.3.2 Execute the program
2.13.3.3 Edit a Timer Result event
2.13.3.4 Delete a Timer Result event

Caution 1.  [E1][E20][EZ Emulator][COM Port]
Timer Result event is not supported.

Caution 2.  Also see "2.16.7 Notes for setting events" for details on Timer Result events (e.g. limits on the number of
enabled events).

2.13.3.1 Set a Timer Result event

To set a Timer Result event, set a timer start event and a timer end event that starts/stops a timer measurement.
Use one of the following methods to set a timer start event and a timer end event.

(1) For execution-related events
Perform this operation in the Editor panel/Disassemble panel in which the source text/disassembly text is dis-
played.
Follow the operation listed below from the context menu, in accordance with your desired event type, after moving
the caret to the target line that has a valid address.

Event Type Operation
Timer start Select [Timer Settings] >> [Start Timer]
Timer end Select [Timer Settings] >> [Stop Timer]
Caution [Simulator]

Simulator will not include the time for a timer end event in the measurement results. For this rea-
son, set a timer end event to one line below the range for which you wish to measure the run time.

A timer start event or a timer end event is set to the instruction at the start address corresponding to the line of the
caret position.
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Once a timer start event or a timer end event is set, the following event mark is displayed in the event area of the

line that an event is set.

Table 2.15 Event Marks of Timer Start Event/Timer End Event

Event Type Event mark
Timer start &)
Timer end he
Figure 2.89 Timer Start and Timer End Events Setting Example (Disassemble Panel)
Event area
’_k_|
Indicates that a timer 77 for(i=0: i<1000:
start event has been set.,_{'j- o420 [+3 fE CLRW
00421 [+a 16 MO
Indicates that a timer 00422 +h 17 MO
end event has been set. 00423 [+c 44803 CMP
e 00426 |+1 deld BHWC
i NOP s

(2) For access-related events
In this product version, this function is not supported.

When a timer start event and a timer end event are set, they are managed collectively on the Events panel as one
instance of a Timer Result event (see "2.16 Manage Events"). When you click the "+" mark at a Timer Result event item,
detailed information on the timer start event and the timer end event you have set is displayed.

Figure 2.90 Example of Timer Start and Timer End Events (Execution Type) in Events Panel

Events ]
X ||| @ || @ 35| (2 =
Marme o [Dhetail Coopntrent
=2 Run-Break. Timer Todal: 179281 ne
é;‘fj‘ Timer Fesult Mot measured \
Tatal Pazs Count  fyerags felae feliny

| Haot measued |N|‘.‘-1. messired |H|:n1 fessured |h||:-l tessured | Mot pessuwred |

Detail

|SLarl: Execution r_mainckB 0x1d1 /

End Execution r_omainc$aD 0xlel

Hame Dbl
W= Unconditional Trace -

Commen

Remark
invalid)").

Event marks differ depending on the event state (see "2.16.1 Change the state of set events (valid/

When an event is set at the point which other event is already set, the event mark ( }H_.Q ) is displayed

meaning more than one event is set at the point.

2.13.3.2 Execute the program

Execute the program (see "2.8 Execute Programs").

When an instruction for which a timer start event or a timer end event has been set is executed, a timer measurement is

started or finished.

After the program is stopped, the result of the measurement is displayed in the Events panel that is opened by selecting

the [View] menu >> [Event], in event type as "Timer Result".
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This Timer Result is a particular type of event that is displayed on only the Events panel when either a timer start event
or a timer end event has been set.

Figure 2.91 Example of Result of Timer Result Event (Timer Start Event/Timer End Event)

Events ]
L El [ El EIRE S
Mame o Datail Ciprnpmaznt
7 =% Fun-Break, Timer Total 40174231 ns
] [ Timer Ragult Total : 36652468 ne Start/End:2
Tatal Fazs Gownt  fyverags felae feliry
|2&552dﬁ3n: |395 |E'|'2I3ng |63625n2 |fi'.'1ﬁﬁns |
Detail
Start Exscwlion r_maincElY 0= 141
End Exccution romain o5 0=le]
Hame [etamil Camment
F] = Unconditional Trace -

2.13.3.3 Edit a Timer Result event

It is possible to edit a timer start event or a timer end event you have set.
For details on how to do it, see "2.16.4.1 Edit execution-related events".

2.13.3.4 Delete a Timer Result event

To delete a Timer Result event you have set, on the Editor panel/Disassemble panel, right-click the event mark in the
event area and select [Delete Event] from the context menu that is displayed.

Also, there is another way to delete a set event. Select the Timer Result event you want to delete on the Events panel,
and then click the button in the toolbar (see "2.16.5 Delete events").

Caution It is not possible to delete only a timer start event or a timer end event (i.e. if either a timer start event or
a timer end event is deleted from the event marks on the event area, all of the corresponding event
marks are deleted).

2.13.4 Measurable time ranges

The scope of time that can be measured via timers using Run-Break Timer events (see "2.13.2 Measure execution time
until stop of the execution" for details) or Timer Result events (see "2.13.3 Measure execution time in a section
[[ECUBE][Simulator]" for details) is shown below.

If the maximum measurable length of time is exceeded, a timer-over break is generated, and program execution stops.

Table 2.16  Measurable Time Ranges

Debug Tool Run-Break Timer Event Timer Result Event
IECUBE Min. | 8 ns Min. | 8 ns
Max. | Approx. 40 hours 43 min Max. | Approx. 40 hours 43 min (time for 4K
Overflow detection included cycles)
Maximum pass count: 4294967295 times
Overflow detection included

E1/E20 Min. 100 ps -
EZ Emulator

Max. | Approx. 119 hours 18 min
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Debug Tool Run-Break Timer Event Timer Result Event

Simulator Depends on the clock frequency for timer/ Depends on the clock frequency for timer/trace
trace

2.14 Measure Coverage [[ECUBE][Simulator]

This section describes coverage measurements that are conducted using the coverage function.

There are several kinds of coverage measurement methods. Of these, CS+ performs, in areas designated below, a
code coverage measurement of fetch-related operations on source lines and functions (CO coverage) and a data cover-
age measurement of access-related operations on variables.

The area in which CS+ performs coverage measurements are as follows:

Table 2.17  Subject Areas of Coverage Measurement

Debug Tool Code Coverage Measurement Area
IECUBE Internal ROM/RAM, DataFlash, Target memory
Simulator Internal ROM/RAM, Emulation ROM/RAM, Target memory

Caution [E1][E20][EZ Emulator][COM Port]
The coverage function is not supported.

Remark CO coverage: Instruction coverage (statement coverage)
For example, if all instructions (statements) in code are executed at least once, then CO = 100%.

2.14.1 Configure the coverage measurement

You need to configure the code coverage measurement before using the coverage function.
The setting method differs depending on the debug tool used.

2.14.1.1 [IECUBE]
2.14.1.2 [Simulator]

2.14.1.1 [IECUBE]

You can configure the coverage measurement in the [Coverage] category on the [Debug Tool Settings] tab of the Prop-
erty panel as follows:

Figure 2.92 [Coverage] Category [IECUBE]

4 Goverags
Reuse coweraze resull Ho

(1) [Reuse coverage result]
The currently obtained results of code coverage measurements are automatically saved when CS+ is discon-
nected from the debug tool. The next time it is connected to the debug tool, specify from the drop-down list
whether or not you want to reproduce the contents of saved measurement results.
Select [Yes] to reproduce the contents of previously obtained code coverage measurement results (default: [No]).
The file that saves results of code coverage measurements (raw.csr.cv) will be created in the folder where the load
module file currently being downloaded exists.

2.14.1.2 [Simulator]

You can configure the coverage measurement function in the [Coverage] category on the [Debug Tool Settings] tab of
the Property panel as follows:
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Figure 2.93 [Coverage] Category [Simulator]

4 Coverage
Lze coverage function Yz
Rauze coverage result Ma

(1) [Use coverage function]
Select whether to use the coverage function.
Select [Yes] to use the coverage function (default: [No]).

R20UT5301EJ0100 Rev.1.00 ENESAS Page 102 of 413
Jun 01, 2023



CS+V8.10.00 2. FUNCTIONS

(2) [Reuse coverage result]
This property appears only when the [Use coverage function] property is set to [Yes].
The currently obtained results of code coverage measurements are automatically saved when CS+ is discon-
nected from the debug tool. The next time it is connected to the debug tool, select whether or not you want to
reproduce the contents of saved measurement results.
Select [Yes] to reproduce the contents of previously obtained code coverage measurement results (default: [No]).

2.14.2 Display the coverage measurement result

When the program starts running, a coverage measurement is automatically begun, and when the program stops run-
ning, the coverage measurement is terminated at the same time.

(1) Code coverage rates

(a) Display of code coverage rates for source text lines and disassembled text lines
The code coverage rates are indicated on the Editor panel/Disassemble panel that is displaying the target pro-
gram.
On each panel, the target source text lines and disassembled result lines are shown in color-coded background
(see "Table 2.19") according to their code coverage rate that was calculated based on the formula described in
"Table 2.18".
Note that the results are not shown when disconnected from the debug tool or during the program execution.
Selecting [Clear coverage information] from the context menu in the Editor panel/Disassemble panel will reset
all the coverage information acquired, including the color-coded display on each panel.

Table 2.18 Method for Calculating Code Coverage Rates for Source Lines and Disassemble Lines

Panel Calculation Method

Editor panel "Number of bytes of code executed in the address range corresponding to the source
text line" / "Total number of bytes of code in the address range corresponding to the
source text line"

Disassemble panel "Number of bytes of code executed in the address range corresponding to the disas-
sembled text line" / "Total number of bytes of code in the address range correspond-
ing to the disassembled text line"

Table 2.19  View of Code Coverage Measurement Result (Default)

Code Coverage Background Color
100 % Source text/disassembled text
11099 % Source text/disassembled text
0 % (not yet executed) Source text/disassembled text
Remark 1. The code coverage measurement result displayed on each panel is automatically updated at

every program break.

Remark 2. The above background colors depend on the configuration in the [General - Font and Color] cat-
egory of the Option dialog box.

Remark 3. The above background colors do not apply to the lines that are outside of the subject area (see
"Table 2.17 Subject Areas of Coverage Measurement”).

Remark 4. If the downloaded lode module file is older than the source file currently being open, the display-
ing of the code coverage measurement result is not performed in the Editor panel.
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Figure 2.94 View of Code Coverage Measurement Result (Editor Panel)
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Figure 2.95 View of Code Coverage Measurement Result (Disassemble Panel)
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(b) Display of code coverage rates for each function
Code coverage rates of each function can be checked via the [Code Coverage[%]] item in the Function List
panel of the analyze tool. For details on "the code coverage rates of the function”, see "CS+ Integrated Devel-
opment Environment User's Manual: Analysis".

(2) Data coverage rates
Data coverage rates of each variable can be checked via the [Data Coverage[%]] item in the Variable List panel of
the analyze tool. For details on "the data coverage rates of the variable", see "CS+ Integrated Development Envi-
ronment User's Manual: Analysis".
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2.15 Set an Action into Programs

This section describes how to set the specified action into the program.

2.15.1 Inset printf

By setting a Printf event that is one of "action events", the value of the specified variable expression can be output to the
Output panel by executing a printf command after temporarily stopping the program in execution at an arbitrary position.
To use this function, follow the steps below.

Caution 1.  Also see "2.16.7 Notes for setting events" for details on action events (e.g. limits on the number of
enabled events).

Caution 2.  No action events occur during step execution ( / / ) or execution ignoring break-related

events ( ).

Caution 3.  [Simulator]
When [Yes] is specified with the [Execute instruction at breakpoint when break] property in the [Break]
category on the [Debug Tool Settings] tab in the Property panel, all of action events currently being set
are handled as Hardware Break events (i.e. no Printf events occur).

(1) Set a Printf event

Set a Printf event to the position where you want to execute the printf command in the Editor panel/Disassemble
panel.

On each panel, select [Register Action Event...] from the context menu after moving the caret to the line that has a
valid address to open the Action Events dialog box below.

In this dialog box, follow the steps below.

Figure 2.96 Set Printf Event (Action Events Dialog Box: [Printf event] tab)
Luickion Events &I

Prrdf evert | State uama'.'art]
Ohtpant slring: Example) Sample:

Vanable expression;  Bxample) aaa, bbb, oo

fr_mirube

Address:

"CAsamplet DefauktBuildsample. abs™Svectthl. asms 13 [ |

Ecmple for Cutput panesl)
Cample: aaa = 10, bbb = 20, e = 30

(a) Specify [Output string]
Directly enter from the keyboard the characters to add when output to the Output panel.
Characters must be in one line (spaces allowed).

(b) Specify [Variable expression]
Specify the variable expression for the Printf event to take place.
Type a variable expression directly into the text box (up to 1024 characters).
You can specify up to 10 variable expressions for a single Printf event by separating them with commas ",".
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If this dialog box opens with a variable expression selected in the Editor panel/Disassemble panel, the selected
variable expression appears as the default.

For the basic input format that can be specified as variable expressions and the values output by Printf event,
see "Table A.14 Relationship between Variable Expressions and Output Value (Printf Event)".

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] +
[Space] key in this text box (see "2.20.2 Symbol name completion function").

(c) Specify [Address]
Specify the address at which to set the Printf event.
The address of the location currently being specified is displayed by default.
If you want to edit this area, you can either type an address expression directly into the text box (up to 1024
characters), or select them from the input history via the drop-down list (up to 10 items).

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] +
[Space] key in this text box (see "2.20.2 Symbol name completion function").

(d) Click the [OK] button
Set the Printf event to the line/address at the caret position in the Editor panel/Disassemble panel.
When the Printf event is set, the ."3' mark is displayed in the event area on the Editor panel/Disassemble panel,
and the set Printf event is managed in the Events panel (see "2.16 Manage Events").

(2) Execute the program
Execute the program (see "2.8 Execute Programs").
By executing the program, the program momentarily stops immediately before executing the instruction at the
location where this event is set, and the value of the variable expression specified in this dialog box is output to the
Output panel.

(3) Check the output result
The output result format from the Printf event in the [Debug Tool] tab of the Output panel are as follows (see "Fig-
ure A.24 Output Result Format of Printf Event").

Figure 2.97 Example of Output Result of Printf Event

Output =

Savple= global_a=101(0xn], 1

stoeped by user cperotion., [Output string]: Sample=

[EOF [Variable expression]: global_a
The result of the specification above

\ Al Messages | “Debug Tool /| bt

(4) Edit the Printf event
You can edit the Print event that has been set once.
To do this, on the Events panel, select [Edit Condition...] from the context menu after selecting the Printf event to
be edited. On the Action Events dialog box opened automatically, edit the items, and then click the [OK] button.
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2.16 Manage Events

An event represents a certain status of the target system when debugging such as "Address 0x1000 is fetched" and
"Data is written to address 0x2000".

In CS+, these events are used as the action trigger of the debug function such as breakpoint, start/stop the tracing, and
start/stop the timer.

This section describes how to manage those events.

Select the [View] menu >> [Event].

Events are all managed in the Events panel. In the Events panel, you can confirm the details of the currently set events
in a list, and they can be deleted and changed enable/disable status.

For details on the contents and function in each area, see the section for the Events panel.

Figure 2.98 Manage Events (Events Panel)

Events ]
x ||| 0| || &]5a| & = =@
Mame ¢ Detail Comment
7| = Run-EBrezk Timer Total 40174281 nz
# (W] 15 Timer Result Total :26552468 ne Start/End2
¥ ¥ Trace Start/End:2
Detail

Start Exscution r_mainc®# 106 0= 111

End Execution r_manc#l 14 (2l ]

Mame o Detal Comment
T =% Unconditional Trace -

& @) 3)

(1): [Name] area
(2): [Detail Information] area
(3): [Comment] area

Remark For details on how to set various events, see the section below:
- Set a breakpoint
- Set a break event (execution type)
- Set a break event (access type)
- Set a Trace event
- Set a Point Trace event

- Set a Timer Result event

2.16.1 Change the state of set events (valid/invalid)

By changing the check on the check box of the event name, the setting state of the event can be changed (the Event
mark is changed depending on the setting state of the event).
The following are types of the setting state of the event.

Figure 2.99 Event Name Check Box

.f_.
1 @ @)
(1): Check box

(2): Event mark
(3): Event name
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Table 2.20  Setting State of Event

Valid state Event occurs when the specified condition is met.
It is possible to set the event to an invalid state by removing the check.

[] | Invalid state Event does not occur when the specified condition is met.
It is possible to set the event to a valid state by removing the check.

Suspended State | The conditions that have been specified cannot be set with the program of the debug-
ging target. It is not possible to operate the check box.

Remark 1. Both of the timer start event and the timer end event is must be set for the Timer Result event. There-
fore, it is not possible to set a particular event to a valid state by only the setting of one of these (at the
same time as both events are set, they are treated as grouped events as a Timer Result).

Remark 2. It is not possible to set the Run-Break Timer event to an invalid/suspended state.

Remark 3. The setting state of the event can be changed from the menu displayed by right clicking on the Event
mark in the Editor panel/Disassemble panel.

Remark 4. The setting of the Unconditional Trace event and the Trace event to valid or invalid state is exclusively
controlled. Therefore, the Unconditional Trace event, which is a built-in event, is valid state by default,
but if either a trace start event/trace end event is set, it automatically becomes invalid state, and the
Trace event, which is a event name that is collectively called with a trace start event and a trace end
event, becomes valid state. Conversely, if the set Trace event is invalid state, the Unconditional Trace
event automatically becomes valid state.

2.16.2 Display only particular event types

Click on the toolbar button to display only the particular event type.

Displays events related to the Hardware Break.

El

Displays events related to the Software Break.
(except [Simulator])

Note

Displays events related to the trace

Displays events related to the timer.

Displays events related to the action event (Printf event).

Displays the built-in events (Unconditional Trace event and Run-Break Timer event).

Note [E1][E20][EZ Emulator][COM Port]
This button is available only when the selected microcontroller incorporates the OCD trace function.

2.16.3 Jump to the event address

Clicking the following buttons jumps to each panel which selected events address exist.
Note however, that when a Trace event/Timer Result event/ Unconditional Trace event/ Run-Break Timer event is
selected, these buttons are disabled.

Opens the Editor panel and jumps to the source line corresponding to the address
where the selected event is being set.

Opens the Disassemble panel and jumps to the disassemble results corresponding to
the address where the selected event is being set.

Opens the Memory panel and jumps to the source line corresponding to the address
where the selected event is being set.
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2.16.4 Edit detailed settings of events

This section describes how to edit detailed settings of various events.

2.16.4.1 Edit execution-related events
2.16.4.2 Edit access-related events
2.16.4.3 Edit combination conditions of events [E1] [E20]

Remark For information on editing of action events (Printf events and interrupt events), see "2.15 Set an Action
into Programs".

2.16.4.1 Edit execution-related events

The address condition and pass count condition [IECUBE][Simulator] for execution-related events you have set can be
edited.

Perform this operation in the Detail dialog box (for execution events) that is opened by selecting [Edit Condition...] from
the context menu after moving the caret to an execution-related eventNote you want to edit on the Events panel.

Note An execution-related event refers to any one of the following events in the Events panel.
- Hardware Break event (execution type)
- Execution-related break event in detailed information on Combination Break event [E1][E20]
- Execution-related event as start and end condition in detailed information on Trace event
- Execution-related event as start and end condition in detailed information on Timer Result event

[IECUBE][Simulator]

Figure 2.100 Example of Detail Dialog Box (for Execution Events) [Simulator]
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(1) Editing [Address Condition]
You can edit the address condition for an execution-related event in this area.

Figure 2.101 [Address Condition] [[ECUBE]

# Agddress condition
Compare condtion Specfied address (==}
Addrass main.cl_mans1

Figure 2.102 [Address Condition] [E1][E20][EZ Emulator][COM Port]

Address man. cd_man+1
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Figure 2.103 [Address Condition] [Simulator]
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- For [IECUBE][Simulator]
From the [Compare condition] drop-down list, select the type of condition for address comparison.
After that, specify the address for use with the selected type of condition in the field displayed under the list.

List of [Compare condition] Setting Method
Specified address (== After selecting any of these conditions, directly enter an address
expression as the address value in the [Address] field displayed under
Greater than or equal to (>=) the list for selection of the type of comparison.

Less than or equal to (<=)

Inside the range (<=Values<=) After selecting any of these conditions, directly enter an address
) expression as the address range in the [Start address] and [End
Outside the range !(<=Values<=) address] field displayed under the list for selection of the type of com-
parison.

It is possible to specify the value of an address mask for the specified address value [Simulator].
In this case, specify [Yes] in the [Use the address mask], and specify the mask value in the [Mask value] field
under the list by directly entering a hexadecimal address.

- For [E1][E20][EZ Emulator][COM Port]
In [Address], the address at which the execution-related event is currently set is displayed.
To edit this address, directly enter an address expression for the address value at which you want to set the

event.

(2) Editing [Pass Count] [[ECUBE][Simulator]
You can edit the pass count condition for an execution-related event in this area.
Directly enter a pass count value in decimal notation between 1 and 65535.

Figure 2.104 [Pass Count]
4 Pass count
Fass count 1

Caution [IECUBE]
A value other than "1" cannot be specified as the pass count condition for an execution-related

event (before execution).

2.16.4.2 Edit access-related events

The address condition, data condition and pass count condition [IECUBE][Simulator] for access-related events you

have set can be edited.
Perform this operation in the Detail dialog box (for access events) that is opened by selecting [Edit Condition...] from the

context menu after moving the caret to an access-related eventNote you want to edit on the Events panel.
Note An access-related event refers to any one of the following events in the Events panel.
- Hardware Break event (access type)
- Access-related break event in detailed information on Combination Break event [E1][E20]

- Access-related event as start and end condition [E1][E20][COM Port] in detailed information on Trace
event

- Access-related event in detailed information on Point Trace event
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Figure 2.105 Example of Detail Dialog Box (for Access Events) [Simulator]
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(1

Editing [Address Condition]
You can edit the address condition for an execution-related event in this area.

Figure 2.106 [Address Condition] [IECUBE]

# Agddress condition
Compare condtion Spectfied addrezg (==}
Addrags main.ch_main+1

Figure 2.107 [Address Condition] [E1][E20][EZ Emulator][COM Port]

4 Pddress condifion
Address man.cH_man-=1

Figure 2.108 [Address Condition] [Simulator]
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- For [IECUBE][Simulator]
From the [Compare condition] drop-down list, select the type of condition for address comparison.
After that, specify the address for use with the selected type of condition in the field displayed under the list.

2. FUNCTIONS

List of [Compare condition] Setting Method
Specified address (== After selecting any of these conditions, directly enter an address
expression as the address value in the [Address] field displayed under
Greater than or equal to (>=) the list for selection of the type of comparison.

Less than or equal to (<=)

Inside the range (<=Values<=) After selecting any of these conditions, directly enter an address
expression as the address range in the [Start address] and [End
address] field displayed under the list for selection of the type of com-
parison.

Outside the range !(<=Values<=)

It is possible to specify the value of an address mask for the specified address value [Simulator].
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In this case, specify [Yes] in the [Use the address mask], and specify the mask value in the [Mask value] field
under the list by directly entering a hexadecimal address.

- For [E1][E20][EZ Emulator][COM Port]
In [Address], the address at which the access-related event is currently set is displayed.
To edit this address, directly enter an address expression for the address value at which you want to set the

event.

(2) Editing [Data Condition]
You can edit the data condition for an access-related event in this area.

Figure 2.109 [Data Condition]
4 Data condition
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(a) Specify an access type
In [Access type], select an access type from the following drop-down list.

Read When a read access occurs, the condition holds true.
Write When a write access occurs, the condition holds true.
Read/Wrote When a read or write access occurs, the condition holds true.

(b) Specify an access size
In [Access size], select an access size from the following drop-down list.

No conditions When an access in any size occurs, the condition holds true.
1byte When an access in 1-byte size occurs, the condition holds true.
2byte When an access in 2-byte size occurs, the condition holds true.

(c) Specify a data comparison condition
From the [Compare condition] drop-down list, select the type of condition for data comparison.
After that, specify the value of data for use with the selected type of condition in the field displayed under the list.

- For [IECUBE][Simulator]

No conditions Comparison data is not specified.

Specified value (== After selecting any of these conditions, directly enter a value in hexa-
decimal number in the [Data] field displayed under the list for selection

Any other value (!=) of the type of comparison.

Greater than or equal to (>=)

Less than or equal to (<=)

Inside the range (<=Values<=) After selecting any of these conditions, directly enter values in hexa-
- decimal number for the data range in the [Data] field displayed under
Outside the range !(<=Values<=) | the |ist for selection of the type of comparison.

For [E1][E20][EZ Emulator][COM Port]

No conditions Comparison data is not specified.

Specified value (== After selecting this, directly enter a value in hexadecimal number in the
[Data] field displayed under this field.
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(d) Specify a data mask
Select [Yes] in the [Use the data mask] field to specify a mask value for the matching of data values. When [Yes]
is selected, a [Mask value] field appears below the [Use a data mask] field. Specify a hexadecimal value with no
more than five digits for the data mask by directly entering it in the [Mask value] field.

(3) Editing [Pass Count] [IECUBE][Simulator]
You can edit the pass count condition for an access-related event in this area.
Directly enter a pass count value in decimal notation between 1 and 65535.

Figure 2.110 [Pass Count]

4 Fass count
Fass court 1

2.16.4.3 Edit combination conditions of events [E1] [E20]

Edit the combination condition for a combination break event comprised of multiple events set.

Caution This function is enabled only when the selected microcontroller supports combination break events.

Perform this operation in the Combination Condition dialog box [E1][E20] that is opened by selecting [Edit Condition...]
from the context menu after moving the caret to a combination break event you want to edit on the Events panel.

Figure 2.111 Example of Combination Condition Dialog Box
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(1) Editing [Combination] area
Select the combination condition from the following drop-down list.

OR The condition is satisfied when one of the set events is encountered (default).
Sequential The condition is satisfied when the set events are encountered in the specified sequence.
Caution When [OR] is selected, up to two break events can be specified.

When [Sequential] is selected, break event can be specified for the 1st to the 2nd position.

(2) Editing [Object event] area
This area displays details on the break event set as a combination break event.
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When [Sequential] is specified in the [Combination] area, the order of display here corresponds to the order in
which the conditions are to be satisfied. To change the order, select a target event and click on the [Up] or [Down]
buttons.

(3) Editing [Reset event] area
Reset events are always enabled.

2.16.5 Delete events

To delete any event and event condition you have set, select the event and click the button on the toolbar.
Note that it is not possible to delete the built-in events (Unconditional Trace event and Run-Break Timer event).

Remark 1. For the Break event of execution type, it is possible to delete the set event to click the event mark dis-
played in the Editor panel/Disassemble panel.

Remark 2. To delete all of the events and event conditions you have set at a time, select [Select All] from the context
menu, then click the button (note, however, that it is not possible to delete the built-in events).

2.16.6 Write comment to events

The user can write comments for each event that has been set.

To input comments, click the [Comment] area after selecting the event to input comments, then input directly the desired
text from the keyboard (the edit mode is cancelled by pressing the [Esc] key).

After editing the comments, complete the editing by pressing the [Enter] key or moving the focus to outside the edit
region.

Up to 256 characters can be inputted for the comments, and this is saved as the settings of the user during use.

2.16.7 Notes for setting events

This section describes notes for setting each type of event.

2.16.7.1 Maximum number of enabled events
2.16.7.2 Event types that can be set and deleted during execution
2.16.7.3 Other notes

2.16.7.1 Maximum number of enabled events

The number of events that can be set to Valid state simultaneously are subject to the following limitations.
Therefore, if this limit is exceeded when you set one or more new valid state events, some of the events that are already
set need to be Invalid state before you can set a new one.
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Table 2.21  Maximum Number of Enabled Events
Event Type Debug Tool to Use
IECUBE E1/E20/EZ Emulator/COM Port Simulator
RL78 FAA RL78 FAA
Without OCD Trace Function With
- - ) OCD
8-bit bus 16-bit bus width Trace
width products Function
products
G15 except
G15
Hardware Break 4 to - - - - - p4Note 4 4
(before execution) gNote 1
Hardware Break 8 2 2 qNote2 | pNote 3 4 -
(after execution)
Hardware Break 8 - - - - - -
(access)
Software Break 2000 - 2000 2000 2000 - - -
Trace 8Note 5 _ _ _ 2Note 3 _ 64Note 4 _
(trace start/trace end)
Point Trace gNote 6 - - - - - -
Timer Result gNote 5 - - - - - -
(timer start/timer end)
Action (Printf) 100Nete 7 - 100Nete 7| qpgNote 7| qggNote 7 - -

Note 1.

Note 2.
Note 3.

Note 4.
Note 5.
Note 6.
Note 7.

Note 8.

Depending on the address and instruction to which the event is set (however, Hardware Break (before
execution) cannot be used in RAM area).

A Hardware Break (after execution) and a Software Break are combined use.

A Hardware Break and a Trace are exclusive of each other (i.e. if one is set, then the other will become
invalid). Total of 2 events (a trace start and a trace end) are available for a Trace.

The before break/after break can be specified in the Property panel.
In this version, only one group can be set (however, two or more Start/Stop events can be set).
In this version, only one can be set (however, two or more conditions for this event can be set).

Combination with Software Break events (however, up to 100 can be set regardless of their valid/invalid
state).

Combination with Hardware Break events (before execution) (however, up to 64 can be set regardless of
their valid/invalid state).

2.16.7.2 Event types that can be set and deleted during execution

Types of events that can be set or removed during execution of the program or during execution of the tracer/timer are
described below.
The meaning of each mark in the table below is as follows:

i Possible

) Possible, if the program execution is allowed to pause for events
(Property panel >> [Debug Tool Settings] tab >> [Set Event While Running] category >> [Set
event by stopping execution momentarily] property >> [Yes])

A Impossible while tracer or timer is executing
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- Impossible, or not supported

Table 2.22 Event Types That Can be Set and Deleted during Execution

Event Type Debug Tool to Use
IECUBE E1/E20/EZ Emulator/COM Port Simulator
RL78 FAA RL78 FAA
Without OCD Trace Function With
- - ) OoCD
8-bit bus 16-bit bus width Trace
width products Function
products
G15 except
G15
Hardware Break i - - - - - A -
(before execution)
Hardware Break (] (] - A -
(after execution)
Hardware Break i - - A -
(access)
Software Break a - - - - - -
Trace i - - - - - -
(trace start/trace end)
Point Trace i - - - - - - -
Timer Result 0 - - - - - - -
(timer start/timer end)
Action (Printf) a - - - - - - -

2.16.7.3 Other notes

- No events can be set to local variables.

- Events do not occur during step execution (including return execution) and program execution by selecting [Go to
Here] from the context menu.

- If the location set for an existing event changes to midway in an instruction because the program to debug has been
downloaded again, re-set the event using the following method.

- If debugging information is available:
The location setting of events is always moved to the beginning of the source text line.

- If debugging information is not available:
Depends on the [Automatic change method of event setting position] property in the [Download] category on the
[Download File Settings] tab of the Property panel.

- If a change to internal ROM/RAM changes the location the event is set to a non-mapped area, then set events will not
occur (they will also not change to Invalid state /Suspended State on the Events panel).

- If you differentiate function or variable names by leading underscores, then CS+ may misrecognize them, and convert
symbols or make break event settings invalid. This applies for cases like when you have two functions, one named
" reset" and the other named "__reset".
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- If there is code (text sections) to be ROMified, any software break event set for that code will be deleted during copy
to RAM. For this reason, no break will occur.

- For other than [Simulator]
Use a hardware break event.

- [Simulator]
Execution will not break even if a hardware break event is used, but it will break if the trace function or the timer
function is valid (on the [Debug Tool Settings] tab of the Property panel, specify [Yes] with the [Use trace func-
tion]/[Use timer function] property on the [Trace]/[Timer] category).

- For other than [IECUBE]
If a software break event is set in a boot-swap area, then a break instruction will be written to the flash ROM.

For this reason, a break instruction will remain after the boot swap.

- [E1][E20][EZ Emulator][COM Port]
Use a hardware break event in a boot-swap area if you wish to.

- [Simulator]
Do not use a break event in a boot-swap area.

- For other than [Simulator]
Hardware Break events with access conditions and Point Trace events [IECUBE] cannot be set for 32-bit (4-byte)

variables.
Additionally, Hardware Break events with access conditions and Point Trace events [IECUBE] cannot be detected if a

single byte of a 16-bit (2-byte) variable is accessed.
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2.17 Use Hook Function

This section describes how to set hooks in the debug tool by using the hook function.

By setting a hook transaction, you can automatically change the values of the SFR/CPU register before and after down-
loading a load module or after resetting the CPU.

Configure the hook transaction in the [Hook Transaction Settings] category on the [Hook Transaction Settings] tab of the
Property panel.

Remark By setting a SFR by using the [Before download] property, for example, downloading can be executed at
high speeds. Downloading to the external RAM is also facilitated by using this function.

Figure 2.112 [Hook Transaction Settings] Category
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Table 2.23  Properties in [Hook Transaction Settings] Category

Property Description
Before download Perform the specified process immediately before downloading the load module
file.
After download Perform the specified process immediately after downloading the load module file.

After CPU reset under breaking | Perform the specified process immediately after resetting the CPU under breaking.

Before running Perform the specified process immediately before starting program execution.

After breaking Perform the specified process immediately after breaking program execution.

The properties in the [Hook Transaction Settings] category indicate the timing with which the hook process will be per-
formed. "[]" indicates the current number of specified processes (no hook processes are configured by default).
Specify the target process in the property for which you want the hook process to be performed.

To specify a process, select the target property, then open the Text Edit dialog box by clicking the [...] button that
appears on the right edge of the field.

Figure 2.113 Opening Text Edit Dialog Box
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Figure 2.114 Use Hook Function (Text Edit Dialog Box)
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In this dialog box, directly enter the desired process from the key board.
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The format for specifying processes is as follows:

[Process 1]:

Automatically overwrites the value of SFR with Value.
Specification format:

SFR-name Value

[Process 2]:

Automatically overwrites the value of CPU register with Value.
Specification format:

CPU-register—-name Value

[Process 3]:

Automatically executes a script file which is specified with Python script path (absolute path or relative path from the
project folder).

Specification format:

Source Python-script-path

Caution You can use the following commands when you execute the Python script in the Hook process of the

debugger. Note that if you want to use other Python command, please use Hook command in the Python
console.

- debugger.Register.GetValue
- debugger.Register.SetValue
- debugger.Memory.Read

- debugger.Memory.Write

Remark 1. When specifying hook processes, lines starting with a hash mark "#" will be treated as comments.

Remark 2. A tab character can be used instead of the space character.

Up to 64 characters for one process, and up to 128 processes for each property can be set (one line in the [Text] area in
the Text Edit dialog box is equivalent to one processing).

After the specification of the process is complete, click the [OK] button to set the process to the Property panel.

Figure 2.115 Example of Hook Transaction
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2.18 Measuring Current Consumption [E2][Simulator]

Measurement of current consumption refers to measuring the amount of current consumption by a whole system to be
debugged [E2] or peripheral modules of within the MCU [Simulator].

Remark Measuring current consumption by the simulator is only available for devices that have peripheral
function simulations. Check which products are supported on the Renesas Web site.

[How to use]
The target for measurement differs between the use of the E2 emulator and the simulator.

The following explains the usage in both cases.

- With the E2 emulator

- With the simulator

- With the E2 emulator
In using the E2 emulator to measure current consumption, the current values in the target system as a whole are

measured.
For measurement of current consumption, the facility for supplying power to the target by the E2 emulator and the E2

expansion interface are used.
Accordingly, to use this facility, be sure to specify [Yes] for the [Power target from the emulator (MAX 200mA)]

property and [Use supplied power from the emulator] for the [Interface for supplying the power] property on the
[Connect Settings] tab in the Property panel before connecting the debug tool.

(1) Open the Measuring Current Consumption panel
Select [RL78 EZ2] as the debug tool, open the Solution List panel, and click on the [GO] button for measuring

current consumption. The Measuring Current Consumption panel [E2][Simulator] will open.

Figure 2.116 Measuring Current Consumption Panel [E2]
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(2) Set the conditions (measurement conditions, trigger conditions, and monitoring points)
In measuring current consumption, you can acquire the pattern of transitions for the current value to be detected
by setting conditions in advance. The main settings that can be made in advance are measurement conditions,

trigger conditions, and monitoring points.

Remark Conditions are set as follows by default.
Operation after record memory is full: Overwrite to the record memory and continue execution
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(a)

Sampling time: 10us
Acquisition condition: All

No external trigger is used.
No monitoring points are set.

If you only want to measure the current as a trial, start the procedure from "(3) Start measurement".

Set the measurement conditions

Set conditions regarding the recording of the measured current values in the Current Consumption
Measurement Condition Setting dialog box [E2] which is displayed by clicking on _'{'j | on the toolbar in the
Measuring Current Consumption panel [E2][Simulator]. )

Figure 2.117 Current Consumption Measurement Condition Setting Dialog Box
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<1> Select the operation after recording memory becomes full

Select any operation from among the following after the memory used to record the current values in the E2
emulator becomes full.

- Overwrite to the record memory and continue execution
- Stop recording (continue to execute the program)

- Stop program

<2> Select the sampling time

Select the sampling time for use in measurement from among the following.
1us, 2us, 5us, 10us, 20us, 50us, 100us, 200us, 500us, 1ms

<3> Select the acquisition condition

An acquisition condition for recording the current values in the memory of the E2 emulator can be set so that
recording only starts when the specific condition has been satisfied.
The condition can be selected as one of the following.

- All
Record all current values that have been sampled after starting measurement without specifying specific
conditions.

During detecting an external trigger input

This item selects recording in memory in response to the external trigger input facility of the E2 expansion
interface only while the specified signal is being detected.

When this is specified, the channel for input of the external trigger to be detected and the level of the signal
to be detected must be specified.

In addition, the external trigger input must have been correctly set before the debug tool is connected.

Remark For details on setting the external trigger input facility of the E2 expansion interface, refer to
the Application Note on the Current Consumption Tuning Solution (E2 Emulator, CS+).

During monitor points
Specify the monitoring point to serve as the start condition in the left entry field and that to serve as the end
condition in the right entry field against [Monitor points rangel].
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The current values will be recorded from detection of the monitoring point specified as the start condition

until detection of the monitoring point specified as the end condition.
For details on the monitoring points, refer to "(c) Set monitoring points".

(b) Set the trigger condition

The E2 emulator is able to stop the program or output an external trigger signal in response to the value for

current being measured satisfying a specific condition.

Set the trigger condition in the Current Consumption Measurement Trigger Condition Setting dialog box [E2],
which is displayed by clicking on on the toolbar in the Measuring Current Consumption panel

[E2][Simulator].

Figure 2.118 Current Consumption Measurement Trigger Condition Setting Dialog Box
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<1> Specify whether to use the trigger facility

Select the checkbox for [Use trigger function] to use the trigger facility.
This checkbox is de-selected by default.

<2> Set the trigger action
Select the operation when a trigger is detected as either of the following.

- Stop program
Stop execution of the program.

- Output external trigger signal
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Output an external trigger through the E2 expansion interface.

Also make the following settings if an external trigger is to be output.

- Select a channel
Specify the channel for output of the external trigger through the E2 expansion interface.

- Select the type of signal to be output
Select whether a high pulse is to be output in response to the condition being satisfied or output of the high
level is to continue as long as the condition is being satisfied.
When a high pulse is to be output, also specify the pulse width.

Remark For details on the external trigger output facility, refer to the Application Note on the Current
Consumption Tuning Solution (E2 Emulator, CS+).

<3> Set the trigger condition
Select the trigger condition for the current value as [Over Threshold], [Under Threshold], [In Range], or [Out of
Rangel].
Specify the current value or range of current values to be detected as the trigger.

Caution For a range of current values, the value entered in the left field for entry must be lower than
that in the right field.

As well as the condition for the current value, a sub-condition (condition for the detection width) regarding the
time over which the condition is satisfied can be set. Specifying a width for detection can eliminate the
detection of noise that temporarily satisfies the condition.

The condition for the detection width is selectable as [Over threshold] (detecting the current value when the
condition continues to be satisfied for more than a specified time) or [In range] (detecting the current value
when the condition is satisfied over a time within the specified range).

Specify a multiple of the sampling time as the detection width.
Note that the actual time for detection also depends on the sampling time.

(c) Set monitoring points
A monitoring point is a facility for recording a timestamp when a specified line of source code is run.
When monitoring points are set, transitions of the execution time and the current values at the monitoring points
can be confirmed on a graph for measuring current consumption.
The monitoring points are indicated by colored vertical lines on the graph.

Remark Monitoring points are not supported for RL78/G10 devices.

Figure 2.119 Monitoring Point
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Monitoring points are set from [Monitor Point Setting] in the context menu after placing the cursor on the line of
the target source code that was opened in the Editor panel.

Figure 2.120 Context Menu in the Editor Panel
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A list of the monitoring points that are currently set is displayed under the Measuring Current Consumption

panel [E2][Simulator].

The monitoring points that have been set are enabled or disabled by the leftmost checkbox in this list or from the

context menu of the Editor panel.

Figure 2.121 List of Monitoring Points
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Monitoring points must be set at the addresses of NOP instructions. An attempt to set monitoring points at other
instructions or the debug tool not being able to detect the NOP instruction even if it is set as a monitoring point
leads to the monitoring points being forcibly disabled when measurement is started.

However, when the compiler in use for the project is V1.05.00 or later of CC-RL and when the source file is reg-
istered in the active project, the NOP instructions can be automatically inserted at the addresses where the
monitoring points are set before measurement, rebuilding and downloading are enabled. In this case,
monitoring points that have been set at any addresses are enabled. However, when the [CPU Reset after down-
load] property in the [Download] category on the [Download File Settings] tab in the Property panel is set to
[Yes], note that the monitoring points are forcibly reset by rebuilding and downloading.

(3) Start measurement
Start measuring current consumption by the target system by using the facilities of the E2 emulator.
Click on ""I'- or ""b- on the toolbar in the Measuring Current Consumption panel [E2][Simulator].

Figure 2.122 Toolbar in the Measuring Current Consumption panel [E2]

ElElE 5 3 BIEM® 4 4 16 M Mok =@ [ B & 0 X &

Caution Current consumption is not measured by clicking on | ﬁ.n in the Main window.

(@) Clickingon ' ¥
The project is rebuilt and downloaded before measurement starts.
However, if the device does not support monitoring points or the compiler used in the active project is a version
of CC-RL earlier than V1.05.00, rebuilding and downloading do not proceed.
When [Hold the build options for monitor point specified when measuring] in the Measuring Current
Consumption panel [E2][Simulator] is selected, the options which are specified for rebuilding and downloading
before measurement are reflected in the [Parameters of NOP instruction insertion for measuring current con-
sumption] property of the build tool.

(b) Clicking on ' #p.
The project is not rebuilt and downloaded before measurement starts.
Select this button when you want to measure current consumption without resets due to rebuilding and
downloading.
Note that this button is not displayed if the device does not support monitoring points or the compiler used in the
active project is a version of CC-RL earlier than V1.05.00.

(4) End measurement
Measurement ends at the same time as execution of the program is stopped.
Execution of the program can be stopped by setting a breakpoint or a trigger condition, or by clicking on @

(5) Display a graph
At the same time as measurement ends, a graph of current values showing the results of measurement is
displayed in the graph display area of the Measuring Current Consumption panel [E2][Simulator].
Check that the current values that are shown are as intended.

In the panel, dragging a cursor (the red vertical line) shows the time and the current value at the cursor location in
the information display area.

When the search facility is used, since the cursor is moved to the location where the search condition was
satisfied, the time and the current value at that location can be confirmed.

Markers A and B (green vertical dashed lines) can also be dragged to confirm the average current and maximum
current between the markers.

When a monitoring point is the target of the search, the location where processing to be confirmed was executed
can be identified immediately.

- With the simulator
When current consumption is measured on the simulator, the current values in the MCU are simulated and displayed.

(1) Open the Measuring Current Consumption panel
Select [RL78 Simulator] as the debug tool, open the Solution List panel, and click on the [GQO] button for
measuring current consumption. The Measuring Current Consumption panel [E2][Simulator] will open.
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Figure 2.123 Measuring Current Consumption Panel [Simulator]
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(2) Enable measurement of the current consumption
The facility for measuring current consumption is enabled or disabled by clicking on {!} on the toolbar in the
Measuring Current Consumption panel [E2][Simulator].
Enabling the facility simulates the current values when the program is executed.

Figure 2.124 Toolbar in the Measuring Current Consumption Panel [Simulator]
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Remark The facility for measuring current consumption is disabled immediately after the debug tool is
connected.

(3) Start measurement
After the facility for measuring current consumption is enabled, measurement proceeds during normal execution
of the debugger initiated by, for example, clicking on | f@=) or [ [ on the toolbar in the Main window.

Remark Furthermore, measurement also proceeds in response to operations that place the debug tool in
the execution state, e.g. source-level step execution.

(4) End measurement
Measurement ends at the same time as execution of the program is stopped.
Execution of the program can be stopped by setting a breakpoint, or by clicking on @

(5) Display a graph
At the same time as measurement ends, a graph of current values showing the results of measurement is
displayed in the graph display area of the Measuring Current Consumption panel [E2][Simulator].
Check that the current values that are shown are as intended.

In the panel, dragging a cursor (the red vertical line) shows the time and the current value at the cursor location in
the information display area.

When the search facility is used, since the cursor is moved to the location where the search condition was
satisfied, the time and the current value at that location can be confirmed.

Markers A and B (green vertical dashed lines) can also be dragged to confirm the average current and maximum
current between the markers.

In addition, hovering the mouse cursor over a point on the graph displays a pop-up window showing the current
value in each peripheral module at that point. This makes it possible to confirm that the intended modules have
been enabled.
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Figure 2.125 Displaying the Values for Current Consumption by Individual Modules
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2.19 Use the Simulator GUI [Simulator]

This section describes how to use the Simulator GUI.
Note that the function of the Simulator GUI described in this section is only supported when a microcontroller whose

Simulator supports peripheral function simulations is selected. Control the Simulator GUI via the Simulator GUI window
below.

This window appears automatically by default after connecting to the debug tool when a microcontroller whose Simula-
tor supports peripheral function simulations is selected and [Simulator] is selected as the debug tool to use.

Remark The Simulator GUI window and windows opened from it cannot be docked to the CS+ Main window.

Figure 2.126 Using Simulator GUI (Simulator GUI Window)
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The setting of the display of the Simulator GUI window can be configured in the [Simulator GUI] category on the [Debug
Tool Settings] tab of the Property panel as follows:
Configure the appropriate settings.

Caution After connecting to the debug tool, all the properties in this category will become invalid if a microcon-

troller whose Simulator does not support peripheral function simulations (instruction simulation version)
is selected.

Figure 2.127 [Simulator GUI] Category
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(1) [Display Simulator GUI]
Specify whether to display the Simulator GUI window from the drop-down list.
Select [Yes] to use the function of the Simulator GUI (default).
When you do not need to use the Simulator GUI, select [No] to close the Simulator GUI window.

(2) [Display Simulator GUI on top of other windows]
This property appears only when the [Display Simulator GUI] property is set to [Yes].

Specify whether to display the Simulator GUI window in the forefront when program execution starts. Select [Yes]
to display it in the forefront (default).

2.19.1 Check the I/0O waveform of the microcontroller

It is possible to check the /0 waveform of the microcontroller by clicking the [ button on the Simulator GUI window's
toolbar and opening the Timing Chart window (shown below).

This window displays a timing chart of the input and output signals of the microcontroller's pins.

See the section on the Timing Chart window for details about controlling the window.
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Figure 2.128 Checking I/O Waveform of Microcontroller (Timing Chart Window)
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2.19.2 Input signals to the pins

To configure the input signal to a pin, click the M...‘S. on the Simulator GUI window's toolbar. The following Signal Data
Editor window opens.

You can use this window to set the input signal data for the input pin to a numerical value, to be input at an arbitrary
time.

See the section on the Signal Data Editor window for details about controlling the window.

Figure 2.129 Configuring Input Signal to Pin (Signal Data Editor Window)
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2.19.3 Perform serial communication

To configure serial communication, click the ﬂ] on the Simulator GUI window's toolbar. The following Serial window
opens.

This window provides serial I/O features for communicating with the CPU's built-in serial interface. This enables you to
input data to the microcontroller's serial receiver pin, and acquire output data from its serial transmitter pin.

See the section on the Serial window for details about controlling the window.
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Figure 2.130 Performing Serial Communication (Serial Window)
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2.19.4 Use buttons, LEDs, level gauges, and other components

The Simulator GUI allows input manipulation and output display simulation by providing standard connected parts (but-
tons, LEDs, level gauges, etc.) in which the I/O block for peripheral I/O designed as a GUI interface.

To configure connected parts, click the |Z& on the Simulator GUI window's toolbar. The following I/O Panel window
opens.

This window enables you to configure the various connected parts, building a dummy target system.

See the section on the I/O Panel window for details about controlling the window.

Figure 2.131 Configuring Connected Parts (/O Panel Window)
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2.20 About Input Value

This section describes consideration to take when inputting values in each panel and dialog box.

2.20.1 Input rule

Following is the rules for input to each panel/dialog box.

(1) Character set
Character sets that are allowed to input are as follows:

Table 2.24  List of Character Set

Character Set Outline

ASCII 1- byte alphabets, numbers, symbols

Shift-JIS 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji and 1-byte Katakana.

EUC-JP 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji and 1-byte Katakana.

UTF-8 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji (include Chinese charac-
ters) and 1-byte Katakana.

UTF-16 2-byte alphabet, number, symbol, Hiragana, Katakana, Kanji (include Chinese charac-
ters) and 1-byte Katakana.

(2) Escape sequence
Escape sequences that are allowed to input are as follows:

Table 2.25 Escape Sequence List

Escape Sequence Value Outline
\0 0x00 null character
\a 0x07 Alert
\b 0x08 Backspace
\t 0x09 Horizontal tab
\n 0x0A New line
\V 0x0B Vertical tab
\f 0x0C Form feed
\r 0x0D Carriage return
\" 0x22 Double-quotation mark
\' 0x27 Single-quotation mark
\? O0x3F Question mark handled as a question mark if ? is entered.
\\ 0x5C Backslash
(3) Number

Notations allowed when entering numbers are as follows:

Table 2.26  Notation List

Notation Outline

Binary number Start with Ob and continues with the numbers from 0 to 1.
(Case insensitive for alphabets)
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Notation Outline
Octal number Start with 0 and continues with the numbers from 0 to 7.
Decimal Start without 0 and continues with the numbers from 0 to 9.
Hexadecimal number Start with Ox and continues with the numbers from 0 to 9 and alphabets a to f.
(Case insensitive for alphabets)
In the input area with the mark, prefix 0x is not needed.

(4) Expression and operator
Expression represents constants, register name, SFR name and symbols and those connected with operators.
An expression comes in two types: an address expression and a watch-expression. The expression that requires
the address of a symbol is referred to as an address expression, and the one that requires the value of a symbol is
referred to as a watch-expression.

(@) An address expression and operators
With an address expression, the address of a symbol is used to perform operations. Only when a CPU register
name is written, the value of the symbol is used to perform operations.
The basic input formats of address expressions are as follows:

Table 2.27  Basic Input Format of Address Expressions

Expression Description

Note 1,2

Name of a C/C++ language variable Address of a C/C++ language variable

Note 3]

Expression [Expression Address of an array

Note 4

Expression.Member name Address of a structure/union/class member

Expression->Member nameNote 4 Address of a structure/union/class member that is pointed to
Watch-expression.*Cast expression Address of the pointer to a member variable
Watch-expression->*Cast expression Address of the pointer to a member variable
Name of a CPU register Value of the CPU register
Name of a SFR Address of the SFR
Label nameN°® 3 EQU symbol nameN°€5 | Address of a label, a value of an EQU symbol, and an immedi-
and [immediate value] ate address
Integer constant Address
Note 1. It represents C language (C89/C99) and C++ language variables.
Note 2. If the register is assigned the value of a C variable, an error results.
Note 3. The expression that is input as an index to an array is parsed as a watch-expression.
Note 4. To specify a member variable of base class, specify scope before a member name.
(Example: variable.BaseClass::member)
Note 5. If$the label name or EQU symbol name includes a "$", be sure to enclose the name in "{ }" (e.g.
{$Label}).

When you specify the CPU register name "I", add ":REG" (e.g. I:REG) to distinguish it from the
keyword "I" that indicates an imaginary number.

From "2.20.2 Symbol name completion function", the following expressions with operator can be constructed.

Table 2.28  Construction of Expressions with Operators

Expression Description
(Expression) Value of the parenthetical watch-expression
! Expression Inverts symbol
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(b)

Expression Description
- Expression Logical negation
~ Expression Bit inversion
Expression * Expression’\°te Multiplication
Expression | ExpressionNote Division
Expression % ExpressionNot Remainder calculation
Expression + ExpressionN° Addition
Expression . ExpressionNote Subtraction

Expression & ExpressionNote

Logical multiplication by bits

Expression * ExpressionNOte Exclusive disjunction by bits
Expression | ExpressionN°t® Logical sum by bits
Note Variables and functions can be combined by an operator only with variables, functions and inte-

ger constants.

Example: C variable name + SFR name

Watch-expression and operator

With watch-expression, the value of a symbol is used to perform operations. Only when the value does not
exist, the address of the symbol is used to perform operations (e.g. main( ) + 1).
The basic input formats of watch-expressions are as follows:

Table 2.29  Basic Input Format of Watch-expressions

Expression

Description

Name of a C/C++ language variableN

ote 1 Address of a C/C++ language variable

Expression [Expression]

Element of an array

Expression.Member nameNote 2

Value of a structure/union/class member

Expression->Member nameNote 2

Value of a structure/union/class member that is pointed to

Watch-expression.*Cast expression

Value of a pointer to member variable

Watch-expression->*Cast expression

Value of a pointer to member variable

*Expression

Value of pointer variable

&Expression

Location address

Name of a CPU register

Value of the CPU register

Name of a SFR

Value of the SFR

Label nameN°® 2, EQU symbol name
and [immediate value]

Note 3 Values of a label, a value of an EQU symbol, and an immedi-

ate address

Integer constant

Integer constant value

Floating constant

Floating point constant value

Character constant

Character constant value

Note 1. It represents C language (C89/C99) and C++ language variables.

Note 2. To specify a member va

riable of base class, specify scope before a member name.

(Example: variable.BaseClass::member)
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Note 3. If the label name or EQU symbol name includes a "$", be sure to enclose the name in "{ }" (e.g.
{$Label}).
Any imaginary number must be multiplied by an uppercase "I" (e.g. 1.0 + 2.0*I). When you spec-
ify the CPU register name "I, add ":REG" (e.g. :REG) to distinguish it from the keyword "I" that
indicates an imaginary number.

From "Table 2.29 Basic Input Format of Watch-expressions", the following watch-expressions with operator can
be constructed. For the operators listed in the table below, the expression is parsed according to C language
specifications.

Table 2.30  Construction of Expressions with Operators

Expression * Expression

Expression Description
(Expression) Specifies the order in which operations are performed
! Expression Inverts symbol
- Expression Logical negation
Note

Multiplication

Expression | ExpressionNote

Division

Note

Remainder calculation

Expression % Expression

Expression + ExpressionN°€ Addition

Note

Expression . Expression Subtraction

Note

Expression & Expression Logical multiplication by bits

Expression * ExpressionNOte Exclusive disjunction by bits
Expression | ExpressionN°t Logical sum by bits
Note Variables and functions can be combined by an operator only with variables, functions and inte-

ger constants.
Example: C variable name + SFR name

Caution 1.  When two or more variables are defined with the same name in unnamed name spaces of different
source files, the Watch panel only shows the information on the first variable to be found.

Caution 2.  After the member-variable pointer "mp1" defined in the program below is registered with the Watch panel
and Local Variables panel, the type of the pointer is indicated as "int *", not "int Foo::*".

class Foo {
int ml;
)z

int Foo::*mpl = &Foo::ml;

Caution 3.  When a char-type one-dimensional array is assigned to multiple locations in registers or memory as
shown below, no character string will be displayed in the value column of the Watch panel or Local Vari-
ables panel even after the array "array" has been registered with the panel.
char array[5] = "ABCD";

Caution 4.  When the selection for [Scope] in the Local Variables panel is not [Current], the values of variables
assigned to registers are not displayed correctly. Editing these values is also not possible.

Caution 5. When a defined variable satisfies both of the conditions given below, the Watch panel and Local Vari-
ables panel indicate the location of the entire variable rather than the location of its member variables.
[Conditions]

<1> The variable is assigned to two or more addresses or registers (i.e. two or more addresses or registers are
displayed in the address column).

<2> A structure-, class-, array-, or union-type member is defined in the variable.
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[Example]

struct Mem ({
long m base;
}i
struct Sample ({
long m a;
struct Mem m b; <- Condition <2>

b

main () {
struct Sample obj;

Display in the Watch and Local Variables panels:

"obj" - { R1:REG, R2:REG } (struct Sample)
Lma 0x00000000 { R1L:REG } (long)
Lmb - { RL:REG, R2:REG } (struct Base)
L m base 0x00000000 { R2:REG } (long)

Caution 6. When a variable is cast to another type in the Watch panel, casting of the variable is C-style.
For this reason, the result of casting a class using virtual inheritance to its base class is not the same as
the result of the cast within the program.

class AAA [
int m aaa;

} objA;

class BBB : public AAA { //BBB inherits AAA.
int m bbb;

} objB;

class CCC { //CCC does not inherit AAA.
int m cccy

} objC
class DDD { //DDD virtually inherits AAA.
public:
int m ddd;
} objD

class AAA* pa = oObjA;
class BBB* pb = objB;
class CCC* pc = objC;
class DDD* pd = objD;

" (AAA*)pa" Usable
" (BBB*)pb" Usable
" (AAA*)pb" Usable
"(CCC*)pc" Usable

" (AAA*)pc" Not usable because pc is considered to point to the top address
of AAA.

Image of the cast in a program: (AAA*) ((void*)pc)

" (AAA*)pd" Not usable because pd is considered to point to the top address
of AAA.

Image of the cast in a program: (AAA*) ((void*)pd)

Caution 7. In case of a variable with the size beyond 0x10000, Value, Style and Address indicate "?" in the Watch
panel.

2.20.2 Symbol name completion function
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This function helps users input data by selecting one of the listed symbol names that exist in the program, when specify-
ing an address expression and so on.
The list of symbol names appears by pressing the [Ctrl] + [Space] keys when a part of the target symbol name is being
input in the text box that supports this function. In this list, double-click the target symbol name (or press the [Spacel/
[Enter] key after selecting it by using the [Up]/[Down] key) to complement the symbol name currently being input.

At this time, if a key other than the [Space]/[Enter] key is pressed or the focus moves to outside the panel/dialog box cur-
rently being operated, then the list of symbol names will disappear (the symbol name completion will not be performed).

Caution 1.

Caution 2.

Remark

If there are no character strings in the text box or there are no candidates of the symbol, then the list of

symbol names will not appear.

Since the information for use by the symbol name completion function is generated while symbols are
being downloaded, the time taken for downloading and the memory usage on the host machine will
increase when this function is enabled. Therefore, if you do not intend to use the symbol name comple-
tion function, we recommend invalidating this function by selecting [No] in the [Generate the information

for input completion] item in the Download Files dialog box ([Yes] is selected by default).

See the explanation of the corresponding panel/dialog box as to whether this function can be used or not

when inputting a symbol name.

Figure 2.132 Symbol Name Completion Function
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2.20.3 Icons for invalid input

In some of the dialogs in CS+, the Q icon will appear at a point where incorrect characters are entered as a warning

sign.
Remark Placing the cursor over the n.,) icon will pop up the information that indicates the characters to be
entered.
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2.21 Saving and Restoring the States of Debug Tools

Saving the states of debug tools (readable and writable memory and register values) enables restoring the states in
which the state information for the debug tools was saved.

Remark If you have selected [Save the value of SFRs and IORs added in the Watch 4 panel] in the [General -
Debug] category of the Option dialog box, the values of SFRs and IORs will also be saved.
Saving and restoring the states of debug tools is mainly used to realize the following two features.

- Rewinding the state of the debug tool to restore the state when the execution of a program was started after the
program has been repeatedly run and stopped

- Restoring the state to any among multiple states that have been stored

(1) Rewinding the state of the debug tool
The state of the debug tool can be restored to that before the program started running after the program has been
repeatedly run and stopped.
[Usage]
(a) Select the [Enable rewind feature] checkbox in the [General - Debug] category of the Option dialog box.
(b) The state of the debug tool is automatically saved when the program starts running.

(c) After the program has been repeatedly run and stopped, select [Rewind debug tool state] from the [Debug]
menu or press the [Ctrl] + [F11] keys to restore the state to that before the program started running.

Remark A maximum number of times of rewinding can be specified with [Maximum number of times of
rewinding] in the Option dialog box.

(2) Saving and restoring the states of multiple debug tools
The states of multiple debug tools can be saved and restored.
For example, you can save the states for functions being debugged which are not frequently called and restore the
states for debugging many times.
[Usage]
(@) Save the states of debug tools in one of the following three ways.
- Select [Save debug tool state 7-4] from the [Save debug tool state] menu under the [Debug] menu.

- Select [Save debug tool state 7-4] on the [State save event] tab in the Action Events dialog box. Executing
the instruction at the address specified in the dialog box saves the states.

- Run debugger.DebugTool.SaveState(fileName) in the Python console to save the states of debug tools in a
file.

(b) Restore the states of debug tools in one of the following three ways.
- Select [Restore debug tool state 7-4] from the [Save debug tool state] menu under the [Debug] menu.

- Select [Restore debug tool state 7-4] on the [State save event] tab in the Action Events dialog box. Execut-
ing the instruction at the address specified in the dialog box restores the states and continues the execution
of the program from the saved states.

- Run debugger.DebugTool.RestoreState(fileName) in the Python console to restore the states of debug
tools from a file.
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2.22 RL78 Instruction Simulator [Simulator]

This section describes the RL78 instruction simulator.

The RL78 instruction simulator simulates the following functions.

- Instructions (each instruction of the RL78-S1, RL78-S2, and RL78-S3 cores)
For the RL78-S3 core, this includes the multiply, divide, and multiply & accumulate instructions.

- Registers

- All memory spaces

- Peripheral functions

(a)

(b)

(c)

Multiplier and divider and multiply-accumulator (only those for the RL78-S2 core)

The list of multiplier and divider and multiply-accumulator operations below only applies to the RL78-S2 core.
16 bits x 16 bits = 32 bits (unsigned)

16 bits x 16 bits = 32 bits (signed)

16 bits x 16 bits + 32 bits = 32 bits (unsigned)

16 bits x 16 bits + 32 bits = 32 bits (signed)

32 bits / 32 bits = 32-bit result and 32-bit remainder (unsigned)

- The following SFRs are supported.
MDAL, MDAH, MDBH, MDBL, MDCL, MDCH, and MDUC

Caution 1.  When the multiplier and divider or multiply-accumulator are used in division mode, the division
processing will be finished in one clock cycle.

Caution 2.  When the multiplier and divider or multiply-accumulator are used in division mode, an interrupt is
not generated at the end of the division operation. However, the SFR which indicates the end of
division is changed, that is, the DIVST bit in the multiplication/division control register (MDUC) is
cleared to 0.

Binary-coded decimal (BCD) correction circuit
The BCD correction circuit is supported.

- The following SFR is supported.
BCDADJ

Clock generator

The CPU clock is generated according to the specifications of the clock generator for the RL78/G13 (and some
of the specifications is for the RL78/G14).

Only the following SFRs are supported.

SFR Remark

CMC Bits 0, 1, and 2 (AMPH, AMPHSO0, and AMPHS1) are not supported.

CKC

CsC

OSTC See caution 1.

OSTS

HOCODIV Operation is according to the specifications of the RL78/G14.

- Option byte
For the settings of the frequency of the high-speed on-chip oscillator for the user option byte (000C2H),
FRQSELO to FRQSELA4 (bits 0 to 4) are supported with the specifications of the RL78/G14.

- Specify the clock for the X1 oscillator with the [Main clock frequency [MHz]] property in the [Clock] category
on the [Connect Settings] tabbed page of the [Property] panel.

- Specify the clock for the XT1 oscillator with the [Sub clock frequency [kHz]] property in the [Clock] category on
the [Connect Settings] tabbed page of the [Property] panel.

Caution 1. The simulator does not simulate the oscillation stabilization time. When oscillation starts, the
OSTC register does not count up and its value is set according to the setting of the OSTS.
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Caution 2.

Caution 3.

Caution 4.

Caution 5.

Caution 6.

Caution 7.

If the specifications of the SFR for the selected microcontroller differ from those of the RL78/G13,
the RL78 instruction simulator operates with the specifications of the RL78/G13.

If the SFR is not present in the selected microcontroller, the RL78 instruction simulator operates
with the value after the SFR for the RL78/G13 has been reset.

If the specifications of the user option byte (000C2H) for the selected microcontroller differ from
those of the option byte of the RL78/G14, the RL78 instruction simulator operates with the speci-
fications of the RL78/G14.

Even if an option byte is not present in the selected microcontroller, the RL78 instruction simula-
tor reads the 000C2H address as the user option byte and operates with the specifications of the
RL78/G14.

Even if a clock source in the RL78/G13 specifications is not present in the selected microcon-
troller, the clock source operates with the specifications of the RL78/G13.

If the specifications of frequencies of the low-speed on-chip oscillator clock (flL) and high-speed
on-chip oscillator clock (fIH) for the selected microcontroller differ from those of the RL78/G13,
the RL78 instruction simulator operates with the specifications of the RL78/G13.

Caution Simulation of the following functions is not supported.

- Pipelining (and accordingly, the simulation is not cycle-accurate)

- Flash memory (e.g. flash self-programming functions and the procedure for accessing the data flash memory)

- Peripheral functions (except for those to be supported)
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Appendix A provides detailed explanations of windows/panels/dialog boxes used for debugging with CS+.

A.1 Description

Windows/panels/dialog boxes for debugging are listed below.

Table A.1

Window/Panel/Dialog Box List

Window/Panel/Dialog Box Name

Description

Main window

Controls the program execution. Various windows, panels and dialogs
can be opened from this window.

Debug Manager panel

Selects a core (PE) to be debugged and displays the core status.

Project Tree panel

Selects the debug tool to use.

Property panel

Displays detailed information on the debug tool currently selected in the
Project Tree panel, and enables the settings of the tool to be changed.

Memory panel

Displays and modifies memory values.

Disassemble panel

Displays the results of memory value disassemble and is used to execute
line assemble and instruction level debug.

CPU Register panel

Displays the contents of CPU registers, and modifies register values.

SFR panel

Displays and modifies SFR values.

Local Variables panel

Displays and modifies local variables.

Watch panel

Displays and modifies registered watch-expression values.

Call Stack panel

Displays call stack information on function calls.

Trace panel

Displays trace data acquired from the debug tool.

Events panel

Displays detailed information on set events, switches the events between
enabled and disabled, or deletes them.

Output panel

Displays messages output from the build tool/debug tool/plug-ins, or the
results of batch searches carried out using the Find and Replace dialog
box.

Memory Mapping dialog box

Sets the memory mapping.

Download Files dialog box

Selects files to be downloaded and sets the download conditions.

Action Events dialog box

Sets action events.

Security ID Input dialog box

Sets security ID.

Column Number Settings dialog box

Specifies the number of view columns of memory values on the Memory
panel.

Address Offset Settings dialog box

Specifies an offset value for the address display on the Memory panel.

Memory Initialize dialog box

Initializes memory.

Memory Search dialog box

Searches memory.

Print Address Range Settings dialog box

Sets the address range to print the contents of the Disassemble panel.

Trace Search dialog box

Searches trace data.

Combination Condition dialog box
[E1][E20]

Displays and modifies detailed information on a Combination Break event
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Window/Panel/Dialog Box Name

Description

Detail dialog box (for execution events)

Displays and modifies detailed information on an execution-related event.

Detail dialog box (for access events)

Displays and modifies detailed information on an access-related event.

Scroll Range Settings dialog box

Sets the scroll range for the Memory panel/Disassemble panel.

Go to the Location dialog box

Moves the caret to the specified position.

Data Save dialog box

Saves the settings and other data displayed in the respective windows/
panels/dialogs or saves upload data.

Specified Section dialog box

Specifies the range for skipping step execution.

Functions and Variables Access Table
panel

Displays the functions that access variables in the form of an orthogonal
table.

Measuring Current Consumption panel
[E2][Simulator]

This panel is central to the functionality of the solution for measuring cur-
rent consumption.

Current Consumption Measurement
Condition Setting dialog box [E2]

This dialog box is used to set measurement conditions in the Measuring
Current Consumption panel [E2][Simulator].

Current Consumption Measurement
Trigger Condition Setting dialog box [E2]

This dialog box is used to set trigger conditions in the Measuring Current
Consumption panel [E2][Simulator].

Current Consumption Measurement
Search dialog box [E2][Simulator]

This dialog box is used to specify and search the detailed conditions in
the Measuring Current Consumption panel [E2][Simulator].

Save Current Values dialog box [E2]

This dialog box is used to save the values for current in the Measuring
Current Consumption panel [E2][Simulator].

Virtual Board panel [Simulator]

This panel is used to configure the virtual target system and operate the
virtual components.

Table A.2

Simulator GUI Block-Dedicated Window/Dialog Box List

Window/Dialog Box Name

Description

Simulator GUI window

Opens and controls various simulator GUI's windows and dialog boxes.

Customize dialog box

Setting of window colors and fonts

Signal Data Editor window

Setting of input signal data

Loop dialog box

Setting of loop information for the Signal Data Editor window

Select Pin dialog box

Selection of display pins in the Signal Data Editor window and Timing
Chart window

Timing Chart window

Timing chart display of input and output signals

Search Data dialog box

Detailed search of the Timing Chart window

1/0 Panel window

Creation of dummy target system

Parts Button Properties dialog box

Setting of button pin connection information

Analog Button Properties dialog box

Setting of analog button pin connection information

Parts Key Properties dialog box

Setting of key matrix LED pin information

Parts Level Gauge Properties dialog box

Setting of level gauge pin connection information

Parts Led Properties dialog box

Setting of key matrix LED pin information
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Window/Dialog Box Name Description
Parts Segment LED Properties dialog Setting of 7/14-segment LED pin connection information
box
Parts Matrix Led Properties dialog box Setting of matrix LED pin connection information
Parts Buzzer Properties dialog box Setting of buzzer pin connection information
Pull up/Pull down dialog box Setting of pull-up/pull-down resistor pin connection information
Object Properties dialog box Setting of connection information for figure, character, and bitmap pins
Parts List dialog box List display of object pin connection status in the 1/0 Panel window
Serial window Serial interface communication window
Format (UART) dialog box Setting of serial format (UART)
Format (CSI) dialog box Setting of serial format (CSI)
Format (IIC) dialog box Setting of serial format (IICA)
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Main window

This window is automatically opened when CS+ is started up.
In this window, you can control the program execution and open panels for the debugging process.

Figure A1 Main Window
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This section describes the following.
- [How to open]

- [Description of each area]

[How to open]

- From the Windows [Start] menu, select [All Programs] >> [Renesas Electronics CS+] >> [CS+ for CC].

Remark In Windows 8.1, select [CS+ for CC (RL78,RX,RH850)] on the start screen.
In Windows 10, select Windows [Start] menu >> [All apps] >> [Renesas Electronics CS+] >> [CS+ for CC
(RL78,RX,RH850)].

[Description of each area]

(1) Menubar
Menu items related to the debugging are as follows:

Remark The items that can be selected in each menu can be customized using the User Setting dialog box.

(a) [View]
The [View] menu provides the following items and functions (default).

Watch The following cascade menus are displayed to open the Watch panel.
These items are disabled when disconnected from the debug tool.
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Watch1 Opens the Watch panel (Watch1).
Watch2 Opens the Watch panel (Watch2).
Watch3 Opens the Watch panel (Watch3).
Watch4 Opens the Watch panel (Watch4).

Local Variable

Opens the Local Variables panel.

Call Stack Opens the Call Stack panel.
Memory The following cascade menus are displayed to open the Memory panel.
These items are disabled when disconnected from the debug tool.
Memory1 Opens the Memory panel (Memory1).
Memory2 Opens the Memory panel (Memory?2).
Memory3 Opens the Memory panel (Memory3).
Memory4 Opens the Memory panel (Memory4).
SFR Opens the SFR panel.

This item is disabled when disconnected from the debug tool.

CPU Register

Opens the CPU Register panel.
This item is disabled when disconnected from the debug tool.

Trace Opens the Trace panelNote,
This item is disabled when disconnected from the debug tool.
Disassemble The following cascade menus are displayed to open the Disassemble panel.

These items are disabled when disconnected from the debug tool.

Disassemble1

Opens the Disassemble panel (Disassemble1).

Disassemble2

Opens the Disassemble panel (Disassemble2).

Disassemble3

Opens the Disassemble panel (Disassemble3).

Disassemble4

Opens the Disassemble panel (Disassemble4).

Event Opens the Events panel.

This item is disabled when disconnected from the debug tool.
Virtual Board Opens the Virtual Board panel [Simulator].
[Simulator] This item is disabled when disconnected from the debug tool.

This item is also disabled even if a device for which the debug tool for the active proj-
ect does not support peripheral function simulations is currently connected to the
debug tool.

Show Current PC
Location

Displays the current PC position in the Editor panel.
This item is disabled when disconnected from the debug tool.

Back to Last Cursor
Position

Goes back to the position before jumping (see "2.7.2.4 Move to the symbol defined
location") to the defined location.
This item is disabled when disconnected from the debug tool.

Forward to Next Cur-
sor Position

Forwards to the position before operating [Back to Last Cursor Position].

Tag Jump

Jumps to the corresponding line/column in the corresponding file if the information of
a file name/line number/column number exists in the line at the caret position on the
Editor panel/Output panel (see "CS+ Integrated Development Environment User's
Manual: Editor").
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Note

[E1][E20][EZ Emulator][COM Port]

This item is available only when the selected microcontroller incorporates the OCD trace func-

tion.

[Debug]

The [Debug] menu provides the following items and functions (default).

Download

Downloads the specified file(s) into the debug tool currently selected in the active
project.

If CS+ is disconnected from the debug tool at this time, it is automatically connected
to the debug tool before a download is executed.

This item is disabled during program execution/build (not including rapid build) exe-
cution.

Build & Download

Builds a project and executes a download to the debug tool currently selected in the
active project after the build is complete. If CS+ is disconnected from the debug tool
at this time, it is automatically connected to the debug tool before a download is exe
cuted.

This item is disabled during program execution/build (not including rapid build) exe-
cution.

When the build has failed, download will not be executed.

Rebuild & Download

Rebuilds a project and executes a download to the debug tool currently selected in
the active project after the rebuild is complete. If CS+ is disconnected from the
debug tool at this time, it is automatically connected to the debug tool before a down-
load is executed.

This item is disabled during program execution/build (not including rapid build) exe-
cution.

When the rebuild has failed, download will not be executed.

Connect to Debug
Tool

Connects to the debug tool currently selected in the active project.

This item is disabled while connected to the debug tool, during build (not including
rapid build) execution or if the version of compiler being used is not supported by
CS+.

Hot Plug-in Connects to the debug tool currently selected in the active project via the hot plug-in
[E1][E20] function, in order to debug the target system currently running (see "2.5.3 Connect
to the debug tool using hot plug-in [E1][E20]").
This item is disabled while connected to the debug tool.
Upload... Opens the Data Save dialog box to save the memory contents.

This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Disconnect from
Debug Tool

Disconnects from the currently connected debug tool.
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Using Debug Tool

The following cascade menus are displayed to select the debug tool to use.
This item is disabled while connected to the debug tool.

RL78 IECUBE Uses IECUBE as the debug tool.
RL78 E2 Uses E2 as the debug tool.
RL78 E2 Lite Uses E2 Lite as the debug tool.

RL78 E1(Serial)

Uses E1 with serial communication method as the debug tool.

RL78 E20(Serial)

Uses E20 with serial communication method as the debug tool.

RL78 EZ Emulator

Uses EZ Emulator with an evaluation kit and so on.

RL78 COM Port

Uses COM Port as the debug tool.

RL78 Simulator

Uses Simulator as the debug tool.
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Stop Forcibly stops the program currently being executed.
This item is disabled when the program is already halted or disconnected from the
debug tool.

Go Executes the program from the current PC position.

Execution of the program will be stopped when the condition of a set break event is
met.

This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Ignore break and go

Executes the program from the current PC position.

Execution of the program continues, ignoring set break events and action events.
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Step In Executes the program step by stepNOte from the current PC position (Step in execu-
tion).
However, in the case of a function call, the program is stopped at the beginning of the
function having been called.
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Step Over Executes the program step by stepN°te from the current PC position (Step over exe-
cution).
In the case of a function call by the CALL instruction, all the source lines/instructions
in the function are treated as one step and executed until the position where execu-
tion returns from the function (step-by-step execution will continue until the same
nest is formed as when the CALL instruction has been executed).
In the case of an instruction other than CALL, operation is the same as when [Step
In] is selected.
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

Return Out Executes the program until execution returns from the current function (or returns to
the calling function)N°®(Return out execution).
This item is disabled during program execution/build (not including rapid build) exe-
cution or when disconnected from the debug tool.

CPU Reset Resets the CPU (does not execute a program)
This item is disabled during build (not including rapid build) execution or when dis-
connected from the debug tool.

Restart Resets the CPU and then executes the program from the reset address.

This item is disabled during build (not including rapid build) execution or when dis-
connected from the debug tool.

Rewind debug tool
state

Rewinds the debug tool to the last state that was automatically saved.

Note that the data to be rewound is limited to memory and register values that can be
read or written.

To use this debugging function, it has to be set so in the Option dialog box.

For details on the features and usage, see “Saving and Restoring the States of
Debug Tools”.

Save debug tool state

The following menus are relevant to saving and restoring of the state of the debug
tool.

Note that the data to be saved is limited to memory and register values that can be
read or written.

For details on the features and usage, see “Saving and Restoring the States of
Debug Tools”.

Restore debug tool
state n

Restores the state of the debug tool from the n-th data file.

Save debug tool
state n

Saves the current state of the debug tool in a file as the n-th data.
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Note Step execution can be carried out either in units of source lines or in units of instructions.
For details, see "2.8.3 Execute programs in steps".

(2) Debug toolbar
The debug toolbar includes the buttons that control the execution of programs.
The debug toolbar provides the following buttons and functions (default).

Remark 1. The buttons on the toolbar can be customized using the User Setting dialog box. Furthermore, a
new toolbar can be created using the same dialog box.

Remark 2. A Group of toolbar displayed can be selected with the context menu that is displayed by right-click-
ing on the toolbar.

Executes the build of a project and downloads the file into the debug tool currently selected in the
active project. If CS+ is disconnected from the debug tool at this time, it is automatically con-
nected to the debug tool before a download is executed.

This item is disabled during program execution/build (not including rapid build) execution.

When the build has failed, download will not be executed.

The function of this item is the same as that of [Build & Download] in the [Debug] menu.

= Downloads the specified file(s) into the debug tool currently selected in the active project.

If CS+ is disconnected from the debug tool at this time, it is automatically connected to the debug
tool before a download is executed.

This item is disabled during program execution/build (not including rapid build) execution.

The function of this item is the same as that of [Download] in the [Debug] menu.

Resets the CPU (does not execute a program)

This item is disabled during build (not including rapid build) execution or when disconnected from
the debug tool.

The function of this item is the same as that of [CPU Reset] in the [Debug] menu.

Forcibly stops the program currently being executed.
This item is disabled when the program is already halted or disconnected from the debug tool.
The function of this item is the same as that of [Stop] in the [Debug] menu.

Executes the program from the current PC position.

Execution of the program will be stopped when the condition of a set break event is met.

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [Go] in the [Debug] menu.

Executes the program from the current PC position.

Execution of the program continues, ignoring set break events and action events.

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [Ignore break and go] in the [Debug] menu.

Resets the CPU and then executes the program from the reset address.

This item is disabled during build (not including rapid build) execution or when disconnected from
the debug tool.

The function of this item is the same as that of [Restart] in the [Debug] menu.

5= Executes the program step by stepN°te from the current PC position (Step in execution).
However, in the case of a function call, the program is stopped at the beginning of the function
having been called.

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [Step In] in the [Debug] menu.
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= Executes the program step by stepNOte from the current PC position (Step over execution).

In the case of a function call by the CALL instruction, all the source lines/instructions in the func-
tion are treated as one step and executed until the position where execution returns from the
function (step-by-step execution will continue until the same nest is formed as when the CALL
instruction has been executed).

In the case of an instruction other than CALL, operation is the same as when the button is
clicked.

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [Step Over] in the [Debug] menu.

= Executes the program until execution returns from the current function (or returns to the calling
function)Nt (Return out execution).

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [Return Out] in the [Debug] menu.

Disconnects from the currently connected debug tool.

This item is disabled during program execution/build (not including rapid build) execution or when
disconnected from the debug tool.

The function of this item is the same as that of [Disconnect from Debug Tool] in the [Debug]
menu.

Note Step execution can be carried out either in units of source lines or in units of instructions.
For details, see "2.8.3 Execute programs in steps”.

(3) Panel display area
This area displays the various panels.
For details on the display content, see the sections describing the individual panels.

(4) Statusbar
Statusbar displays the following items of information.

Figure A.2  Statusbar

Executes CPU reset. START =01 FAaA | EREA) StandbyDizable O30 S RLTE Simulator :;} Mot measured D

R N S N

@) (b) (©) (d) (e) (f) () (h) (i)

(a) Status message
This area displays the following messages and other information.

- A brief explanation of the selected menu item
- A message reporting that an invalid value has been input in the panel/dialog

- A message reporting that the specified character string has not been found as a result of a search using the
Find and Replace dialog box

- A statement of the cause of the break when a break has occurred (see "2.9 Stop Programs (Break)")

(b) Focus panel status information
This area displays status information on the panel currently having the focus.
Note that nothing is displayed here for a panel that has no status information.

(c) Selection of debug target core
This area is used to select a core (PE) to be debugged.
Note that nothing is displayed here when the selected microcontroller version does not support multi-core or
when disconnected from the debug tool.

Caution When the drop-down list used for switching between cores on the status bar is being displayed
while the size of this window is maximized, part of the list is hidden behind the task bar and thus
cannot be selected.

Set the task bar to "Hide automatically" or set the location of the task bar as [Right], [Left], or
[Upper].

(d) Running state
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(e)

V)

(9)

This area displays the state of the program with the following icons and character strings.
Note that nothing is displayed here when the debug tool is not connected.

State of Program Displayed Content
Under execution IEI RUN
Now halted [m] BREAK
Step execution in progress IEI STEP

CPU status

This area displays the current CPU status of the debug tool. When there is the possibility that the CPU is in two
or more statuses, the corresponding display contents are displayed separated by "&".

Note that nothing is displayed here when the debug tool is not connected.

Debug Tool Displayed Content CPU Status

IECUBE Halt In HALT mode
Stop In STOP mode
Wait In wait state
Reset In reset state
Pow Off Power not supplied to the target

E1/E20 Reset In reset state

EZ Emulator

COM Port Pow Off Power not supplied to the target
Standby A clock signal is not being supplied to the FAA.
Disable FAA operation disabled
Sleep FAA is low power consumption mode

Simulator Halt In HALT mode
Stop In STOP mode
Reset In reset state
Standby A clock signal is not being supplied to the FAA.
Disable FAA operation disabled
Sleep FAA is low power consumption mode

Remark Nothing is displayed here when the CPU is in status other than those listed above.

Current PC position

This area displays the current PC position with a hexadecimal value. When this area is clicked, the caret moves
to the current PC position on the Editor panel.

In addition, when the mouse pointer is placed over this area, a pop-up window appears to display the following
information. Note, however, that nothing is displayed here when the debug tool is not connected.

- Current PC: Ox current PC value (source namettline countNte)
Note "symbol name+offset value" is displayed when acquisition of information is impossible.
Remark "Running" is displayed in this area during execution of a program.

Connection state
This area displays the current state of connection with the debug tool using the following icons and character
strings.

Connection State Displayed Content

Connected =2 Debug tool name
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Connection State

Displayed Content

Disconnected

=%; DISCONNECTED

(h) Run-Break Timer measurement result
This area displays the result of measurement by the Run-Break Timer event (the unit of value used differs
depending on the measurement amount). See "2.13.2 Measure execution time until stop of the execution".
Note that nothing is displayed here when the debug tool is not connected.

Condition

Displayed Content

Un-measuring

Not measured

Under measurement

Measuring

occurred

When a timer measurement overflow has OVERFLOW

(i) Debug tool state [[IECUBE][Simulator]
This area displays the current state of debug tool's functions using the following icons and character strings.
When a function is stopped, clicking the appropriate icon enables the state to be switched between "Use" and

"Not use"Note

Note that nothing is displayed here when the debug tool is not connected.

Function Being Executed Stopped (Use) Not Use
Trace ¥y ¥y
Timer [ ) %)
Coverage A% Err
Note [IECUBE]

Switching is impossible because the trace function, the timer function and the coverage function
are always used (the icon for "Not use" is not displayed).

[Simulator]

The result of switching will be reflected in the setting of the [Use trace function]/[Use timer func-
tion])/[Use coverage function] property in the [Trace]/[Timer]/[Coverage] category on the [Debug
Tool Settings] tab of the Property panel.
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Debug Manager panel

When the selected microcontroller is the multi-core product, this panel is used to select a core (PE: Processer Element)
to be debugged and display the core status.
This panel appears only when connected to the debug tool.

Caution This panel cannot be opened when the selected microcontroller is the single-core product.

Figure A.3 Debug Manager Panel

_ | Debug Manager 5
[Toolbar] | | G By ¥y | @ B (B %) @ | 5= G= ©
Debug target:

M| @ ceu O FAA

Debug target status:

Running status: IEI BREAK
(2) - Target status:

Current PC: (ec0i26c

This section describes the following.
- [How to open]
- [Description of each area]

- [Toolbar]

[How to open]

- From the [View] menu, select [Debug Manager].

[Description of each area]

(1) [Selects debug target core] area
Select a core (PE) to be debugged with a option button.

Remark 1. [Simulator]
This area becomes invalid during execution of a program.

Remark 2. You can also select a core to be debugged on the statusbar in the Main window.

(2) [Debug target core status] area
This area displays the status of the core currently being selected.

Remark You can also confirm the information displayed in this area on the statusbar in the Main window.

(@) [Running status]
Displays the current state of the program with the following icons and character strings.

State of Program Displayed Content
Running | = |RUN
Stopped | m |BREAK
In step execution | ﬁ |STEP
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(b) [Core status]

Displays the current core statuses of the debug tool. When there is the possibility that the core is in two or more
statuses, the corresponding display contents are displayed separated by "&".

Debug Tool Displayed Content CPU Status

IECUBE Halt In HALT mode
Stop In STOP mode
Wait In wait state
Reset In reset state
Pow Off Power not supplied to the target

E1/E20 Reset In reset state

EZ Emulator

COM Port Pow Off Power not supplied to the target
Standby A clock signal is not being supplied to the FAA
Disable FAA operation disabled
Sleep Low power consumption mode

Simulator Halt In HALT mode
Stop In STOP mode
Reset In reset state
Standby A clock signal is not being supplied to the FAA
Disable FAA operation disabled
Sleep Low power consumption mode

(c) [Current PC]

Displays the current PC position with a hexadecimal value. When this button is clicked, the caret moves to the
current PC position on the Editor panel.

[Toolbar]

The function of this toolbar is the same as that of the Debug toolbar on the Main window. For details on the function of
each button, see "(2) Debug toolbar".
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Project Tree panel

This panel is used to display the project components (microcontroller, build tool, debug tool, etc.) in a tree structure.
On this panel, you can select or change the debug tool to use.

Figure A4  Project Tree Panel

Project Tree ]
¢ @ 3 |[E
- fiRL78 G13 (Project)*
% RSF100LE (Microcontroller)
-, CC-RL (Build Tool)
_"- RL72 Simulater {Debug Taal)
=-3 File
#-Fl Build kool generated files
(1) — i 5] Startup
n-| main.h
e] subdl.c
h-| sub0l.h
&.] subbz.c
h.| sub02.h
&.] main.c

The following items are explained here.
- [How to open]
- [Description of each area]

- [Context menu]

[How to open]

- From the [View] menu, select [Project Tree].

[Description of each area]

(1) Project tree area
Project components are displayed in tree view with the following given node.

Node Description

RL78 Debug tool name (Debug tool) Debug tool name:

The debug tool (IECUBE, E2, E2 Lite, E1(Serial), E20(Serial),
EZ Emulator, COM Port or Simulator) currently being used in
the project is displayed.

[Simulator] is selected by default.

Select the debug tool node to configure with the Property panel. If the Property panel is not being opened, double-
click the node to open the corresponding Property panel.
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[Context menu]

Using Debug Tool The following cascade menus are displayed to select the debug tool to use.
RL78 IECUBE Uses IECUBE as the debug tool.
RL78 E2 Uses E2 as the debug tool.
RL78 E2 Lite Uses E2 Lite as the debug tool.
RL78 E1(Serial) Uses E1 with serial communication method as the debug tool.
RL78 E20(Serial) Uses E20 with serial communication method as the debug tool.
RL78 EZ Emulator Uses EZ Emulator with an evaluation kit and so on.
RL78 COM Port Uses COM Port as the debug tool.
RL78 Simulator Uses Simulator as the debug tool.
Property Displays the selected category node's property in the Property panel.
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Property panel

This panel is used to display and set the debug tool operation environment that is selected in the Project Tree panel.

Figure A.5 Property Panel (When IECUBE Is Selected)

Property |
ga, RLT8 IECUBE Property i] ;]t

4 Internal ROMRAM
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4 CGlock
(M Man clack sowrce Gienerate by emulator
Plain chock frequancy [MHz] 400
Sub clock zource Generate by emulaior
Sub clack frequencylkHz] 31760
4 Connection with Tanset Boand
L Caormecing with tanget bozrd i [1]
Size of mternal ROM
Specifies the zize of the indennal FOM.

(2){ \/Connec...., Debug T /[ FlashSel . | DataFlas.. | Downloa. [ Hook Tra.. / =

This section describes the following.

- [How to open]

- [Description of each area]

- [[Edit] menu (Property panel-dedicated items)]

- [Context menu]

[How to open]

- On the Project Tree panel, select the [RL78 Debug tool name (Debug Tool)] node to use, and then select [Property] from
the [View] menu or the context menu.

- On the Project Tree panel, double-click the [RL78 Debug tool name (Debug Tool)] node to use.

Remark If this panel has been opened, the detailed information on the debug tool is displayed by selecting the
[RL78 Debug tool name (Debug Tool)] node on the Project Tree panel.

[Description of each area]

(1) Detailed information display/change area
In this area, the detailed information on the debug tool that is selected in Project Tree panel is displayed by cate-
gory in the list. Also, you can directly change its settings.
The [E] mark is indicates all the items in the category are expanded. The [# mark indicates all the items are col-
lapsed. You can expand/collapse the items by clicking these marks or double-clicking the category name.
Note that only the hexadecimal number is allowed in the text box if the mark is displayed in the property con-
figuration area.
For details on the information/how to setup in the category and property items contained in it, see the section
explaining the corresponding tab.

(2) Tab selection area
Categories for the display of the detailed information are changed when each tab is selected.
In this panel, following tabs are contained (see the section explaining each tab for details on the display/setting on
the tab).
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- [Connect Settings] tab

- [Debug Tool Settings] tab

- [Flash Self Emulation Settings] tab [IECUBE]
- [DataFlash Emulation Settings] tab [IECUBE]
- [Download File Settings] tab

- [Hook Transaction Settings] tab

[[Edit] menu (Property panel-dedicated items)]

Undo Undoes the latest property value editing being done.

Cut Deletes the selected character string(s) and copies them to the clipboard while editing the
property value.

Copy Copies the contents of the selected range to the clipboard as character string(s).

Paste Pastes the contents of the clipboard to the property value while editing the property value.
Delete Deletes the selected character string(s) while editing the property value.

Select All Selects all the character strings in the selected property while editing the property value.

[Context menu]

[While not editing the property value]

Reset to Default Restores the selected setting of the property item to default value.

Reset All to Default Restores all the selected settings of the property items on the tab to default value.

[While editing the property value]

Undo Undoes the latest property value editing being done.

Cut Deletes the selected character string(s) and copies them to the clipboard while editing the
property value.

Copy Copies the contents of the selected range to the clipboard as character string(s).

Paste Pastes the contents of the clipboard to the property value while editing the property value.

Delete Deletes the selected character string(s) while editing the property value.

Select All Selects all the character strings in the selected property while editing the property value.
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[Connect Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed.

(1) [Internal ROM/RAM]

(2) [Clock]

(3) [Connection with Emulator] [E1] [E20]

(4) [Connection with Target Board] [[ECUBE][E1][EZ Emulator][COM Port]
(5) [FAA]

(6) [E2 Expansion Interface] [E2]

(7) [Flash] [E1][E20][EZ Emulator][COM Port]

(8) [Hot Plug-in] [E1][E20]

(9) [Configuration] [Simulator]

[Description of each category]

(1) [Internal ROM/RAM]
The detailed information on internal ROM/RAM is displayed and its configuration can be changed.

Caution You should be careful not to overlap the area with other memory mapping area.
Size of internal Display and change the internal ROM size of the selected microcontroller.
ROMI[KBytes]

Default Internal ROM size of the selected microcontroller
Modifying | [IECUBE][Simulator]
Select from the drop-down list.
[E1][E20][EZ Emulator][COM Port]
Changes not allowed
Available | Depends on the selected microcontroller.
values
Size of internal Display and change the internal RAM size of the selected microcontroller.
RAM|[Bytes] -
Default Internal RAM size of the selected microcontroller
Modifying | [IECUBE][Simulator]
Select from the drop-down list.
[E1][E20][EZ Emulator][COM Port]
Changes not allowed
Available | Depends on the selected microcontroller.
values
Size of DataFlash Displays the size of the data flash memory area of the selected microcontroller.
memory[KBytes] - -
(except [Simulator]) Default Data flash memory size of the selected microcontroller
Modifying | Changes not allowed
(2) [Clock]

The detailed information on clocks is displayed and its configuration can be changed.
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Main clock source Select the main clock source to input to the CPU.
[IECUBE]

Default Generate by emulator

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug

tool.
Available | Generate by emulator | Uses a clock generated inside IECUBE.
values
External Uses a main clock (square wave) on the target
board.
Clock socket Uses a clock of the transmitter on the clock
socket.

Main clock frequency | Specify the main clock frequency in MHz unit. Note !

[MHz] [IECUBE]

This property appears only when the [Main clock source] property is set to [Generate
by emulator].

Default [IECUBE][Simulator]
4.00

[E1][E20][EZ Emulator][COM Port]
Using internal clock

Modifying | Select from the drop-down list or directly enter from the keyboard.

Available | [IECUBE]

values - Either one of the following from the drop-down listN°t¢ 2

1.00, 2.00, 3.00, 3.57, 4.00, 4.19, 4.91, 5.00, 6.00, 8.00, 8.38, 10.00,
12.00, 16.00, 20.00 (unit: MHz)
[E1][E20][EZ Emulator][COM Port]Note 3

- Either one of the following from the drop-down list
Using internal clock, 2.00, 3.00, 3.57, 4.00, 4.19, 4.91, 5.00, 6.00, 8.00,
8.38, 10.00, 12.00, 16.00, 20.00 (unit: MHZz)

- Directly enter the numbers ranged below
0.001 to 99.999 (unit: MHz)
[Simulator]

- Either one of the following from the drop-down list
2.00, 3.00, 3.57, 4.00, 4.19, 4.91, 5.00, 6.00, 8.00, 8.38, 10.00, 12.00,
16.00, 20.00 (unit: MHz)

- Directly enter the numbers ranged below
0.001 to 99.999 (unit: MHz)

Sub clock source Select the sub clock source to input to the CPU and peripheral microcontrollers.
[IECUBE]

Default Generate by emulator

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.

Available | Generate by emulator | Uses a clock generated inside IECUBE.
values

External Uses a main clock (square wave) on the target
board.
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Sub clock fre- Specify the sub clock frequency in kHz unit. Note 1

quency[kHz] [IECUBE]

This property appears only when the [Sub clock source] property is set to [Generate
by emulator].

Default [IECUBE][Simulator]
32.768

[E1][E20][EZ Emulator][COM Port]
Using internal clock

Modifying | Select from the drop-down list or directly enter from the keyboard.

Available | [IECUBE]
values 32.768 or 38.40 (unit: kHz)
[E1][E20][EZ Emulator][COM Port]

- Either one of the following from the drop-down list
Using internal clock, 32.768, 38.40 (unit: kHz)

- Directly enter the numbers ranged below
0.001 to 99.999 (unit: kHz)
[Simulator]

- Either one of the following from the drop-down list
32.768 or 38.40 (unit: kHz)

- Directly enter the numbers ranged below
0.001 to 99.999 (unit: kHz)

Monitor clock Select a clock for monitor programs to operate while the program is stopped.
[E1][E20]
[EZ Emula- Default System

tor][COM Port] Modifying | Select from the drop-down list.

Available | System Operates with main clock.
values
User Operates with the clock that the program speci-
fied.

Select Timer/Trace Select the clock frequency for using timer/trace function.

clock frequency
[Simulator] Default CPU clock frequency

Modifying | Select from the drop-down list.

Available | CPU clock frequency | Uses the CPU clock frequency.

values
Specify clock fre- Specifies an arbitrary frequency (property items to
quency specify become valid in the lower area).
Unit of Timer/Trace Select the unit of the clock frequency for timer/trace.
clock frequency This property appears only when the [Select Timer/Trace clock frequency] property is
[Simulator] set to [Specify clock frequency].

Default MHz

Modifying | Select from the drop-down list.

Available | MHz The unit of the frequency is in MHz.
values
kHz The unit of the frequency is in kHz.
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Timer/Trace clock The operation of this property differs depending on the specification with the [Select
frequency Timer/Trace clock frequency] property.
[Simulator]

- When [Specify clock frequency] is specified
Specify the clock frequency for timer/trace.

- When [CPU clock frequency] is specified, displays the following (changes not

allowed)

While disconnected from the debug tool:  [---_---]

While connected to the debug tool: [CPU clock frequency]
Default 4.00

Modifying | Directly enter from the keyboard.

Available | 1 kHz to 99.999 MHz
values Unit is depending on the specification with the [Unit of Timer/Trace clock
frequency] property.

Note 1.

Note 2.

Note 3.

[E1][E20][EZ Emulator][COM Port]
This clock frequency is used to synchronize the communication between emulator and the host
machine. This specification is not for the frequency of the CPU operation.

You can also select the frequency greater than 20.00 MHz, depending on the selected microcon-
troller.

When using X1/X2 oscillation, specify the clock frequency.
When using an external clock oscillation with the embedded PLL circuit, specify the frequency of
the transmitter/resonator (the frequency before the setting of the PLL clock).

(3) [Connection with Emulator] [E1] [E20]

Emulator serial No. Select the serial No. of the emulator to be connected.Note

Default Blank
How to By selecting from the drop-down list
change However, changeable only when disconnected from the debug tool

Specifiable | Depends on the emulator used.
value

Note

If an attempt is made to connect the emulator when this category is blank, the serial number of the
emulator that is found first by search will be automatically selected and connection is made. The
serial number of the emulator that is automatically selected in such a case will not be saved in the
project information.

(4) [Connection with Target Board] [IECUBE][E1][EZ Emulator][COM Port]
The detailed information on the connection to the target board is displayed and its configuration can be changed.
Note that this category does not appear if no property displayed exists according to the type of the selected micro-

controller.
Communication port | Select the communications port.
[COM Port] The drop-down list is updated every time drop down.
Default Blank
Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.
Available | Depends on the host machine used.
values
R20UT5301EJ0100 Rev.1.00 -IENESAS Page 160 of 413

Jun 01, 2023



CS+V8.10.00 A. WINDOW REFERENCE

Reset control pin Select the reset control pin.
[COM Port]

Default DTR

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.

Available | DTR Use DTR.
values

RTS Use RTS.

Connecting with tar- | Select if the target board is connected to IECUBE or not.

get board
[[ECUBE] Default No
Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.
Available | Yes Target board is connected.
values )
No Target board is not connected.
Low voltage OCD Select whether to use a low voltage OCD board.
board This property appears only when the selected microcontroller supports a low voltage
[E1] OCD board.
[EZ Emulator]
Default No
Modifying | Select from the drop-down list.
Available | Yes Uses a low voltage OCD board.
values
No Does not use a low voltage OCD board.
Power target from Select whether to supply power to the target board from E1.
the emulator (MAX This property appears only when the [Low voltage OCD board] property is set to [No] if
200mA) it is displayed.
[E1]
Default No

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug

tool.
Available | Yes Supplies power to the target board.
values
No Does not supply power to the target board.

Interface for supply- | Select the interface for supplying the power to the target board from the emulator.
ing the power

[E2] Default USER I/F
Modifying | Select from the drop-down list.
Available | USER I/F Uses the user interface.
values

E2 expansion I/F Uses the E2 expansion interface.
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Supply voltage Select the power voltage supplied to the target board.
[E1] This property appears only when the [Power target from the emulator (MAX 200mA)]
property is set to [Yes].

Default 3.3V

Modifying | [E1]
Select from the drop-down list.
[E2]
Select from the drop-down list or directly enter from the keyboard.

Available | [E1]
values 3.3,5.0
[E2 Lite]

3.3
[E2]

- Either one of the following from the drop-down list
3.3,5.0

- Directly enter the numbers ranged below
1.8 t0 5.0, or 0 (unit: V)

Baud rate Selects the baud rate of the COM port.
[COM Port]

Default Auto

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.

Available | Auto, 115200bps, 250Kbps, 500Kbps, 1Mbps
values

(5) [FAA]
The detailed information on the FAA is displayed and its configuration can be changed.

Debug FAA Select whether the FAA is to be debugged.
This property only appears when the selected microcontroller supports this facility.

Default No

Modifying | Select from the drop-down list.

Available | Yes Select [Yes] when the FAA is to be debugged.
values

No Select [No] when the FAA is not to be debugged.

(6) [E2 Expansion Interface] [E2]
The detailed information on the E2 expansion interface is displayed and its configuration can be changed.

Interface for supply- | Select whether to use the E2 expansion interface.
ing the power
[E2] Default No use

Modifying | Select from the drop-down list.

Available | No use Does not use the E2 expansion interface.
values

Use the power sup- Uses the E2 expansion interface by the power
plied from the target | supplied to the target.

Use supplied power Uses the E2 expansion interface by the supplied
from the emulator power from the emulator.

(7) [Flash] [E1][E20][EZ Emulator][COM Port]
The detailed information on the flash memory writing is displayed and its configuration can be changed.
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Security ID Specify a security ID for reading codes in the internal ROM or internal flash memo-
Note

ry "2,

This property appears only when the selected microcontroller supports the ROM secu-

rity function (security ID) for flash memory.

Default - For ID authentication of 20 digits
00000000000000000000

- For ID authentication of 32 digits
00000000000000000000000000000000

Modifying | Directly enter from the keyboard.
Note that changes can be made only when disconnected from the debug
tool.

Available | - For ID authentication of 20 digits
values 0x0 to OXFFFFFFFFFFFFFFFFFFFE in hexadecimal number
20 digits hexadecimal number (10 bytes)

- For ID authentication of 32 digits
0x0 to OxFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFE in hexadecimal
32 digits hexadecimal number (16 bytes)

Serial Programming | Specify serial programming security ID.
Security ID For details on the serial programming security ID, see User's Manual of the emulator.

Default | FFFFFFFFFFFFFFFFFFFFFFFFFFFFFFFF

Modifying | Directly enter from the keyboard.
Note that changes can be made only when disconnected from the debug
tool.

Available | 32 digits hexadecimal number (16 bytes)

values
Permit flash pro- Select whether to enable flash rewrite.
gramming
Default Yes
Modifying | Select from the drop-down list.
Available | Yes Enables flash rewrite.
values
No Disables flash rewrite.
The flash memory area cannot be rewritten at all from the debug
tool.
Permit rewrite the Select whether to enable the serial programming security ID rewrite.
serial programming
security ID Default No
Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.
This property is changed to “No” when CS+ is disconnected from the debug
tool.
Available | Yes Enables serial programming security ID rewrite.
values
No Disables serial programming security ID rewrite.
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Initialize unused Select whether to initialize the unused area with FFH when flash memory is rewritten.
space during flash This property appears only when the selected microcontroller supports this function.
programming
Default No
Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug
tool.
Available | Yes The unused area is initialized with FFH when the flash memory is
values rewritten.
No The unused area is not initialized with FFH when rewriting the
flash memory.
Use wide voltage Select whether to rewrite the flash memory with the wide voltage mode.
mode This property appears only when the selected microcontroller supports the wide voltage

mode for the flash memory rewriting.

Default Yes

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug

tool.
Available | Yes Rewrites the flash memory with the wide voltage mode.
values No Rewrites the flash memory with the normal mode.
Erase flash ROM Select whether to erase flash ROM when connecting to the debug tool.
when starting This property appears only when the [Permit flash programming] property is set to [Yes].
[E1][E20]

When conducting hot plug-in connection, the setting of this property will be ignored
and flash ROM will not be erased.

Default No

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug

tool.
Available | Yes Erases the flash ROM when connecting to the debug tool.
values Note that after connecting to the debug tool, this property auto-
matically selects [No].
No Does not erase flash ROM when connecting to the debug tool.

Using the flash self Specifies whether to operate the flash by using the flash self programming. If you want
programming to break during the flash self programming, specify [Yes].
This property only appears when the selected microcontroller requires it.

Default No

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug

tool.
Available | Yes Rewrites the flash.
values
No Does not rewrite the flash.
Note For details on the on-chip debug security ID, see User's Manual of the emulator.

(8) [Hot Plug-in] [E1][E20]
The detailed information on hot plug-in connection is displayed and its configuration can be changed.
Note that this category appears only when the selected microcontroller incorporates the hot plug-in function.
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Retrying interval[ms] | Specify the interval in 1-ms units for retrying connection in the case of hot plug-in con-
nection when the emulator fails to communicate with the microcontroller on the target
board.

Default 1000

Modifying | Directly enter from the keyboard.
Note that changes can be made only when disconnected from the debug
tool.

Available | 0to 60000 in decimal number
values

Number of times of Specify the number of times for retrying connection in the case of hot plug-in connection
retrying when the emulator fails to communicate with the microcontroller on the target board.

Default 3

Modifying | Directly enter from the keyboard.
Note that changes can be made only when disconnected from the debug
tool.

Available | 0 to 3 in decimal number
values

(9) [Configuration] [Simulator]
The detailed information when customizing the simulator is displayed and its configuration can be changed.

Use simulator config- | Select whether to use the simulator configuration file to perform user customization
uration file (adding of user models) of the simulator.

Default No

Modifying | Select from the drop-down list.
Note that changes can be made only when disconnected from the debug

tool.
Available | Yes Uses the simulator configuration file.
values
No Does not use the simulator configuration file.

Simulator configura- | Specify the simulator configuration file to be use.
tion file This property appears only when the [Use simulator configuration file] property is set to
[Yes].

Default Blank

Modifying | Directly enter from the keyboard, or specify with the Select Simulator Con-
figuration File dialog box that is opened by clicking the [...] button.

Note that changes can be made only when disconnected from the debug
tool.
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[Debug Tool Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed.

) [Memory]

) [Access Memory While Running]
) [Set Event While Running] [IECUBE]
) [E2 Expansion Interface] [E2]
) [Break]

) [Fail-safe Break] [[IECUBE]
) [Trace]

) [Timer] [IECUBE][Simulator]
) [Coverage] [[ECUBE][Simulator]

0) [Mask for Input Signal] (except [Simulator])
1) [Virtual Board] [Simulator]

2) [Simulator GUI] [Simulator]

3

1
2
3
4
5
6
7
8
9
1
1
1
13) [Step function]

(
(
(
(
(
(
(
(
(
(
(
(
(

—_ — — —

[Description of each category]

(1) [Memory]
The detailed information on memories is displayed and its configuration can be changed.

Memory mappings Current memory mapping status is displayed by the types of memory areaNote,

Default [Sum total by microcontroller's inherent type of memory mapped area]

Modifying | Changes not allowed

Displayed | Displays the memory mapping status by the types of memory area.
Content The following detailed information is displayed by clicking the "+" mark of
each memory type.

- Memory type

- Start address

- End address

- Access width[bits]
Verify on writing to Select whether to perform a verify check when the memory value is initialized.
memory
(except [Simulator]) | Default Yes

Modifying | Select from the drop-down list.

Available | Yes Executes the verify check.
values

No Does not execute the verify check.

FAA memory space | Select the space displayed for [Memory 1] in the [Memory] panel and [Watch 1] in the
(1) [Watch] panel during FAA debugging.

This property only appears when the selected microcontroller supports this facility and
the [Debug FAA] property in the [FAA] category on the [Connect Settings] tab is set to
[Yes].

Default Data space

Modifying | Select from the drop-down list.

Available | Data space
values

Instruction code space

R20UT5301EJ0100 Rev.1.00 RENESAS Page 166 of 413
Jun 01, 2023



CS+V8.10.00 A. WINDOW REFERENCE

FAA memory space Select the space displayed for [Memory 2] in the [Memory] panel and [Watch 2] in the
(2) [Watch] panel during FAA debugging.

This property only appears when the selected microcontroller supports this facility and
the [Debug FAA] property in the [FAA] category on the [Connect Settings] tab is set to
[Yes].

Default Data space

Modifying | Select from the drop-down list.

Available | Data space
values

Instruction code space

FAA memory space Select the space displayed for [Memory 3] in the [Memory] panel and [Watch 3] in the
3) [Watch] panel during FAA debugging.

This property only appears when the selected microcontroller supports this facility and
the [Debug FAA] property in the [FAA] category on the [Connect Settings] tab is set to
[Yes].

Default Data space

Modifying | Select from the drop-down list.

Available Data space
values

Instruction code space

FAA memory space Select the space displayed for [Memory 4] in the [Memory] panel and [Watch 4] in the
(4) [Watch] panel during FAA debugging.

This property only appears when the selected microcontroller supports this facility and
the [Debug FAA] property in the [FAA] category on the [Connect Settings] tab is set to
[Yes].

Default Data space

Modifying | Select from the drop-down list.

Available Data space
values

Instruction code space

Note The type is of the memory mapping area registered in the device file.

(2) [Access Memory While Running]
The detailed information on memory accesses while executing a program (real-time display update function: see
"2.10.1.4 Display/modify the memory contents during program execution") is displayed and its configuration can

be changed.
Access by stopping [IECUBE]
execution For a memory area not accessible during execution of a program, select whether
(except [Simulator]) access to the area is permitted (target memory area/SFR area/CPU registers).

[E1][E20][EZ Emulator][COM Port]
Select whether to allow access to the memory area while executing a program

Default No
Modifying | Select from the drop-down list.
Available | Yes Temporarily stops execution and reads/writes.
values
No Does not access to the memory during execution of a program.
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Update display dur- Select whether to update the display in the Memory panel/Watch panel during a pro-
ing the execution gram execution.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Updates the display during program execution.
values

No Does not update the display during program execution.

Display update inter- | Specify the interval in 100ms unit to update the contents in the Memory panel/Watch
val[ms] panel display while executing a program.

This property appears only when the [Update display during the execution] property is
set to [Yes].

Default except [COM Port]
500

[COM Port]
10000

Modifying | Directly enter from the keyboard.

Available | except [COM Port]

values Integer number between 100 and 65500 (rounding up the fractions less
than 100 ms).

[COM Port]
Integer number between 5000 and 65500 (rounding up the fractions less
than 100 ms).

(3) [Set Event While Running] [[ECUBE]
The detailed information on the function of the event setting during program execution is displayed and its config-
uration can be changed.

Set event by stop- Select whether to forcibly pause the execution for events that cannot be set while exe-
ping execution cuting the program.
momentarily For details on the event types that are affected by this property, see "2.16.7.2 Event

types that can be set and deleted during execution”.

Default No
Modifying | Select from the drop-down list.
Available | Yes Sets these events by stopping the program execution momen-
values tarily.
No Does not allow to set these events during program execution.

(4) [E2 Expansion Interface] [E2]
The detailed information on the E2 expansion interface is displayed and its configuration can be changed.

External trigger input | Set the settings related to the external trigger input.
You can select different actions for each channel.

Channel number The channel number is displayed.
(Subproperty)

Default Oor1

Modifying | Changes not allowed
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Use Specify whether to use the external trigger input for this channel number.
(Subproperty)

Default No

Modifying | Select from the drop-down list.

Available | Yes Uses the external trigger signal input through the selected chan-
values nel.
No Does not use the external trigger signal input through the
selected channel.

Input signal Specify the input signal.
(Subproperty)

Default Rising Edge

Modifying | Select from the drop-down list.

Available | Rising Edge Detects rising edges of the external trigger signal input
values through the selected channel.
Falling Edge Detects falling edges of the external trigger signal input

through the selected channel.

Both Edges Detects both rising and falling edges of the external
trigger signal input through the selected channel.

High Detects the high level of the external trigger signal
input through the selected channel.

Low Detects the low level of the external trigger signal input
through the selected channel.

Action when input- The action when inputting the external trigger is displayed.
ting the external trig-

ger Default Stop program

(Subproperty)

Modifying | Changes not allowed

External trigger out- | Set the settings related to the external trigger output.

put You can select different actions for each channel.
Channel number The channel number is displayed.
(Subproperty)

Default Oor1

Modifying | Changes not allowed

Use Specify whether to use the external trigger output for this channel number.
Subpropert
(Subproperty) Default No
Modifying | Select from the drop-down list.
Available | Yes Uses the external trigger signal output through the selected chan-
values nel.
No Does not use the external trigger signal output through the
selected channel.

Output timing The output timing is displayed.
(Subproperty)

Default Stop program

Modifying | Changes not allowed
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Output signal The output signal is displayed.
(Subproperty) Default High Pulse
Modifying | Changes not allowed
Pulse width [us] Specify the pulse width.
(Subproparty) Default 1
Modifying | Directly enter from the keyboard.
Available | Integer number between 1 and 65535
values
(5) [Break]

The detailed information

on break functions is displayed and its configuration can be changed.

First using type of
breakpoint
(except [Simulator])

Select the type of the breakpoint to use with priority when setting it at the source line or
the execution address with a one click operation of the mouse in the Editor panel/Disas-

semble panel.

This property does not appear when the selected microcontroller supports only one

breakpoint type.

Default Software break

Modifying | Select from the drop-down list.

Available | Software break Sets software breakpoint with priority.
values

Hardware break

Sets hardware breakpoint with priority.

Stop emulation of
timer group when

Select whether to terminate the peripheral emulation of timers while stopping the pro-

gram execution (Peripheral Break).

stopping
(except [Simulator])

Default No

Modifying | Select from the drop-down list.

Available | Yes Terminates the peripheral emulation of timersNote 1,
values No Does not terminate the peripheral emulation of timers.

Stop emulation of
serial group when

stopping

Select whether to terminate the peripheral emulation of serials while stopping the pro-

gram execution (Peripheral Break).

This property appears only when the selected microcontroller supports this function.

(except [Simulator])

Default No

Modifying | Select from the drop-down list.

Available | Yes Terminates the peripheral emulation of serials.

values No Does not terminate the peripheral emulation of serials.

Stop FAA when stop-
ping

Specifies whether to stop the FAA when stopped.
This property only appears when the selected microcontroller supports this facility and
the [Debug FAA] property in the [FAA] category on the [Connect Settings] tab is set to

[Yes].
Default No
Modifying | Select from the drop-down list.
Available | Yes Stop FAA when stopped.
values
No Does not stop FAA when stopped
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(6)

Use open break
function
[IECUBE]

Select whether to use the open break function.

This property appears only when the selected microcontroller supports the open break

function.
Default Depends on the selected microcontroller.
Modifying | Select from the drop-down list.
Available | Yes(Hi-Z) The open break target pin becomes the Hi-Z state after
values the CPU is stopped.
No(Output sig- The open break target pin outputs the signal even after
nal) the CPU is stopped.

Restore the break-
point when pin reset
occurs

[E1][E20]

[EZ Emulator]

Select whether to restore the breakpoints when a pin reset occurs.

This property appears only when the selected microcontroller supports this function,

and [Yes] is specified for the [Permit flash programming] property.

Default Yes
Modifying | Select from the drop-down list.
Available | Yes The CPU is briefly halted for restoration of the breakpoints after a
values pin reset.
No The breakpoints are ignored and not restored after a pin reset,

but are restored when the program is stopped.

Execute instruction
at breakpoint when
break

Select the timing to stop the program execution by breakpoints either after or before the

execution of the instruction at the breakpoint.

[Simulator] Default No
Modifying | Select from the drop-down list.
Available | Yes Breaks after executing the instructionN°t 2,
values
No Breaks before executing the instruction.
Note 1. [E1][E20][EZ Emulator][COM Port]

In the case of the selected microcontroller that provides the open break function, when this property
is set to [Yes], the open break target pin becomes the Hi-Z state after the CPU is stopped (when
this property is set to [No], the open break target pin outputs the signal even after the CPU is

stopped).

Note 2.

events (see "2.15 Set an Action into Programs").

[Fail-safe Break] [IECUBE]
The detailed information on fail-safe break functions is displayed and its configuration can be changed.

When [Yes] is selected, all of action events currently being set are handled as Hardware Break

Stop when fetched
from fetch protected
area

Select whether to stop the execution right after fetching from the fetch protected area.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after fetching.

values
No Does not stop even after fetching.

Stop when wrote to
write protected area

Select whether to stop the execution right after writing to the write protected area.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after writing.

values "
No Does not stop even after writing.
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Stop when read from | Select whether to stop the execution right after reading from the read protected SFR.
read protected SFR

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after reading.
values

No Does not stop even after reading.

Stop when wrote to Select whether to stop the execution right after writing to the write protected SFR.
write protected SFR

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after writing.
values
No Does not stop even after writing.
Stop when over- Select whether to stop the execution right after the user stack overflow occurs.
flowed user stack
Default No
Modifying | Select from the drop-down list.
Available | Yes Stops right after the occurrence.
values
No Does not stop even after the occurrence.
Stop when under- Select whether to stop the execution right after the user stack underflow occurs.
flowed user stack
Default No

Modifying | Select from the drop-down list.

Available | Yes Stops right after the occurrence.
values
No Does not stop even after the occurrence.
User stack section Specify the section of the user stack.
Default .stack_bss

Modifying | Directly enter from the keyboard.

Available | Address expression from 0 to the "end address of the address space".
values

Stop when operated | Select whether to stop the execution right after the operation of the stack pointer that is
uninitialized stack not initialized.
pointer

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after the operation.
values

No Does not stop even after the operation.

Stop when read from | Select whether to stop the execution right after reading from the RAM that is not initial-
uninitialized RAM ized.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Stops right after reading.
values

No Does not stop even after reading.
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()

Stop when accessed
to non-mapping area

Select whether to stop the execution right after accessing to the areas where are not
memory mapped in the [Memory Mappings] property in the [Memory] category.

Default Yes
Modifying | Select from the drop-down list.
Available | Yes Stops right after accessing.
values
No Does not stop even after accessing.

Stop when word
miss-align accessed

Select whether to stop the execution right after accessing to the odd number address by

the word width.

Default Yes
Modifying | Select from the drop-down list.
Available | Yes Stops right after accessing.
values
No Does not stop even after accessing.

Stop when received
fail safe from periph-

Select whether to stop the execution right after the fail safe from the peripheral occurs.

Caution

eral Default Yes
Modifying | Select from the drop-down list.
Available | Yes Stops right after the occurrence.
values
No Does not stop even after the occurrence.
Stop when occurred | Select whether to stop the execution right after the flash illegal occurs.
flash illegal
Default Yes
Modifying | Select from the drop-down list.
Available | Yes Stops right after the occurrence.
values
No Does not stop even after the occurrence.
[Trace]

The detailed information on trace functions is displayed and its configuration can be changed.
[E1]E20][EZ Emulator][COM Port]

This category appears only when the selected microcontroller incorporates the OCD trace function.

Use trace function
[E1][E20]

[EZ Emula-
tor][COM Port]
[Simulator]

Select whether to use the trace functionNote 1.
Default No
Modifying | Select from the drop-down list.
Available | Yes Uses trace functions.
values

No Does not use trace functions.

Clear trace memory
before running
[IECUBE]
[Simulator]

Select whether to clear the trace memory before executing.

Default Yes
Modifying | Select from the drop-down list.
Available | Yes Clears the trace memory.
values
No Does not clear the trace memory.
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Operation after trace

Select the operation after the trace memory is full with the collected trace data.

memory is full

Default Non stop and overwrite to trace memory

Modifying | Select from the drop-down list.

Available | Non stop and over- Continues overwriting trace data even after trace
values write to trace memory | memory is used up.

Stop trace Stops overwriting trace data when trace memory
is used up (the program execution will not be
stopped).

Stop Stops running the program and overwriting trace

[IECUBE] data when trace memory is used up.

[Simulator]

Rate of frequency

Select the frequency division ratio of the counter to be used for time tag display.

division of trace time

tag Default 1/1(4ns/0.3min)

[IECUBE] Modifying | Select from the drop-down list.
Available | 1/1(4ns/0.3min)1/2(8ns/0.6min)1/4(17ns/1.2min)
values 1/8(33ns/2.4min)1/16(67ns/4.8min)1/32(133ns/9.5min)

1/64(267ns/19.1min)1/128(533ns/38.2min)1/256(1067ns/1.3h)
1/512(2133ns/2.5h)1/1024(4267ns/5.1h)1/2048(8533ns/10.2h)
1/4096(17067ns/20.4h)

(Values in "()" indicate the resolution and the maximum measurement
time.)

Accumulate trace

Select whether to display the accumulated tracing time in the Trace panel.

time
[Simulator]

Default No
Modifying | Select from the drop-down list.
Available | Yes Displays the accumulated tracing time.
values
No Displays the trace time with differential value.

Trace memory

Select the size of memory that stores trace data by the number of trace frames

Note 2, 3

size[frames]

Jun 01, 2023

[E1][E20] Default [E1][E20][EZ Emulator][COM Port]
[EZ Emula- Depends on the selected microcontroller.
tor][COM Port] [Simulator]
[Simulator] 4K
Modifying | [E1][E20][EZ Emulator][COM Port]
Changes not allowed
[Simulator]
Select from the drop-down list.
Available | [Simulator]
values 4K, 8K, 12K, 16K, 20K, 24K, 28K,32K, 36K, 40K, 44K, 48K, 52K,56K,
60K, 64K, 128K, 192K, 256K, 320K, 384K, 448K, 512K, 576K, 640K,
704K, 768K, 832K, 896K, 960K, 1M, 2M, 3M
Note 1. This property is automatically set to [Yes] when selecting [Start Tracing]/[Stop Tracing] from the
context menu in the Editor panel/Disassemble panel.
[E1]E20][EZ Emulator][COM Port]
This property is automatically changed in accordance with the property setting of the build tool
used.
Note 2. The trace frame is a unit of trace data. Each fetch/write/read uses one trace frame.
Note 3. [Simulator]
The trace memory is cleared when you change the setting of this property.
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(8) [Timer] [IECUBE][Simulator]
The detailed information on timer functions is displayed and its configuration can be changed.

Rate of frequency Select the frequency division ratio of the timer counter (120 MHz) used for timer mea-
division of timer surementNote,
[IECUBE]

Default 1/2(17ns/1.2min) (Resolution/maximum measurement time are displayed

in ll()ll)-
Modifying | Select from the drop-down list.

Available | 1/1(8ns/0.6min),1/2(17ns/1.2min),1/4(33ns/2.4min),

values 1/8(67ns/4.8min),1/16(133ns/9.5min),1/32(267ns/19.1min),
1/64(533ns/38.2min),1/128(1067ns/1.3h),1/256(2133ns/2.5h),
1/512(4267ns/5.1h),1/1024(8533ns/10.2h),1/2048(17067ns/20.4h),

1/4096(34133ns/40.7h
Use timer function Select whether to use the timer function.
[Simulator]
Default No
Modifying | Select from the drop-down list.
Available | Yes Uses timer functions.
values
No Does not use timer functions.
Note It is not possible to divide the timer counter for the Run-Break time.

(9) [Coverage] [IECUBE][Simulator]
The detailed information on coverage functions is displayed and its configuration can be changed.

Use coverage func- Select whether to use the coverage function.

tion
[Simulator] Default | No

Modifying | Select from the drop-down list.

Available | Yes Uses coverage functions

values -

No Does not use coverage functions

Reuse coverage Select whether to load/save the coverage measurement result when connecting to or
result disconnecting from the debug tool.

[Simulator]

This property appears only when the [Use coverage function] property is set to [Yes].

Default No

Modifying | Select from the drop-down list.

Available | Yes Loads/saves the coverage measurement result.
values

No Does not load/save the coverage measurement result.

(10) [Mask for Input Signal] (except [Simulator])
The detailed information on the masking input signal is displayed and its configuration can be changed.

Caution 1.  [E1][E20]
The properties in this category are disabled in the case of a hot plug-in connection.
That is, the program operates as if the specification for the properties is [No] (the properties
become enabled again after reconnection with CS+).

Caution 2.  [E1][E20][COM Port]
Maskable signals differ depending on the selected microcontroller type (a signal that cannot be
masked will be hidden).
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Mask WAIT signal Select whether to mask WAIT signal to prevent the signal input to emulators.
[IECUBE]

Default NoNote

Modifying | Select from the drop-down list.

Available | Yes Masks WAIT signal.

values
No Does not mask WAIT signal.
Mask TARGET Select whether to mask TARGET RESET signal to prevent the signal input to emula-
RESET signal tors.
Default NoNote

Modifying | Select from the drop-down list.

Available | Yes Masks TARGET RESET signal.

values
No Does not mask TARGET RESET signal.
Mask INTERNAL Select whether to mask INTERNAL RESET signal to prevent the signal input to emula-
RESET signal tors.
Default No
Modifying | Select from the drop-down list.
Available | Yes Masks INTERNAL RESET signal.
values
No Does not mask INTERNAL RESET signal.
Mask NMI signal Select whether to mask NMI signal to prevent the signal input to emulators.
[IECUBE]
Default No
Modifying | Select from the drop-down list.
Available | Yes Masks NMI signal.
values
No Does not mask NMI signal.
Note [IECUBE]

When the [Connecting with target board] property in the [Connection with Target Board]
[[ECUBE][E1][EZ Emulator][COM Port] category on the [Connect Settings] tab is set to [No], this
property is fixed to [Yes] automatically after connecting to the debug tool (changes not allowed).

(11) [Virtual Board] [Simulator]
The detailed information on the virtual board is displayed and its configuration can be changed.

Caution After connecting to the debug tool, all the properties in this category will become invalid when a
microcontroller whose Simulator does not support peripheral function simulations (instruction simu-
lation version) is selected.

Use the same virtual | Select whether to use the same virtual board as the web simulator.
board as the web See "Virtual Board panel [Simulator]" for details on the function of the virtual board.
simulator

Default No

Modifying | Select from the drop-down list.
(Changes not allowed during connecting to the debug tool.)

Available | Yes Uses the same virtual board as the web simulator.
values
No Does not use the same virtual board as the web simulator.
Note Immediately after a project has been created, when [Yes] is selected for the [Use the same virtual

board as the web simulator] property, the virtual board is connected to the simulator, and there is an
evaluation board for the selected microcontroller, you can select whether the information on the ini-
tial components of the board is to be read for the virtual board.
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(12) [Simulator GUI] [Simulator]
The detailed information on the Simulator GUI is displayed and its configuration can be changed.

Caution After connecting to the debug tool, all the properties in this category will become invalid when a
microcontroller whose Simulator does not support peripheral function simulations (instruction simu-
lation version) is selected.

Display Simulator Select whether to display the Simulator GUI window to use the Simulator GUI.
GUI

Default Yes

Modifying | Select from the drop-down list.
(Changes not allowed during execution of a program.)

Available | Yes Uses the function of the Simulator GUI.
values
No Does not use the function of the Simulator GUI.
Display Simulator Select whether to display the Simulator GUI window in the forefront when program exe-
GUI on top of other cution starts.
windows This property appears only when the [Display Simulator GUI] property is set to [Yes].
Default Yes
Modifying | Select from the drop-down list.
Available | Yes Displays it in the forefront.
values
No Does not display it in the forefront.

(13) [Step function]
The detailed information on the control method of step execution is displayed and its configuration can be

changed.
Skip target section Select whether to skip the target section.
Default No
Modifying | Select from the drop-down list.
Available | Yes Skips the target section.
values
No Does not skip the target section.
Target section Specify the target section.
This property appears only when the [Skip target section] property is set to [Yes].
Default [Number of sections to skip]
Modifying | Specify with the Specified Section dialog box.
The Specified Section dialog box is opened by clicking the [...] button that
appears at right edge of this field when you select this property (The sec-
tions to be skipped cannot be specified from this panel.).
R20UT5301EJ0100 Rev.1.00 -IENESAS Page 177 of 413

Jun 01, 2023



CS+V8.10.00 A. WINDOW REFERENCE

[Flash Self Emulation Settings] tab [IECUBE]

This tab is used to display the detailed information categorized by the following and the configuration can be changed.
Note that this tab appears only when the selected microcontroller incorporates the flash memory.

(1) [Flash Self Emulation]

(2) [Writing Time/Erasing Time]
(3) [Macro Service Error]

(4) [Setting Flash shield window]
(5) [Security Flag Emulation]

[Description of each category]

(1) [Flash Self Emulation]
The detailed information on flash self programming emulation functions is displayed and its configuration can be
changed.

Flash self-program- | Select whether to use the flash self programming emulation function.
ming

Default No

Modifying | Select from the drop-down list.

Available | Yes Uses the flash self programming emulation function.
values

No Does not use the flash self programming emulation function.

(2) [Writing Time/Erasing Time]
The detailed information on the time for writing to and erasing the flash memory is displayed and its configuration
can be changed.

Writing time Select the value to simulate the delay time for writing to the flash memory.

Default Typical number of times that is assumed by flash macro specifications

Modifying | Select from the drop-down list.

Available | No retry Specifies "0" as the number of times of retry.
values The delay time is 0 (the writing speed is fast-
est).

Typical number of times Specifies the typical number of times that is

that is assumed by flash assumed by flash macro specifications.
macro specifications

Maximum number of Specifies the maximum number of times that
times that is assumed by is assumed by flash macro specifications.
flash macro specifications

Retries for the maximum Specifies the maximum number of times of
number of times specified | retry.
The delay time is maximum (the writing speed

is longest).
Address for writing Specify the target address at which to simulate the delay time for writing.
fime Default 0
Modifying | Directly enter from the keyboard.
Available | 0x0 to OXFFFFF in hexadecimal number
values
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Address mask value

Specify a mask value for the address for writing time.

for writing time

Default 0x3

Modifying | Directly enter from the keyboard.

Available | 0x0 to OXFFFFF in hexadecimal numberNote 1
values

Erasing time

Select the value to simulate the delay time for erasing the flash memory.

Default Typical number of times that is assumed by flash macro specifications

Modifying | Select from the drop-down list.

Available | No retry Specifies "0" as the number of times of retry.

values The delay time is O (the erasing speed is fast-
est).

Typical number of times Specifies the typical number of times that is
that is assumed by flash assumed by flash macro specifications.
macro specifications

Maximum number of Specifies the maximum number of times that
times that is assumed by | is assumed by flash macro specifications.
flash macro specifications

Retries for the maximum Specifies the maximum number of times of
number of times specified | retry.

The delay time is maximum (the erasing
speed is longest).

Address for erasing

Specify the target address at which to simulate the delay time for erasing.

time

Default 0

Modifying | Directly enter from the keyboard.
Available | 0x0 to OXFFFFF in hexadecimal number
values

Address mask value

Specify a mask value for the address for erasing time.

for erasing time

Default Ox3FF
Modifying | Directly enter from the keyboard.
Available | 0x0 to OXFFFFF in hexadecimal numberNote 2
values
Note 1. The flash library writes to the code flash memory in 4-byte units, so fix the lowest and second-low-

est order bits of the address mask to 1.

Note 2. The flash library erases the code flash memory in block units, so fix the lower-order 10 bits of the
address mask to 1.

(3) [Macro Service Error]

The detailed information on the flash macro service is displayed and its configuration can be changed.
The error values that are not returned during normal emulation can be forcibly returned by setting the properties of

this category.

Macro Service Errors

Specify the error to generate in the flash macro service to emulate.
Up to three types of errors to generate ([0]/[1]/[2]) can be specified with subproperties
for this property.
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Generate error

Select the type of error to generate.

(Subproperty)

Default None

Modifying | Select from the drop-down list.
Available | None

values

Generate FlashErase Error (Erase)

Generate FlashBlankCheck Error (BlankCheck)

Generate FlashWrite Error (Write)

Generate FlashlVerify Error (IVerify)

Generate FlashSetSecurity / FlashSetFSW Error (Erase)

Generate FlashSetSecurity / FlashSetFSW Error (Write)

Generate FlashSetSecurity / FlashSetFSW Error (IVerify)

Address for error
(Subproperty)

Specify an address at which the error is to be generated, within the flash memory area.
This property appears only when the [Generate error] subproperty is set to [Generate
erase error for FlashErase]/[Generate write error for FlashWrite]/[Generate |Verify error
for FlashlVerify)/[Generate BlankCheck error for FlashBlankCheck].

Default 0

Modifying | Directly enter from the keyboard.
Available | 0x0 to OxFFFFF in hexadecimal number
values

Address mask value
for error
(Subproperty)

Specify a mask value for the address, at which the error is to be generated.

This property appears only when the [Generate error] subproperty is set to [Generate
erase error for FlashErase]/[Generate write error for FlashWrite]/[Generate |Verify error
for FlashlVerify)/[Generate BlankCheck error for FlashBlankCheck].

Default

0

Modifying

Directly enter from the keyboard.

Available
values

0x0 to OXFFFFF in hexadecimal numberNote

Note In the [Generate error] subproperty, when [Generate FlashWrite Error (Write)] is selected, fix the
lowest and second-lowest order bits of the mask value to 1, because the flash library writes to the
code flash memory in 4-byte units.

Also, when [Generate FlashErase Error (Erase))], [Generate FlashBlankCheck Error (BlankCheck)]
or [Generate FlashlVerify Error (IVerify)] is selected, fix the lower-order 10 bits of the mask value to
1, because erasure of the code flash memory, blank checking, and internal verification proceed in

block units.

(4) [Setting Flash shield window]
The detailed information on the flash shield window function is displayed and its configuration can be changed.

Caution Settings of this category are applied after CPU reset is generated.
If you changed these settings, execute the program after reset the CPU.

Flash shield window
start block

Specify the start block of the area that can be written to and erased by flash self pro-

gramming.

Default 0

Modifying | Directly enter from the keyboard.
Available | 0x0 to OxFFFF in hexadecimal number
values
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end block gramming.

Flash shield window | Specify the end block of the area that can be written to and erased by flash self pro-

Default FFFF

Modifying | Directly enter from the keyboard.

Available | 0x0 to OxFFFF in hexadecimal number
values

(5) [Security Flag Emulation]

The detailed information on the security flag emulation function is displayed and its configuration can be changed.

Caution Settings of this category are applied after CPU reset is generated.
If you changed these settings, execute the program after reset the CPU.

Disable block erase Select whether to emulate to disable block erase.

Default No

Modifying | Select from the drop-down list.

Available | Yes Emulates to disable block erase.
values
No Does not emulate to disable block erase.
Disable program Select whether to emulate to disable writing.
Default No
Modifying | Select from the drop-down list.
Available | Yes Emulates to disable writing.
values
No Does not emulate to disable writing.
Disable boot block Select whether to emulate to disable rewrite boot area.
cluster reprogram
Default No

Modifying | Select from the drop-down list.

Available | Yes Emulates to disable rewrite boot area.
values
No Does not emulate to disable rewrite boot area.
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[DataFlash Emulation Settings] tab [[ECUBE]

This tab is used to display the detailed information categorized by the following and the configuration can be changed.
Note that this tab appears only when the selected microcontroller incorporates the data flash memory.

(1) [DataFlash Emulation]
(2) [Writing Time]
(3) [Macro Service Error]

[Description of each category]

(1) [DataFlash Emulation]
The detailed information on the data flash emulation functions is displayed and its configuration can be changed.

DataFlash emulation Select whether to use the data flash emulation function.
Default No
Modifying | Select from the drop-down list.
Available Yes Uses data flash emulation functions.
values
No Does not use data flash emulation functions.

(2) [Writing Time]
The detailed information on the time for writing to the data flash memory is displayed and its configuration can be

changed.
Writing time Select the value to simulate the delay time for writing to the data flash memory.
Default Typical number of times that is assumed by flash macro specifications
Modifying | Select from the drop-down list.
Available | No retry Specifies "0" as the number of times of retry.
values The delay time is 0 (the writing speed is fastest).
Typical number of times | Specifies the typical number of times that is
that is assumed by flash | assumed by flash macro specifications.
macro specifications
Maximum number of Specifies the maximum number of times that is
times that is assumed assumed by flash macro specifications.
by flash macro specifi-
cations
Retries for the maximum | Specifies the maximum number of times of retry.
number of times speci- | The delay time is maximum (the writing speed is
fied longest).
Address for writing Specify the target address at which to simulate the delay time for writing.
time
Default F1000
Modifying | Directly enter from the keyboard.
Available | 0xF1000 to OxFFFFF in hexadecimal number
values
Address mask value | Specify a mask value for the address for writing time.
for writing time
Default 0
Modifying | Directly enter from the keyboard.
Available | 0x0 to OXFFFFF in hexadecimal number
values
R20UT5301EJ0100 Rev.1.00 -IENESAS Page 182 of 413

Jun 01, 2023



CS+V8.10.00

A. WINDOW REFERENCE

(3) [Macro Service Error]

The detailed information on the data flash macro service is displayed and its configuration can be changed.
The error values that are not returned during normal emulation can be forcibly returned by setting the properties of

this category.

Macro Service Errors

Specify the error to generate in the data flash macro service to emulate.

Up to four types of errors to generate ([0]/[1]/[2]/[3]) can be specified with subproperties

for this property.

Generate error

Select the type of error to generate.

(Subproperty)

Default None

Modifying | Select from the drop-down list.

Available | None

values
Generate FlashBlankCheck Error (BlankCheck)

Generate FlashWrite Error (Write)

Generate FlashlVerify Error (IVerify)

Address for error
(Subproperty)

Specify an address at which the error is to be generated, within the flash memory area.
This property appears only when the [Generate error] subproperty is set to the value

other than [None].

Default F1000

Modifying | Directly enter from the keyboard.

Available | 0xF1000 to OxFFFFF in hexadecimal number
values

Address mask value
for error
(Subproperty)

Specify a mask value for the address, at which the error is to be generated.
This property appears only when the [Generate error] subproperty is set to the value

other than [None].

Default 0

Modifying | Directly enter from the keyboard.

Available | 0x0 to OXFFFFF in hexadecimal number
values
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[Download File Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed.
For details on the download function, see "2.6 Download/Upload Programs".

(1) [Download]
(2) [Debug Information]

[Description of each category]

(1) [Download]
The detailed information on download is displayed and its configuration can be changed.

Download files Specify the file to downloadNo® -
The names of files to be downloaded and the download conditions are listed in the
lower area.

Default [Number of files to download]

Modifying | Specify with the Download Files dialog box.

The Download Files dialog box is opened by clicking the [...] button that
appears at right edge of this field when you select this property (you cannot
specify the file to download on this panel).

CPU Reset after Select whether to reset the CPU after downloading.
download This property does not appear when the selected microcontroller always resets the
CPU after downloading.

Default Yes

Modifying | Select from the drop-down list.

Available | Yes Resets the CPU after downloading.
values

No Does not reset the CPU after downloading.

Download Mode Select the download mode for downloading to the flash ROM.
(except [Simulator])

Default Speed priority

Modifying | Select from the drop-down list.

Available | Speed priority Fills free space between the first data and the final
values data with FFH.

Download speed will be faster because the writing
data is reduced (default).

Data priority Retains the previous value in free space.
Download speed will be very slow because data in
free space are read once.

Erase flash ROM Select whether to erase the flash ROM before downloading.
before download
(except [Simulator])

Default No

Modifying | Select from the drop-down list.
Note that changes cannot be made when the [Download Mode] property is
set to [Data priority].

Available | Yes Erases the flash ROM before downloading.
values
No Does not erase the flash ROM before downloading.
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)

Automatic change
method of event set-
ting position

Select how to perform the setting again if the file is downloaded again, and the location

(address) set for the currently set event changes to midway in the instructionNot€ 2,
Default Suspend event
Modifying | Select from the drop-down list.
Available | Move to the head Sets the event to the top address of the instruction.
values of instruction

Suspend event Disables the event (suspended state).

Check reserved area
overwriting when
downloading
[E1][E20]

[EZ Emula-
tor][COM Port]

Select whether to output a message when overwriting to an area reserved for use by
the emulator is attempted at the time of downloading.

Default Yes
Modifying | Select from the drop-down list.
Available | Yes Outputs a message when overwriting to an area reserved is
values attempted.
No Does not output a message when overwriting to an area reserved
is attempted.

Specify code section
name defined in FAA
source file

Specify code section name defined in FAA source file.

This property only appears when the selected microcontroller supports this facility and
the [Debug FAA] property in the [FAA] category on the [Connect Settings] tab is set to
[Yes].

Default Blank

Modifying | Directly enter from the keyboard.
Available | Up to 32767 characters

values

Specify code section
name defined in FAA
source file

Specify code section name defined in FAA source file.

This property only appears when the selected microcontroller supports this facility and
the [Debug FAA] property in the [FAA] category on the [Connect Settings] tab is set to
[Yes].

Default Blank

Modifying | Directly enter from the keyboard.
Available | Up to 32767 characters

values

Note 1.

Files specified as build targets in a main project or sub-project cannot be deleted from the target

files to download (These files are automatically registered as download files by default).
See "Table 2.2 Downloadable File Formats" for downloadable file format.

Note 2.

This property setting works only for the location setting of events without the debug information.

The location setting of events with the debug information is always moved to the beginning of the
source text line.

[Debug Information]

The detailed information on debugging is displayed and its configuration can be changed.
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Execute to the speci- | Select whether to execute the program to the specified symbol position after CPU reset.
fied symbol after
CPU Reset Default Yes

Modifying | Select from the drop-down list.

Available | Yes Executes the program to the specified symbol position after CPU
values reset.
No Does not execute the program after CPU reset.
Specified symbol Specify the position at which the program is stop after CPU reset.

This property appears only when the [Execute to the specified symbol after CPU Reset]
property is set to [Yes].

Default _main

Modifying | Directly enter from the keyboard.

Available | Address expression from 0 to the "end address of the address space".
values

The upper limit size | Specify the memory size to be used for reading the debug informationN°te.

of the memory usage
[Mbytes] Default 500

Modifying | Directly enter from the keyboard.

Available | Decimal number between 100 and 1000
values

Note In some cases, lowering the upper limit may lead to poorer responsiveness since it leads to more
frequent discarding and re-reading of debug information.
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[Hook Transaction Settings] tab

This tab is used to display the detailed information categorized by the following and the configuration can be changed.
For details on the hook transaction, see "2.17 Use Hook Function".

(1) [Hook Transaction Settings]

[Description of each category]

(1) [Hook Transaction Settings]

The detailed information on the hook transaction is displayed and its configuration can be changed.
Note that the properties on this tab can be specified via the Text Edit dialog box, which is opened by clicking the

[...] button that appears at right edge of a field when you select each property (you cannot specify the process
directly on this panel).

Caution Up to 64 characters for one process, and up to 128 processes for each property can be set (one
line in the [Text] area in the Text Edit dialog box is equivalent to one processing).
Before download Specify the process to proceed right before downloading the load module file.
Default Before download[0] ("[I" is the current number of specified processes.)
Modifying | Specify with the Text Edit dialog box.
Format Either one of the following
- SFR name + space + Value
[Process] Automatically overwrites the value of SFR with Value.
- CPU register name + space + Value
[Process] Automatically overwrites the value of CPU register with Value.
- Source + space + Python script path
[Process] Automatically executes a script file specified with Python
script path.
After download Specify the process to proceed right after downloading the load module file.
Default After download[0] ("[]" is the current number of specified processes.)
Modifying | Specify with the Text Edit dialog box.
Format Either one of the following
- SFR name + space + Value
[Process] Automatically overwrites the value of SFR with Value.
- CPU register name + space + Value
[Process] Automatically overwrites the value of CPU register with Value.
- Source + space + Python script path
[Process] Automatically executes a script file specified with Python
script path.
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After CPU reset

Specify the process to proceed right after CPU reset during break.
under breaking

Default

After CPU reset under breaking[0] ("[]" is the current number of specified
processes.)

Modifying | Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value

[Process] Automatically overwrites the value of SFR with Value.
- CPU register name + space + Value

[Process] Automatically overwrites the value of CPU register with Value.

- Source + space + Python script path

[Process] Automatically executes a script file specified with Python
script path.

Before running Specify the process to proceed right before the execution of the program.

Default Before running[0] ("[]" is the current number of specified processes.)

Modifying | Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value
[Process] Automatically overwrites the value of SFR with Value.
- CPU register name + space + Value
[Process] Automatically overwrites the value of CPU register with Value.

- Source + space + Python script path

[Process] Automatically executes a script file specified with Python
script path.

After breaking Specify the process to proceed right after the program break.

Default After breaking[0] ("[]" is the current number of specified processes.)

Modifying | Specify with the Text Edit dialog box.

Format Either one of the following

- SFR name + space + Value

[Process] Automatically overwrites the value of SFR with Value.

- CPU register name + space + Value

[Process] Automatically overwrites the value of CPU register with Value.
- Source + space + Python script path

[Process] Automatically executes a script file specified with Python
script path.
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Memory panel

This panel is used to display the contents of the memory and change the memory value (see "2.10.1 Display/change

the memory").

Furthermore, the contents of data flash memory can be displayed and changed when the selected microcontroller incor-

porates the data flash memory.

Up to a maximum of four of these panels can be opened. Each panel is identified by the names "Memory1", "Memory2",

"Memory3", and "Memory4" on the titlebar.

The display contents are automatically updated when the value of the memory changes after a program is executed

(when the execution is done in steps, the display is updated after each step).

In addition, by enabling the Real-time display update function, it is also possible to update the display contents in real-

time even while a program is being executed.
This panel appears only when connected to the debug tool.

Remark 1. You can set the scroll range of the vertical scroll bar on this panel via the Scroll Range Settings dialog
box which is opened by clicking the button from [View] on the toolbar.

Remark 2. This panel can be zoomed in and out by |1 nox -| in the tool bar, or by moving the mouse

wheel forward or backward while holding down the [Ctrl] key.

Figure A6 Memory Panel
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This section describes the following.
- [How to open]
- [Description of each areal
- [Toolbar]
- [[File] menu (Memory panel-dedicated items)]

- [[Edit] menu (Memory panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Memory] >> [Memory7-4].

[Description of each area]

(1) Display position specification area

T
(4)

It is possible to specify the display start position of the memory contents by specifying an address expression.

Specify the following items.
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(@) Specify an address expression
Directly input the address expression of the memory value address to display in the text box. You can specify an
input expression with up to 1024 characters. The result of the expression is treated as the display start position
address.
Note that if an address value greater than the microcontroller address space is specified, the high-order address
value is masked.
In addition, an address value greater than the value expressed within 32 bits cannot be specified.

Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] +
[Space] key in this text box (see "2.20.2 Symbol name completion function").

Remark 2. If the specified address expression is the symbol and its size can be recognized, everything from
the start address to the end address of that symbol is displayed selected.

(b) Specify automatic/manual evaluation of the address expression
The timing to change the display start position can be determined by specifying in the [Move when Stop] check
box and the [Move] button.

[Move when Stop] The caret is moved to the address which is automatically calculated from the
address expression after the program is stopped.

[] | The address expression is not automatically evaluated after the program is
stopped.
Click the [Move] button to manually evaluate the address expression.

[Move] button When the [Move when Stop] check box is not checked, click this button to evalu-
ate the address expression and move the caret to the result address of the evalu-
ation.

(2) Address area
The address of the memory is displayed (hexadecimal number notation fixing).
The display starts from address 0x0 by default. However, an offset value of the start address can be set via the
Address Offset Settings dialog box that is opened by selecting [Address Offset Value Settings...] from the context
menu.
The address width corresponds to the one in memory space of the specified microcontroller in the project.
This area cannot be edited.

Caution The offset value that have been set is automatically changed in accordance with the number of
view columns in the Memory value area.

(3) Memory value area
The value of the memory is displayed and changed.
Specification of the display notation, display width of memory values or the number of view columns is performed
by selecting the buttons on the toolbar or [Notation]/[Size Notation]/[View] from the context menu (see "2.10.1.2
Change display format of values").
The meanings of the marks and colors displayed as memory values are as follows (character colors and back-
ground colors depend on the configuration in the [General - Font and Color] category of the Option dialog box):

Display Example (Default) Description

Qo Character color Blue Memory value that the user is changing
Press the [Enter] key to write to the target memory.

Background color | Standard color

E Character color Standard color | Memory value of the address whose symbol has been
(Under line) defined (Registering watch-expression can be per-
Background color | Standard color formed).
o Character color Brown Memory value that has been changed because of the exe-
cution of a programNete
Background color | Cream To reset the highlighting, select the button on the tool-
bar.
(]| Character color Pink Memory value for which the Real-time display update

function is being operated
Background color | Standard color
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Display Example (Default) Description
an Character color Standard color | Read/ Current access condition of the memory
Fetch value when the Real-time display update
Background color | Palegreen function is being operated
a0 Character color Standard color | Write
Background color | Orange
(i Character color Standard color | Read and
Write
Background color | Paleturquoise
an Character color Gray Memory value of the read-protected area
Background color | Standard color
s Character color Gray Areas not memory-mapped
Background color | Standard color
- Character color Gray Areas not rewritable (e.g. SFR area/l/O protection area) or
when acquisition of memory values failed
Background color | Standard color
* Character color Standard color | When display is specified for other than the real-time dis-
play update area during program execution or when
Background color | Standard color | 5cquisition of memory values failed
Note Just before execution of a program, only the memory value in the address range for which the
Memory panel had been displayed becomes the target.
In addition, the value is not highlighted if it is same for before and after the execution of the pro-
gram.
Caution The number of view columns is automatically changed in accordance with the set value of [Size

Notation] of the context menu.

This area is provided with the following functions.

(@) Pop-up display
The following contents are pop-up displayed based on the nearest existing symbol forward from the address the
mouse is designating when hovering the mouse cursor over the memory value.

Note that if there is no symbol information (the underlining is non-display), no pop-up display is done.

Symbol name

variable + 0x14

Offset value

Symbol name

Indicates the name of the symbol.

Offset value

When a symbol has not been defined for the addresses, the offset value from the nearest
symbol exists forward is displayed (hexadecimal number notation fixing).

(b) Real-time display update function

Using the real-time display update function allows you to display/modify the value of the memory contents not
only while the program is stopped, but also in execution.
See "2.10.1.4 Display/modify the memory contents during program execution" for details on the real-time dis-
play update function.

(c) Changing memory values
Directly edit from the keyboard after moving the caret to the memory value to be edited.
The color of the memory value changes when it is in editing. Press the [Enter] key to write the edited value to
the target memory (if the [Esc] key is pressed before the [Enter] key is pressed, the editing is cancelled).
See "2.10.1.3 Modify the memory contents" for details on the method for changing the memory value.
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(d) Searching/initializing memory value
The Memory Search dialog box is opened to search the memory contents in the specified address range by
selecting [Find...] from the context menu (see "2.10.1.5 Search the memory contents").
In addition, the Memory Initialize dialog box is opened to change the memory contents collectively in the speci-
fied address range by selecting [Fill...] from the context menu (see "2.10.1.6 Modify the memory contents in
batch (initialize)").

(e) Copying and pasting
By selecting a range of memory values with the mouse, the contents of the range can be copied to the clipboard
as a character string, and these contents can be pasted to the caret position.
These operations are performed by selecting from the context menu or selecting from the [Edit] menu.
However, the paste operation is possible only when the character string to be pasted and the display notation
(radix and size) of the area match.
If the display notation does not match, a message is displayed.
The character codes and character strings that can be handled by this area are as follows.
If character strings other than these are pasted, a message is displayed.

Character code ASCII

Character string 0,1,2,3,4,5,6,7,8,9,a,b,c,d, e,f,A,B,C,D,E, F

(f) Registering watch-expression
A memory value with underline indicates that a symbol has been defined in the address, and its symbol can be
registered as a watch-expression.
After selecting the memory value or placing the caret on the memory value, the symbol name of the address is
registered in the Watch panel (Watch1) as a watch-expression by selecting [Register to Watch1] from the con-
text menu.

Caution A memory value without underline cannot be registered as a watch-expression.

(g) Saving the contents of memory values
The Data Save dialog box can be opened by selecting the [File] menu >> [Save Memory Data As...], and the
contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.10.1.7 Save the memory contents" for details on the method for saving the contents of memory values.

(4) Character strings area
Memory values converted into character code are displayed.
The character code can be specified by selecting [Encoding] from the toolbar or context menu (ASCII code is
selected by default).
Furthermore, in this area, memory values converted into a floating-point value can be displayed as character
strings. To do this, select the following item from [Encoding] of the context menu.

Item Display Format Size
Half-Precision Half-precision floating-point value 16-bit
Float Numeric value | <sign><mantissa>e<sign><exponent>

Infinite number | Inf, and -Inf
Not a number NaN
Example + 1.234e+1
Float Single-precision floating-point value 32-bit

Numeric value | <sign><mantissa>e<sign><exponent>
Infinite number | Inf, and -Inf
Not a number NaN
Example + 1.234567e+123
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Item Display Format Size

Double Double-precision floating-point value 64-bit

Numeric value | <sign><mantissa>e<sign><exponent>

Infinite number | Inf, and -Inf

Not a number NaN

Example +1.2345678901234e+123

Float Complex Complex number of single-precision floating-point 64-bit

<Single-precision floating-point value> <Single-precision floating-point
value>* |

Double Complex Complex number of double-precision floating-point 128-bit

<Double-precision floating-point value> <Double-precision floating-point
value> * |

Float Imaginary Imaginary number of single-precision floating-point 32-bit

<Single-precision floating-point value> * |

Double Imaginary | Imaginary number of double-precision floating-point 64-bit

<Double-precision floating-point value> * |

Caution Nothing is displayed when the minimum size of a character code or a floating-point value is greater
than "the number of bytes of display width of memory values" x "the number of bytes of the number
of view columns".

This area is provided with the following functions.

(@) Changing character strings
Directly edit from the keyboard after moving the caret to the character string to be edited.
The color of the character string changes when it is in editing. Press the [Enter] key to write the edited value to
the target memory (if the [Esc] key is pressed before the [Enter] key is pressed, the editing is cancelled).

Caution Character strings displayed as floating-point values cannot be searched.

(b) Searching character strings
The Memory Search dialog box is opened to search for character strings by selecting [Find...] from the context
menu (see "2.10.1.5 Search the memory contents").

(c) Copying and pasting
By selecting a range of character strings with the mouse, the contents of the range can be copied to the clip-
board as a character string, and these contents can be pasted to the caret position.
These operations are performed by the selecting from the context menu or selecting from the [Edit] menu.
However, the paste operation is possible only when [ASCII] has been selected as the character code. If other
than [ASCII] is selected, a message is displayed.

[Title]
Memory <index> [Code|Data]

During FAA debugging, code or data is displayed in accordance with the value of the [FAA memory space] prop-
erty in the [Memory] category on the [Debug Tool Settings] tabbed page. When [Instruction code space] is
selected for the property, code is displayed. When [Data space] is selected for the property, data are displayed.
Code or data is only displayed during FAA debugging.

[Toolbar]
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El|

Acquires the latest data from the debug tool, and updates the contents of this panel.

Resets highlighting of values that have been changed by executing a program.
This item is disabled during execution of a program.

Notation

The following buttons to change the notation of memory values are displayed.
The items below is disabled during execution of a program.

Hexadecimal

Displays memory values in hexadecimal number (default).

Signed Decimal

Displays memory values in signed decimal number.

Unsigned Decimal

Displays memory values in unsigned decimal number.

Octal

Displays memory values in octal number.

Binary

Displays memory values in binary number.

Size Notation

The following buttons to change the notation of sizes of memory values are dis-
played.
The items below is disabled during execution of a program.

4 Bits

Displays memory values in 4-bit width.

1 Byte

Displays memory values in 8-bit width (default).

2 Bytes

Displays memory values in 16-bit width.
Values are converted depending on the endian of the target memory area.

E 4 Bytes

Displays memory values in 32-bit width.
Values are converted depending on the endian of the target memory area.

8 Bytes

Displays memory values in 64-bit width.
Values are converted depending on the endian of the target memory area.

Encoding

The following buttons to change the encoding of character strings are displayed.
The items below is disabled during execution of a program.

ASCII

Displays character strings in ASCII code (default).

Shift_JIS

Displays character strings in Shift_JIS code.

EUC-JP

Displays character strings in EUC-JP code.

UTF-8 Displays character strings in UTF-8 code.
UTF-16 Displays character strings in UTF-16 code.

Half-Precision Float

Displays character strings as a half-precision floating-point value.

pi
=]

Float

Displays character strings as a single-precision floating-point value.

Double

Displays character strings as a double-precision floating-point value.

Float Complex

Displays character strings as a complex number of single-precision floating-point.

22| Double Complex

Displays character strings as a complex number of double-precision floating-point.

Float Imaginary

Displays character strings as an imaginary number of single-precision floating-
point.

Double Imaginary

Displays character strings as an imaginary number of double-precision floating-
point.
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View

The following buttons to change the display format are displayed.

Settings Scroll Range... | Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Column Number Settings... Opens the Column Number Settings dialog box to set the number of view columns
in the Memory value area.

Address Offset Value Set- Opens the Address Offset Settings dialog box to set an offset value for addresses

tings... displayed in the Address area.

[[File] menu (Memory panel-dedicated items)]

The following items are exclusive for the [File] menu in the Memory panel (other items are common to all the panels).
Note that all these items are disabled during execution of a program.

Save Memory Data

Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file
(*.csv) (see "(g) Saving the contents of memory values").

Note that when the file has never been saved or the file is write disabled, the same oper-
ation is applied as the selection in [Save Memory Data As...].

Save Memory Data As...

Opens the Data Save dialog box to newly save the contents of this panel to the specified
text file (*.txt)/CSV file (*.csv) (see "(g) Saving the contents of memory values").

[[Edit] menu (Memory panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Memory panel (all other items are disabled).
Note that all these items are disabled during execution of a program.

Copy

Copies the contents of the selected range to the clipboard as character string(s).

Paste

Pastes the character string(s) copied in the clipboard to the caret position.
- To the memory value area: See "(e) Copying and pasting".

- To the character strings area: See "(c) Copying and pasting".

Find...

Opens the Memory Search dialog box.
The search is operated either in the Memory value area or the Character strings area, in

which a caret is.

[Context menu]

Register to Watch1

Registers the symbol at the caret to the Watch panel (Watch1).

At this time, since it is registered as a variable name, the symbol name that is displayed
changes depending on the scope.

Note that this item is disabled when no symbol has been defined in the address corre-
sponding to the memory value at the caret position (see "(f) Registering watch-expres-
sion").

Find... Opens the Memory Search dialog box.
The search is operated either in the Memory value area or the Character strings area
(unless the floating-point value display is selected), in which a caret is.
This item is disabled during execution of a program.
Fill.... Opens the Memory Initialize dialog box.
Refresh Acquires the latest data from the debug tool, and updates the contents of this panel.
Copy Copies the contents of the selected range to the clipboard as character string(s).
This item is disabled during execution of a program.
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Paste Pasts the character string(s) copied in the clipboard to the caret position.
This item is disabled during execution of a program.
- To the memory value area: See "(e) Copying and pasting".
- To the character strings area: See "(c) Copying and pasting".
Notation The following cascade menus are displayed to specify the notation of memory values.
Hexadecimal Displays memory values in hexadecimal number (default).

Signed Decimal

Displays memory values in signed decimal number.

Unsigned Decimal

Displays memory values in unsigned decimal number.

Octal

Displays memory values in octal number.

Binary

Displays memory values in binary number.

Size Notation

The following cascade menus are displayed to specify the notation of sizes of memory val-
ues.

4 Bits Displays memory values in 4-bit width.
1 Byte Displays memory values in 8-bit width (default).
2 Bytes Displays memory values in 16-bit width.
Values are converted depending on the endian of the target memory area.
4 Bytes Displays memory values in 32-bit width.
Values are converted depending on the endian of the target memory area.
8 Bytes Displays memory values in 64-bit width.
Values are converted depending on the endian of the target memory area.
Encoding The following cascade menus are displayed to specify the display format in the character
strings area.
ASCII Displays character strings in ASCII code (default).
Shift_JIS Displays character strings in Shift_JIS code.
EUC-JP Displays character strings in EUC-JP code.
UTF-8 Displays character strings in UTF-8 code.
UTF-16 Displays character strings in UTF-16 code.
Half-Precision Float Displays character strings as a half-precision floating-point value.
Float Displays character strings as a single-precision floating-point value.
Double Displays character strings as a double-precision floating-point value.
Float Complex Displays character strings as a complex number of single-precision floating-point.
Double Complex Displays character strings as a complex number of double-precision floating-point.
Float Imaginary Displays character strings as an imaginary number of single-precision floating-point.
Double Imaginary Displays character strings as an imaginary number of double-precision floating-point.

R20UT5301EJ0100 Rev.1.00 RENESAS Page 196 of 413

Jun 01, 2023




CS+V8.10.00 A. WINDOW REFERENCE

View The following cascade menus are displayed to specify the display format.
Settings Scroll Opens the Scroll Range Settings dialog box to set the scroll range for this panel.
Range...

Column Number Set- | Opens the Column Number Settings dialog box to set the number of view columns in the
tings... Memory value area.

Address Offset Value | Opens the Address Offset Settings dialog box to set an offset value for addresses dis-
Settings... played in the Address area.

Highlight Accessed Highlights memory values that have changed by execution of a program if this item is
checked (default).
This item is disabled during execution of a program.

Periodic Updating The following cascade menus are displayed to set for the real-time display update function
(see "(b) Real-time display update function").

Periodic Updating Opens the Property panel to set for the real-time display update function.
Options
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Disassemble panel

This panel is used to display the results of disassembling the contents of the memory (disassembled text), and execute
line assembly (see "2.7.4 Perform line assembly").
Furthermore, the instruction level debugging (see "2.8.3 Execute programs in steps") and the code coverage measure-
ment result display [IECUBE][Simulator] (see "2.14 Measure Coverage [I[ECUBE][Simulator]") can be performed in this

panel.

Up to a maximum of four of these panels can be opened. Each panel is identified by the names "Disassemble1”,
"Disassemble2", "Disassemble3" and "Disassemble4" on the titlebar.

The source text in the source file corresponding to the code data can also be displayed by setting to the Mixed display

mode (default).

This panel appears only when connected to the debug tool.

Caution A step execution is performed in instruction level units when the focus is in this panel (see "2.8.3 Exe-
cute programs in steps").
Remark 1. You can set the scroll range of the vertical scroll bar on this panel via the Scroll Range Settings dialog
box which is opened by clicking the button from [View] on the toolbar.
Remark 2. You can print the current screen image of this panel by selecting [Print...] from the [File] menu.
Remark 3. This panel can be zoomed in and out by |1 a0k -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.
Figure A.7  Disassemble Panel (When Mixed Display Mode Is Selected)
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Figure A.8 Disassemble Panel (When Disassemble Display Mode Is Selected)
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Figure A.9 Disassemble Panel (When Code Coverage Measurement Result Is Displayed)
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Disassemble panel-dedicated items)]
- [[Edit] menu (Disassemble panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Disassemble] >> [Disassemble? - 4].
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[Description of each area]

(1) Eventarea
The lines for which events can be set are shown with the background color in white (this mean that events cannot
be set for those lines whose background color in gray).
In addition, the Event mark corresponding to an event that has been currently set is displayed.
This area is provided with the following functions.

(a) Setting/deleting breakpoints
By clicking where you want to set a breakpoint with the mouse, the breakpoint can be set easily.
The breakpoint is set to the instruction at the start address of the clicked line.
Once the breakpoint is set, the Event mark is displayed at the line that is set. In addition, the detailed informa-
tion about the set breakpoint is reflected in the Events panel.
When this operation is performed at a place where any one of the event marks is already being displayed, that
event is deleted and the setting of breakpoints cannot be done.
Note that the setting of events can be done only for those lines where the background color is shown in white.
See "2.9.3 Stop the program at the arbitrary position (breakpoint)" for details on how to set the breakpoint.

(b) Changes event status
Event status can be changed from the following menu displayed by right-clicking the event mark.

Enable Event Changes the selected event state to a Valid state.

Event occurs when the specified condition is met.

When the event mark ( hj‘ ) which indicates that multiple events have been set
is selected, all of the events that have been set are enabled.

Disable Event Changes the selected event state to an Invalid state.

Event does not occur when the specified condition is met.

When the event mark ( hﬁ' ) which indicates that multiple events have been set
is selected, all of the events that have been set are disabled.

Delete Event Deletes the selected event.
When the event mark ( ,hi,@' ) which indicates that multiple events have been set
is selected, all of the events that have been set are deleted.

View Event Detailed Opens the Events panel to display the detailed information of the selected event.
Setup

(c) Pop-up display
By hovering the mouse cursor over the Event mark, the name of the event, the detailed information for the event
and the comments added to the event are pop-up displayed.
When multiple events have been set in the applicable place, information for each event, up to a maximum of
three events, is listed and displayed.

(2) Address area
The address per line to start disassembling is displayed (hexadecimal number notation fixing).
In addition, the current PC mark ( ) that corresponds to the current PC position (PC register value) is dis-
played.
The address width corresponds to the one in memory space of the specified microcontroller in the project.
For the source text line in the mixed display mode, line numbers (xxx:) in the source file correspond to the start
address are displayed.
This area is provided with the following functions.

(@) Pop-up display
By hovering the mouse cursor over a address or line number, the following information is pop-up displayed.

Address Format: <Label name> + <Offset value>
Example1: main + 0x10
Example2: sub function + 0x20
Source line number Format:  <File name> # <Line number>
Example1: main.c#40
Example2: main.c#100

(3) Disassemble area
The results of disassembling are displayed next to the corresponding source text as follows.
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Figure A.10 Display Contents of Disassemble Area (In Case of Mixed Display Mode)
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Offset value Code Instruction

Label line The label is displayed when a label is defined for the address, and its correspond-
ing line is shown highlighted in lightgreen.
PC line A line corresponding to an address of the current PC (PC register value) is shown

highlightedNete 1,

Breakpoint line

A line at which a breakpoint is set is shown highlightedN°te 1.

Source text line

The source text corresponding to the code data is displayedN°t 2,

Disassem- | Offset value | The offset value from the nearest label is displayed when a label is defined for the
ble results addressNote 3,
Code The code that is the target of disassembly is displayed in hexadecimal number.
Instruction Instruction is displayed as the result of disassembling.
The mnemonics are shown highlighted in blue.
Note 1. The highlighting color depends on the configuration in the [General - Font and Color] category of
the Option dialog box.
Note 2. The source text can be set to non-display by clicking the button (toggle) on the toolbar or
removing the check for [Mixed Display] from the context menu (this option is checked by default).
Note 3. Offset values are not displayed by default. They can be displayed by clicking the button on the

toolbar or selecting [Show Offset] from the context menu.

This area is provided with the following functions.

Instructions and code displayed in this panel can be edited (line assembly).
See "2.7.4 Perform line assembly" for details on how to operate it.

Execution can be controlled at the instruction level unit by step executing a program in a state where there is a

See "2.8.3 Execute programs in steps" for details on how to operate it.

(@) Line assembly

(b) Program execution by instruction level
focus on this panel.

(c) Setting of various events

Various events can be set to the addresses/lines where the caret currently exists by selecting [Bread Settings],
[Trace Settings] or [Timer Settings] from the context menu.

The corresponding Event mark is displayed in the Event area when an event is set. In addition, the detailed
information about the set event is reflected in the Events panel.

+Note, however, that the setting of events can be done only for those lines where the background color is shown
in white in the event area.

See the following for details on how to set events.

- "2.9.5 Stop the program with the access to variables/SFRs"
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(d)

(e)

V)

(9

(h)

- "2.12.3 Collect execution history in a section"
- "2.12.4 Collect execution history only when the condition is met [[IECUBE][Simulator]"
- "2.13.3 Measure execution time in a section [[ECUBE][Simulator]"

Remark A breakpoint can be set or deleted easily in the Event area as well (see "(a) Setting/deleting
breakpoints").

Registering watch-expression

Variable names of C language, CPU registers, SFR, and assembler symbols can be registered in the Watch
panel as watch-expressions.

See "2.10.6.1 Register a watch-expression" for details on how to operate it.

Moving to symbol definition place

By clicking the button on the toolbar or selecting [Go to Symbol] from the context menu in a state where the
caret has been moved to a instruction that has referenced a symbol, the caret position is moved to the address
where the symbol at the caret position has been defined.

In addition, when following on this operation you click on the button on the toolbar or select [Back to
Address] from the context menu, the caret position is returned to the instruction that has referenced a symbol
before the caret was moved (the address value of the instruction that has referenced a symbol is displayed in
Address).

Jump to source line and memory

Selecting [Jump to Source] from the context menu will open the Editor panel with the caret moved to the source
line corresponding to the address at the current caret position (if the Editor panel is already open, the screen will
jump to the panel).

In addition, similarly, selecting [Jump to Memory] will open the Memory panel (Memory1) with the caret moved
to the memory value corresponding to the address at the current caret position (if the Memory panel (Memory1)
is already open, the screen will jump to the panel).

Code coverage measurement result display [IECUBE][Simulator]

When the coverage function is validN°® lines corresponding to the specified coverage measurement area are
shown highlighted based on the code coverage measurement result that is acquired by executing the program.
See "2.14 Measure Coverage [IECUBE][Simulator]" for details on the coverage measurement.

Note [IECUBE]
The coverage function is always valid.

Saving the contents of disassembled data

The Data Save dialog box can be opened by selecting the [File] menu >> [Save Disassemble Data As...], and
the contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv). See "2.7.2.5 Save the disassem-
bled text contents" for details on the method for saving the contents of disassembled data.

[Toolbar]

Acquires the latest data from the debug tool, and updates the contents of this panel.

Sets to the mixed display mode and displays the correspondence between the disas-
sembled data and the source text (default).

Specifies the caret position so that it follows the current PC value.

Moves the caret to the define position of the selected symbol.

o = ]

Moves the caret to the position (address) immediately before it is moved with the
button.

View The following buttons to set the display contents in the disassemble area are dis-
played.
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Show Offset Displays the offset value of the label. The offset value from the nearest label is dis-
played when a label is defined for the address.

Show Symbol Displays the address value in the format "symbol + offset value" (default).
Note that when a symbol has been defined as the address value, only the symbol is
displayed.

Show Function Name | Displays the name of the register by its function name (default).

Show Absolute Name | Displays the name of the register by its absolute name.

3 Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

[[File] menu (Disassemble panel-dedicated items)]

The following items are exclusive for the [File] menu in the Disassemble panel (other items are common to all the pan-
els).
Note that all these items are disabled during execution of a program.

Save Disassemble Data Overwrites the contents of the disassembling to the previously saved text file (*.txt)/CSV
file (*.csv) (see "(h) Saving the contents of disassembled data").

Note that when the file has never been saved or the file is write disabled, the same
operation is applied as the selection in [Save Disassemble Data As...].

Save Disassemble Data Opens the Data Save dialog box to newly save the contents of the disassembling to the

As... specified text file (*.txt)/CSV file (*.csv) (see "(h) Saving the contents of disassembled
data").

Print... Opens the Print Address Range Settings dialog box for printing the contents of this
panel.

[[Edit] menu (Disassemble panel-dedicated items)]

The following items are exclusive for the [Edit] menu in the Disassemble panel (all other items are disabled).

Copy When a line is selected, copies the contents of the selected line to the clipboard as a
character string.
In the case of the edit mode, copies the selected character string to the clipboard.

Rename Changes to the edit mode to edit the instruction/code at the caret position (see "2.7.4
Perform line assembly").
This item is disabled during execution of a program.

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab.
Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab.
Move... Opens the Go to the Location dialog box to move the caret to the specified address.

[Context menu]

[Disassemble area and Address area]

Register to Watch1 Registers the selected character string or the word at the caret position to the Watch
panel (Watch1) as a watch-expression (the judgment of the word depends on current build
tool).

At this time, since it is registered as a variable name, the symbol name that is displayed
changes depending on the scope.

Register Action Event... Opens the Action Events dialog box to set an action event to the address at the caret
position.
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Go to Here

Executes the program from the address indicated by the current PC value to the address
corresponding to the line at the caret position.

This item is disabled during program execution/build (not including rapid build) execu-
tion.

Set PC to Here

Sets the address of the line at the current caret position to the current PC value.
This item is disabled during program execution/build (not including rapid build) execu-
tion.

Move... Opens the Go to the Location dialog box to move the caret to the specified address.

Go to Symbol Moves the caret to the define position of the selected symbol.

Back to Address Moves the caret to the position (address) immediately before it is moved by [Go to Sym-
E%lzé that this item is disabled when no symbol name is displayed in the address.

Break Settings The following cascade menus are displayed to set the break-related event.

Note that breakpoints can be set only for lines for which events can be set (see "(1)
Event area").

Set Hardware Break

Sets a breakpoint (Hardware Break event to the address at the caret position (see "2.9.3
Stop the program at the arbitrary position (breakpoint)").

Set Software Break
(except [Simulator])

Sets a breakpoint (Software Break event) to the address at the caret position (see "2.9.3
Stop the program at the arbitrary position (breakpoint)").

Set Combination Break
[E1][E20]

Sets a break event (execution type) to the address at the caret position as one of the
condition for a combination break event (see "2.9.4.1 Set a break event (execution
type)")NOte 1.

Set Read Break to

Sets a break event with read access condition to a variable at the caret or a selected
variable (global variable/static variable inside functions/file-internal static variable)/SFR
(see "2.9.5.1 Set a break event (access type)").

Set Write Break to

Sets a break event with write access condition to a variable at the caret or a selected
variable (global variable/static variable inside functions/file-internal static variable)/SFR
(see "2.9.5.1 Set a break event (access type)").

Set R/W Break to

Sets a break event with read/write access condition to a variable at the caret or a
selected variable (global variable/static variable inside functions/file-internal static vari-
able)/SFR (see "2.9.5.1 Set a break event (access type)").

Set Read Combination
Break to
[E1]1[E20]

Sets a break event with read access condition to the line at the caret or the selected vari-
able (global variable, static variable inside functions, or file-internal static variable)/SFR
as one of the condition for a combination break event (see "2.9.5.1 Set a break event
(access type)")Note 1,

Set Write Combination
Break to

Sets a break event with write access condition to the line at the caret or the selected vari-
able (global variable, static variable inside functions, or file-internal static variable)/SFR

[E1][E20] as one of the condition for a combination break event (see "2.9.5.1 Set a break event
(access type)"Note 1,

Set R/W Combination Sets a break event with read/write access condition to the line at the caret or the

Break to selected variable (global variable, static variable inside functions, file-internal static vari-

[E1]1[E20] able)/SFR as one of the condition for a combination break event (see "2.9.5.1 Seta
break event (access type)")Note 1,

Break Option Opens the Property panel to set the break function.

Trace Settings

The following cascade menus are displayed to set the trace-related eventNote 2
Note that events can be set only for lines for which events can be set (see "(1) Event
area").
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Start Tracing Sets a trace start event to start collecting the trace data when an instruction of an
address at the caret position is executed (see "2.12.3.1 Set a Trace event").
[Simulator]
In addition, the selecting of the [Use trace function] property in the [Trace] category on
the Property panel is automatically set to [Yes].
Stop Tracing Sets a trace end event to stop collecting the trace data when an instruction of an address

at the caret position is executed (see "2.12.3.1 Set a Trace event").

[Simulator]
In addition, the selecting of the [Use trace function] property in the [Trace] category on
the Property panel is automatically set to [Yes].

Record Reading Value

Sets a Point Trace event to record the access value as the trace data when a variable at
the caret or the selected variable (global variable, static variable inside functions, file-
internal static variable) or SFR is read accessed (see "2.12.4.1 Set a Point Trace
event").

Record Writing Value

Sets a Point Trace event to record the access value as the trace data when a variable at
the caret or the selected variable (global variable, static variable inside functions, file-
internal static variable) or SFR is write accessed (see "2.12.4.1 Set a Point Trace
event").

Record R/W Value

Sets a Point Trace event to record the access value as the trace data when a variable at
the caret or a selected variable (global variable/static variable inside functions/file-inter-
nal static variable)/SFR is read/write accessed (see "2.12.4.1 Set a Point Trace event").

Record Start R/'W
Value
[E1][E20][COM Port]

Sets a trace start event to start collecting the trace data when a variable at the caret or
the selected variable (global variable, static variable inside functions, file-internal static
variable) /SFR is read/ write accessed (see "2.12.3.1 Set a Trace event").

Record End R/W Value
[E1][E20][COM Port]

Sets a trace end event to stop collecting the trace data when a variable at the caret or
the selected variable (global variable, static variable inside functions, file-internal static
variable) /SFR is read/ write accessed (see "2.12.3.1 Set a Trace event").

Show Trace Result

Opens the Trace panel and displays the acquired trace data.

Trace Settings

Opens the Property panel to set the trace function.

Timer Settings
[IECUBE][Simulator]

The following cascade menus are displayed to set the timer-related event (see "2.13.3
Measure execution time in a section [I[ECUBE][Simulator]").

Note that events can be set only for lines for which events can be set (see "(1) Event
area").

Start timer

Sets a timer start event to start measuring the execution time of the program when an
instruction of an address at the caret position is executed.
[Simulator]
In addition, the selecting of the [Use timer function] property in the [Timer]
[[ECUBE][Simulator] category on the Property panel is automatically set to [Yes].

Stop timer

Sets a timer end event to stop measuring the execution time of the program when an
instruction of an address at the caret position is executed.
[Simulator]
In addition, the selecting of the [Use timer function] property in the [Timer]
[[ECUBE][Simulator] category on the Property panel is automatically set to [Yes].

View Result of Timer

Opens the Events panel and displays only timer-related events.

Clear Coverage Informa-
tion

Clears all the coverage measurement results currently being stored in the debug tool.
Note that this item appears only when the debug tool used supports the coverage func-
tion.

Edit Disassemble

Changes to the edit mode to edit the instruction of the line at the caret position (see
"2.7.4 Perform line assembly").
This item is disabled during execution of a program.
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Edit Code Changes to the edit mode to edit the code of the line at the caret position (see "2.7.4
Perform line assembly").
This item is disabled during execution of a program.
View The following cascade menus to set the display contents in the disassemble area are
displayed.
Show Offset Displays the offset value of the label. The offset value from the nearest label is displayed
when a label is defined for the address.
Show Symbol Displays the address value in the format "symbol + offset value" (default).

Note that when a symbol has been defined as the address value, only the symbol is dis-
played.

Show Function Name

Displays the name of the register by its function name (default).

Show Absolute Name

Displays the name of the register by its absolute name.

Settings Scroll Range...

Opens the Scroll Range Settings dialog box to set the scroll range for this panel.

Mixed Display

Sets to the mixed display mode and displays the correspondence between the disas-
sembled data and the source text (default).

Jump to Source

Opens the Editor panel and jumps to the source line corresponding to the address at the
caret position in this panel.

Jump to Memory

Opens the Memory panel (Memory1) and jumps to the memory value corresponding to
the address at the caret position in this panel.

Note 1. [E1][E20]

This item is displayed only when the selected microcontroller supports combination break events.

Note 2. [E1][E20][EZ Emulator][COM Port]
This item is enabled only when the selected microcontroller incorporates the OCD trace function.

[Event area] (except [Simulator])

Hardware Break First

The type of break that can be set by a one click operation of the mouse is set as a hard-
ware breakpoint (this is reflected in the setting of the [First using type of breakpoint] prop-
erty in the [Break] category on the Property panel).

Software Break First

The type of break that can be set by a one click operation of the mouse is set as a software
breakpoint (this is reflected in the setting of the [First using type of breakpoint] property in
the [Break] category on the Property panel).
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CPU Register panel

This panel is used to display the contents of the CPU register (general-purpose registers and control registers) and
change the CPU register values (see "2.10.2 Display/change the CPU register").
This panel appears only when connected to the debug tool.

Remark 1. This panel can be zoomed in and out by |1 a0x -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.

Figure A.11 CPU Register Panel
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This section describes the following.
- [How to open]
- [Description of each area]
- [Toolbar]
- [[File] menu (CPU Register panel-dedicated items)]
- [[Edit] menu (CPU Register panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [CPU Register].

[Description of each area]

(1) [Register Name] area
The types of register are classified as categories (folders), and a list of the respective register names is displayed.
Note that neither category names nor register names can be edited and deleted.
The meanings of the icons are as follows:

L{ Indicates that the register name belonging to this category is displayed. When you double-click
on the icon, or click on the "-" mark, the category is closed and the register name is hidden.

& Indicates that the register name belonging to this category is hidden. When you double-click on
the icon, or click on the "+" mark, the category is opened and the register name is displayed.

J Indicates the name of the register. When you double-click on the icon, or click on the "+" or
marks, the name of the register part is displayed or hidden.

R20UT5301EJ0100 Rev.1.00 ENESAS Page 207 of 413
Jun 01, 2023



CS+V8.10.00

A. WINDOW REFERENCE

=1 Indicates the name of the register part.

Category names and register names displayed are as follows (number of "+" marks before register names indi-
cates the depth of the display level):

Table A.3 Category Names and Register Names in CPU Register Panel
Category Name Register Name (Alias) Bit Width Description
General-purpose + AX(RPO) 16 General-purpose register (current register
register ++ X(RO) 8 bank)
++ A(R1) 8
+ BC(RP1) 16
++ C(R2) 8
++ B(R3) 8
+ DE(RP2) 16
++ E(R4) 8
++ D(R5) 8
+ HL(RP3) 16
++ L(R6) 8
++ H(R7) 8
Control register + PC 20 Program counter
+ PSW 8 Program status word
++ |E 1 Interrupt enable flag
++Z 1 Zero flag
++ RBS1 1 Register bank selection flag
++ AC 1 Auxiliary carry flag
++ RBSO 1 Register bank selection flag
++ ISP1 1 In service priority flag
++ ISPO 1 In service priority flag
++ CY 1 Carry flag
+ SP 16 Stack pointer
+ ES 8 ES register
+CS 8 CS register
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Category Name Register Name (Alias) Bit Width Description
General-purpose + AX(RPO): Register bankn | 16 General-purpose register (Register bank n)
register: Register )
bank n'\ote + X(RO): Register bank n | 8

++ A(R1): Register bank n | 8

+ BC(RP1): Registerbankn | 16

++ C(R2): Register bank n | 8

++ B(R3): Register bank n | 8

+ DE(RP2): Register bank n | 16

++ E(R4): Register bank n | 8

++ D(R5): Register bank n | 8

+ HL(RP3): Register bank n | 16

++ L(R6): Register bank n | 8

++ H(R7): Register bank n | 8

Note "n" indicates the number of the register bank (n =0, 1, 2, 3).

Table A.4 Category Names and Register Names in FAA Register Panel

Category Name Register Name | Bit Width Description
(Alias)

Operation parameter register AO 32 Accumulator

set MO 32 Multiplier register
M1 32 Shift count register
LO 32 Upper limit register
L1 32 Lower limit register
RO 32 Addend register

Address pointer set DPO 12 Address pointer for accumulator
DP1 12 Address pointer for operation parameters
RPO 12 Address pointer for storing operation results
PGO 12 Program pointer
SPO 12 Stack pointer
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Category Name Register Name | Bit Width Description
(Alias)
Control Register +FAACNT 16 Processor Control Register
++START 1 Program execution bit
+FAAFLG 16 Flag Bit Register
++| 1 Interrupt flag
++ZERO 1 Zero flag
++UNDER 1 Under flag
++OVER 1 Over flag
+SYSC 16 System Control Register
++EXE 1 Processor operating bit
++ENB 1 Operation enable bit
++SRST 1 Software reset bit
++SLP 1 Sleep bit

This area is provided with the following functions.

(a) Registering watch-expression

CPU registers/categories can be registered in the Watch panel as watch-expressions.
See "2.10.6.1 Register a watch-expression" for details on how to operate it.

Remark 1.

Remark 2.

When you have registered a watch-expression with a category as the object, all of the CPU reg-

isters belonging to that category are registered as watch-expressions.

(2) [Value] area
The values of each CPU register are displayed and changed.
The radix of a data value can be selected by the button on the toolbar or the context menu item. In addition, a dis-
play format adding the value in hexadecimal number constantly can also be selected as well.
The meanings of the colors of the CPU register values are as follows (character colors and background colors
depend on the configuration in the [General - Font and Color] category of the Option dialog box):

A scope specification is automatically added to a registered watch-expression.

Display Example (Default)

Description

00

Character color

Blue

Background color

Standard color

The value of the CPU register that the user is changing
Press the [Enter] key to write to the target memory.

Q=0

Character color

Brown

Background color

Cream

The value of the CPU register that has been changed because
of the execution of a program.
The highlighting is rest by executing again the program.

This area is provided with the following functions.

(@) Changing the CPU register value
To edit the CPU register value, select the value to edit, then change the value directly from the keyboard after

clicking again on it (press the [Esc] key to cancel the edit mode).

After you edit the value of the CPU register, it is written to the target memory of the debug tool by pressing the
[Enter] key or moving the focus to outside the edit region.

(b) Saving the contents of the CPU register
The Save As dialog box can be opened by selecting the [File] menu >> [Save CPU Register Data As...], and all
the contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).

See "2.10.2.4 Save the CPU register contents" for details on the method for saving the contents of the CPU
register.
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[Toolbar]
El| Acquires the latest data from the debug tool, and updates the contents of this panel.
This item is disabled during execution of a program.
Notation The following buttons to change the notation of a data value are displayed.

AutoSelect

Displays the value of the selected item (including sub-items) in the default notation
(default).

Hexadecimal

Displays the value of the selected item (including sub-items) in hexadecimal number.

Signed Decimal

Displays the value of the selected item (including sub-items) in signed decimal number.

Unsigned Decimal

Displays the value of the selected item (including sub-items) in unsigned decimal number.

Octal

Displays the value of the selected item (including sub-items) in octal number.

Binary

Displays the value of the selected item (including sub-items) in binary number.

ASCII

Displays the character string of the selected item (including sub-items) in ASCII code. If
the character size is 2 bytes and above, it is displayed with the characters for each 1 byte
arranged side-by-side.

Float

Displays the value of the selected item in Float.
Note that when the value is not 4-byte data, displays it in the default notation.

Double

Displays the value of the selected item in Double.
Note that when the value is not 8-byte data, displays it in the default notation.

Adds the value in hexadecimal number enclosing with "()" at the end of the value.

[[File] menu (CPU Register panel-dedicated items)]

The following items are exclusive for the [File] menu in the CPU Register panel (other items are common to all the pan-
els).
Note that all these items are disabled during execution of a program.

Save CPU Register
Data

Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file (*.csv)
(see "(b) Saving the contents of the CPU register").

Note that when the file has never been saved or the file is write disabled, the same opera-
tion is applied as the selection in [Save CPU Register Data As...].

Save CPU Register
Data As...

Opens the Save As dialog box to newly save the contents of this panel to the specified text
file (*.txt)/CSYV file (*.csv) (see "(b) Saving the contents of the CPU register").

[[Edit] menu (CPU Register panel-dedicated items)]

The following items are exclusive for [Edit] menu in the CPU Register panel (all other items are disabled).

Cut Deletes the selected character string and copies it to the clipboard.
This item becomes valid only when the character string is being edited.
Copy Copies the selected character string to the clipboard during editing.
If a line is selected, copies the register or the category to the clipboard.
The copied item can be pasted to the Watch panel.
Paste Pasts the character string copied in the clipboard to the caret position.
This item becomes valid only when the character string is being edited.
Select All Selects all the items of this panel.
Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab.
Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab.
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[Context menu]

Register to Watch1 Registers the selected register or category to the Watch panel (Watch1).
Copy Copies the selected character string to the clipboard during editing.
If a line is selected, copies the register or the category to the clipboard.
The copied item can be pasted to the Watch panel.
Notation The following cascade menus to specify the notation of a data value are displayed.
AutoSelect Displays the value of the selected item (including sub-items) in the default notation
(default).
Hexadecimal Displays the value of the selected item (including sub-items) in hexadecimal number.

Signed Decimal

Displays the value of the selected item (including sub-items) in signed decimal number.

Unsigned Decimal

Displays the value of the selected item (including sub-items) in unsigned decimal number.

Octal Displays the value of the selected item (including sub-items) in octal number.

Binary Displays the value of the selected item (including sub-items) in binary number.

ASCII Displays the character string of the selected item (including sub-items) in ASCII code.
If the character size is 2 bytes and above, it is displayed with the characters for each 1
byte arranged side-by-side.

Float Displays the value of the selected item in Float.

Note that when the value is not 4-byte data, displays it in the default notation.

Double Displays the value of the selected item in Double.

Note that when the value is not 8-byte data, displays it in the default notation.

Include Hexadecimal
Value

Adds the value in hexadecimal number enclosing with "()" at the end of the value.
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SFR panel

This panel is used to display the contents of the SFR and change the SFR values (see "2.10.3 Display/change the
SFR").
This panel appears only when connected to the debug tool.

Caution The SFR that cause the microcontroller to operate when it is read is read-protected and therefore cannot
be read ("?" is displayed in the value).
To read the value of read-protected SFR, select [Force Read Value] from the context menu.

Remark 1. This panel can be zoomed in and out by |1 a0k -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.

Figure A.12 SFR Panel
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (SFR panel-dedicated items)]
- [[Edit] menu (SFR panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [SFR].

[Description of each area]

(1) Search area
This area is used to search for the SFR name.

|= Specifies the character strings to search (case-insensitive).
You can either type character strings directly from the key board (up to 512 characters), or
select one from the input history via the drop-down list (up to 10 items).
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(2)

(a)

(b)

Searches up for the SFR name containing the string specified in the text box, and selects
the SFR that is found.

[E Searches down for the SFR name containing the string specified in the text box, and selects
the SFR that is found.

Remark 1. A hidden SFR name being classified with a category can be searched (the category is opened and
the SFR is selected).

Remark 2. After typing character strings to search, to press the [Enter] key is the same function as clicking the
button, and to press the [Shift] + [Enter] key is the same function as clicking the button.

[SFR] area
The types of SFR are classified as categories (folders), and a list of the respective SFR name is displayed.
The meanings of the icons are as follows:

Indicates that the SFR name belonging to this category is displayed. When you double-click on
the icon, or click on the "-" mark, the category is closed and the SFR name is hidden.
Note that no categories exist by default. Perform Tree editing if you need a category.

Indicates that the SFR name belonging to this category is hidden. When you double-click on the
icon, or click on the "+" mark, the category is opened and the SFR name is displayed.
Note that no categories exist by default. Perform Tree editing if you need a category.

= Indicates the name of the SFR.

Remark The category names are sorted in character code order by clicking on the header part of this area
(the SFR names in the category are also similarly sorted).

This area is provided with the following functions.

Tree editing

The each SFR can be categorized (by folders) and displayed in the tree view.

To create a category, Click the button on the toolbar or select [Create Category] from the context menu after
moving the caret to a SFR name to create a category, and then input a desired name from the keyboard (up to

1024 characters).

To delete a category, select the category then click the button on the toolbar or select [Delete] from the con-
text menu. However, the categories that can be deleted are only the empty categories.

To rename the created category, select the category then do either one of the following.

- Click the name again, then directly rename the category name.

- Select the [Edit] menu >> [Rename], then directly rename the category name.

- Press the [F2] key, then directly rename the category name.

By directly dragging and dropping the SFR in the created category, each SFR is displayed in the categorized
tree view.

Also, the display order of the categories and the SFR names (upper or lower position) can be changed easily by
drag and drop operation.

To clear and restore an edited category, click on the 4" button on the toolbar or select [Clear customization]
from the context menu.

Remark SFRs are categorized according to their initial states in CS+ V8.07.00 and later versions. When
customization is cleared, SFRs are classified in their default categories.

Caution 1.  Categories cannot be created within categories.
Caution 2.  SFRs cannot be added or deleted.

Registering a watch-expression

Variable names of C language, CPU registers, SFR, and assembler symbols can be registered in the Watch
panel as watch-expressions.

See "2.10.6.1 Register a watch-expression" for details on how to operate it.

Remark 1. When you have registered a watch-expression with a category as the object, all of SFR belong-
ing to that category are registered as watch-expressions.

Remark 2. A scope specification is automatically added to a registered watch-expression.
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(3) [Value] area
The value of SFR is displayed and changed.
The radix of a data value can be selected by the button on the toolbar or the context menu item. In addition, a dis-
play format adding the value in hexadecimal number constantly can also be selected as well.
The meanings of the marks and colors displayed as SFR values are as follows (character colors and background
colors depend on the configuration in the [General - Font and Color] category of the Option dialog box):

Display Example (Default) Description

Q=0 Character color Blue The value of the SFR that the user is changing (press the
[Enter] key to write to the target memory).

Background color | Standard color

0 Character color Brown The value of the SFR that has been changed because of the
execution of a program
Background color | Cream To reset the highlighting, select the button on the toolbar or

[Reset Color] from the context menu.

b Character color Gray The value of the SFR that is a read-protected objectNOte

Background color | Standard color

Note An SFR for which the microcontroller ends up being activated by a read operation is shown.
To read the value of read-protected SFR, select [Force Read Value] from the context menu.

Caution The timing for acquiring the values differs in the case of a 1 byte/2 bytes SFR and that of 1 bit SFRs
that have been allocated to a 1 byte/2 bytes SFR. Owing to this, there are also cases where the
values differ even if the value of the same SFR is displayed.

Remark The values are sorted in ascending order of the numerical values by clicking on the header part of
this area.

This area is provided with the following functions.

(@) Changing SFR values
To edit the SFR value, select the value to edit, then change the value directly from the keyboard after clicking
again on it (press the [Esc] key to cancel the edit mode).
After you edit the value of the SFR, it is written to the register of the debug tool by pressing the [Enter] key, or
moving the focus to outside the edit region.
See "2.10.3.4 Modify the SFR contents" for details on the method for changing the SFR value.

(b) Saving the contents of the SFR
The Save As dialog box can be opened by selecting the [File] menu >> [Save SFR Data As...], and all the con-
tents of the SFR can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.10.3.6 Save the SFR contents" for details on the method for saving the contents of the SFR.

(4) [Type (Byte Size)] area
The type information of each SFR is displayed in the following formats.

- <Type of SFR> [<Access attribute> <All accessible sizes>](<Size>)

Access attribute One of the following is displayed as the access attribute.
R Read only
W Write only
R/W Read/Write
All accessible All accessible sizes are demarcated by a comma and listed in order of the smallest size in
sizes bit units.
Size The size of the SFR is displayed.
It is displayed by supplying the unit, in byte units in the event that it can be displayed in
byte units, and in bit units in the event that it can be displayed on in bit units.

Example 1.  "The case of "SFR [R/W 1.8] (1 byte)"
An SFR that is readable/writable and 1 bit accessible/8 bit accessible, and whose size is 1 byte
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Example 2.  "The case of "SFR [R/W 1] (1 bit)"
An SFR that is readable/writable and 1 bit accessible, and whose size is 1 byte

Remark The type information is sorted in the character code order by clicking on the header part of this
area.

(5) [Address] area
The address that each SFR is mapped is displayed (hexadecimal number notation fixing).
However, in the case of the bit register, it is displayed by providing a bit offset value like the following examples.

Example 1.  The case of "0xFF40"
This is allocated to the address "OxFF40"

Example 2.  The case of "0xFF40.4"
This is allocated to bit 4 of the address "OxFF40.4" (bit register)

Remark The addresses are sorted in ascending order of numerical values by clicking on the header part of
this area.

[Toolbar]

E| Acquires the latest data from the debug tool, and updates the contents of this panel.
Note that the values of read-protected SFR are not re-read.
This item is disabled during execution of a program.

Resets highlighting of the selected SFR whose value has been changed by executing a
program.
Note that this item is disabled during execution of a program.

Adds a new category (folder). Directly input the category name in the text box.

There are no restrictions on the number of categories that can be created anew (how-
ever, it is not possible to create a category inside a category).

Note that this item is disabled during execution of a program.

. & Clears the user customization (creation of categories, changing orders, and changing
notation).
Deletes the selected character string(s).
If an empty category is in a select state, its category is deleted (it is not possible to delete
SFRs).
Notation The following buttons to change the notation of a data value are displayed.
Hexadecimal Displays the value of the selected item in hexadecimal number (default).

Signed Decimal Displays the value of the selected item in signed decimal number.

Unsigned Decimal | Displays the value of the selected item in unsigned decimal number.

Octal Displays the value of the selected item in octal number.
Binary Displays the value of the selected item in binary number.
ASCII Displays the value of the selected item in ASCII code.
Adds the value in hexadecimal number enclosing with "()" at the end of the value of the

selected item.

[[File] menu (SFR panel-dedicated items)]

The following items are exclusive for the [File] menu in the SFR panel (other items are common to all the panels).
Note that all these items are disabled during execution of a program.
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Save SFR Data

Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file
(*.csv) (see "(b) Saving the contents of the SFR").

Note that when the file has never been saved or the file is write disabled, the same
operation is applied as the selection in [Save SFR Data As...].

Save SFR Data As...

Opens the Save As dialog box to newly save the contents of this panel to the speci-
fied text file (*.txt)/CSV file (*.csv) (see "(b) Saving the contents of the SFR").

[[Edit] menu (SFR panel-dedicated items)]

The following items are exclusive for [Edit] menu in the SFR panel (all other items are disabled).

Cut Deletes the selected character string(s) and copies them to the clipboard (it is not
possible to cut SFRs/categories).

Copy Copies the contents of the selected range to the clipboard as character string(s).
If the SFR(s)/category(s) are selected, copies them to the clipboard.
The copied item can be pasted to the Watch panel.

Paste If texts are in editing, pastes the contents of the clipboard to the caret position (it is
not possible to paste SFRs/categories).

Delete Deletes the selected character string(s).
If an empty category is in a select state, its category is deleted (it is not possible to
delete SFRs).

Select All If texts are in editing, selects all the character strings.
If texts are not in editing, selects all the SFRs/categories.

Rename Edits the name of the selected category.

Find... Moves the focus to the text box in the Search area.

Move... Opens the Go to the Location dialog box to move the caret to the specified SFR.

[Context menu]

Register to Watch1

Registers the selected SFR or category to the Watch panel (Watch1).

Refresh

Acquires the latest data from the debug tool, and updates the contents of this panel.
Note that the values of read-protected SFR are not re-read.
This item is disabled during execution of a program.

Force Read Value

Forcibly reads once the value of the read-protected SFR.

Move...

Opens the Go to the Location dialog box.

Create Category

Adds a new category (folder). Directly input the category name in the text box.
There are no restrictions on the number of categories that can be created anew
(however, it is not possible to create a category inside a category).

Note that this item is disabled during execution of a program.

Clear customization

Clears the user customization (creation of categories, changing orders, and chang-
ing notation).

Copy Copies the contents of the selected range to the clipboard as character string(s).
If the SFR(s)/category(s) are selected, copies them to the clipboard.
The copied item can be pasted to the Watch panel.

Delete Deletes the selected character string(s).

If an empty category is in a select state, its category is deleted (it is not possible to
delete SFRs).
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Notation The following cascade menus are displayed to specify the notation.
Hexadecimal number Displays the value of the selected item in hexadecimal number (default).
Signed Decimal Displays the value of the selected item in signed decimal number.

Unsigned decimal number | Displays the value of the selected item in unsigned decimal number.

Octal Displays the value of the selected item in octal number.
Binary Displays the value of the selected item in binary number.
ASCII Displays the value of the selected item in ASCII code.

Include Hexadecimal Value | Adds the value in hexadecimal number enclosing with "()" at the end of the value of
the selected item.

Reset Color Resets highlighting of the selected SFR whose value has been changed by execut-
ing a program.
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Local Variables panel

This panel is used to display the contents of the local variable and change the local variable values (see "2.10.5 Dis-
play/change local variables").
This panel appears only when connected to the debug tool.

Caution 1.  Nothing is displayed on this panel during execution of a program. When the execution of a program is
stopped, items in each area are displayed.

Caution 2.  Because of optimization by a compiler, for blocks where variables, or the subject to be operated on, are
not in use, there may be no variable data in the stack and registers. In this case, no variables are dis-
played that are the subject to be operated on.

Remark 1. This panel can be zoomed in and out by |1 a0x '-| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.

Figure A.13 Local Variables Panel
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This section describes the following.

- [How to open]

- [Description of each areal

- [Toolbar]

- [[File] menu (Local Variables panel-dedicated items)]

- [[Edit] menu (Local Variables panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Local Variable].

[Description of each area]

(1) Scope area
Select the scope of the local variable to be displayed from the following drop-down list.

Item Operation

Current Displays local variables in the scope of the current PC value.

<Depth> <Function name() [file name#line | Displays local variables in the scope of the calling function.
number]>Note 1.2 After the program is executed, the scope that is selected is main-
tained as long as the selected scope exists.
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Note 1. The calling functions displayed on theCall Stack panel are displayed.

Note 2. When scope information that has lost its reliability, items in the list is shown in gray (the character
color/background color when showing "Invalid" depends on the configuration in the [General - Font
and Color] category of the Option dialog box).

(2) [Name] area
The local variable name or function name is displayed.
The argument of the function is also displayed as the local variable.
In addition, the hierarchical structure is displayed in tree format for arrays, pointer variables, and structures/
unions/class.
This area cannot be edited.
The meanings of the icons are as follows:

. Indicates the variable. Auto, Internal Static, and Register variables are also displayedNOte.

In addition, the hierarchical structure is displayed in tree format for arrays, pointer variables, and struc-
tures/unions/class.

If "+" mark exist at the top of the name, the next structure is expanded by clicking it (the mark changes
to "-" after the expansion).

Array All elements in the array

Pointer variables | Variables that the pointer designates
If the pointer designates a pointer, add "+" mark and expand it by clicking the mark.
Note that if the pointer designates an unknown, "?" mark is displayed.

Structures/ All the member of structures/unions/class
Unions/class

Indicates the argument.

Indicates the function.

Note When Auto variables are used to display local variables, accurate values cannot be displayed at a
prologue ("{") or epilogue ("}") of a function. The Auto variable addresses are the relative
addresses from the address pointed to by the stack pointer (SP), so their addresses are not deter-
mined until the SP value is determined in the function. The SP is manipulated via prologues or epi-
logues, so the accurate value cannot be displayed.

This area is provided with the following functions.

(a) Registering watch-expression
Variable names of C language can be registered in the Watch panel as watch-expressions.
See "2.10.6.1 Register a watch-expression" for details on how to operate it.

Remark A scope specification is automatically added to a registered watch-expression.

(b)  Jump to memory
By selecting [Jump to Memory] from the context menu, the Memory panel (Memory1) opens with moving the
caret to the source line corresponding to the address where the selected local variable is disposed (if the Mem-
ory panel (Memory1) is already open, the screen will jump to the panel).

(3) [Value] area
The value of the local variable is displayed and changed.
The notation of a data value can be selected by the button on the toolbar or the context menu item. In addition, a
display format adding the value in hexadecimal number constantly can also be selected as well.
The meanings of the marks and colors displayed as the values of the local variables are as follows (character col-
ors and background colors depend on the configuration in the [General - Font and Color] category of the Option

dialog box):
Display Example (Default) Description
00 | Character color Blue The value of the local variable that the user is changing
Press the [Enter] key to write to the target memory.
Background color | Standard color
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Display Example (Default) Description
00 | Character color Brown The value of the local variable that have been changed because
of the execution of a programN°te.
Background color | Cream The highlighting is rest by executing again the program.
7 Character color Gray The value of the local variable that could not be acquired.
Background color | Standard color

Note Variables that the name stays same from the start point where the program started executing to the
breakpoint and their values are changed are the target.

This area is provided with the following functions.

(a) Changing the local variable/argument value
To edit the local variable value or the argument value, select the value to edit, then change the value directly
from the keyboard after clicking again on it (press the [Esc] key to cancel the edit mode).
After you edit the value of the local variable or the argument, it is written to the target memory of the debug tool
by pressing the [Enter] key or moving the focus to outside the edit region.
See "2.10.5.2 Modify the contents of local variables" for details on the method for changing the local variable/
argument value.

(b) Saving the contents of the local variable
The Save As dialog box can be opened by selecting the [File] menu >> [Save Local Variables Data As...], and all
the contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.10.5.3 Save the contents of local variables" for details on the method for saving the contents of the local
variable.

(4) [Type (Byte Size)] area
The type name of the local variable is displayed. The notation accords with the description of C language.
For an array, an element number is displayed in "[]". For a function, its size (number of bytes) is displayed in "()".
This area cannot be edited.

(5) [Address] area
The address of the local variable is displayed. When a variable is assigned to the register, the name of the register

is displayed.
This area cannot be edited.

[Toolbar]
These buttons below are disabled during execution of a program.
El| Acquires the latest data from the debug tool, and updates the con-
tents of this panel.
Notation The following buttons to specify the notation of values are displayed.
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AutoSelect Displays values on this panel in the default notation according to the
type of variable (default).

Hexadecimal Displays values on this panel in hexadecimal number.

Decimal Displays values on this panel in decimal number.

Octal Displays values on this panel in octal number.

Binary Displays values on this panel in binary number.

Decimal Notation for Array Index Displays array indexes on this panel in decimal number (default).

Hexadecimal Notation for Array Index | Displays array indexes on this panel in hexadecimal number.

Float Displays values on this panel in Float.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation.

Double Displays values on this panel in Double.
Note that when the value is not 4-byte data, or has the type informa-
tion, displays it in the default notation.

Adds the value in hexadecimal number enclosing with "()" at the end
of the value.
Encoding The following buttons to specify the encoding of character variables
are displayed.
Displays character variables in ASCII code (default).
Displays character variables in Shift_JIS code.
Displays character variables in EUC-JP code.
7 Displays character variables in UTF-8 code.
= Displays character variables in UTF-16 code.

[[File] menu (Local Variables panel-dedicated items)]

The following items are exclusive for the [File] menu in the Local Variables panel (other items are common to all the pan-
els).
Note that all these items are disabled during execution of a program.

Save Local Variables Data | Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file
(*.csv) (see "(b) Saving the contents of the local variable").

Note that when the file has never been saved or the file is write disabled, the same
operation is applied as the selection in [Save Local Variables Data As...].

Save Local Variables Data | Opens the Save As dialog box to newly save the contents of this panel to the specified
As... text file (*.txt)/CSV file (*.csv) (see "(b) Saving the contents of the local variable").

[[Edit] menu (Local Variables panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Local Variables panel (all other items are disabled).

Copy Copies the contents of the selected line or the character string to the clipboard.
Select All Selects all the items of this panel.
Rename Changes to the edit mode to edit the selected local variable value (see "2.10.5.2 Modify

the contents of local variables").
This item is disabled during execution of a program.

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab.
R20UT5301EJ0100 Rev.1.00 RENESAS Page 222 of 413

Jun 01, 2023



CS+V8.10.00

A. WINDOW REFERENCE

Replace...

Opens the Find and Replace dialog box with selecting the [Replace in Files] tab.

[Context menu]

Register to Watch1 Registers the selected local variable to the Watch panel (Watch1).
Copy Copies the contents of the selected line or the character string to the clipboard.
Notation The following cascade menus to specify the notation of values are displayed.
AutoSelect Displays values on this panel in the default notation according to the type of variable
(default).
Hexadecimal Displays values on this panel in hexadecimal number.
Decimal Displays values on this panel in decimal number.
Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.

Decimal Notation for
Array Index

Displays array indexes on this panel in decimal number (default).

Hexadecimal Notation
for Array Index

Displays array indexes on this panel in hexadecimal number.

Float Displays values on this panel in Float.
Note that when the value is not 4-byte data, or has the type information, displays it in the
default notation.

Double Displays values on this panel in Double.
Note that when the value is not 4-byte data, or has the type information, displays it in the
default notation.

Include Hexadecimal Adds the value in hexadecimal number enclosing with "()" at the end of the value.
Value
Encoding The following cascade menus to specify the encoding of character variables are dis-
played.

ASCII Displays character variables in ASCII code (default).

Shift_JIS Displays character variables in Shift_JIS code.

EUC-JP Displays character variables in EUC-JP code.

UTF-8 Displays character variables in UTF-8 code.

UTF-16 Displays character variables in UTF-16 code.

Jump to Memory Opens the Memory panel (Memory1) and jumps to the memory value corresponding to

the address of the selected line in this panel.
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Watch panel

This panel is used to display the contents of the registered watch-expressions and change their values (see "2.10.6
Display/change watch-expressions").

Up to a maximum of four of these panels can be opened. Each panel is identified by the names "Watch1", "Watch2",
"Watch3", and "Watch4" on the titlebar, and the watch-expressions can be registered/deleted/moved individually.

Watch-expressions can be registered in this panel as well as in the Editor panel, Disassemble panel, Memory panel,
CPU Register panel, Local Variables panel or SFR panel.

When the panel is closed with registered watch-expressions, the panel closes but the information on the registered
watch-expressions is retained. Therefore, if the same panel is opened again, it is opened with the watch-expressions reg-
istered.

The display contents are automatically updated when the value of the watch-expression changes after a program is
executed (when the execution is done in steps, the display is updated after each step).

In addition, by enabling the Real-time display update function, it is also possible to update the display contents in real-
time even while a program is being executed.

This panel appears only when connected to the debug tool.

Caution 1. It is not possible to display or change the CPU register contents during program execution.

Caution 2.  In a block where a variable that is the subject of operation is not used, variable data may not always exist
in the stack or register, due to optimization by a compiler. In this case, even when a variable that is the
subject of operation is registered as a watch-expression, the displayed value remains marked with "?."

Remark 1. This panel can be zoomed in and out by |1 a0x -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Remark 2. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.

Figure A.14 Watch Panel
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This section describes the following.

- [How to open]

- [Description of each areal

- [Toolbar]

- [[File] menu (Watch panel-dedicated items)]
- [[Edit] menu (Watch panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Watch] >> [Watch{ - 4].
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[Description of each area]

(1) [Watch] area
All the registered watch-expressions are displayed in a list.
Clicking the title of the list in this area sorts the watch-expressions in the list in alphabetical order.
Categories (folders) can be created to categorize the watch-expressions and display them in the tree view (see
"(a) Tree editing").
The meanings of the icons are as follows:

Indicates that the watch-expression belonging to this category is displayed. When you double-
click on the icon, or click on the "-" mark, the category is closed and the watch-expression is
hidden.

Indicates that the watch-expression belonging to this category is hidden. When you double-
click on the icon, or click on the "+" mark, the category is opened and the watch-expression is
displayed.

. Indicates that the watch-expression is a variable.
At the top of the watch-expression represents arrays, pointer type variables, and structures/
unions/class, "+"/"-" mark is displayed. Click the mark to Expand/shrink display.

Indicates that the watch-expression is a function.

EE Indicates that the watch-expression is an immediate value.
fied Indicates that the watch-expression is an expression.

5 Indicates that the watch-expression is SFR.

J Indicates that the watch-expression is CPU register.

At the top of the watch-expression that has the lower level register (part of the register), "+"/"-"
mark is displayed. Click the mark to Expand/shrink display.

This area is provided with the following functions.

(a) Tree editing
Watch-expressions can be categorized (by folders) and displayed in the tree view.
To create a category, click the button on the toolbar or select [Create Category] from the context menu after
moving the caret to the position to create a category, and then input a desired name from the keyboard.
To delete a category, select the category then click the button on the toolbar or select [Delete] from the con-
text menu.
To rename the created category, select the category then do either one of the following.

- Click the name again, then directly rename the category name.

- Select the [Edit] menu >> [Rename], then directly rename the category name.

- Press the [F2] key, then directly rename the category name.

By directly dragging and dropping the registered watch-expression in the created category, each category is dis-
played in the categorized tree view.

Also, the display order of the categories and the watch-expressions (upper or lower position) can be changed
easily by drag and drop operation.

Caution 1.  Categories cannot be created within categories.

Caution 2.  Up to 1500 categories can be created in one watch panel (if this restriction is violated, a message
appears).

Remark Drag and drop the watch-expressions/categories in other watch panel (Watch1 to Watch4) to
copy them.

(b) Expand/shrink display
At the top of the watch-expression represents arrays, pointer type variables, structures/unions/class, and regis-
ters (with the name of the part), "+"/"-" mark is displayed. Click the mark to expand the contents ("+" mark is
changed to "-" after the expansion).
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Watch-Expression

Contents When Expanded

Array

All elements in the array
Select [Encoding] >> [ASCII] from the context menu to display the value as a string
(up to 256 characters). Note, however, that any characters that cannot be dis-

played in the encoding will be shown as periods "." or "?".

Pointer type variable

Variables that the pointer designates

Structure/Union/class

All the member of structure/union/class

Register

Name of the bit/bit string that constructs register

Example) AX register
A register
X register

(c)

Registering new watch-expression
There are three ways as follows to register new watch-expressions.

Caution Up to 128 watch-expressions can be registered in one watch panel (if this restriction is violated, a

message appears).

<1> Register from other panels
Do either one of the following to register watch-expressions in other panels.

- Drag and drop the target character string onto this area in the desired watch panel (Watch1 to Watch4).

- Select [Register to Watch1] from the context menu after selecting the target character string or place the
caret on either of the target character string (the target is automatically determined).

- Select the [Edit] menu >> [Paste] in this area in the desired watch panel (Watch1 to Watch4) after selecting
the [Edit] menu >> [Copy] for the target character string.

The relationship between panels that can use this operation and targets that can be registered as watch-
expressions is as follows:

Table A.5 Relationship between Panels and Targets That Can be Registered as Watch-Expressions
Panel Name Targets That can be Registered as Watch-Expressions
Editor panel Variable names of C/C++ IanguageNOte 1 cPU registers, SFR, and assembler

symbols

Variable names of C/C++ IanguageNOte 1, CPU registers, SFR, and assembler
symbols

Disassemble panel

Note 2

CPU Register panel CPU registers

Local Variables panel | Variable names of C/C++ languageN°® ! (local variables)

SFR panel SFRNote 2

Note 1.
Note 2.

It represents C language (C89/C99) and C++ language variables.

The scope-specification is automatically added to the registered watch-expression.

<2> Directly register in the Watch panel

Click the button on the toolbar or select [Add New Watch] from the context menu in the desired watch
panel (Watch1 to Watch4) to display an entry box for a new watch-expression in the bottom of this area.
Directly input a watch-expression from the keyboard in the [Watch] area in the entry box then press the [Enter]
key.

For details on the input formats of watch-expressions, see "(b) Watch-expression and operator".

Watch-expressions can be registered with specifying the scope. The scope specifications with watch-expres-
sion registration are as follows:

Caution If a load module name or file name contains a space or one of the following symbols, enclose

the name in double-quotes (" ").

R20UT5301EJ0100 Rev.1.00

RENESAS
Jun 01, 2023

Page 226 of 413



CS+V8.10.00 A. WINDOW REFERENCE

$HGLLL &N~ %+ -5 002, [\, <, >, !
Example: "c:\folder\prog.abs" $file.c#func

Table A.6 Handling of a C/C++ Language Function When Registered in Watch by Specifying Scope

Scope Specification | Load Module File Name | Source File Name | Function Name Variable Name
prog$file#func prog file func Static functions
prog$func prog Global func Global functions
file#func Current file func Static functions
func Current Current func AlNote

Note A search is made for static functions and global functions from the scope of the current PC

value in that order. Static functions out of scope are not searched for.

To specify a function defined in a name space, do not write scope. (Example: Scope::func)
Also, if functions with the same name exist, write the type of parameter expressly. (Example:
func(int, int))

Table A.7 Handling of a C/C++ Language Variable When Registered in Watch by Specifying Scope

Scope Specification | Load Module Source Function Variable Subject to be searched
File Name File Name Name Name
prog$file#func#var | prog file func var Static variables inside a
static functionNote !
prog$file#var prog file Global var Static variables inside a file
prog$var prog Global Global var Global variables
filef#func#var Current file func var Static variables inside a

static functionNote 1

file#tvar Current file Global var Static variables inside a file
var Current Current Current var AlNote 2
Note 1. To specify a function defined in a name space, do not write scope. (Example: Scope::func)

Also, if functions with the same name exist, write the type of parameter expressly. (Example:
func(int, int))

Note 2. If the current PC value exists in a specified function, the local variables that are not declared as
static also comprise the subject to be searched.

Note 3. A search is made for local variables, static variables inside a file and global variables from the
scope of the current PC value in that order. The local variables and the static variables inside
a file that are out of scope are not searched for.

Table A.8 Handling of a CPU Register When Registered in Watch by Specifying Scope

Scope Specification Register Bank Name of CPU Register
AX:RBO Register bank 0 AX
AX:REG Current register bank AX

Table A.9 Handling of a SFR when Registered in Watch by Specifying Scope

Scope Specification Name of SFR
PO:SFR PO
PO PO
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Remark 1. A symbol name at the current caret position can be complemented by pressing the [Ctrl] +
[Space] key in this area (see "2.20.2 Symbol name completion function").

Remark 2. Immediates are handled as a numeric value. Also, operators can be used for immediates.
Remark 3. Arithmetic expressions using a symbol can be specified as watch-expressions.

Remark 4. If the same name exists either in C/C++ language variables, CPU registers or SFRs, and it is
registered without specifying scopes, then its value will be displayed after the symbol is deter-
mined in the following order.

Variable of C language > CPU registers > SFR

Remark 5. If a local variable and a global variable exist with the same name, and its symbol name is reg-
istered without specifying scopes, then its value will be displayed after the symbol is deter-
mined based on the scope of the current PC value.

Remark 6. If the letter "I" alone is specified as a watch-expression, it is interpreted as an imaginary key-
word. To acquire the value of a register "l," add ":REG" after the register.

<3> Register from other application
Select a character string of a variable of C/C++ language, CPU register, SFR or assembler symbol from a
external editor then do either one of the following.

- Drag and drop the target character string in this area in the desired watch panel (Watch1 to Watch4).

- Select the [Edit] menu >> [Paste] in this area in the desired watch panel (Watch1 to Watch4) after copying
the target character string.

Remark 1. Each watch-expression registered in each watch panel (Watch1 to Watch4) is managed in
each panel and saved as the user information of the project.

Remark 2. More than one watch-expression with the same name can be registered.

Remark 3. You can export registered watch-expressions to a file and import it so that the watch-expres-
sions can be re-registered (see "2.10.6.8 Export/import watch-expressions").

(d) Editing watch-expression
To edit the registered watch-expression, double-click the watch-expression to be edited to change the watch-
expression to edit mode then directly edit from the keyboard (press the [Esc] key to cancel the edit mode).
After editing the watch-expression, press the [Enter] key to complete the editing.

(e) Deleting watch-expression
To delete the registered watch-expression, select the watch-expression(s) to be deleted then click the but-
ton on the toolbar or select [Delete] from the context menu.

(f)  Setting of various events
Various events can be set to the selected watch-expression by selecting [Access Break] or [Trace Output] from
the context menu.
If an access event is set, the mark of the watch-expression is changed (the event mark of a break event is dis-
played under the icon of the watch-expression in layers).
When an event is set, the detailed information about the set event is reflected in the Events panel.
Note that events are only set to the watch-expressions that are global variables, static variables inside functions,
or file-internal static variables.
See the following for details on how to set events.

- "2.9.5 Stop the program with the access to variables/SFRs"
- "2.12.4 Collect execution history only when the condition is met [[IECUBE][Simulator]"

(g9) Jump to the address with memory definition
By selecting [Jump to Memory] from the context menu, the Memory panel (Memory1) opens with moving the
caret to the address in which the selected watch-expression is defined (if the Memory panel (Memory1) is
already open, the screen will jump to the panel).
Note that this operation is disabled when more than one watch-expression is selected at the same time or the
CPU register/SFR is selected.

(2) [Symbol] area
Symbols that have been registered as watch-expressions are displayed.
The display of the [Symbol] area is switched by selecting [Displays symbol column] from the context menu or tool-
bar.
When watch-expressions have a specified scope, the [Symbol] area is displayed without specifying the scopes of
watch-expressions.
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Example var for prog$file#func#var
When arrays, pointer-type variables, and structures, unions, or classes of the watch-expression are expanded, the
[Symbol] area displays watch-expressions including the name of the parent node.

Example sobj.mem for the mem member expanded from the sobj structure object

(3) [Value] area
The value of the registered watch-expression is displayed and changed (if the watch-expression is a function
pointer, the function name is displayed in this area).
Notations and encodes can be selected by the button on the toolbar or the context menu item. In addition, a dis-
play format adding the value in hexadecimal number constantly can also be selected as well.
The default display format of the values is automatically decided depending on the type of the watch-expression.

Table A.10 Display Format of Watch-Expressions (Default)

Type of Watch-Expression Display Format
char, signed char, unsigned char ASCII code with hexadecimal number
short, signed short, short int, signed short int, int, Hexadecimal value added in "( )" following signed
signed, signed int, long, signed long, long int, signed decimal value

long int

unsigned short, unsigned short int, unsigned, unsigned | Hexadecimal value added in "( )" following unsigned

int, unsigned long, unsigned long int decimal value
float, float _Complex, float _Imaginary Float (when the size is 4-byte) with hexadecimal
number Note?
double, long double, double _Complex, long double Double (when the size is 8-byte) with hexadecimal
Note1

_Complex, double _Imaginary, long double _Imaginary | number

Pointers to char, signed char, unsigned char Characters
Encoding: ASCII

Pointers to other than char, signed char, unsigned char | Hexadecimal number

Arrays of char, signed char, unsigned char types Characters
Encoding: ASCII

Bool Hexadecimal value added in "( )" following unsigned
decimal value

Enumeration type Hexadecimal value added in "( )" following enumer-
ated constant

LabelN°'2 address of immediate valueN°®3, EQU sym- | Hexadecimal value added in "( )" following signed
bol decimal value

bit symbol Hexadecimal value added in "( )" following unsigned
decimal value

Others Hexadecimal number

Note 1. The values of floating and complex types are rounded to an approximate value (nearest whole
value) before being displayed.

Note 2. The memory space for the label of the FAA is displayed in accordance with the memory space
(instruction code space or data space) to which the label belongs

Note 3. The memory space for the address of an immediate value is displayed in accordance with the value
of the [FAA memory space] property in the [Memory] category on the [Debug Tool Settings] tabbed
page.

The meanings of the marks and colors displayed as the values of watch-expressions are as follows (character col-
ors and background colors depend on the configuration in the [General - Font and Color] category of the Option
dialog box):
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Display Example (Default) Description

00 | Character color Blue The value of the watch-expression that the user is changing
Press the [Enter] key to write to the target memory.

Background color | Standard color

=0 Character color | Pink The value of the watch-expression that is displayed with the
Real-time display update function

Background color | Standard color

00 | Character color Brown The value of the watch-expression that has been changed
because of the execution of a program
Background color | Cream To reset the highlighting, select the button on the toolbar or

[Reset Color] from the context menu.

2 Character color Gray Variable that does not exist is registered as a watch-expression

or the value of the watch-expression cannot be retrieved (vari-
Background color | Standard color | gpje is out of the scope)

Remark 1. The SFR that cause the microcontroller to operate when it is read is read-protected and therefore
cannot be read. To read the value of read-protected SFR, select [Force Read Value] from the con-
text menu.

Remark 2. Each watch-expression acquires the value in the order it was registered.

As the timing to acquire a value is different, the values displayed may be different if the same SFR
is registered more than once.

This area is provided with the following functions.

(@) Real-time display update function
Using the real-time display update function allows you to display/modify the value of the watch-expression not
only while the program is stopped, but also in execution.
See "2.10.1.4 Display/modify the memory contents during program execution" for details on the real-time dis-
play update function.

(b) Changing values of watch-expressions
To edit the value of the watch-expression, change the value directly from the keyboard after double-clicking on
the value to be edited (press the [Esc] key to cancel the edit mode).
After you edit the value of the watch-expression, it is written to the target memory of the debug tool by pressing
the [Enter] key, or moving the focus to outside the edit region.
See "2.10.6.6 Modify the contents of watch-expressions" for detail on how to change values of watch-expres-
sions.

(c) Saving the contents of watch-expressions
By selecting the [File] menu >> [Save Watch Data As...], the Save As dialog box can be opened, and all the con-
tents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
By selecting [Save Expanded Watch Data...] from the context menu, the Save As dialog box can be opened,
and the selected contents of watch-expressions can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.10.6.9 Save the contents of watch-expressions" for details on the method for saving the contents of
watch-expressions.

(4) [Type (Byte Size)] area
The type information of watch-expressions with the following format is displayed.

Watch-Expression Display Format

Single CPU register | <Types of CPU register> (<SizeN%'¢ 1>)

Single SFR <SFR type> (<Access attribute> <Access type><SizeNote 1>)
Access attribute R: Read only
W: Write only
R/W: Read/Write only
Access type 1: Bit accessible
: Byte accessible
16: Word accessible
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Watch-Expression Display Format
Unknown ?
Others <Watch-expression type that follow the C compiler's determinationN°t 2> (<SizeNote 1)
Note 1. The size of the watch-expression is displayed in bytes.

However, for bit SFR or C language bit field, the size is displayed in bits and "bits" is added to the
end of the number.

Note 2. Watch-expressions are handled as having the type indicated here when they are compiled.
In the case of double/long double type, type name is output in accordance with [Process double
type / long double type as float type] property in the [Output Code] category on the [Compile
Options] tab in the build tool's Property panel.

[Address] area
The address that each watch-expression is mapped is displayed (hexadecimal number notation fixing).
If the watch-expression is single CPU register or is unknown, "-" or "?" is displayed instead.

Remark When the watch-expression is the bit SFR, the bit-offset value is also displayed.

Example When the bit register is allocated to bit 4 of the address "0xFF40"
Display example:0xFF40.4

[Memo] area

The user can write comments for the watch-expressions/categories.

Each comment for a watch-expression/category written in this area is saved individually as the user information of
the project. Therefore, when any of the watch-expression/category is deleted, the comment corresponding to it is
also deleted.

Note that when arrays or register are displayed expanded, the comment cannot be input for each element.

To edit the comment, input the character strings directly from the keyboard after double-clicking on the item to be
edited (press the [Esc] key to cancel the edit mode).

Up to 256 character strings can be input (line feed code is ignored).

After editing the character strings, complete the editing by pressing the [Enter] key or moving the focus to outside
the edit region.

[Toolbar]

El|

Reacquires all the values of the registered watch-expression and updates the display.
Note that read-protected SFR values are not re-read.

Switches between display and non-display of the [Symbol] area.

B [

Resets highlighting of the selected watch-expression whose value has been changed by
executing a program.
This item is disabled during execution of a program.

Registers a new watch-expression.
Directly input the watch-expression in the text box (see "(c) Registering new watch-
expression")

Adds a new category (folder).

Directly input the category name in the text box.

Note that up to 64 categories can be created in one watch panel (categories cannot be
created in categories).

[X]

Deletes the selected character string(s).
If the watch-expression(s)/category(s) are selected, deletes them (except when the
expanded item of the watch-expression is selected).
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Notation The following buttons to change the notation of a data value are displayed.
AutoSelect Displays the value of the selected watch-expression in the default notation (see "Table
A.10 Display Format of Watch-Expressions (Default)") according to the type of variable
(default).
Hexadecimal Displays the value of the selected item in hexadecimal number.

Signed Decimal Displays the value of the selected item in signed decimal number.

Unsigned Decimal | Displays the value of the selected item in unsigned decimal number.

Octal Displays the value of the selected item in octal number.

Binary Displays the value of the selected item in binary number.

ASCII Displays the value of the selected item in ASCII code.

Float Displays the value of the selected item in Float.
Note that this item becomes valid only when the selected watch-expression value is 4-
byte data.

Double Displays the value of the selected item in Double.
Note that this item becomes valid only when the selected watch-expression value is 8-
byte data.

Adds the value in hexadecimal number enclosing with "()" at the end of the value of the

selected item (except the item displayed in hexadecimal number).

[[File] menu (Watch panel-dedicated items)]

The following items are exclusive for the [File] menu in the Watch panel (other items are common to all the panels).
Note that all these items are disabled during execution of a program.

Save Watch Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file (*.csv)
(see "(c) Saving the contents of watch-expressions").

Note that when the file has never been saved or the file is write disabled, the same opera-
tion is applied as the selection in [Save Watch Data As...].

Save Watch Data As... Opens the Save As dialog box to newly save the contents of this panel to the specified text
file (*.txt)/CSV file (*.csv) (see "(c) Saving the contents of watch-expressions").

[[Edit] menu (Watch panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Watch panel (all other items are disabled).

Cut Deletes the selected character string(s) and copies them to the clipboard.
If the watch-expression(s)/category(s) are selected, deletes them (except when the
expanded item of the watch-expression is selected).

Copy Copies the contents of the selected range to the clipboard as character string(s).
If the watch-expression(s)/category(s) are selected, copies them to the clipboard (except
when the expanded item of the watch-expression is selected).

Paste If texts are in editing, pastes the contents of the clipboard to the caret position.
If texts are not in editing and the watch-expression(s) are copied in the clipboard, registers
them to the caret position.

Delete Deletes the selected character string(s).
If the watch-expression(s)/category(s) are selected, deletes them (except when the
expanded item of the watch-expression is selected).

Select All If texts are in editing, selects all the character strings.
If texts are not in editing, selects all the watch-expressions/categories.
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Rename Renames the selected watch-expression/category.
Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab.
Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab.

[Context menu]

Access Break

This item becomes valid only when the selected watch-expression is the global variable,
the static variable inside functions, the file-internal static variable, or SFR.

The following cascade menus are displayed to set the access break event (see "2.9.5.1
Set a break event (access type)").

Set Read Break to

Sets a break event with read access condition to the selected watch-expression.

Set Write Break to

Sets a break event with write access condition to the selected watch-expression.

Set R/W Break to

Sets a break event with read/write access condition to the selected watch-expression.

Set Read Combina-
tion Break to
[E1]1[E20]

Sets a break event with read access condition to the selected watch-expressionNOte.

Set Write Combina-
tion Break to
[E1]1[E20]

Sets a break event with write access condition to the selected watch-expressionN°t.

Set R/W Combination
Break to
[E1][E20]

Sets a break event with read/write access condition to the selected watch-expressionN°.

Trace Output
[IECUBE][Simulator]

This item becomes valid only when the selected watch-expression is a global variable,
static variable inside functions, file-internal static variable, or SFR.

The following cascade menus are displayed to set the trace-related event (see "2.12.4.1
Set a Point Trace event" or "2.12.3.1 Set a Trace event").

Record Reading
Value

Sets a Point Trace event to record the values in the trace memory when the selected
watch-expression is accessed for read.

Record Writing Value

Sets a Point Trace event to record the values in the trace memory when the selected
watch-expression is accessed for write.

Record R/W Value

Sets a Point Trace event to record the values in the trace memory when the selected
watch-expression is accessed for read/write.

Record Start R/'W
Value
[E1][E20][COM Port]

Sets a trace start event to start collecting the trace data when the selected watch-expres-
sion is accessed for read/write.

Record End R/W
Value
[E1][E20][COM Port]

Sets a trace end event to stop collecting the trace data when the selected watch-expres-
sion is accessed for read/write.

Trace

Opens the Trace panel and displays the acquired trace data.

Periodic Updating

The following cascade menus are displayed to set for the real-time display update function
(see "(a) Real-time display update function").

Periodic Updating Opens the Property panel to set for the real-time display update function.
Options
Refresh Reacquires all the values of the registered watch-expression and updates the display.

Note that the values of read-protected SFR are not re-read.

Symbol Column

Switches between display and non-display of the [Symbol] area.
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Force Read Value Forcibly reads once the values of the read-protected SFR.
This item is disabled during execution of a program.

Add New Watch Registers a new watch-expression. Directly input the watch-expression in the text box (see
"(c) Registering new watch-expression")

Create Category Adds a new category (folder). Directly input the category name in the text box.
Note that up to 64 categories can be created in one watch panel (categories cannot be
created in categories).

Delete Deletes the selected character string(s).
If the watch-expression(s)/category(s) are selected, deletes them (except when the
expanded item of the watch-expression is selected).

Cut Deletes the selected character string(s) and copies them to the clipboard.
If the watch-expression(s)/category(s) are selected, deletes them (except when the
expanded item of the watch-expression is selected).

Copy Copies the contents of the selected range to the clipboard as character string(s).
If the watch-expression(s)/category(s) are selected, copies them to the clipboard (except
when the expanded item of the watch-expression is selected).

Paste If texts are in editing, pastes the contents of the clipboard to the caret position.
If texts are not in editing and the watch-expression(s) are copied in the clipboard, registers
them to the caret position.

Rename Renames the selected watch-expression/category.
Import Watch Expres- Opens the Open Watch Expression Data File dialog box to import watch-expressions (see
sion... "2.10.6.8 Export/import watch-expressions").
Notation The following cascade menus are displayed to specify the notation.
AutoSelect Displays the value of the selected watch-expression in the default notation (see "Table
A.10 Display Format of Watch-Expressions (Default)") according to the type of variable
(default).

Hexadecimal number | Displays the value of the selected item in hexadecimal number.

Signed Decimal Displays the value of the selected item in signed decimal number.

Unsigned decimal Displays the value of the selected item in unsigned decimal number.

number

Octal Displays the value of the selected item in octal number.

Binary Displays the value of the selected item in binary number.

ASCII Displays the value of the selected item in ASCII code.

Include Hexadecimal | Adds the value in hexadecimal number enclosing with "()" at the end of the value of the
Value selected item (except the item displayed in hexadecimal number).

Float Displays the value of the selected item in Float.

Note that when the selected watch-expression value is not 4-byte data, or has the type
information, displays it in the default notation (see "Table A.10 Display Format of Watch-
Expressions (Default)").

Double Displays the value of the selected item in Double.

Note that when the selected watch-expression value is not 8-byte data, or has the type
information, displays it in the default notation (see "Table A.10 Display Format of Watch-
Expressions (Default)").

Decimal Notation for Displays array indexes on this panel in decimal number (default).
Array Index

Hexadecimal Nota- Displays array indexes on this panel in hexadecimal number.
tion for Array Index
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Encoding The following cascade menus are displayed to specify the character code.
ASCII Displays the value of the selected item in ASCII code (default).
Shift_JIS Displays the value of the selected item in Shift_JIS code.
EUC-JP Displays the value of the selected item in EUC-JP code.
UTF-8 Displays the value of the selected item in UTF-8 code.
UTF-16 Displays the value of the selected item in UTF-16 code.
Size Notation The following cascade menus are displayed to specify the size notation.
1 Bytes Displays the value of the selected item as 8-bit data.
2 Bytes Displays the value of the selected item as 16-bit data.
4 Bytes Displays the value of the selected item as 32-bit data.
8 Bytes Displays the value of the selected item as 64-bit data.
Jump to Memory Opens the Memory panel (Memory1) and jumps to the address which the selected watch-
expression is defined (see "(g) Jump to the address with memory definition").
Reset Color Resets highlighting of the selected watch-expression whose value has been changed by
executing a program.
This item is disabled during execution of a program.
Save Expanded Watch | Opens the Save As dialog box to newly save the selected contents of watch-expressions
Data... to the specified text file (*.txt)/CSV file (*.csv) (see "(c) Saving the contents of watch-
expressions").

Note [E1][E20]
This item is displayed only when the selected microcontroller supports combination break events.
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Call Stack panel

This panel is used to display the call stack information for the function call (see "2.11.1 Display call stack information").
This panel appears only when connected to the debug tool.

Caution Nothing is displayed on this panel during execution of a program.
When the program is stopped, items in each area are displayed.

Remark This panel can be zoomed in and out by |1 a0k '-'| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Figure A.15 Call Stack Panel

Call Stack =

[Toolbar]~|: [@ Motation= | Encoding - r 1
Oepih  Cisll S8sck
0 main G DefaultBuildest sbefr_mainc??]

This section describes the following.

- [How to open]

- [Description of each areal

- [Toolbar]

- [[File] menu (Call Stack panel-dedicated items)]
- [[Edit] menu (Call Stack panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Call Stack].

[Description of each area]

(1) [Depth] area
The depth of the call is displayed.
The line at the current PC position becomes 0 and incremented numbers from 1 is added to the calling function in
the order.

(2) [Call Stack] area
The current source position and the call stack information pushed on the stack (position of the calling function and
arguments of a each function, etc.) are displayed.
The display format in this area differs depending on the selection condition of the / . button on the toolbar,
or of [Show Parameter])/[Show Module File Name] from the context menu.

Condition Display Format

- Display arguments <Function>(<Argument>=<Argument ValueNote>, ...)[<Module file

- Display module file name name>$<File name>#<Line number>] (default)
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Condition Display Format
- Display arguments <Function>(<Argument>=<Argument valueNote>, ...)[<File Name>#<Line
- Do not display module file number>]
name
- Do not display arguments <Function>()[<Module file name>$<File name>#<Line number>]

- Display module file name

- Do not display arguments <Function>()[<File name>#<Line number>]

- Do not display module file
name

Note When the argument value is character string, up to 20 characters can be displayed.

Remark Array arguments are passed as pointers rather than arrays (C language specification). For this rea-
son, if the argument is an array, it is displayed as a pointer.

This area is provided with the following functions.

(@) Jump to the source line/disassemble line
By selecting [Jump to Source] from the context menu, the Editor panel is opened with moving the caret to the
source line corresponding to the calling function at the current caret position (if the Editor panel is already open,
the screen will jump to the panel).
In addition, similarly by selecting [Jump to Disassemble], the Disassemble panel (Disasemmble1) is opened
with moving the caret to the address corresponding to the calling function at the current caret position (if the Dis-
assemble panel is already open, the screen will jump to the panel (Disassemble1)).

Remark It is possible to jump to the target source line by double-clicking on that line as well.

(b) Display of local variables
By selecting [Jump to Local Variable at This Time] from the context menu, the Local Variables panel is opened
to display the local variables indicated by the currently selected line.

(c) Saving the contents of call stack information
By selecting the [File] menu >>[Save Call Stack Data As...], the Save As dialog box can be opened, and all the
contents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).
See "2.11.1.4 Save the contents of call stack information" for details on the method for saving the contents of
call stack information.

[Toolbar]
The buttons below are disabled during execution of a program.
El| Acquires the latest data from the debug tool, and updates the contents of this panel.
Notation The following buttons to specify the notation of values are displayed.

AutoSelect Displays values on this panel in the default notation according to the type of variable (default).

Hexadecimal | Displays values on this panel in hexadecimal number.

Decimal Displays values on this panel in decimal number.
Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.
Encoding The following buttons to specify the encoding of character variables are displayed.
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ASCII Displays character variables in ASCII code (default).
Shift_JIS Displays character variables in Shift_JIS code.
EUC-JP Displays character variables in EUC-JP code.
UTF-8 Displays character variables in UTF-8 code.
UTF-16 Displays character variables in UTF-16 code.
Displays the call stack information with the module file name (default).
Displays the call stack information with the parameters (arguments) of the function call
(default).

[[File] menu (Call Stack panel-dedicated items)]

The following items are exclusive for the [File] menu in the Call Stack panel (other items are common to all the panels).
Note that all these items are disabled during execution of a program.

Save Call Stack Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file
(*.csv) (see "(c) Saving the contents of call stack information").

Note that when the file has never been saved or the file is write disabled, the same
operation is applied as the selection in [Save Call Stack Data As...].

Save Call Stack Data As... | Opens the Save As dialog box to newly save the contents of this panel to the specified
text file (*.txt)/CSV file (*.csv) (see "(c) Saving the contents of call stack information").

[[Edit] menu (Call Stack panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Call Stack panel (all other items are disabled).

Copy Copies the contents of the selected line to the clipboard.

Select All Selects all the items of this panel.

Find... Opens the Find and Replace dialog box with selecting the [Find in Files] tab.
Replace... Opens the Find and Replace dialog box with selecting the [Replace in Files] tab.

[Context menu]

Copy Copies the contents of the selected line to the clipboard.
Show Module File Name Displays the call stack information with the module file name (default).
Show Parameter Displays the call stack information with the parameters (arguments) of the function call
(default).
Notation The following cascade menus to specify the notation of values are displayed.
AutoSelect Displays values on this panel in the default notation according to the type of variable
(default).
Hexadecimal Displays values on this panel in hexadecimal number.
Decimal Displays values on this panel in decimal number.
Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.
Encoding The following cascade menus to specify the encoding of character variables are dis-
played.
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ASCII Displays character variables in ASCII code (default).
Shift_JIS Displays character variables in Shift_JIS code.
EUC-JP Displays character variables in EUC-JP code.
UTF-8 Displays character variables in UTF-8 code.
UTF-16 Displays character variables in UTF-16 code.
Jump to Disassemble Opens the Disassemble panel (Disassemble1) and jumps to the address corresponding

to the calling function of the selected line in this panel.

Jump to Source Opens the Editor panel and jumps to the source line corresponding to the calling func-
tion of the selected line in this panel.

Jump to Local Variable at | Opens the Local Variables panel to display the local variable corresponding to the
This Time selected line.
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Trace panel

This panel is used to display trace data recording the execution history of the program (see "2.12 Collect Execution His-
tory of Programs").

The trace data displays by mixing the disassembled text and source text by default, but it is also possible to display
either one of these by selecting the Display mode.

After the execution of the program is stopped, the display position is automatically updated such that the latest trace
data is displayed.

This panel appears only when connected to the debug tool.

Caution 1.  [E1][E20][EZ Emulator][COM Port]
The trace function is supported only when the selected microcontroller incorporates the OCD trace func-
tion. For details on the OCD trace function, see "Table 2.12 Operation Specifications of OCD Trace
Function”.
Caution 2.  [Simulator]
4 bytes of the final address of the code flash area (when a code flash area is 0x0 - Ox1FFFF, Ox1FFFC -
1FFFFF corresponds to it) and the RAM area which can be fetched cannot be fetched (a message of
"Stopped by accessing to no map area." will appear).
Remark 1. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.
Remark 2. This panel can be zoomed in and out by |1 a0k -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.
Figure A.16 Trace Panel
Tracs kA
[Toolbar]~|: [ % | &% @ 58 MNotationr | [T 8y IE LWL |
usber Tiws (himincs.ss.us,ns?  Line Musber/Addrass SourcedDissssesble Address [ats =
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This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Trace panel-dedicated items)]

- [[Edit] menu (Trace panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Trace].

- On the Editor panel/Disassemble panel, select [Trace Settings] >> [Show Trace Result] from the context menu.
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[Description of each area]

(1

(2)

@)

(4)

[Number] area
The trace number corresponding to the trace frame is displayed.

[Time (h:min:s,ms,us,ns)] area [IECUBE][Simulator]

This area displays the time required from the execution start of the program to the execution start of an instruction

of each frame or generation of memory access cause.

The time is displayed in units of "hours, minutes, seconds, milliseconds, microseconds and nanoseconds".

If overflow occurs, this area is displayed in invalid color (gray).

Remark 1. [IECUBE]

The precision of the time depends on the setting of the [Rate of frequency division of trace time tag]
property on the [Trace] category on the [Debug Tool Settings] tab of the Property panel.

Remark 2. [Simulator]

The question of whether to set the time display as an integrated value or differential value depends
on the setting of the [Accumulate trace time] property on the [Trace] category on the [Debug Tool

Settings] tab of the Property panel.

[Line/Address] area
The address of the assemble code or the line number of a source file is displayed.

The notation of a data value can be selected by the button on the toolbar or the context menu item.

The display formats are as follows:

Type of Display Line Display Format

Instruction (disassemble results) <Address>

Source text <File name>#<Line number>

Other than above -

Remark Since the following execution histories are not displayed, the line numbers displayed are not con-

secutive numbers.

- CPU register access
- Operand access

- Invalid fetch

[Source/Disassemble] area
The collected trace data is displayed as follows.

The items displayed in this area differ depending on the selection of the display mode (see "(a) Display mode").

Figure A.17 Display Contents of [Source/Disassemble] Area (Default)

Sowce Dizazsambla

Label —»( main) (farl=0 141000, =+ 4~ Source text

Offset value —@ ( Moww  aX[HL] «— Instruction (disassemble results)

farf=ly 1000, #+4
+110 CMPW 8K E3EEH

farl =0 11000 #++Y
113 BHZ B _manelid

((Stopped by step execution,) «—— Break cause

Label The label is displayed when a label is defined for the address.

the address.

Offset value The offset value from the nearest label is displayed when a label is defined for
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Source text The corresponding source text is displayed when the Mixed display mode or
Source display mode is selected.

However, when a place where no debugging information is present is exe-
cuted, "<No Debug Information>" is displayed.

[IECUBE][Simulator]

When the value of a variable or an SFR that is accessed during execu-
tion of a source line can be analyzed, that value is displayed in the following
format at the end of the source line.

Note 1

- <<<Variable name = Variable value>>>

- <<<SFR name = SFR value>>>
Example: a=b; <<<a=5>>>
The results of the Point Trace are displayed as same as format above.

Instruction (disassemble The corresponding instructions are displayed as the result of disassembling
results) when the Mixed display mode or Disassemble display mode is selectedNo€ 2,
The mnemonics are shown highlighted.

Break cause The reason why the program has broken down is displayed.
[IECUBE][Simulator]

Reset cause The reason why CPU reset has occurred is displayed.
[IECUBE]
Note 1. [IECUBE][Simulator]

When there is a memory access, a symbol will be interpreted as a variable and displayed only if a
symbol is assigned to the accessed address. Note, however, that only variables of up to 2 bytes
are supported. If multiplication or other code is processed by the standard libraries, the label of the
SADDR area used by the standard library may be shown.

Note 2. At a frame for which not all the trace data was fetched, "(LOST)" is displayed. In this case, the cor-
responding line is shown in error color (the error color depends on the configuration in the [General
- Font and Color] category of the Option dialog box).

This area is provided with the following functions.

(@) Display mode
It is possible to select the following three display modes by selection of a button on the toolbar or the context

menu.
Display Mode Displayed Content
Mixed display mode Displays the instruction (disassemble results), labels, source text (correspond-
ing source line), point trace results, reset causes [IECUBE], and break causes
(default).

Disassemble display mode | Displays the instruction (disassemble results), labels, point trace results, reset
causes [IECUBE], and break causes.

Source display mode Displays the source text (corresponding source line) reset causes [IECUBE],
and break causes.

However, when a place where no debugging information is present is exe-
cuted, "<No Debug Information>" is displayed.

(b)  Jumping to source line or disassemble
By selecting [Jump to Source] from the context menu, the Editor panel opens with moving the caret to the
source line corresponding to the line at the current caret position (if the Editor panel is already open, the screen
will jump to the panel).
In addition, similarly by selecting [Jump to Disassemble], the Disassemble panel (Disasemmble1) is opened
with moving the caret to the address corresponding to the fetch address of the line at the current caret position
(if the Disassemble panel is already open, the screen will jump to the panel (Disassemble1)).

(c) Linking with other panels
By clicking the / button on the toolbar, or selecting [Window Connecting] >> [Connect Source Window]/
[Connect Disassemble Window] from the context menu, it is possible to link and display the corresponding
places on the Editor panel/Disassemble panel, with the address of the caret position on this panel used as the
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pointer (no movement of the focus is done).

(d) Pop-up display

By hovering the mouse cursor over a line, all the area (item) data corresponding to that line is pop-up displayed

in tandem shape.

(e) Saving trace data

The Data Save dialog box can be opened by selecting the [File] menu >> [Save Trace Data As...], and the con-

tents of this panel can be saved in a text file (*.txt) or CSV file (*.csv).

See "2.12.9 Save the contents of execution history" for details on the method for saving trace data.

(5) [Address] area [IECUBE][Simulator]
The target address of memory access is displayed.
However, in the event of access to SFR, the SFR name is displayed instead of the address (when a plurality is
accessed these are displayed in the following lines).

The radix of a data value can be selected by the button on the toolbar or the context menu item.

(6) [Data] area [IECUBE][Simulator]

The accessed data value and the access type at that time are displayed.

However, CPU register access is not displayed.
The notation of a data value can be selected by the button on the toolbar or the context menu item.
The display format of the data value and the access type are as follows (character colors and background colors

depend on the configuration in the [General - Font and Color] category of the Option dialog box):

Display Example (Default)

Memory Access Type

R Data value

Character color

Standard color

Read access

Background color

Palegreen

W Data value

Character color

Standard color

Write access

Background color

Orange

RW Data value

Character color

Standard color

Read and write access

Background color

Paleturquoise

VECT Data Character color Standard color Vector read access
Background color | Palegreen
[Toolbar]
E]| Acquires the latest data from the debug tool, and updates the contents of this panel.
This item is disabled while the tracer is running.
Clears the trace memory and the display of this panel (initialized).

This item is disabled while the tracer is running.

Starts the tracer operation.
[IECUBE][Simulator] | The content currently being displayed in this panel is cleared.
This item is disabled while the tracer is running.

Stops the tracer operation.
[IECUBE][Simulator] | The contents of trace data newly acquired are displayed.
This item is disabled while the tracer is stopped.

Opens the Trace Search dialog box.
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Notation The following buttons to change the notation of a data value are displayed.
This item is disabled while the tracer is running.

Displays values on this panel in hexadecimal number (default).

Displays values on this panel in decimal number.

Displays values on this panel in octal number.

Displays values on this panel in binary number.

i
VamEm

Links with the Editor panel.
I

m

CUBE][Simulator]

Links with the Disassemble panel.

]

m

CUBE][Simulator]

=

; Sets to the Mixed display mode as the display mode (default).

IECUBE][Simulator] | This item is disabled while the tracer is running.
y Sets to the Disassemble display mode as the display mode.
IECUBE][Simulator] | This item is disabled while the tracer is running.

I

Sets to the Source display mode as the display mode.
CUBE][Simulator] | This item is disabled while the tracer is running.

m

[[File] menu (Trace panel-dedicated items)]

The following items are exclusive for the [File] menu in the Trace panel (other items are common to all the panels).
Note that all these items are disabled during execution of a program.

Save Trace Data Overwrites the contents of this panel to the previously saved text file (*.txt)/CSV file (*.csv)
(see "(e) Saving trace data").

Note that when the file has never been saved or the file is write disabled, the same opera-
tion is applied as the selection in [Save Trace Data As...].

This item is disabled while the tracer is running.

Save Trace Data As... Opens the Data Save dialog box to newly save the contents of this panel to the specified
text file (*.txt)/CSV file (*.csv) (see "(e) Saving trace data").
This item is disabled while the tracer is running.

[[Edit] menu (Trace panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Trace panel (all other items are disabled).

Copy Copies the contents of the selected line to the clipboard (multiple line selections impossi-
ble).
This item is disabled while the tracer is running.

Find... Opens the Trace Search dialog box.

[Context menu]

Clear Trace Clears the trace memory and the display of this panel (initialized).
This item is disabled while the tracer is running.

Start Trace Starts the tracer operation.
[IECUBE][Simulator] The content currently being displayed in this panel is cleared.
This item is disabled while the tracer is running.

Stop Trace Stops the tracer operation.
[IECUBE][Simulator] The contents of trace data newly acquired are displayed.
This item is disabled while the tracer is stopped.
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Find... Opens the Trace Search dialog box.
This item is disabled while the tracer is running.

Copy Copies the contents of the selected line to the clipboard (multiple line selections impossi-
t')I'lﬁl)s item is disabled while the tracer is running.

Mixed Display Sets to the Mixed display mode as the display mode.

This item is disabled while the tracer is running.

Disassemble View

Sets to the Disassemble display mode as the display mode.
This item is disabled while the tracer is running.

Source View Sets to the Source display mode as the display mode.
This item is disabled while the tracer is running.
Notation The following cascade menus are displayed to specify the notation.
This item is disabled while the tracer is running.
Hexadecimal number | Displays values on this panel in hexadecimal number (default).
Decimal Displays values on this panel in decimal number.
Octal Displays values on this panel in octal number.
Binary Displays values on this panel in binary number.

Window Connecting
[IECUBE][Simulator]

The following cascade menus are displayed to link with other panels (see "(c) Linking with
other panels").

Connect Source Win-
dow

Links with the Editor panel.

Connect Disassem-
ble Window

Links with the Disassemble panel.

Jump to Disassemble
[IECUBE][Simulator]

Opens the Disassemble panel (Disassemble1) and jumps to the fetch address corre-
sponding to the line at the caret position in this panel.

Jump to Source
[IECUBE][Simulator]

Opens the Editor panel and jumps to the source line corresponding to the line at the caret
position in this panel.

Jump to Memory
[IECUBE][Simulator]

Opens the Memory panel and jumps to the memory value corresponding to the line at the
caret position in this panel.
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Events panel

This panel is used to display the detailed information about the events that are set on the Editor panel/Disassemble
panel/Watch panel. On this panel, you can change the setting state of the event between valid/invalid and delete the
event (see "2.16 Manage Events").

This panel appears only when connected to the debug tool.

Remark 1. The available event types depend on the type of the selected microcontroller and of the debug tool in
use. Refer to the descriptions under "See ..." sentences in the category "Description” in "Table A.12
Event Type". Alternatively, see "2.16.7.1 Maximum number of enabled events".

Remark 2. The events that have been set on the Function List panel or Variable List panel of the analyze tool (Pro-
gram Analyzer) are also managed on this panel.

Remark 3. This panel can be zoomed in and out by |1 a0k -| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Remark 4. When the separator line of each area in this panel is double-clicked, the width of the area changes to the
shortest possible size that can display the contents of the area.

Figure A.18 Events Panel
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This section describes the following.
- [How to open]
- [Description of each areal
- [Toolbar]
- [[Edit] menu (Events panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Event].

- [IECUBE][Simulator]
On the Editor panel/Disassemble panel, select [Timer Settings] >> [View Result of Timer] from the context menu.

[Description of each area]

(1) [Name] area
A list of the event names that have currently been set is displayed in the following format.
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'_f_ '% Hardware Bresk0007
(@) (b) (c)
Remark It is possible to limit the event to be displayed by clicking the button on the toolbar (see "[Toolbar]").

(@) Check box
The setting state of the event is displayed/changed.
Note that the Event mark is changed depending on the setting state of the event.

Valid state Event occurs when the specified condition is met.
It is possible to set the event to an invalid state by removing the check.

[7] | Invalid state Event does not occur when the specified condition is met.
It is possible to set the event to a valid state by removing the check.

Suspended state The conditions that have been specified cannot be set with the program of the
debugging target.
It is not possible to operate the check box.

Remark 1. Both of the Timer Start event and Timer Stop event is must be set for the Timer Result event.
Therefore, it is not possible to set a particular event to a valid state by only the setting of one of
these (at the same time as both events are set, they are treated as grouped events as a Timer
Result).

Remark 2. It is not possible to set the Run-Break Timer event to an invalid/suspended state.

Remark 3. The setting of the Unconditional Trace event and the Trace event to valid or invalid state is exclu-
sively controlled. Therefore, the Unconditional Trace event, which is a built-in event, is valid
state by default, but if either a trace start event/trace end event is set, it automatically becomes
invalid state, and the Trace event, which is a event name that is collectively called with a trace
start event and a trace end event, becomes valid state. Conversely, if the set Trace event is
invalid state, the Unconditional Trace event automatically becomes valid state.

(b) Event mark
The event mark shows the type of event, and in addition shows the current setting state.
The meanings of the marks displayed are as follows:

Table A.11  Event Mark

Event Type Valid State Invalid Suspended Note
State State
Hardware Break w5 5 », -
Software Break a5 T M -
Combination Break e w5 , -
Break at start of function w, ki ”:n A break event that can be set via the
; analyze tool.

Access break to variable R {)K ”»,
Unconditional Trace o = None -
Run-Break Timer =o None None -
Trace 12 b 3 Displayed on only the Events panel

Trace start i h 3 Displayed on only the Editor panel/

- - Disassemble panel

Trace end i X

Timer Result 4] 5 I Displayed on only the Events panel
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(c)

Event Type Valid State Invalid Suspended Note
State State
Timer start 4] 5 Sid Displayed on only the Editor panel/
- Disassemble panel
Timer end ) [
Point Trace - ¥ § -
Printf (Action event) g & 5 -
Setting of two or more i Note 1 flp§ Note 2 [mNote 3| Displayed on only the Editor panel/
events Disassemble panel

Note 1.
Note 2.
Note 3.

Event name

There is one or more event with valid state.
There is no event with valid state and at least one event with invalid state.

All the set events are suspended state.

The event type and ID number are displayed as the event name.
A number from 0001 is automatically provided as the ID number for each event (no renumbering of the ID nhum-
ber is done even in the event that an event that has been set once is deleted).
Event types that are displayed are as follows:

Table A.12  Event Type

Event Type

Description

Hardware Break
(BreakNote 1)

Breaks the program when the condition is met while the debug tool monitors
the break condition all the time during program execution.

-> See "2.9.3 Stop the program at the arbitrary position (breakpoint)"

-> See "2.9.4 Stop the program at the arbitrary position (break event)"

-> See "2.9.5 Stop the program with the access to variables/SFRs"

Software Break
(BreakNote T

Breaks the program when the instruction, which an address code to break is
rewritten for the break instruction, is executed.
-> See "2.9.3 Stop the program at the arbitrary position (breakpoint)"

Combination Break

Breaks the program when, while the debug tool successively is checking plural
break conditions during program execution, the combination condition is met.
-> See "2.9.4 Stop the program at the arbitrary position (break event)"

-> See "2.9.5 Stop the program with the access to variables/SFRs"

Break at start of function

This event type is a Hardware Break (execution type) that is set in the Function
panel of the analyze tool (Program Analyzer).

Access break to variable

This event type is a Hardware Break (access type) that is set in the Variable
panel of the analyze tool (Program Analyzer).

Unconditional Trace

Automatically collects the trace data with start of a program execution, and
stops collecting the trace data with stop of the program execution.

This event cannot be deleted because of the built-in eventNote 2 (this event is
set to a Valid state by default).

-> See "2.12.2 Collect execution history until stop of the execution"

Run-Break Timer

Automatically measures the execution time of a program with start of the pro-
gram execution, and stops the measurement with stop of the program execu-
tion. This event cannot be deleted because of the built-in eventNote 2 (this
event is set to a Valid state by default).

-> See "2.13.2 Measure execution time until stop of the execution”

Trace

Starts/stops collecting the trace data when the condition specified with a trace
start event and a trace end event is met (this event is displayed when either a
trace start event or a trace end event is set).

-> See "2.12.3 Collect execution history in a section"
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Event Type Description
Timer Result Starts/stops measuring the execution time of a program when the condition
specified with a timer start event and a timer end event is met (this event is dis-
played when either a timer start event or a timer end event is set).
-> See "2.13.3 Measure execution time in a section [[IECUBE][Simulator]"
Point Trace Records the information as the trace data only when accessing the specified
variable or SFR during execution of a program.
-> See "2.12.4 Collect execution history only when the condition is met
[[ECUBE][Simulator]"
Printf Executes printf command in software processing after temporary stopping a
program in execution at an arbitrary position (action event).
-> See "2.15.1 Inset printf"
Note 1. A breakpoint that is set by a one click operation of the mouse is displayed "Break" (see "2.9.3.1
Set a breakpoint").
Note 2. This is set in the debug tool by default.

(2) [Detail Information] area

Detailed information about each event is displayed.
The contents of the information that is displayed differ depending on the event type as follows:

Caution For an access-related event to which the detailed event conditions have been set via the Detail dia-
log box (for access events), "[Refer To A Detail Dialog]" may be displayed in this area. If this is the
case, refer to the contents of the Detail dialog box (for access events).

Table A.13 Detailed Information with Event Type

Event Type Displayed ContentNote 1
Hardware Break Format1 | <Condition to occur> <File name#Line number> <Address>
(Condition: execution)
Example | Before Execution main.c#39  0x100
After Execution sub.c#100 0x200
Before Execution - 0x300
Execution main.c#39  0x300 [Simulator]
Format2 | <Condition to occur> <Symbol + Offset> <Address>
Example | Before Execution funcA + 0x10 0x100
After Execution funcB + 0x20 0x200
Before Execution - 0x300
Hardware Break Format1 | <Condition to occur> <File name#Variable name> <Address(range)>
(Condition: access) <Comparison condition> <Comparison value>
Example | Read main.c#variablel  0x100 - 0x101 == 0x5
Write sub.c#variable2 0x200 - 0x200 == Ox7
Read/Write sub2.c#variable3  0x300 - 0x303 == 0x8
Format2 | <Condition to occur> <File name#Function name#Variable name>
<Address(range)> <Comparison condition> <Comparison value>
Example | Read main.c#funci#variable!  0x100 - 0x101 == 0x10
Format3 | <Condition to occur> <Variable name> <Address(range)> <Comparison
condition> <Comparison value>
Example | Write variable1 0x100 - 0x101 == 0x10
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Event Type Displayed ContentNote 1

Software Break Format1 | <Condition to occur> <File name#Line number> <Address>

Example | Before Execution main.c#40 0x102

Before Execution sub.c#101  0x204

Format2 | <Condition to occur> <Symbol + Offset> <Address>

Example | Before Execution funcA + 0x12  0x102

Combination Break Format <Combination condition>
(Condition: execution/ <Detailed information of combination break event>
access)

Example | OR

- After execution main.c#100  0x300

- After execution funcA + 0x10 0x100

- Write sub.c#fvariable2 0x200 - 0x200 == O0x7
- Read/Write sub2.c#variable3 0x300 - 0x303 == 0x8

Unconditional Trace Format -

Example -

Run-Break Timer Format Total: <Total execution time>

Example | Total: 1000ms

Total: OVERFLOW

Trace Format Total of Start/End: <Total number of trace start/trace end events> Note 2
(Condition: execution) <Start/End> <Detailed information of trace start/frace end event>

Example | Total of Start/End: 4

- Start  After Execution main.c#100  0x300
- Start After Execution funcA + 0x100 0x300
- End After Execution main.c#200  0x100
- End After Execution funcA + 0x10 0x100

Timer Result Format Total:<Total execution time > Total of Start/End: <Total number of timer
(Condition: execution) start event/timer end event>Not 2

- <Total execution time> <Pass Count> <Average> <Max> <Min>

- <Start/End> <Detailed information of timer start event/timer end event>

Example | Total: 10ms Total of Start/End: 4

- Total: 10ms Pass Count: 5 Average: 2ms Max: 4ms Min: 1ms
- Start After Execution main.c#100  0x300

- Start After Execution  funcA + 0x30 0x100

- End After Execution main.c#100  0x300

- End After Execution funcA + 0x50 0x100
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Event Type Displayed ContentNote 1

Point Trace Format1 | <Condition to occur> <Variable name> <Variable address>
(Condition: access)

Example | Read variable1 0x100

Format2 | <Condition to occur> <File name#Variable name> <Variable address>

Example | Write sub.c#variable2 0x200

Format3 | <Condition to occur> <File name#Function name#Variable name> <Vari-
able address>

Example | Read/Write sub.c#func1#variable3 0x300

Printf Format <Condition to occur> <File name#Line number> <Address> <Setting of
(Action event) Printf event>
Example | Before Execution main.c#39 0x100 aaa, bbb, ccc
After Execution sub.c#100 0x200 Result of aaa : aaa
Note 1. Following are the details on the display format.
<Condition to Displays one of the following conditions.
occur> For other than [Simulator]
Execution: Before Execution or After Execution
Access: Read, Write, Read/Write
[Simulator]
Execution: Execution
Access: Read, Write, Read/Write

<File name#Line | Shows the line number of the source. Display format is the same as the
number> watch type scope specification expression.

If there are multiple load module files that are downloaded, <Load module
name$File name#Line number> is displayed.

For those events set in the Disassemble panel, display <Line number> in
the format <Symbol + offset> in the condition below.

- Line information exists and the specified position that the event is set not
the top of the line information

- Line information does not exist and symbol information exists.

Show <Line number> in "-" in the following condition.

- Line information and symbol information does not exist.

<Variable name> | Shows the variable name in the source file. Display format is the same as
the watch type scope specification expression.

<Comparison Condition to compare (==) is shown. If the comparison value is not specified,
condition> comparison condition is not shown.
<Comparison Comparison value is shown. If the comparison value is not specified, com-
value> parison condition is not shown.
<Address> Address in the memory area is shown (only in hex number).
<Combination One of the following conditions is displayed:
condition> OR, Sequential
<Start/End> Shows whether the contents of the detailed information is start event or the
stop event.
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<Pass Count> Shows the measurement result of the pass count of the timer.

If a timer overflow occurs (see "2.13.4 Measurable time ranges"), or if the
illegal value was acquired, "OVERFLOW" is displayed.

If measurements have not been performed yet, "Not measured" is dis-
played.

<Total> Shows the measurement result of the timer total execution time.

The unit is either of ns/us,/ms/s/min/clock (if, however, the unit is in "min”, a
value in "s" unit also appears).

If a timer overflow occurs (see "2.13.4 Measurable time ranges"), or if the
illegal value was acquired, "OVERFLOW" is displayed.

If measurements have not been performed yet, "Not measured" is dis-

played.

<Average> Shows the measurement result of average execution of the timer.

The unit is either of ns/us,/ms/s/min/clock (if, however, the unit is in "min", a
value in "s" unit also appears).

If a timer overflow occurs (see "2.13.4 Measurable time ranges"), or if the
illegal value was acquired, "OVERFLOW" is displayed.

If measurements have not been performed yet, "Not measured" is dis-

played.

<Max> Shows the measurement result of the maximum execution time of the timer.
The unit is either of ns/us,/ms/s/min/clock (if, however, the unitis in "min", a
value in "s" unit also appears).

If a timer overflow occurs (see "2.13.4 Measurable time ranges"), or if the
illegal value was acquired, "OVERFLOW" is displayed.

If measurements have not been performed yet, "Not measured" is dis-
played.

<Min> Shows the measurement result of the minimum execution time of the timer.
The unit is either of ns/us,/ms/s/min/clock (if, however, the unitis in "min", a
value in "s" unit also appears).

If a timer overflow occurs (see "2.13.4 Measurable time ranges"), or if the
illegal value was acquired, "OVERFLOW" is displayed.

If measurements have not been performed yet, "Not measured" is dis-
played.

<Set print event> | Shows the variable expression and the character strings specified in the
Action Events dialog box.

Note 2. Click this line to display the detailed information of the lower lines.

(3) [Comment] area
The user can write comments for each event that has been set.
To input comments, click on this area, or select [Edit Comment] form the context menu after selecting the event in
which you want to input comments, and then input directly the desired text from the keyboard (the edit mode is
cancelled by pressing down the [Esc] key).
After editing the comments, complete the editing by pressing the [Enter] key or moving the focus to outside the
edit region. Up to a maximum of 256 characters can be inputted for the comments, and this is saved as the set-
tings of the user during use.

[Toolbar]
Deletes the selected event and event condition.
Note that it is not possible to delete the built-in events (Unconditional Trace event and Run-
Break Timer event).
Displays events related to Hardware Break (default).
Displays events related to Software Break (default).
(except [Simulator])
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Displays events related to the traceN°te ! (default).

<)@

m

CUBE][Simulator]

Displays events related to the timer (default).

Displays events related to the action event (Printf event) (default).

]| (&3]

Displays events related to the built-in event (Unconditional Trace event/Run-Break Timer
event) (default).

[l

Opens the Editor panel and jumps to the source line corresponding to the address where
the selected eventN°t 2 is being set.

]

Opens the Disassemble panel and jumps to the disassemble results corresponding to the
address where the selected eventN°t® 2 is being set.

E

Opens the Memory panel and jumps to the memory corresponding to the address where
the selected eventN°® 2 is being set.

Note 1. [E1][E20][EZ Emulator][COM Port]
This button is only available when the selected microcontroller incorporates the OCD trace function.

Note 2. Events other than Trace events, Timer Result events and built-in events (Unconditional Trace events/
Run-Break Timer events) can be objects of this button.

[[Edit] menu (Events panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Events panel (all other items are disabled).

Delete Deletes the selected event and event condition.
Note that it is not possible to delete the built-in events (Unconditional Trace event and
Run-Break Timer event).

Select All Selects all the events displayed on the panel.

Find... Opens the Find and Replace dialog box with selecting [Find in Files] tab.

Replace... Opens the Find and Replace dialog box with selecting [Replace in Files] tab.

[Context menu]

Enable Event

Enables the selected event (valid state).
Note that this item is disabled if the selected event is a valid state.

Disable Event

Disables the selected event (invalid state).
Note that this item is disabled if the selected event is an invalid state.

Delete Deletes the selected event.
Note that it is not possible to delete the built-in events (Unconditional Trace event and
Run-Break Timer event).

Select All Selects all the events of this panel.
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View Select

The following cascade menus are displayed to limit the event type to be displayed.
All of the items have been selected by default.

Hardware Break

Displays events related to Hardware Break.

Software Break

Displays events related to Software Break.

Timer Event

Displays events related to the timer.

Trace Event

Displays events related to the traceNote 1,

Action Event

Displays events related to action events (Printf events).

Built-in Event Displays events related to built-in events (Unconditional Trace event or Run-Break Timer
event).
Timer Settings The following cascade menus are displayed to do the settings related to the timer.
Note that this item is enabled only when a timer-related event has been selected.
Init Timer Initializes the timer used by the selected event (except for Run-Break Timer).
Nanosecond Displays the result of a selected event measured by a timer in nanosecond (ns) units.

Microsecond

Displays the result of a selected event measured by a timer in microsecond (us) units.

Millisecond Displays the result of a selected event measured by a timer in millisecond (ms) units.
Second Displays the result of a selected event measured by a timer in second (s) units.
Minute Displays the result of a selected event measured by a timer in minute (min) units.
Clock Displays the result of a selected event measured by a timer in clock units.

Jump to Memory

Opens the Memory panel (Memory1) and jumps to the memory corresponding to the
address where the selected eventN° 2 is being set.

Jump to Disassemble

Opens the Disassemble panel (Disassemble1) and jumps to the disassemble results cor-
responding to the address where the selected eventNo€ 2 jg being set.

Jump to Source

Opens the Editor panel and jumps to the source line corresponding to the address where
the selected eventN°t® 2 is being set.

Edit Condition...

Opens one of the following dialog box to edit the selected event

- For an execution-related event
Detail dialog box (for execution events)

- For an access-related event
Detail dialog box (for access events)

- For a Combination Break event
Combination Condition dialog box [E1][E20]

- For an action event (Printf event)
Action Events dialog box

Edit Comment

Sets to the edit mode to input comments for the selected event.
When comments are already present, all of that character string is set to a select state.

Note 1.

[E1][E20][EZ Emulator][COM Port]

This button is only available when the selected microcontroller incorporates the OCD trace function.

Note 2.

Events other than Trace events, Timer Result events and built-in events (Unconditional Trace events/

Run-Break Timer events) can be objects of this button.
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Output panel

This panel is used to display operation logs for various components (debug tool, design tool, build tool, etc.) provided by
CS+, in addition to results of batch searches by the Find and Replace dialog box and a Printf event (see "2.15.1 Inset
printf").

The messages are classified by the message origination tool and displayed on the individual tabs.

Remark This panel can be zoomed in and out by |1 a0k '-'| in the tool bar, or by moving the mouse
wheel forward or backward while holding down the [Ctrl] key.

Figure A.19 Output Panel
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This section describes the following.

- [How to open]

- [Description of each area]

- [[File] menu (Output panel-dedicated items)]
- [[Edit] menu (Output panel-dedicated items)]

- [Context menu]

[How to open]

- From the [View] menu, select [Output].

[Description of each area]

(1) Message area
The output messages of each tool, search results and results by a Printf event are displayed.
In the case of search results (batch search), every time a search is performed, a new message will be displayed
after the previous message is cleared (except for the [All Messages] tab).
The colors of message display differ with the type of message as shown below (character colors and background
colors depend on the configuration in the [General - Font and Color] category of the Option dialog box).

Message Type Display Example (Default) Description

Normal message | azBhbC: | Character color Black Displayed with information notices

Background color | White

Warning mes- A~aBhCe | Character color Blue Displayed with warnings about opera-

sage tions
Background color | Standard color

Error message ~LaBhic; | Character color Red Displayed when there is a critical error, or
when execution is not possible due to a
operational mistake

Background color | Light gray

This area is provided with the following functions.
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(@) Tagjump
By double-clicking on the output message, the Editor panel is opened and the number of the corresponding line
in the corresponding file is displayed.
This allows you to jump from error messages that are output when building, etc. to the corresponding error line
in the source file.

(b) Help display
If there is a caret on the line where a warning message or error message is being displayed, you can select
[Help for Message] from the context menu. You can also display help for that line's message by pressing the
[F1] key.

(c) Savingalog
The Save As dialog box can be opened by selecting the [File] menu >> [Save Output-tab name As...], and the
contents that are displayed on the currently selected tab can be saved in a text file (*.txt) (messages on dese-
lected tabs will not be saved).

(2) Tab selection area
Select the tab that indicates the origin of message.
The following tabs are available for the debug tool.

Tab Name Description

All Messages Displays operation logs for all components (debug tool, design tool, build tool, etc.)
provided by CS+ in order of output.

Debug Tool Displays messages output from the debug tool.
Display only operation logs for the debug tool out of those for various components
(debug tool, design tool, build tool, etc.) provided by CS+.

Find and Replace Displays the batch search results from the Find and Replace dialog box.
Caution Even if a new message is output on a deselected tab, tab selection will not automatically switch. In
this case, "*" mark will be added in front of the tab name, indicating that a new message has been
output.

[[File] menu (Output panel-dedicated items)]

The following items are exclusive for the [File] menu in the Output panel (other items are common to all the panels).
Note that all these items are disabled during execution of a program.

Save Output-tab name | Overwrites the contents that are displayed on the currently selected tab to the preciously
saved text file (see "(c) Saving a log").

Note that when the file has never been saved or the file is write disabled, the same opera-
tion is applied as the selection in [Save Output-tab name As...].

This item is disabled while building.

Save Output-file name Opens the Save As dialog box to newly save the contents that are displayed on the cur-
As... rently selected tab to the specified text file (*.txt) (see "(c) Saving a log").

[[Edit] menu (Output panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Output panel (all other items are disabled).

Copy Copies the contents of the selected range to the clipboard as character string(s).

Select All Selects all the messages displayed on the currently selected tab.

Find... Opens the Find and Replace dialog box with selecting [Quick Find] tab.

Replace... Opens the Find and Replace dialog box with selecting [Replace in Files] tab.
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[Context menu]

Copy Copies the contents of the selected range to the clipboard as character string(s).
Select All Selects all the messages displayed on the currently selected tab.

Clear Deletes all the messages displayed on the currently selected tab.

Tag Jump Opens the Editor panel and jumps to the number of the corresponding line in the corre-

sponding file of the message at the caret position.

Stop Searching Cancels the search currently being executed.
This item is disabled when a search is not being executed.

Help for Message Displays help for the massage on the current caret position.
This item only applies to warning messages and error messages.
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Memory Mapping dialog box

This dialog box is used to display the state of the memory mapping.

Figure A.20 Memory Mapping Dialog Box

Mermory Mapping
|  Memory byps: Addregs parge
L = (1]
(M7 Aocess wadth:
Ii=mory mapped list:
Hemosy typs hddress sange Zize Aosess widsh

Iecacnal ROM aras JwI0000 — OwJfEfff 64 FEyYcad 0 bica

Honm-map aArsa IR10000 = Oxeffff B89 BEBEyces I c1its

SFR mfaa O E0000 — OxEQTEE 3 FBy=aa b Bita

| Hon-map arca IxEZ0800 — Oxfdfff Z EByc-os O bitca
(2) DasaFlash areas I%E1000 = OxflEEE 4 EByses B bitme
Hirsar aras IxEZ000 — Onfaaff S5Z3957 Eycas 0 bica

Luternal RAM arsa UOxfsfol = Uxiiedf 4084 Bytes I blits

FEgiabeas ADsa Ixffeel — OxEffeff 37 Bysea b EBita

[Function buttons]{ | Ok | [ Caricsl ]

This section describes the following.
- [How to open]
- [Description of each areal

- [Function buttons]

[How to open]

- On the [Debug Tool Settings] tab of the Property panel, click the [...] button displayed by selecting one of the values of

the [Memory mappings] property in the [Memory] category.

Caution This dialog box cannot be opened during execution of a program.

[Description of each area]

(1) Added memory mapping specification area
This area is always invalid.

(2) [Memory mapped list] area

(a) List display
Information about the microcontroller's internal memory mapping is displayed.
This area cannot be edited.

Memory type Displays the memory types.
Address range Displays the address range as <Start address> - <End address>.
Display is fixed as "0x"-prefixed hexadecimal numbers.
Size Displays size as a decimal number (unit: bytes/KbytesNOte).
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Access width

Displays the access width (unit: bits).

Note Only in the case of multiple of 1024, displays in kilobyte units.
(b) Button
Button Function
Remove This button is always invalid.
[Function buttons]
Button Function
OK Closes this dialog box.
Cancel Closes this dialog box.
Help Displays the help for this dialog box.
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Download Files dialog box

This dialog box is used to select files for downloading and configure download conditions (see "2.6 Download/Upload

Programs").
Note that files specified as build targets in a project (main project or sub-project) are automatically registered as down-

load targets (they can be unregistered).

Caution This dialog box cannot be opened during execution of a program.

Figure A.21 Download Files Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- On the [Download File Settings] tab of the Property panel, click the [...] button displayed by selecting the [Download
files] property in the [Download] category.

[Description of each area]

(1) [Download file list] area
(a) List display
Displays a list of files to download. The names of files specified as build targets in a project (main project or
sub-project) are displayed by default (they can be removed).
Files are downloaded in the order that they are displayed here.
To add a new file to be downloaded, click the [Add] button in this area, then in the [Download file property] area,
specify the download conditions of the file to add.

(b) Button
Button Function
Up Moves the selected file up one row in the list.
Clicking this for the top file in the list has no effect.
Down Moves the selected file down one row in the list.
Clicking this for the bottom file in the list has no effect.
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Button Function
Add Adds an empty item "-" to the list, and selects it.
Specify the download conditions of the file to add in the [Download file property] area.
Note that this button will be disabled if 20 files have already been registered.
Remove Removes the selected file from the list.
Note, however, that this button is disabled if the selected file is a project build target.
Remark 1. By hovering the mouse cursor over a file name, the pass information of the file is pop-up dis-

played
Remark 2.

By dragging a file name with the mouse, the display order in the list can be changed.

Note, however, that the order of a project build target cannot be changed.

(2)
(a)

[Download file property]

area

[Download file information]

This area is used to display or edit the download conditions of the file selected in the [Download file list] area.
It can also be used to specify the download conditions of new download files added via the [Add] button.

File Specify the name of the file to download.
Default File name (but it will be blank for newly added files)
Modifying Directly enter from the keyboard, or specify with the Select Down-
load File dialog box that is opened by clicking the [...] buttonN°t¢ 1
appears at right by selecting this item.
Available values | See "Table 2.2 Downloadable File Formats"
Up to 259 characters
File type Specify the type of the file to download.
Default Load module file
Modifying Select from the drop-down list.
Available values | Load module file Specifies a load module file (*.abs).
Hex file Specifies an Intel HEX file (*.hex).
S-record file Specifies a Motorola S-record file (*.mot).
Binary data file Specifies an binary file (*.bin).
Offset Specify the offset from the address at which the file's download is to start.
Note that this item appears only when [File type] or [S-record file] is set to [Hex file].
Default 0
Modifying Directly enter from the keyboard.
Available values | 0x0 to OXFFFFF in hexadecimal number
Start address Specify the address at which to start the file's download.
Note that this item appears only when [File type] is set to [Binary data file].
Default 0
Modifying Directly enter from the keyboard.
Available values | 0x0 to OxFFFFF in hexadecimal number
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Download object | Specify whether to download the object information from the specified file.
Note that this item appears only when [File type] is set to [Load module file].

Default Yes
Modifying Select from the drop-down list.
Available values | Yes Downloads object information.
No Does not download object information.
Download sym- | Specify whether to download the symbol information from the specified fileNot 2,
bol information Note that this item appears only when [File type] is set to [Load module file].
Default Yes
Modifying Select from the drop-down list.
Available values | Yes Downloads symbol information.
No Does not download symbol information.
Generate the Select whether to generate the information for the Symbol name completion function
information for when downloadingNot€ 3.

input completion Note that this item appears only when [File type] is set to [Load module file].

Default Yes

Modifying Select from the drop-down list.

Available values | Yes Generates the information for the symbol name com-
pletion function. (i.e. uses the symbol name comple-
tion function.)

No Does not generate the information for the symbol
name completion function. (i.e. does not use the sym-
bol name completion function.)

Note 1. When a file specified as build target in the project is selected in the [Download file list] area, or
when the program is executing, the [...] button does not appear.

Note 2. If the symbol information have not been downloaded, the source level debugging cannot be per-
formed.

Note 3. When [Yes] is selected, the time taken for downloading and the memory usage on the host

machine will increase. We recommend selecting [No] in this item if you do not intend to use the
symbol name completion function.

[Function buttons]

Button Function
OK Finishes configuring the download files, and closes this dialog box.
Cancel Cancels any changes to the download files, and closes this dialog box.
Help Displays the help for this dialog box.
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Action Events dialog box

This tab is used to configure action events (see "2.15 Set an Action into Programs").
This dialog box appears only when connected to the debug tool.

Caution Also see "2.16.7 Notes for setting events" for details on Printf events (e.g. limits on the number of
enabled events).

Figure A.22 Action Events Dialog Box

Bction Events ﬁ
(1 Prrtf evert | State save avent

— Chtpud slrimg: Example) Sample:

e

Vanable expression;  Bxample) aaa, bbb, oo

_minube
Address:

“Csample! DefauktBuildsample. abs Svecttbl asma 13 [=]

(2 Example: for Cutput pare)
Sample: saa = 10, bbb = 20, oce = 30

[Function buttons]~|: E Ok ” Lancel || Help

"

This section describes the following.
- [How to open]
- [Description of each areal

- [Function buttons]

[How to open]

- On the Editor panel, move the caret to the line where you wish to set an action event, then select [Register Action
Event...] from the context menu.

- On the Disassemble panel, move the caret to the address where you wish to set an action event, then select [Register
Action Event...] from the context menu.

- On the Events panel, select an action event, then select [Edit Condition...] from the context menu.

[Description of each area]

(1) Tab selection area
Select a tab to switch the type of an action event to be set.
This dialog box has the following two tabs.

- [Printf event] tab

Caution If this dialog box is opened by selecting [Edit Condition...] from the context menu, this area does not
appear.
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(2) Event condition setting area
Use this area to configure detailed condition of an action event.
For details on how to setup an action event, see the section explaining the corresponding tab.

[Function buttons]

Button Function
OK Finishes configuring the action event, and sets it at the position specified in this dialog box.
Cancel Cancels the action event settings and closes this dialog box.
Help Displays the help for this dialog box.
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[Printf event] tab

Use this tab to configure Printf events as action events (see "2.15 Set an Action into Programs").

A Printf event momentarily stops the execution of the program at a specified location, and executes the printf command
via software processing. When a Printf event is set, the program momentarily stops immediately before executing the
command at the location where this event is set, and the value of the variable expression specified in this dialog box is
output to the Output panel.

This dialog box appears only when connected to the debug tool.

Figure A.23 Action Events Dialog Box: [Printf event] Tab
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- On the Editor panel, move the caret to the line where you wish to set a Printf event, then select [Register Action
Event...] from the context menu.

- On the Disassemble panel, move the caret to the address where you wish to set a Printf event, then select [Register
Action Event...] from the context menu.

- On the Events panel, select a Printf event, then select [Edit Condition...] from the context menu.

[Description of each area]

(1) [Output string] area
Type in the string to add to the Output panel directly via the keyboard (up to 1024 characters).
Note that the output string can only be one line (spaces allowed).

(2) [Variable expression] area
Specify the variable expression(s) for the Printf event.
Type a variable expression directly into the text box (up to 1024 characters).
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You can specify up to 10 variable expressions for a single Printf event by separating them with commas (",").

If this dialog box opens with a variable expression selected in the Editor panel/Disassemble panel, the selected
variable expression appears as the default.

The basic input format that can be specified as variable expressions and the values output by Printf event are as

follows:

Table A.14 Relationship between Variable Expressions and Output Value (Printf Event)

Variable Expression Output Value
Variable name of C/C++ languageN°t ! Value of C/C++ language variable
Variable expression [Variable expression] Element of array
Variable expression.Member nameN°te 2 Member of structure/union/class
Variable expression -> Member nameNote 2 Member of structure/union/class that pointer designates
Variable expression.*Cast expression Value of a pointer to member variable
Variable expression->*Cast expression Value of a pointer to member variable
*Variable expression Value of pointer variable
&Variable expression Location address
(Type name) Variable expression Value cast to a specified type
CPU register name Value of a CPU register
SFR name Value of a SFR
Label nameN°® 3, EQU symbol nameN°t¢ 3 and Values of label, EQU symbol and immediate address
immediate address

Note 1. It represents C language (C89/C99) and C++ language variables.

Note 2. When using a member variable of a base class, specify the scope before the member name (e.g.
variable.BaseClass::member).

Note 3. If the label name or EQU symbol name includes a "$", be sure to enclose the name in "{ }" (e.g.
{$Label}).

Any imaginary number must be multiplied by an uppercase "I" (e.g. 1.0 + 2.0*l). When you specify
the CPU register name "I", add ":REG" (e.g. I:REG) to distinguish it from the keyword "I" that indi-
cates an imaginary number.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in this text box (see "2.20.2 Symbol name completion function").

(3) [Address] area
Specify the address at which to set the Printf event.
You can either type an address expression directly into the text box (up to 1024 characters), or select them from
the input history via the drop-down list (up to 10 items). The address of the location currently being specified is
displayed by default.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in this text box (see "2.20.2 Symbol name completion function").

Note that the output result format by the Printf event in the Output panel are as follows:

Figure A.24 Output Result Format of Printf Event

Specified-characters Variable-expression-1 = Value-1, Variable-expression-2 = Value-2, ...

Specified characters Characters specified with [Output string]

Variable expression 1 - 10 Characters specified with [Variable expression]
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Value 1-10 Value of variable corresponds to " Variable expression 1-10".

The value is displayed in the default notation (see "Table A.10 Display Format of
Watch-Expressions (Default)") according to the type of the variable (note, however,
that "?" will be displayed if the specified variable expression cannot be obtained).
Moreover, the value in hexadecimal number enclosing with "()" is also displayed (note,
however, that "-" will be displayed if the value cannot be displayed in that notation).

[Function buttons]

Button Function
OK Finishes configuring the Printf event, and sets it at the caret position in the Editor panel/
Disassemble panel.
Cancel Cancels the Printf event settings and closes this dialog box.
Help Displays the help for this dialog box.
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[State save event] tab

This tab is used to configure how to save and restore the state of the debug tool upon occurrence of an action event.
Note that the data to be restored is limited to memory and register values that can be read or written.

Figure A.25 Action Events Dialog Box: [State save event] Tab
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This section describes the following.
- [How to open]

- [Description of each area]

[How to open]

- On the Editor panel, move the caret to the line where you wish to set a State save event, then select [Register Action
Event...] from the context menu.

- On the Disassemble panel, move the caret to the address where you wish to set a State save event, then select [Reg-
ister Action Event...] from the context menu.

- On the Events panel, select a State save event, then select [Edit Condition...] from the context menu.

[Description of each area]

(1) [Save debug tool state n] area
When an action event occurs, the state of the debug tool is saved in a file as the n-th data.

(2) [Restore debug tool state n] area
When an action event occurs, the state of the debug tool is restored from the n-th data file.

(3) [Address] area
Specify the address at which to set a state save event.
You can either type an address expression directly into the text box (up to 1024 characters), or select them from
the input history via the drop-down list (up to 10 items). The address of the location currently being specified is dis-
played by default.
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For details on the features and usage, see “Saving and Restoring the States of Debug Tools”.

[Function buttons]

Button Function
OK Finishes configuring the state save event, and sets it to the line/address at the
caret position in the Editor panel/Disassemble panel.
Cancel Cancels the state save event setup and closes this dialog box.
Help Displays the help for this dialog box.
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Security ID Input dialog box

Displayed when the security ID authentication is retried when the hot plug-in is connected to the debug tool.

Figure A.26 Security ID Input dialog box
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This section describes the following.
- [How to open]
- [Description of each areal

- [Function buttons]

[How to open]

- Select [Hot Plug-in] from the [Debug] menu
>> Security ID authentication fails and message dialog opens(W0602219)
>> Select [Retry] button

- Select [Hot Plug-in] from the [Debug] menu
>> Times out for security ID authentication and message dialog opens (W0602218)
>> Select [Retry] button

[Description of each area]

(1) security ID Input area
Enter the value you want to set for the security.

[Function buttons]

Button Function
OK Moves the caret to the specified location, from the beginning of the area displayed in the tar-
get panel.
Cancel Cancels the jump and closes this dialog box.
Help Displays the help for this dialog box.
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Column Number Settings dialog box

This dialog box is used to set the number of view columns of memory values on the Memory panel.
Figure A.27 Column Number Settings Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- On the Memory panel, select [View] >> [Column Number Settings...] from the context menu.

[Description of each area]

(1) [Column Number] area
Directly enter a decimal value as the number of columns you want to display.
The settable range depends on [Size Notation] currently being set on the Memory panel, as follows:

Size Notation Settable Range
4 Bits 2 - 512Note
1 Byte 1-256
2 Bytes 1-128
4 Bytes 1-64
8 Bytes 1-32
Note Only an even number is specifiable (if an odd number is specified, then it will be changed to a value

one greater than such odd number).

[Function buttons]

Button Function
OK Displays memory values in the specified number of columns.
Cancel Cancels the settings and closes this dialog box.
Help Displays the help for this dialog box.
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Address Offset Settings dialog box

This dialog box is used to set an offset value of the start address in the address area on the Memory panel.

Figure A.28 Address Offset Settings Dialog Box
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This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Memory panel, select [View] >> [Address Offset Value Settings...] from the context menu.

[Description of each area]

(1) [Address Offset Value] area
Directly enter a hexadecimal value as an offset value for the address display.
The settable range depends on the number of bytes of the memory currently being displayed in a line on the Mem-
ory panel, as follows:

- Settable range:

Example

[Function buttons]

0x0 - ("Set value of [Size Notation]' x "The number of view columns") -1

When "Set value of [Size Notation]" is 1 byte and "The number of view columns" is 16 columns:

Offset Value

Displayed Content of Address Area

0x0

(default)

0000
0010
0020

0x1

0001
0011
0021

0x2

0002
0012
0022

Button Function
OK Displays memory addresses with the specified offset value.
Cancel Cancels the settings and closes this dialog box.
Help Displays the help for this dialog box.
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Memory Initialize dialog box

This dialog box is used to initialize memory (see "2.10.1.6 Modify the memory contents in batch (initialize)").
The memory area in the specified address range is repeatedly overwritten with the specified initial data pattern.

Figure A.29 Memory Initialize Dialog Box
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This section describes the following.
- [How to open]
- [Description of each areal

- [Function buttons]

[How to open]

- On the Memory panel, select [Fill...] from the context menu.

[Description of each area]

(1) Range specification area
Specify the range of memory address to initialize via the [Start address/symbol] and [End address/symbol]. You
can either type address expressions directly into the text boxes (up to 1024 characters), or select them from the
input history via the drop-down list (up to 10 items).
The results of calculating the address expressions you have entered are treated as start and end addresses,
respectively.
Note that address values greater than the microcontroller address space cannot be specified.

Caution You cannot specify the range of address aligned across the different endian area.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.20.2 Symbol name completion function").

(2) [Initialize data] area
Specify the initial value(s) with which to overwrite the memory.
You can either type the initial value into the text box directly in hexadecimal number (the value need not start with
"0x"), or select one from the input history via the drop-down list (up to 10 items).
You can specify more than one initial value. Specify up to 16 values of up to 4 bytes (8 characters) each, sepa-
rated by spaces.
Each initial value is parsed from the end of the string, with each two characters interpreted as a byte.
If the string has an odd number of characters, then the first character is interpreted as one byte.
Note that if a initial value consists of more than one byte, then the target memory is overwritten with the value con-
verted into an array of bytes of the specified address range's endian, as follows.

Input Character Strings How Data is Overwritten (in Bytes)
(Initial Value)
Little Endian Big Endian
1 01 01
012 0012 00 12
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Input Character Strings How Data is Overwritten (in Bytes)
(Initial Value)
Little Endian Big Endian
00 012 345 00 12 00 45 03 00 00 1203 45
000 12 000345 0000124503 00 00 00 12 00 03 45
[Function buttons]
Button Function
OK The memory area in the specified address range is repeatedly overwritten with the speci-
fied initial data pattern. If the end address is reached in the middle of the pattern, then
writing ends at that point.
Cancel Cancels the memory initialization and closes this dialog box.
Help Displays the help for this dialog box.
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Memory Search dialog box

This dialog box is used to search memory (see "2.10.1.5 Search the memory contents").
Search in either the Memory value area or Character strings area where the caret was located in the Memory panel
immediately before this dialog box opened.

Figure A.30 Memory Search Dialog Box
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This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Memory panel, select [Find...] from the context menu.

[Description of each area]

(1)

)

@)

[Search Data] area

Specify data to search.

You can either type a value directly into the text box (up to 256 bytes), or select one from the input history via the

drop-down list (up to 10 items).

If the search is performed in the Memory value area of the Memory panel, the value must be entered in the same

display format (notation and size) as that area.

If the search is performed in the Character strings area, then the target of the search must be a string. The speci-
fied string is converted into the encoding format displayed in that area, and searched for.

If a memory value was selected immediately prior to opening this dialog box, then that value will appear as default.

[Search Range] area
Select the range to search from the following drop-down list.

Specify address range Searches in the address range specified in the [Address] area.

Memory mapping Searches within the selected memory mapping range.
This list item displays the memory mappings set in the Memory Mapping dialog
box (except the non-mapped area).

Display format: <memory type> <address range> <size>

[Address] area

This item is only enabled if [Specify address range] is selected in the [Search Range] area.

Specify the range of memory address to search via the start and end addresses. You can either type address
expressions directly into the text boxes (up to 1024 characters), or select them from the input history via the drop-
down list (up to 10 items).

The results of calculating the address expressions you have entered are treated as start and end addresses,
respectively.
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Note that if an address value greater than the microcontroller address space is specified, the high-order address
value is masked.
In addition, an address value greater than the value expressed within 32 bits cannot be specified.

Remark 1.

Remark 2.
Remark 3.

A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.20.2 Symbol name completion function").

If the start address field is left blank, it is treated as if "Ox0" were specified.

If the end address field is left blank, then it is treated as if the maximum value in the microcon-
troller's address space were specified.

[Function buttons]

Button

Function

Search Backward

Searches upward within the range specified in the [Address] area or the [Search Range]
area. The location found by the search is selected in the Memory panel.

Note that if an illegal value is specified or while the program is being executed, a message
will appear, and the memory search will not be performed.

If focus moves to this dialog box while the memory panel is hidden or another panel has
focus, then this button will be disabled.

Search Forward

Searches downward within the range specified in the [Address] area or the [Search
Range] area. The location found by the search is selected in the Memory panel.

Note that if an illegal value is specified or while the program is being executed, a message
will appear, and the memory search will not be performed.

If focus moves to this dialog box while the memory panel is hidden or another panel has
focus, then this button will be disabled.

Cancel Cancels the memory search and closes this dialog box.
Help Displays the help for this dialog box.
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Print Address Range Settings dialog box

This dialog box is used to specify the address range to print the contents of the Disassemble panel.

Figure A.31 Print Address Range Settings Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- On the Disassemble panel, select [Print...] from the [File] menu.

[Description of each area]

(1) Range specification area
Select a range to print from the following option buttons.

(a) [Current display area] (default)
Prints only the contents of the Disassemble panel currently being displayed.

(b) [Current selected area]
Prints only the range currently being selected in the Disassemble panel.
Note, however, that this option button will be disabled when nothing is selected in the Disassemble panel.

(c) [Range of specified]
Specify the range of address to print via [Start address] and [End address]. You can either type address expres-

sions directly into the text boxes (up to 1024 characters), or select them from the input history via the drop-down
list (up to 10 items).

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] +
[Space] key in each text box (see "2.20.2 Symbol name completion function").

[Function buttons]

Button Function

OK Closes this dialog box and opens the Windows dialog box to print the contents of
the specified range of the Disassemble panel.
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Button

Function

Cancel

Cancels the range specification and closes this dialog box.

Help

Displays the help for this dialog box.
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Trace Search dialog box

This dialog box is used to search trace data (see "2.12.8 Search the trace data").
The search can be performed at the instruction or source level.

Figure A.32 Trace Search Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- On the Trace panel, select button on the toolbar.

- On the Trace panel, select [Find...] from the context menu.

[Description of each area]

(1) Tab selection area
Select a tab to switch the level of the search.
This dialog box has the following two tabs.

- [Instruction Level] tab
- [Source Level] tab

(2) Search parameter setup area
Use this area to configure detailed search parameters.

For details on the window elements and how to configure the parameters for a particular tab, see the section for
the tab in question.
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[Function buttons]

Button Function

Search Backward Searches upward (in the direction of larger to smaller numbers) within the specified range.
Search matches are selected in the Trace panel.

Note that if an illegal value is specified or while the program is being executed, a message
will appear, and the trace data search will not be performed.

If focus moves to this dialog box while the Trace panel is hidden or another panel has
focus, then this button will be disabled.

Search Forward Searches forward (in the direction of smaller to larger numbers) within the specified range.
Search matches are selected in the Trace panel.

Note that if an illegal value is specified or while the program is being executed, a message
will appear, and the trace data search will not be performed.

If focus moves to this dialog box while the Trace panel is hidden or another panel has
focus, then this button will be disabled.

Cancel Cancels the trace data search and closes this dialog box.
Help Displays the help for this dialog box.
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[Instruction Level] tab

Use this tab to search the acquired trace data at the instruction level.

Caution If the Trace panel is set to Source display mode, then performing an instruction level search via this tab
will not perform the target search correctly. In order to perform an instruction level search, set the mode
to Mixed display mode or Disassemble display mode.

Figure A.33 Trace Search Dialog Box: [Instruction Level] Tab
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This section describes the following.
- [How to open]

- [Description of each area]

[How to open]

- On the Trace panel, select button on the toolbar.

- On the Trace panel, select [Find...] from the context menu.

[Description of each area]

(1) [Search condition] area

(a) [Fetch Address]
Specify the fetch address if it is a required search parameter.
You can either type address expressions directly into the text boxes, or select them from the input history via the
drop-down lists (up to 10 items).
The fetch address can also be specified as a range. In this case, specify a range by specifying address expres-
sions in both the left and right text boxes.
If the right-hand text box is blank or contains the text [(Input value when range is specified)], then the fixed
address specified in the left-hand text box will be searched.
Note that if an address value greater than the microcontroller address space is specified, the high-order address
value is masked.
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(b)

(c)

(d)

(e)

)
(a)

In addition, an address value greater than the value expressed within 32 bits cannot be specified.

[Mnemonic]

Specify the mnemonic if it is a required search parameter.

The specified character strings in this area are searched within the [Source/Disassemble] area of the Trace
panel.

You can either type a mnemonic directly into the text boxes, or select one from the input history via the drop-
down list (up to 10 items).

Searches are case-insensitive, and partial matches are also allowed.

[Access Address] [IECUBE][Simulator]

Specify the access address if it is a required search parameter.

You can either type address expressions directly into the text boxes, or select them from the input history via the
drop-down lists (up to 10 items).

The access address can also be specified as a range. In this case, specify a range by specifying address
expressions in both the left and right text boxes.

If the right-hand text box is blank or contains the text [(Input value when range is specified)], then the fixed
address specified in the left-hand text box will be searched.

Note that if an address value greater than the microcontroller address space is specified, the high-order address
value is masked.

In addition, an address value greater than the value expressed within 32 bits cannot be specified.

[Access Status] [[ECUBE][Simulator]

This item is only enabled if a value for [Access Address] [[ECUBE][Simulator] is specified.
Select the access type from the following drop-down list.

Select [No Specification] if you do not wish to limit access types.

(No Specification)

Read/Write

Read

Write

Vector Read

DMA

[Data] [IECUBE][Simulator]

This item is only enabled if a value for [Access Address] [[ECUBE][Simulator] is specified.

Specify the access data.

You can either type the data directly into the text boxes (in hexadecimal number), or select it from the input his-
tory via the drop-down list (up to 10 items).

The data can also be specified as a range. In this case, specify a range by specifying data in both the left and

right text boxes.

If the right-hand text box is blank or contains the text [(Input value when range is specified)], then the fixed data
specified in the left-hand text box will be searched.

[Search range] area

[Number]

Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace
panel.

Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number"
are specified by default).

You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input
history via the drop-down lists (up to 10 items).

If the left-hand text box is left blank, it is treated as if "0" were specified.

If the right-hand text box is left blank, it is treated as if the last number were specified.
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[Source Level] tab

Use this tab to search the acquired trace data at the source level.

Caution If the Trace panel is set to Disassemble display mode, then performing an source level search via this tab
will not perform the target search correctly. In order to perform an source level search, set the mode to
Mixed display mode or Source display mode.

Figure A.34 Trace Search Dialog Box: [Source Level] Tab

Trace Search =

— Search chject
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The ezecution parl is relrieved specilyirg the funclion
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Search cardition
Source and Line: F|

Search range
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This section describes the following.
- [How to open]

- [Description of each area]

[How to open]

- On the Trace panel, select button on the toolbar.

- On the Trace panel, select [Find...] from the context menu.

[Description of each area]

(1) [Search object] area
Select the search object from the following option buttons.

The execution part is retrieved specify- | Finds the execution location in the specified source line (default).
ing the source line Only [Source and Line] will be enabled as a search parameter.

The execution part is retrieved specify- | Finds the execution location in the specified function.

ing the function Only [Function Name] will be enabled as a search parameter.
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The execution part is retrieved specify- | Finds the location at which the specified global variable was

ing the global variable accessed.

[IECUBE][Simulator] Only [Variable Name] [IECUBE][Simulator], [Kind] [[ECUBE][Simula-
tor] and [Value] [IECUBE][Simulator] will be enabled as a search
parameters.

(2) [Search condition] area

(@) [Source and Line]
This item is only enabled if [The execution part is retrieved specifying the source line] is selected.
The specified character strings in this area are searched within the [Line/Address] area of the Trace panel.
You can either type the character strings of the source line to be find directly into the text box, or select them
from the input history via the drop-down list (up to 10 items).
Searches are case-insensitive, and only complete matches are retrieved.

Example 1.  main.c#40
Example 2.  main.c
Example 3. main

(b) [Function Name]
This item is only enabled if [The execution part is retrieved specifying the function] is selected.
You can either type the function name to be find directly into the text box, or select it from the input history via
the drop-down list (up to 10 items).
Searches are case-insensitive, and only complete matches are retrieved.

(c) [Variable Name] [IECUBE][Simulator]
This item is only enabled if [The execution part is retrieved specifying the global variable] is selected.
You can either type the variable name to be find directly into the text box, or select it from the input history via
the drop-down list (up to 10 items).
Searches are case-insensitive, and only complete matches are retrieved.

(d) [Kind] [[ECUBE][Simulator]
This item is only enabled if [The execution part is retrieved specifying the global variable] is selected.
Select the access type ([Reference/Substitution], [Reference], or [Substitution]) from the drop-down list.

(e) [Value] [IECUBE][Simulator]
This item is only enabled if [The execution part is retrieved specifying the global variable] is selected.
Specify the accessed variable value in hexadecimal number.
You can either type a variable value directly into the text box, or select one from the input history via the drop-
down list (up to 10 items).
The variable value can also be specified as a range. In this case, specify a range by specifying variable values
in both the left and right text boxes.
If the right-hand text box is blank, then access locations with the fixed variable values specified in the left-hand
text box will be searched for.

(3) [Search range] area

(@) [Number]
Specify the range within the trace data to search via the number displayed in the [Number] area of the Trace
panel.
Specify the starting number in the left text box, and the ending number in the right text box ("0" to "last number"
are specified by default).
You can either type the numbers directly into the text boxes (in base-10 format), or select them from the input
history via the drop-down lists (up to 10 items).
If the left-hand text box is left blank, it is treated as if "0" were specified.
If the right-hand text box is left blank, it is treated as if the last number were specified.
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Combination Condition dialog box [E1][E20]

This dialog box is used to display and modify detailed information on the combination break event selected in the Events
panel.

Figure A.35 Combination Condition Dialog Box

Combinaticn Condition o
()| | | Break
(2) — Combinatian; | Saguential x
B Oibject event:
Ma.  Ewant Ip
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3)— ) Wikte shrar feSE - it T == (k1 -
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| | Reast event:
Redease
(4)— Event
[Function buttons] — | Cancsl ]  Heb

This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- On the Events panel, move the caret to the combination break event [E1][E20], then select [Edit Condition...] from the
context menu.

[Description of each area]

(1) Tab selection area
In this product version, the [Break] tab is displayed in this area.

(2) [Combination] area
Select the combination condition from the following drop-down list.

OR The condition is satisfied when one of the events listed in the [Object event] area is encoun-
tered (default).

Sequential The condition is satisfied when the events listed in the [Object event] area are encountered
in the specified sequence.

Caution When [OR] is selected, up to two break events can be specified.
When [Sequential] is selected, break event can be specified for the 1st to 2nd position.
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(3) [Object event] area

(a) Display of the list
This area lists the detailed information on the object events to be combined.
When [Sequential] is specified in the [Combination] area, numbers are allocated to each item from the top of the
list to indicate the order in which the conditions are to be satisfied.

(b) Buttons
The following buttons are enabled only when [Sequential] is selected in the [Combination] area.

Button Function
Up Moves the event serial number upward in the target event list.
Down Moves the event serial number downward in the target event list.
R Event This button is always invalid.

(4) [Resetevent] area

(a) Display of the list
This area is always invalid.

[Function buttons]

Button Function

OK Applies the detailed settings specified in the dialog box to the combination break and closes
this dialog box.

Cancel Cancels the save and closes this dialog box.
Help Displays the help for this dialog box.
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Detail dialog box (for execution events)

This dialog box is used to display and modify detailed information on an execution-related event selected in the Events

panel.

Note that the execution-related events refer to the following events in the Events panel.

- Hardware Break event (execution type)

- Execution-related break event in detailed information on Combination Break event [E1][E20]

- Execution-related event as start and end condition in detailed information on Trace event

- Execution-related event as start and end condition in detailed information on Timer Result event [[IECUBE][Simula-

tor]

Figure A.36 Detail Dialog Box (for Execution Events) [IECUBE]
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Figure A.37 Detail Dialog Box (for Execution Events) [E1][E20][EZ Emulator][COM Port]
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Figure A.38 Detail Dialog Box (for Execution Events) [Simulator]
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This section describes the following.
- [How to open]

- [Description of each area]

- [Toolbar]

- [Function buttons]

[How to open]

- On the Events panel, move the caret to any one of the following events, and then select [Edit Condition...] from the
context menu.

- Hardware Break event (execution type)
- Execution-related break event in detailed information on Combination Break event [E1][E20]
- Execution-related event as start and end condition in detailed information on Trace event

- Execution-related event as start and end condition in detailed information on Timer Result event
[IECUBE][Simulator]

[Description of each area]

(1) Event conditions setting area

(@) [Address Condition]
Specify the address condition.

Compare condition | Specify the condition to compare address.
[IECUBE]
[Simulator] Default Specified address (==
Modifying | Select from the drop-down list
Available | Specified address (== Specifies the address with [Address].
values
Greater than or equal to (>=)
Less than or equal to (<=)
Inside the range (<=Values<=) | Specifies the range with [Start address]
and [End address].
Outside the range !(<=Val-
ues<=)
Address Specify the address.
[IECUBE][Simulator]
This item appears only when [Specified address (==)], [Greater than or equal to
(>=)] or [Less than or equal to (<=)] is selected in [Compare condition].
Default The current set value
Modifying | Directly enter from the keyboard.
Available | Address expression within the valid range
values
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Start address Specify the start address.
[IECUBE] [IECUBE][Simulator]
[Simulator] This item appears only when [Inside the range (<=Values<=)] or [Outside the range

l(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying | Directly enter from the keyboard.

Available | Address expression within the valid range

values
End address Specify the end address.
[IECUBE] [IECUBE][Simulator]
[Simulator] This item appears only when [Inside the range (<=Values<=)] or [Outside the range

I(<=Values<=)] is selected in [Compare condition].

Default The current set value
Modifying | Directly enter from the keyboard.
Available | Address expression within the valid range
values
Use the address Specify whether to specify an address mask.
mask
[Simulator] Default No
Modifying | Select from the drop-down list
Available | Yes Specifies an address mask.
values -
No Does not specify an address mask.
Mask value Specify the value of address mask.
[Simulator] This item appears only when [Use the address mask] is set to [Yes].
Default The current set value

Modifying | Directly enter from the keyboard.

Available | Hexadecimal number up to five digits
values

(b) [Pass Count] [IECUBE][Simulator]
Specify the pass count condition.

Pass count Specify a pass count.
The relevant event occurs when the event condition is met as many times as the spec-
ified pass count.

Default 1

Modifying | Directly enter from the keyboard.

Available 1 to 65535 in decimal number
values

Caution [IECUBE]
A value other than "1" cannot be specified as the pass count condition for an execution-related
event (before execution).

(2) Description area
This area displays a simple description of the item selected in the Event conditions setting area.
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[Toolbar]

Displays all categories in the Event conditions setting area.

Hides categories in the Event conditions setting area and rearranges only setting items in the

ascending order

This button is always invalid.

[Function buttons]

Button Function
OK Applies detailed settings made in this dialog box to execution-related events and closes this
dialog box.
Cancel Cancels the save and closes this dialog box.
Help Displays the help for this dialog box.
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Detail dialog box (for access events)

This dialog box is used to display and modify detailed information on an access-related event selected in the Events
panel.

Note that the access-related events refer to the following events in the Events panel.

- Hardware Break event (access type)

- Access-related break event in detailed information on Combination Break event [E1][E20]

- Access-related event as start and end condition [E1][E20][COM Port] in detailed information on Trace event

- Access-related event in detailed information on Point Trace event

Figure A.39 Detail Dialog Box (for Access Events) [IECUBE]
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Figure A.40 Detail Dialog Box (for Access Events) [E1][E20][EZ Emulator][COM Port]
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Figure A.41 Detail Dialog Box (for Access Events) [Simulator]
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This section describes the following.
- [How to open]

- [Description of each area]

- [Toolbar]

- [Function buttons]

[How to open]

- On the Events panel, move the caret to any one of the following events, and then select [Edit Condition...] from the
context menu.

- Hardware Break event (access type)
- Access-related break event in detailed information on Combination Break event [E1][E20]
- Access-related event as start and end condition [E1][E20][COM Port] in detailed information on Trace event

- Access-related event in detailed information on Point Trace event

[Description of each area]

(1) Event conditions setting area

(a) [Address]
Specify the address condition.
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Compare condition

Specify the condition to compare address.

[IECUBE]
[Simulator] Default The current set value
Modifying | Select from the drop-down list
Available | Specified address (== Specifies the address with
values [Address].
Greater than or equal to (>=)
Less than or equal to (<=)
Inside the range (<=Values<=) Specifies the range with [Start
address] and [End address].
Outside the range !(<=Values<=)
Address Specify the address.
[IECUBE][Simulator]
This item appears only when [Specified address (==)], [Greater than or equal to
(>=)] or [Less than or equal to (<=)] is selected in [Compare condition].
Default The current set value
Modifying | Directly enter from the keyboard.
Available | Address expression within the valid range
values
Start address Specify the start address.
[IECUBE] [IECUBE][Simulator]
[Simulator] This item appears only when [Inside the range (<=Values<=)] or [Outside the range

I(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying | Directly enter from the keyboard.
Available | Address expression within the valid range
values

End address
[IECUBE]
[Simulator]

Specify the end address.

[IECUBE][Simulator]
This item appears only when [Inside the range (<=Values<=)] or [Outside the range
I(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying | Directly enter from the keyboard.
Available | Address expression within the valid range
values

Use the address
mask

Specify whether to specify an address mask.

Jun 01, 2023

[Simulator] Default No
Modifying | Select from the drop-down list
Available | Yes Specifies an address mask.
values
No Does not specify an address mask.
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Mask value Specify the value of address mask.
[Simulator] This item appears only when [Use the address mask] is set to [Yes].

Default The current set value

Modifying | Directly enter from the keyboard.
Available | Hexadecimal number up to five digits
values

(2) [Data Condition]

Specify the data condition.

Access type

Specify the type of access.

Default The current set value

Modifying | Select from the drop-down list

Available Read Sets a read access as the type of access.

values Write Sets a write access as the type of access.
Read/Write Sets a read and a write access as the type of access.

Access size

Specify the access size.

Default The current set value

Modifying | Select from the drop-down list

Available No conditions Sets no access size.
values True for all access sizes.

1byte Sets 1-byte as the access size.

2byte Sets 2-byte as the access size.

Compare condition

Specify the condition to compare the data.

Default The current set value

Modifying | Select from the drop-down list

Available No conditions Specifies no data value.
values

Specified value (==)

Specifies the data with [Compare data].

Any other value (=)
[IECUBE][Simulator]

Greater than or equal to (>=)
[IECUBE][Simulator]

Less than or equal to (<=)
[IECUBE][Simulator]

Inside the range (<=Values<=)
[IECUBE][Simulator]

Specifies the range with [Lower data]
and [Upper datal].

Outside the range !(<=Val-
ues<=)
[IECUBE][Simulator]
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Compare data Specify the data to compare.
This item appears only when [Specified value (==)], [Any other value (!=)], [Greater than
or equal to (>=)] or [Less than or equal to (<=)] is selected in [Compare condition].

Default The current set value

Modifying | Directly enter from the keyboard.

Available Hexadecimal number up to five digits

values
Lower data Specify the lower data for the range in [Compare condition].
[IECUBE] This item appears only when [Inside the range (<=Values<=)] or [Outside the range
[Simulator] l(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying | Directly enter from the keyboard.

Available Hexadecimal number up to five digits

values
Upper data Specify the upper data for the range in [Compare condition].
[IECUBE] This item appears only when [Inside the range (<=Values<=)] or [Outside the range
[Simulator] l(<=Values<=)] is selected in [Compare condition].

Default The current set value

Modifying | Directly enter from the keyboard.

Available Hexadecimal number up to five digits
values

Use the data mask | Specify whether to specify a data mask.

Default No

Modifying | Select from the drop-down list

Available Yes Specifies a data mask.
values
No Does not specify a data mask.
Mask value Specify the value of data mask.

This item appears only when [Use the data mask] is set to [Yes].

Default The current set value

Modifying | Directly enter from the keyboard.

Available Hexadecimal number up to five digits
values

(a) [Pass Count] [IECUBE][Simulator]
Specify the pass count condition.

Pass count Specify a pass count.
The relevant event occurs when the event condition is met as many times as the spec-
ified pass count.

Default 1

Modifying Directly enter from the keyboard.

Available 1 to 65535 in decimal number
values

(3) Description area
This area displays a simple description of the item selected in the Event conditions setting area.
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[Toolbar]

Displays all categories in the Event conditions setting area.

Hides categories in the Event conditions setting area and rearranges only setting items in the
ascending order

This button is always invalid.

[Function buttons]

Button Function
OK Applies detailed settings made in this dialog box to access-related events and closes this
dialog box.
Cancel Cancels the save and closes this dialog box.
Help Displays the help for this dialog box.
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Scroll Range Settings dialog box

This dialog box is used to set the scroll range of the vertical scroll bar on the Memory panel/Disassemble panel.
By setting the appropriate range, it is possible to improve the operability of a mouse (e.g. dragging) because the size of
the vertical scroll bar on the panel is changed suitably.

Caution After setting a scroll range via this dialog box, the scroll range is not updated automatically even if the
address evaluated by the address expression is changed because of such as a line assembly.

Remark It is possible to move outside the scroll range by using the [Page Up]/[Page Down]/[Up]/[Down] key, a
button at either end of the scroll bar or a menu item related to the jump function.

Figure A.42 Scroll Range Setting Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]
- On the Memory panel, click the button from [View] on the toolbar.

- On the Memory panel, select the [View] menu >> [Settings Scroll Range...] from the context menu.
- On the Disassemble panel, click the button from [View] on the toolbar.

- On the Disassemble panel, select the [View] menu >> [Settings Scroll Range...] from the context menu.

[Description of each area]

(1) [Start address] area
Specify the start address of the range of scrolling.
You can either type an address expression directly into the text box (up to 1024 characters), or select it from the
input history via the drop-down list (up to 10 items).
Note that the setting of the scroll range is not performed if "All" is selected in the drop-down list at this time (the
scroll range is not limited).

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in this text box (see "2.20.2 Symbol name completion function").

(2) [End address] area
Specify the end address of the range of scrolling.
You can either type an address expression directly into the text box (up to 1024 characters), or select it from the
input history via the drop-down list (up to 10 items).
Note that this area becomes invalid if [Start address] is specified with [All].

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in this text box (see "2.20.2 Symbol name completion function").
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[Function buttons]

Button Function
OK Sets the specified scroll range for the target panel.
Moves the caret to the start address, from the beginning of the area displayed in
the target panel.
Cancel Cancels the jump and closes this dialog box.
Help Displays the help for this dialog box.
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Go to the Location dialog box

This dialog box is used to move the caret to a specified position.
Figure A.43 Go to the Location Dialog Box
Go to the Location [
(1) | Adoress/Symbal || [=]

[Function buttons]{ [ Cancel ] | Help ]

This section describes the following.

- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]
- Focus the Disassemble panel, and then select [Go to...] from the [Edit] menu.
- Focus the SFR panel, and then select [Go to...] from the [Edit] menu.
- On the Disassemble panel, select [Go to...] from the context menu.

- On the SFR panel, select [Go to...] from the context menu.

[Description of each area]

(1) [Address/Symbol], or [SFR] area
Specify the location to which the caret jumps.
You can either type a location directly into the text box (up to 1024 characters), or select one from the input history
via the drop-down list (up to 10 items).
The data to specify various depending on the target panel, as follows:

Target Panel Data Specified
Disassemble panel Address expression
SFR panel SFR name
Remark If this dialog box is opened from the Disassemble panel, a symbol name at the current caret posi-

tion can be complemented by pressing the [Ctrl] + [Space] key in this text box (see "2.20.2 Symbol
name completion function").

[Function buttons]

Button Function
OK Moves the caret to the specified location, from the beginning of the area displayed in the tar-
get panel.
Cancel Cancels the jump and closes this dialog box.
Help Displays the help for this dialog box.
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Data Save dialog box

This dialog box is used to save data displayed in the Disassemble panel, Memory panel, or Trace panel, and save
uploaded data (see "2.6.3 Execute uploading").
This dialog box appears only when connected to the debug tool.

Figure A.44 Data Save Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- With the Disassemble panel in focus, select [Save Disassemble Data As...] form the [File] menu.
- With the Memory panel in focus, select [Save Memory Data As...] form the [File] menu.
- With the Trace panel in focus, select [Save Trace Data As...] form the [File] menu.

- From the [Debug] menu, select [Upload...].

[Description of each area]

(1) [File Name] area
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history
via the drop-down list (up to 10 items).
You can also specify the file by clicking the [...] button, and selecting a file via the Select Data Save File dialog
box.
When only the name of the file is specified, i.e. path information is not included, the file will be in the project folder.

(2) [File Type] area
Select the format in which to save the file from the following drop-down list.
The available file formats will differ as follows depending on the type of data being saved.

(@) When saving the displayed content of a panel

Text files (*.txt) Text format (default)
CSV (Comma-Separated Variables) (*.csv) CSV formatNote
Note The data is saved with entries separated by commas (,).

If the data contains commas, each entry is surrounded by double quotes (") in order to avoid ille-
gal formatting.
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(b)  When saving upload data

Displayed List ltems File Format
Intel Hex format (*.hex) Intel Hex format
Motorola S-record (*.mot) Motorola S type format
Binary data (*.bin) Binary format
Remark See "2.6.3 Execute uploading" for details on uploading.

(3) [Save Range xxx] area
Specify the range of data to save.
You can either type ranges directly into the text boxes, or select them from the input history via the drop-down lists
(up to 10 items).
The method of specifying the ranges will differ as follows depending on the type of data to be saved.

Type of Data Description

Disassemble panel Specify the range of addresses to save via the start and end addresses.
Ranges can be entered as base-16 numbers or as address expressions.

When a range is selected in the panel, that range is specified by default.

When there is no selection, then the range currently visible in the panel is speci-
fied.

Memory panel Specify the range of memory to save via the start and end addresses.

Ranges can be entered as base-16 numbers or as address expressions.

When a range is selected in the panel, that range is specified by default.

When there is no selection, then the range currently visible in the panel is speci-
fied.

Trace panel - Specifying a range to save
Specify the trace range to save via the start and end trace numbers
Ranges can only be entered as base-10 numbers.

Note

- Saving all trace data
From the drop-down list to the left, select [All Trace Data]. The text box to the
right is disabled. All currently acquired trace data will be saved.

The range currently visible in the panel is specified by default.

Upload data Specify the range of memory to save via the start and end addresses.
Ranges can be entered as base-16 numbers or as address expressions.

Note These are the numbers shown in the [Number] area of the Trace panel.

Remark A symbol name at the current caret position can be complemented by pressing the [Ctrl] + [Space]
key in each text box (see "2.20.2 Symbol name completion function").

[Function buttons]

Button Function
Save Saves the data to a file with the specified filename, in the specified format.
Cancel Cancels the save and closes this dialog box.
Help Displays the help for this dialog box.
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Specified Section dialog box

This dialog box is used to specify the range for skipping step execution.

Figure A.45 Specified Section Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- On the [Debug Tool Settings] tab of the Property panel, click the [...] button displayed by selecting the [Target section]
property in the [Step function] category.

[Description of each area]

(1) [Specified section list] area

(a) Listdisplay
This area is used to display the list of the range for skipping step execution.
To add a new section, click the [Add] button in this area, then in the [Specified section property] area, specify the

sections to add.

(b) Button
Button Function
Up Moves the selected section up one row in the list.
Clicking this for the top section in the list has no effect.
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Button Function
Down Moves the selected section down one row in the list.
Clicking this for the bottom section in the list has no effect.
Add Adds an empty item "-" to the list, and selects it.
Specify the section to add in the [Specified section property] area.
Remove Removes the selected section from the list.

(2) [Specified section property] area

(@) [Select section]

This area is used to display or edit the section selected in the [Specified section list] area.
It can also be used to specify the new sections added via the [Add] button.

Section select
type

Specify the method for specifying the section.

Default Section name

Modifying Select from the drop-down list.

Available values | Section name | Specifies the range by the section name.

Start and end | Specifies the range by the start and end address.
address

Section name

Specify the section name.
Note that this item appears only when [Section select type] is set to [Section name].

Modifying Directly enter from the keyboard.

Start address

Specify the start address.
Note that this item appears only when [Start and end address] is set to [Section name].

Modifying Directly enter from the keyboard.

End address

Specify the end address.
Note that this item appears only when [Start and end address] is set to [Section name].

Modifying Directly enter from the keyboard.
[Function buttons]
Button Function
OK Finishes configuring the target sections, and closes this dialog box.
Cancel Cancels any changes to the target sections, and closes this dialog box.
Help Displays the help for this dialog box.
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Functions and Variables Access Table panel

This panel displays the functions that access variables in the form of an orthogonal table.

Figure A.46 Functions and Variables Access Table Panel
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This section describes the following.
- [How to open]
- [Description of each area]

- [Toolbar]

[How to open]

- From the [View] menu, select [Functions and Variables Access Table].

[Description of each area]

(1) Table area

(a) [Orthogonal Table] tab
In the active project, the functions that access variables are displayed in an orthogonal table.
This information is created using the cross reference information and map information. If no information is dis-
played, click &,  (button for running a build with the build option for generating the orthogonal table made valid)
on the right edge of the toolbar and generate information.

The state of functions accessing variables which has been acquired by statically analyzing the C source pro-
gram is also displayed.

- A cell containing "R" indicates that the value of the variable has been read. The number in parentheses indi-
cates the number of locations at which the variable was read from within the function.

- A cell containing "W" indicates that the value of the variable has been written. The number in parentheses
indicates the number of locations at which the variable was written to within the function.

Double-clicking the variable name or cell which shows the state of access to the variable displays that definition

in an editor.

(2) Tab selection area
There is the [Orthogonal Table] tab which displays the functions that access variables in the form of an orthogonal
table.

[Toolbar]

The toolbar is displayed only when the compiler in use supports generation of cross reference information.
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(1 If the build option related to generation of the cross reference information is invalid, clicking on
this button validates the build option and runs a build. If a file is being edited by the text editor
at the time, the file is saved.
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Measuring Current Consumption panel [E2][Simulator]

This panel is central to the functionality of the solution for measuring current consumption.

See "2.18 Measuring Current Consumption [E2][Simulator]" for details on the solution for measuring current consump-

tion.

Caution 1.  Monitoring points are not supported when the MCU is RL78/G10.

Caution 2.  There will be some error in the results of measurement. For the specifications of the measurement of cur-
rent consumption, e.g. the maximum current consumption, the maximum time over which measurement
is possible, the resolution of measurements of current consumption, etc., refer to the E2 Emulator User's

Manual.

Figure A.47 Measuring Current Consumption Panel
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This section describes the following.
- [How to open]

- [Description of each area]

- [Toolbar]

- [Context menu]

[How to open]

- From the [Debug] menu, select [Debug Solutions] >> [Measuring Current Consumption].

- On the Solution List panel, click the [Go] button of Measuring Current Consumption.

[Description of each area]
(1) Warning display area

This area shows warning messages if there are inconsistencies between the conditions for measurement of cur-

rent consumption and the conditions to be set before the debug tool is connected.
This area is hidden when there is no warning to be reported.

(2) Graph display area

This area shows the measured results for current consumption with the current represented by the y axis and time

by the x axis of the graph.
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(a)

(b)

(c)

(d)

(e)

()

(9)

This area also has the following lines which can be dragged.

Supplementary Line Description
Cursor Red vertical line
Marker A, Marker B Green vertical line

Supplementary lines for search- | Orange horizontal line
ing

When a cursor or marker is dragged, information in the information display area is updated accordingly.
The supplementary lines for searching are used to simply specify the threshold current which is the basis of the
search.

Remark While current consumption is being measured, the display of data is cleared and the cursor and
markers cannot be dragged.

With the simulator, when the mouse cursor is hovered over a point on the graph, the following window pops up to
display the values for current consumption by the individual modules.

Figure A.48 Window Displaying the Values for Current Consumption by Individual Modules
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Information display area
This area displays particular values from the graph of the measured data that is displayed in the graph area.

[Average current]

The average of the values for current between markers A and B is displayed.

When there are no markers, the average value over the whole range of measured data is displayed in the case
of the simulator and blank space is displayed in the case of the E2 emulator.

[Maximum current]

The maximum of the values for current between markers A and B is displayed.

When there are no markers, the maximum value over the whole range of measured data is displayed in the
case of the simulator and blank space is displayed in the case of the E2 emulator.

[Current]
The values for current at the position of the cursor is displayed.
When the cursor is not displayed, this item becomes blank.

[Time]
The time at the position of the cursor is displayed.
When the cursor is not displayed, this item becomes blank.

[Marker A]
The time at the position of marker A is displayed.
When marker A is not displayed, this item becomes blank.

[Marker B]
The time at the position of marker B is displayed.
When marker B is not displayed, this item becomes blank.

(B -A]

The time between markers A and B is displayed.
When markers are not displayed, this item becomes blank.
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Monitor point list display area [E2]
This area displays a list of monitoring points that have been set and is used to specify the settings for building and
downloading when monitor points are set.

Caution This area is not displayed when the MCU is RL78/G10.

(a) [Hold the build options for monitor point specified when measuring]

When building proceeds with the function for automatically inserting nop instructions for monitoring points, the
options for use in building are reflected in the properties of the build tool.

Caution This check box is only effective when the compiler for the current active project is CC-RL
V1.05.00 or later.

(b) [Monitor point list]

A list of monitoring points that are currently set is displayed.

When the measured results are displayed in the graph display area and a cell is double-clicked with each line of
the list selected, the cursor in the graph display area is moved to the position of the monitoring point that is indi-
cated by that line.

A selected monitoring point can be deleted by pressing the [Delete] key.

The following describes the individual components.

<1> Check box
Monitoring points for which the check boxes are selected are valid in the measurement of current consump-
tion.

<2> Cursor
Displays the cursor in the graph display area at the position of the monitoring point on the given line.
When the cursor is selected for a point, the background color of the cell changes to red.

<3> Count
Displays how many times the monitoring point on the given line has been crossed during measurement.

<4> Location
Displays the position of the monitoring point on the given line in the format "file-name#line-number (address)".

Example main.c#16(0xFFFOE)
Caution Addresses are only displayed when they have already been determined during measurement.

<5> Line Color
In the graph display area, the color of the vertical line is displayed at the position corresponding to the moni-
toring point on the given line.

[Toolbar]

1-'.,_ Executes the program and starts measurement of current consumption.
When V1.05.00 or later of the CC-RL compiler is selected for the active project,

[E2] rebuilding and downloading are performed to insert nop instructions at the positions
corresponding to monitoring points in the source file registered in the active project.
However, even if the RRM or DMM function is enabled, the setting is ignored during
the measurement of current consumption.

""t=- Executes the program and starts measurement of current consumption.
Rebuilding and downloading are not performed to insert nop instructions at the posi-

[E2][Except RL78/G10] tions corresponding to monitoring points.
Note that this button appears when V1.05.00 or later of the CC-RL compiler is
selected for the active project.
However, even if the RRM or DMM function is enabled, the setting is ignored during
the measurement of current consumption.

[!} Selects whether current consumption is to be measured during the execution of a
program.

[Simulator]

@ Has the same functionality as the same button on the Debug toolbar in the Main win-
dow.
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...J:i Opens the Current Consumption Measurement Condition Setting dialog box [E2] to
set measurement conditions.

Opens the Current Consumption Measurement Trigger Condition Setting dialog box
[E2], which is used to set trigger conditions for measurement.

Moves marker A in the graph display area to the corresponding position.

Moves the cursor in the graph display area to the corresponding position.

E;] Moves marker B in the graph display area to the corresponding position.

Switches between showing and hiding the cursor, marker A, marker B, and the sup-
plementary lines for searching in the graph display area.

L—ﬂ Searches for the first position that matches the condition set with the supplementary
lines for searching and the search mode.

When the position is found, the cursor in the graph display area is moved to that
position.

'ﬂﬂ Searches for the first position before the cursor position that matches the condition
set with the supplementary lines for searching and the search mode.

When the position is found, the cursor in the graph display area is moved to that
position.

F& Searches for the first position after the cursor position that matches the condition set
with the supplementary lines for searching and the search mode.

When the position is found, the cursor in the graph display area is moved to that
position.

bﬂ Searches for the last position that matches the condition set with the supplementary
lines for searching and the search mode.

When the position is found, the cursor in the graph display area is moved to that
position.

— Selects a search mode from among L—Q , *ﬂ’l , F& and H .
"Under threshold", "In range", "Out of range" or "Monitor point" can be selected as

the search mode.

Opens the Current Consumption Measurement Search dialog box [E2][Simulator] to
specify and search the detailed conditions.

H Selects whether movement of the cursor in the graph display area is linked with the
Editor panel.

When this icon is selected and the cursor is stopped on a monitoring point, the posi-
tion of source code where the monitoring point has been set is opened in the Editor
panel.

Selects whether movement of the cursor in the graph display area is linked with the
Disassemble panel.

When this icon is selected and the cursor is stopped on a monitoring point, the posi-
tion of source code where the monitoring point has been set is opened in the Disas-
semble panel. When movement of the cursor is also linked with the Editor panel,
linking with the Editor panel is given priority.

%

H:l' Opens the Save Current Values dialog box [E2] or the Save File dialog box [Simula-
tor] to save the data on current in the measured results of current consumption in a
file with the CSV format.

The file saved by this button can be displayed in the graph display area by clicking

on ﬂ:'
Reads the CSV file saved by using H.Tl;_ and displays it in the graph display area.

L
s 4
liﬂ Opens the Save File dialog box to save the measured results for current consump-
tion and settings of conditions for measurement in a file with the CSV or Microsoft
Office Excel book format.
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X

Clears the graph showing the measured results in the graph display area.

B
L

Clears the graph of the data which has been read by using ﬂ:' in the graph display
area.

[Context menu]

Save Results of Current Val-
ues

Opens the Save Current Values dialog box [E2] or the Save File dialog box [Simula-
tor] to save the data on current in the measured results of current consumption in a

file with the CSV format.

The file saved by this menu can be displayed in the graph display area by selecting
the [Load Results of Current Values] menu.

Load Results of Current Val-
ues

Reads the CSV file saved by using the [Save Results of Current Values] menu and
displays it in the graph display area.

Clear Measurement Result

Clears the graph showing the measured results in the graph display area.

Clear Loaded Data

Clears the graph of the data which has been read by using the [Save Results of Cur-
rent Values] menu in the graph display area.

Time Unit The following cascade menus are displayed to switch the time unit of the X axis in
the graph display area.
Second Switches the time unit of the X axis in the graph display area to seconds.
Millisecond Switches the time unit of the X axis in the graph display area to milliseconds.

Microsecond

Switches the time unit of the X axis in the graph display area to microseconds.

Zoom In The following cascade menus are displayed to zoom in the display ranges of the X
and Y axes in the graph display area.
Zoom In Zooms in the display ranges of the X and Y axes in the graph display area.

Zoom In X Axis

Zooms in the display ranges of the X axe in the graph display area.

Zoom In'Y Axis

Zooms in the display ranges of the Y axe in the graph display area.

Zoom Out The following cascade menus are displayed to zoom out the display ranges of the X
and Y axes in the graph display area.
Zoom Out Zooms out the display ranges of the X and Y axes in the graph display area.

Zoom Out X Axis

Zooms out the display ranges of the X axe in the graph display area.

Zoom Out Y Axis

Zooms out the display ranges of the Y axe in the graph display area.

Reset Zoom

Restores the display ranges of the X and Y axes in the graph display area to the ini-
tial values.
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Current Consumption Measurement Condition Setting dialog box [E2]

This dialog box is used to set measurement conditions in the Measuring Current Consumption panel [E2][Simulator].

Figure A.49 Current Consumption Measurement Condition Setting Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- On the Measuring Current Consumption panel [E2][Simulator], click the _H button on the toolbar.

[Description of each area]

(1) [Operation after record memory is full]
Select the operation of the debugger after the recording memory of the emulator becomes full during the measure-
ment of current consumption from the following drop-down list.

Overwrite to the record mem- | Continue to execute the program and to record data by overwriting the data

ory and continue execution from the beginning of the recording memory.

Stop recording Only stop writing to the recording memory but continue to execute the pro-
gram.

Stop program Stop both writing to the recording memory and execution of the program.

(2) [Sampling time]
Select the sampling time during the measurement of current consumption.
The following sampling times can be selected.
1us, 2us, 5us, 10us, 20us, 50us, 100us, 200us, 500us, 1ms

(3) [Acquisition condition] area
Make settings regarding conditions for writing to the recording memory of the emulator.

(@) [Condition]
Select the type of condition for writing to the recording memory of the emulator from the following drop-down list.

All Record all measured data without restrictions.
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During detecting an external trigger | Record the measured data with use of the function for detecting an

input external trigger input in the extended interface of the E2 emulator only
while the external trigger input is detected.
During monitor points Record the measured data only over the time from detection of the

monitoring point for starting measurement until detection of the moni-
toring point for ending measurement.

(b) [Channel]

When "During detecting an external trigger input” is selected for [Condition], select "ch0" or "ch1" as the external
trigger input channel from the extended interface of the E2 emulator that is to be detected.

(c) [External trigger input type]
When "During detecting an external trigger input" is selected for [Condition], select "High" or "Low" as the level
of the external trigger input signal to be detected.

(d) [Monitor points range]
When "During monitor points" is selected for [Condition], select the two target monitoring points.
Monitoring points that have currently been specified for the project are displayed in a drop-down list.
The measured data will only be recorded from the time the monitoring point set in the left side has been
detected until detection of the monitoring point set on the right side.

[Function buttons]

Button Function
OK Reflects the settings of the measurement conditions that were made in this dialog box to
the Measuring Current Consumption panel [E2][Simulator].
Cancel Nullifies settings and closes this dialog box.
Help Displays the help for this dialog box.
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Current Consumption Measurement Trigger Condition Setting dialog box [E2]

This dialog box is used to set trigger conditions in the Measuring Current Consumption panel [E2][Simulator].

Figure A.50 Current Consumption Measurement Trigger Condition Setting Dialog Box
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This section describes the following.
- [How to open]
- [Description of each areal

- [Function buttons]

[How to open]

- On the Measuring Current Consumption panel [E2][Simulator], click the button on the toolbar.

[Description of each area]

(1) [Use trigger function]
Specify whether to use the trigger function.

(2) [Trigger action settings] area
Set the operation of the E2 emulator on detection of the trigger.
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(@) [Action when detecting a trigger]
Select the operation on detection of the trigger from the following drop-down list.

Stop program Stop execution of the program.

Output external trigger signal Output the external trigger signal by using the function for output of an
external trigger signal from the extended interface of the E2 emulator.

(b) [Channel]
When "Output external trigger signal" is selected for [Action when detecting a trigger], select "ch0" or "ch1" as
the external trigger output channel of the extended interface of the E2 emulator.

(c) External trigger output type
Select [High pulse] or [Hold High level during the current meets the condition] as the type of signal for output as
the external trigger.
When [High pulse] is selected, specify the width of the pulse as a decimal value between 1 and 65535 (in micro-
seconds).

(3) [Trigger condition settings] area
Set the trigger conditions.

(@) [Condition]
Select the type of change in values for current as the trigger condition from the following drop-down list.

Over threshold Detect the moment when the current being measured becomes or exceeds a
specified value.

Under Threshold Detect the moment when the current being measured becomes or falls below
a specified value.

In range Detect the moment when the current being measured enters a specified
range of values.

Out of Range Detect the moment when the current being measured leaves a specified
range of values.

(b) [Current value]
Specify the specific value or range of values for current to serve as the trigger condition in microamperes.
Specify one value for current when "Over threshold" or "Under Threshold" is selected for [Condition], and two
values for current when "In range" or "Out of Range" is selected for [Condition].

Caution For a range of current values, the value entered in the left field for entry must be lower than that
in the right field.

(c) [Specify detecting width]
When "Over threshold", "Under Threshold", or "In range" is selected for [Condition], specify whether the trigger
is only detected when the change in the value for current continues for a specific period or at the instant the
required change in the value is detected.
To select detection of the trigger, select the check box and specify the condition for the interval and the interval.

<1> Condition for the interval
Select the condition for the interval from the following drop-down list.

Over threshold Detect the trigger when the condition specified for [Condition] continues to be satis-
fied for at least the specified interval.

In range Detect the trigger only when the condition specified for [Condition] continues to be
satisfied within the specified interval.

<2> |Interval
Specify a multiple of the sampling time selected for [Sampling time] in the Current Consumption Measurement
Condition Setting dialog box [E2].
The actual interval is the specified multiple of the sampling time.

R20UT5301EJ0100 Rev.1.00 ENESAS Page 314 of 413
Jun 01, 2023



CS+V8.10.00 A. WINDOW REFERENCE

[Function buttons]

Button Function

OK Reflects the settings of the trigger conditions that were made in this dialog box to the Mea-
suring Current Consumption panel [E2][Simulator].

Cancel Nullifies settings and closes this dialog box.
Help Displays the help for this dialog box.
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Current Consumption Measurement Search dialog box [E2][Simulator]

This dialog box is used to specify and search the detailed conditions in the Measuring Current Consumption panel
[E2][Simulator].

Figure A.51 Current Consumption Measurement Search Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- On the Measuring Current Consumption panel [E2][Simulator], click the I._! button on the toolbar.

[Description of each area]
(1) [Searching option] area
Specify the search conditions.

(@) [Condition]
Select the type of the search conditions from the following drop-down list.

Over threshold Detect the moment when the current being measured becomes or exceeds a
specified value.

Under Threshold Detect the moment when the current being measured becomes or falls below
a specified value.
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In range Detect the moment when the current being measured enters a specified
range of values.

Out of Range Detect the moment when the current being measured leaves a specified
range of values.

Monitor point [E2] Detect the specified monitoring point.

(b) [Current value]
Specify the specific value or range of values for current to serve as the search condition in microamperes.
Specify one value for current when "Over threshold" or "Under Threshold" is selected for [Condition], and two
values for current when "In range" or "Out of Range" is selected for [Condition].

Caution For a range of current values, the value entered in the left field for entry must be lower than that
in the right field.

(c) [Specify detecting width] [E2]
When "Over threshold", "Under Threshold", or "In range" is selected for [Condition], specify whether the data is
only searched when the change in the value for current continues for a specific period or at the instant the
required change in the value is detected.
To search the data, select the check box and specify the condition for the interval and the interval.

<1> Condition for the interval
Select the condition for the interval from the following drop-down list.

Over threshold Detect the data when the condition specified for [Condition] continues to be satisfied
for at least the specified interval.

In range Detect the data only when the condition specified for [Condition] continues to be sat-
isfied within the specified interval.

<2> |Interval
Specify a multiple of the sampling time selected for [Sampling time] in the Current Consumption Measurement
Condition Setting dialog box [E2].
The actual interval is the specified multiple of the sampling time.

(d)  [Monitor point] [E2]
When "Monitor point" is selected for [Condition], select "All" or the current monitoring point as the target monitor-
ing point.

[Function buttons]

Button Function

Find First Searches the whole of the measured data from its start for points that satisfy the conditions
specified in this dialog box.

Find Previous Searches forward in time from the position of the cursor in the graph display area in the
Measuring Current Consumption panel [E2][Simulator] for the points that satisfy the condi-
tions specified in this dialog box.

Find Next Searches backward in time from the position of the cursor in the graph display area in the
Measuring Current Consumption panel [E2][Simulator] for the points that satisfy the condi-
tions specified in this dialog box.

Find Last Searches the whole of the measured data from its end for points that satisfy the conditions
specified in this dialog box.

Close Nullifies settings and closes this dialog box.
Help Displays the help for this dialog box.
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Save Current Values dialog box [E2]

This dialog box is used to save the values for current in the Measuring Current Consumption panel [E2][Simulator].

Figure A.52 Save Current Values Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- On the Measuring Current Consumption panel [E2][Simulator], click the H.Tl"_ button on the toolbar.

[Description of each area]

(1) [File Name] area
Specify the name of the file to save.
You can either type a filename directly into the text box (up to 259 characters), or select one from the input history
via the drop-down list (up to 10 items).
You can also specify the file by clicking the [Reference...] button, and selecting a file via the Select Current Values
Data Save File dialog box.
When only the name of the file is specified, i.e. path information is not included, the file will be in the project folder.

(2) [Saverange] area
Specify the range in time of values for current to be saved by specifying the times (in microseconds) where saving
is to start and end. The numbers are decimal.
You can either type ranges directly into the text boxes, or select them from the input history via the drop-down lists
(up to 10 items).
When "All data" is selected, the values for current from the minimum time as the start time to the maximum time as
the end time will be saved.

[Function buttons]

Button Function
Save Saves the data to a file with the specified filename, in the CSV format.
Cancel Cancels the save and closes this dialog box.
Help Displays the help for this dialog box.
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Virtual Board panel [Simulator]

This panel is used to configure the virtual target system and operate the virtual components.
With this panel, the results of data that have been input to and output from peripheral 1/O modules can be confirmed.
Note that this panel is only available when the simulator for the active project supports peripheral function simulations.

Figure A.53 Virtual Board panel [Simulator]

Virtual Board B
(2 Environment 1 TMP 25 *C Open ‘Detailed Waveform Monitor'.. :}:Eg;
Subtype:
Name: bl potor
BLDC Motor Parameters: Setting...
Input-Output connection: Input6 Qutput:3
(1) -(3 —(6)
This section describes the following.
- [How to open]
- [Description of each area]
[How to open]
- From the [View] menu, select [Virtual Board].
[Description of each area]
(1) Virtual board area
This area is used to operate the virtual target system.
It supports the following components.
These components can be operated while the program is running.
" Light Emitting Diode
. ' An LED can be connected to any pin, and the output from the pin can be
indicated by switching the LED on or off.
() Light Emitting Diode
. ' An LED can be connected to any pin, and PWM control can be used to con-
trol the apparent brightness by switching the LED on and off.
(with brightness control) The display on the LED is not correct if the PWM cycle is greater than 100
ms.
3 [ | Digital input switch (push type)
; ANk | A button can be connected to any pin. A digital input value can be given to
: . the connected pin by clicking the displayed button.
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E—] | [—. | Digital input switch (toggle type)
A button can be connected to any pin. A digital input value can be given to
- S ) the connected pin by clicking the displayed button.
[ v Used for inputting analog data. Any data within a given range can be set.
[ —— Any value within a specified range can be assigned to a pin connected to an
A/D converter.
O Used for inputting analog data. Any data within a given range can be set.
& x = The gas concentration sensor value (PPM) is converted to a voltage for a
pin connected to. Any value within a specified range can be assigned to the
pin.
o Used for inputting analog data. Any data within a given range can be set.
s = = The current value (mA) is converted to the voltage for the connected pin.

Any value within a specified range can be assigned to the pin.

- Used for inputting analog data. Any data within a given range can be set.
The illuminance (lux) is converted to a voltage for the connected pin.
Any value within a specified range can be assigned to the pin.

bob | Switch for vibration sensing
Ty A button can be connected to any pin. A digital input value can be given to
the connected pin by clicking the displayed button.

' [ Buzzer for an alarm machine
| 1% A button can be connected to any pin. The output of the pin is indicated by

both sound and image.

20 [ Temperature sensor
= The voltage produced from the specified temperature can be applied to a
pin to which the A/D converter is connected.
Relational expression between temperature and input voltage:
Voltage (V) input to the connected pin =
(conversion_factor[mV/ °C ] x specified_temperature[ °C ] +
conversion_offsetimV]) / 1000.0

T™MP

z Fan motor

The fan is made to rotate by the input of a digital signal from the connected
- pin.
The rotational velocity can be controlled by the duty ratio of the PWM signal.

DC motor
i ) The motor is made to rotate by the input of a digital signal from the con-
nected pin.
The rotational velocity can be controlled by the duty ratio of the PWM signal.

Shading sensor
J A specified voltage value can be output to the connected pin in response to

covering the red light-emitting part by the hand-image icon.

Wireless-charging transmitter
When a PWM signal is being input through the connected pin, a sphere
revolves around the component to indicate that charging is in progress.

Infrared receiver
Clicking on the component leads to the output of the signal which has been
specified for the connected pin.

Segment LCD for internal driverNote!
Segments of this LCD are illuminated in response to control signals sent
from the LCD driver in the MCU. You can control the correspondence

between the MCU's control signals and segments in the property area.

7-segment LEDs for displaying up to eight-digit numbers with dynamic light-
ing.
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o Brushless DC motorNote2
@ Ditection: CW Signals output from the component are used in control by a feedback sys-
tem. When a three-phase PWM signal is input, the motor rotates.
ST Rl Used for specifying multiple switches for an analog input pin.
. ‘ .]. 45 ¥V A maximum of five switches are specifiable.
e e When a switch is pressed, the voltage specified for the given switches is

input to the selected analog pin.

RSK LCD Panel
An LCD panel included with the Renesas Starter Kit for RL78/L12Note?,
which operates with the on-chip LCD controller of that MCU.

Character LCDs that operate with GPIO connections, one having a display
area with two lines of eight characters and the other two lines of 16 charac-
ters.

A console used for UART communications with the MCU. The transmitted or
received data can be confirmed in the Serial Monitor tab.

The serial monitoring area can also be opened by clicking on the icon button
at the bottom right corner of the component.

Connected to the MCU via the UART to operate as a mock-up component
for Wi-Fi communications.

When a command is received from the MCU via the UART, a defined
response is returned. The transmitted or received data can be confirmed in
the Serial Monitor tab.

The serial monitoring area can also be opened by clicking on the icon button
at the bottom right corner of the component.

i i

A humidity-temperature sensor for acquiring data on temperature and
humidity through I12C communications.

Details of the 12C communications can be confirmed on the Serial Monitor
tab. The serial monitoring area can also be opened by clicking on the con-
sole icon button at the bottom right corner of the component.

The register values in the component can be confirmed by clicking on the
table icon button next to the center-right side of the component.

A character-LCD component for displaying data through 12C communica-

tions.

The component has a display area with two lines of 16 characters.

Details of the 12C communications can be confirmed on the Serial Monitor
tab. The serial monitoring area can also be opened by clicking on the con-
sole icon button at the bottom right corner of the component.

The register values in the component can be confirmed by clicking on the

table icon button next to the center-right side of the component.

A device for sending and receiving data through 12C communications. The
register values in the component can be changed to the desired values.
Details of the I2C communications can be confirmed on the Serial Monitor
tab. The serial monitoring area can also be opened by clicking on the con-
sole icon button at the bottom right corner of the component.

The register values in the component can be confirmed by clicking on the
table icon button next to the center-right side of the component.

An air velocity sensor for acquiring wind-velocity data through 12C communi-
cations.

Details of the 12C communications can be confirmed on the Serial Monitor
tab. The serial monitoring area can also be opened by clicking on the con-
sole icon button at the bottom right corner of the component.

The register values in the component can be confirmed by clicking on the
table icon button next to the center-right side of the component.
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A flow sensor for acquiring airflow data through 12C communications.

= Details of the 12C communications can be confirmed on the Serial Monitor
= tab. The serial monitoring area can also be opened by clicking on the con-
sole icon button at the bottom right corner of the component.

The register values in the component can be confirmed by clicking on the
table icon button next to the center-right side of the component.

A component representing the operation of a fire detector that consists of an
infrared LED, photodiode, and operational amplifier. If a fire is detected, it

, ‘ produces current for input to an analog input pin.
Note 1. At present, this component is only available for use with devices of the RL78/L12 group.
Note 2. At present, this component is only available for use with devices of the RL78/G1F, G24 group.

(2) Environments area
Values related to the environment, such as the temperature or humidity in the vicinity of the virtual board, can be
specified. Some components operate by acquiring these values.

(3) Button area
These buttons are used to add components.
This area is valid while the program is stopped.

Add component Clicking on the button displays a list of components which are available to be
selected for addition.

Drag the component to move it to the position where it is to be placed.

Clicking on the delete button in the upper-right corner of the selected component
deletes that component.

(4) Detailed waveform monitoring area
Clicking on the tab shows the detailed waveform monitor.
This monitor displays the waveforms of pins registered beforehand at 500-ns intervals for one millisecond before
execution of the program is stopped.
In addition, markers can be used to check the states at particular points and a search function can be used to
check whether combinations of states that satisfy certain conditions are present.
For details, refer to the part of the help system that can be displayed from the detailed waveform monitor.

Figure A.54 Detailed waveform monitoring
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Caution At present, this component is only available for use with devices of the RL78/G1F group.

(5) Tab selection area
Selecting a tab switches the category in which detailed information is displayed.
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The following tabs exist in this panel (for details on what is displayed and how to configure settings on each tab,
refer to the corresponding (6) Detailed information display/change area).

- Property tab
- Pins tab
- Serial Monitor tab
(6) Detailed information display/change area

(a) Property tab
This area is used to display or edit the properties of the component.
The properties of the component selected while the program is stopped are displayed.
The following items are displayed in this area.

Subtype Switch the method for controlling the component.
This property is displayed when the component is an LED, a DC motor, a DC fan
motor, or a brushless DC motor.

Name Specify the name of the part.
Connected to Select the name of the pin to which the LED is to be connected.
Color Select the color of the LED.

This property is displayed when the component is an LED.
The following colors can be selected.
Red, Green, Blue, Orange

Active Level Select the active state.
This property is displayed when the component is an LED, switch, Buzzer, DC
Motor, DC Fan Motor, Infrared receiver or Vibration Sensor.

Active High Sets the active level to High.
Active Low Sets the active level to Low.
Appearance Select the appearance of a component. This property is displayed when the compo-

nent is a switch, a vibration sensor, an analog input switch, or a character LCD.

Initial Input Value Select the initial value when the CPU is reset.
This property is displayed when the component is a potentiometer, a gas sensor, a
temperature sensor or a illuminance Sensor.

On Reset Select the operation when the CPU is reset.

This property is displayed when the component is a potentiometer, a gas sensor,
a temperature sensor, a current sensor or a illuminance Sensor.

Hold The state immediately before the CPU was
reset is retained after the CPU has been
reset.

Initialize Specify the value which has been selected in
[Initial Input Value] when the CPU is reset.

Sound Select the mute of the buzzer.
This property is displayed when the component is a buzzer.
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COM/SEG Signal - Segment LCD for internal driver
View or change the current settings of control signals to be sent to the Segment
LCD for internal driver.
This property initially shows the current setting for the number of digits and
whether the control signals have been selected.
Selecting this property produces a button in the displayed area.
Clicking on the button brings up the control interface shown below.
COM/SEG Signal

Enter the desired number of digits, number of segment and select the control sig-
nals for the individual segments. Click on the [OK] button to complete the set-
tings.

RSK LCD Panel
View or change the current settings for control signals to be sent to the LCD
panel of the RSK.

Selecting this property brings up the control interface shown below.

COM/SEG Signal

Select the COM and SEG signals to be connected to the LCD panel. Click on the
[OK] button to complete the settings.
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Input OutPut connection | View or change the current settings for the input and output pins to be used with the
brushless DC motor.

Selecting this property produces a button in the displayed area.

Clicking on the button brings up the control interface shown below.

Input-Output connection settings

Output pins

n connecting pins are reflected in setting

Cancel OK

Input-Output connection settings

Input pins (from MCU to Motor)

u 03 /ANI16/51

/AVREFP/IVCMP12

P21/ANI /AVREFM/IVCMP 13

n connecting pins are reflected in setting

Switches View or set the number of analog input switches and the voltages for the switches.
Selecting this property produces a box for entering the maximum input voltage, a
box for entering the voltage and the [Add] button, and tags for the voltages of
individual switches.

A switch with the voltage specified in the box for entering the value is added by
pressing the [Add] button.

The voltages of individual switches are deleted by clicking on the [Delete] button of
the tag.

Switches

Max. In|

You can add less

0.1 ;
13v % Jov x ] asv x]
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Pin Settings Clicking on the [Setting...] button opens a dialog box for making pin settings. Spec-
ify the MCU pins to be connected to the character LCD.

Pin Settings

Character LED Controdler
or D&

UART Config Clicking on the [Setting...] button opens a dialog box for making UART settings. Set

the pins to be connected to the UART console and make the UART communica-

tions settings.
UART Config

UART Unit UARTAD
» Tran:
Baud Rate

Data Transmit

Receive Code Settings Clicking on the [Setting...] button opens a dialog box for making signal code set-
tings. Set a waveform which is repeatedly input to the MCU..
Signal Code Settings
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BLDC Motor Parameter | View or change the parameters of a brushless DC motor.
Selecting this property produces a button in the displayed area.
Clicking on the button brings up the control interface shown below.

BLDC Motor Parameters

Input Voltage @

MNun

Resistance @
d-axis Inductance I

g-axis Inductance @

Conversion Formula Clicking on the button of this property brings up the control interface shown below.
Define a conversion factor for use when a value entered from a component is con-
verted to a voltage to be input to the MCU.

This property is displayed when the component is a potentiometer, a gas sensor, a
temperature sensor, or a current sensor.

Conversion Formula

Max, Input Veltage

Conversion Offset

Max. Input Voltage *

Min. Input

e specified because it is calculated automatically

Conversion Formula

Input Method Specify the method for the input of values to the component. Selecting [Get ** from

the environment] acquires the required values from the environment above the vir-

tual board according to the component and enters the values to the MCU.

This property is displayed when the component is a temperature sensor, a gas sen-
sor, or an illuminance sensor.

I2C (Slave) Config Clicking on the [Setting...] button opens a dialog box for making 12C settings. Set
an 12C unit connected to the device and the slave address of a device.

12C (Slave) Config

12C Unit IICAD

L

Slave Address

Cancel OK

R20UT5301EJ0100 Rev.1.00 ENESAS Page 327 of 413
Jun 01, 2023



CS+V8.10.00 A. WINDOW REFERENCE

Product Type This property is displayed for selecting the product type of the component when the
component is a temperature-humidity sensor (I12C) or an air velocity sensor (12C).
Confirm the specifications of the given product by clicking on the [Spec] button to
display the modal dialog box.

Spec: HS3001

Temperature Sens:

* Range: -

22 | Bt [ Bito

|
ata

Pin & Operation Settings | Clicking on the [Setting...] button opens a dialog box for making pin and operation
settings. Specify the method for operating the MCU pins connected to the 7-seg-
ment LED (dynamic lighting) component and the LEDs.

Pin & Operation Settings

Pin & Operation Settings

Humber of digits | 4

DIGIT 1 =

DIGIT 2 P

DIGIT 3

DIGIT4 P70/

Segment

Cancel OK
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Fire Detector Config Clicking on the [Setting...] button opens a dialog box for making settings for the fire
detector. Specify the pins to be connected to and the maximum value of the voltage
to be input to the fire detector.

Fire Detector Config

Carvcel (s13

(b) Pinstab
Displays a list of all pins of the MCU.
Each pin can be used to input a digital or analog value when it is not connected to a component.
The value specified here cannot be changed during program execution.

Figure A.55 Pins

Serial Monitor

_RESET
MNotused =
@ P10/_SCKO0/SEG28
Digital * ® High

@ P11/5100/RxD0/TOOLRXD/SEG29

(c) Serial Monitor tab
The serial communication component added to the virtual board allows you to check the contents of data
received and send data to the simulator.
An icon button is displayed in the lower right corner of the serial communication component, and clicking the
button displays the [Serial Monitor] tab.
UART communication supports hexadecimal notation and ASCII code notation, and data sent from the MCU is
prefixed with > is added to the beginning of each line of data sent from the MCU.

Figure A.56 Serial Monitor (UART)

UARTO

HELLO
> HELLOTPI

For I2C communications, the Serial Monitor tab shows the communication direction (read or write), the slave
address of the communication destination, and the communication data. When a single 12C unit is connected to
multiple slave addresses, the communication data can be filtered per slave address.
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Figure A.57 Serial Monitor (I12C)

8x38 ex25

- Copyright
The Virtual Board Panel may use the copyrighted components specified in the file below.
CS+ install folder\ CC\vboard\licenses-abstract.txt
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Simulator GUI window

This window appears automatically by default after connecting to the debug tool when a microcontroller whose Simula-
tor supports peripheral function simulations is selected and [Simulator] is selected as the debug tool to use (see "2.19 Use
the Simulator GUI [Simulator]").

In Simulator GUI, other windows (Signal Data Editor window, Timing Chart window, 1/0O Panel window, and Serial win-

dow) are manipu

Caution 1.

Caution 2.

Caution 3.

Caution 4.

Remark

lated from this window.

When a microcontroller whose Simulator does not support peripheral function simulations (instruction
simulation version) is selected, this window cannot be opened.

This window and windows opened from it cannot be docked to the CS+ Main window.

The help for this window will not be displayed even if the [F1] key on the keyboard is pressed when no
window opened from this window is opened.
To open the help for this window, select the [Help] menu >> [Main Window] on this window.

The [x] button on this window's titlebar is invalid (it is invalid even if using the Aero function of Windows
Vista). If you wish to close this window, perform the configuration of the Property panel (see "2.19 Use
the Simulator GUI [Simulator]").

In addition, do not use the [Alt] + [F4] key to close this window.

The language of titlebar/menubar of this window and windows opened from it depends on the setting of
[Regional and Language Options] in [Control Panel] of the host machine used (if this setting is set to
[Japan]/[Japanese], their titlebar/menubar are displayed in Japanese).

Figure A.58 Simulator GUI Window

File
E
A

(1){

() Simulator GUIT

|-:|IIEI 3

Simulator

Option

—

3

o 2 =]

Window Help

This section describes the following.

- [How to open]

- [Description

of each area]

[How to open]

- This window appears automatically by default after connecting to the debug tool when a microcontroller whose Simu-
lator supports peripheral function simulations is selected and [Simulator] is selected as the debug tool to use.
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[Description of each area]

(1
(a)

(b)

(c)

(d)

(e)

V)

(9)

[Menubar]
[File] menu
New File... Opens a new window for the Simulator GUI window.
Same operation as the I% button.
Open... Opens the files handled in the Simulator GUI window.
Same operation as the & button.
Close Closes the window currently having the focus.
Save Overwrites the contents of the window currently having the focus to the file handled in
the Simulator GUI window.
Same operation as the H button.
Save As... Saves the contents of the window currently having the focus to the specified file.
[Edit] menu

This menu varies depending on the window currently having the focus.
For details on this menu items, see "[Dedicated menu]" section in the Signal Data Editor window, Timing Chart
window, /O Panel window, or Serial window.

[View] menu

This menu varies depending on the window currently having the focus.

For details on this menu items, see "[Dedicated menu]" section in the Signal Data Editor window, Timing Chart
window, I/O Panel window, or Serial window.

[Parts] menu
This menu is added when the 1/O Panel window is opened.
For details on this menu items, see the [Parts] menu/[Parts] toolbar.

[Figure] menu
This menu is added when the 1/0 Panel window is opened.
For details on this menu items, see the [Figure] menu/[Figure] toolbar.

[Option] menu

ToolBar Switches on/off display of the toolbar corresponding to the cascade menu.
Simulator Standard Selects whether the [Simulator Standard] toolbar is displayed or not.
Simulator Tools Selects whether the [Simulator Tool] toolbar is displayed or not.

Signal Data Editor Selects whether the [Signal Data Editor] toolbar is displayed or not.
Timing Chart Selects whether the [Timing Chart] toolbar is displayed or not.
Parts Selects whether the [Parts] toolbar is displayed or not.

Figure Selects whether the [Figure] toolbar is displayed or not.

Customize... Opens the Customize dialog box.

[Simulator] menu

Signal Data Editor Opens the Signal Data Editor window.
Same operation as the M_.E. button.

Timing Chart Opens the Timing Chart window.
Same operation as the |1y button.

1/0 Panel Opens the I/0 Panel window.

Same operation as the E-E button.

Serial Opens the Serial window.
Same operation as the =0 button.
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(h) [Window] menu

Close All Closes all windows, except this window.
Cascade Cascade display of the windows in this window.
Tile Cascade display of the windows in this window.
Arrange Icons Rearranges the icons in this window.

(i) [Help] menu

Main Window Displays the help for this window.

Current Window Displays the help for the current window.

(2) [Toolbar]
(@) [Simulator Standard] toolbar

= Opens a new window for the Simulator GUI window.

Opens the files handled in the Simulator GUI window.

tor GUI window.

Overwrites the contents of the window currently having the focus to the file handled in the Simula-

Undoes the immediately preceding operation.

Cuts the selected range and saves it to the clipboard.

=
=
=2
= Restores the status undone by the [ button.
3

Copies the selected range and saves it to the clipboard.

Pastes the clipboard contents.

i Opens the Search Data dialog box.

T Displays the contents of the help.

(b) [Simulator Tool] toolbar

Opens the Signal Data Editor window.

Opens the Timing Chart window.

Opens the Serial window.

i | (| 58| B

Opens the /O Panel window.

(c) [Signal Data Editor] toolbar
This toolbar can be used when the Signal Data Editor window has the focus.
For details on this toolbar, see the [Signal Data Editor toolbar].

(d) [Timing Chart] toolbar
This toolbar can be used when the Timing Chart window has the focus.
For details on this toolbar, see the [Timing Chart toolbar].

(e) [Parts] toolbar
This toolbar can be used when the 1/0 Panel window has the focus.
For details on this toolbar, see the [Parts] menu/[Parts] toolbar.

(f)  [Figure] toolbar
This toolbar can be used when the 1/0 Panel window has the focus.
For details on this toolbar, see the [Figure] menu/[Figure] toolbar.

(3) [Window display areal]

This area is used to display various windows (Signal Data Editor window, Timing Chart window, 1/0 Panel window,

or Serial window).
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The displayed window can be changed in size or an icon can be created in this area.
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Customize dialog box

This dialog box is used to set or change the color and fonts for the Signal Data Editor window, Timing Chart window or
Serial window.

Figure A.59 Customize Dialog Box: [Color] Tab (For Timing Chart Window)
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Figure A.60 Customize Dialog Box: [Font] Tab
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This section describes the following.

- [How to open]
- [[Color] tab]
- [[Font] tab]

- [Function buttons]

[How to open]

- With the Signal Data Editor window, Timing Chart window or Serial window in focus, select [Customize...] from the
[Option] menu.
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[[Color] tab]

(1) Color setting area
Set and change the color of each part in the window.

List The parts for which color change is possible are displayed in list form.
The parts displayed differ depending on the target window.

Color The currently set color of the part is displayed when that part is selected from the list.

[Change...] button The color currently set for the relevant part of each listed item can be changed.

[[Font] tab]

(2) Font setting area
Set and change the text font of each part in the window.

List The parts for which font change is possible are displayed in list form.

Font The current font name of the part is displayed, when that part is selected from the list.
Size The current font size of the part is displayed, when that part is selected from the list.
[Change...] button The font currently set for the relevant part of each listed item can be changed.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
Apply Cannot be selected.
Help Displays the help for this dialog box.
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Signal Data

Editor window

This window is used to create and edit the signal data that is input to input pins.
The created signal data can be input to the input pin during simulation by selecting the [Edit] menu >> [Signal Input].
This data can also be saved to the signal data file (*.wvi) by selecting the [File] menu >> [Save]/[Save As...] or by saving

the project file.
The saved file

Caution 1.

Caution 2.

Caution 3.

Remark 1.

Remark 2.

contents can be restored by selecting the [File] menu >> [Open...] or by loading the project file.

If the saved signal data file is opened or the project file is opened while Simulator GUI is running with a
microcontroller different from the one used when the signal data file was created, the settings of pins that
are not provided in the microcontroller will not be restored.

The main clock and sub clock cannot be input from this window. Set the main clock/sub clock oscillation
frequency on the [Connect Settings] tab in the Property panel.

If inputting of signals is started during program break, the signals will actually be input when the program
is resumed from the break.

The following data can be displayed or edited in this window:
- Newly created signal data
- Previously created signal data files

- File of signal data previously obtained by performing simulation and saving the results as output signal
data

On the titlebar of this window, "Project file name + Serial number (from 0).wvi" is displayed when the proj-
ect file has been loaded. However, after having loaded a project file of PM+, then if you save a file as the
project file of CS+, "Project file name + CS+ Serial number (from 0).wvi" is displayed on the titlebar.

Figure A.61 Signal Data Editor Window
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This section describes the following.
- [How to open]
- [Description of each area]
- [Dedicated menu (Signal Data Editor window)]
- [Signal Data Editor toolbar]
- [Context menu]
- [Operation]
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[How to open]
- Click the & button

- Select [Signal Data Editor] from the [Simulator] menu.

[Description of each area]

(1) Information bar
It can be specified whether this area is displayed or not, by selecting the [View] menu >> [Information Bar].

2 ||'r|.ai|'f3||; v Select the unit of the wait time from the drop-down list.
The wait time unit can be changed by selecting the [Edit] menu >> [Time unit].

% If this button is clicked while the program is running, signal input starts.
If this button is clicked while the program is stopped, signal input starts auto-
matically the next time the program execution is started.

o If this button is clicked while the program is running, signal input is stopped.
If this button is clicked while the program is stopped, signal input does not start
automatically even if the program execution is started.

P The current signal input line (line highlighted with yellow) is returned to the

beginning.

(2) Client area

(Wark[[¥ait [[POD[PO1 PO [ANIOD AYREF$— ()
1| 100)|( 0 0 0 0 5000
s oo o 0 I a00 5000
3 100f o0 1 0 1000 5000
4 100 0 ] I 1500 5000
b o 1 1 0 goon s00g
B 100 1 0 0 2500 5000
i a1 0 1 2000 5000
g 100 1 1 | 3500 5000
g | g o 0 1 4000 500C
10 L%g 0 1 0 4500 5000
(L) (¢ (d) (L)

(@) | Pinarea Displays the input pin names.

The input pin to be used is selected via the Select Pin dialog box that is opened by click-
ing the |7y button on the toolbar or selecting the [Edit] menu >> [Select Pin...].
Data input to pins can be enabled/disabled by selecting the [Edit] menu >> [Pin Status].

(b) | Line number | Displays line number.
area This area is used when performing editing in line units.
Note that up to 1,048,576 (= 1M) lines can be specified as the signal data.

(c) | Mark area Displays the loop information for the specified input value.

The loop information is specified by selecting from the context menu or the [Edit] menu
>> [Mark] in the relevant field.

The following marks are displayed after the loop information has been specified.

F Loop start location (endless loop)
Fn Loop start location (with loop count)
t Loop end location
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(d) | Wait area

Displays as "wait time" the timing at which the specified input value is input to the pins.
The wait time is specified by directly writing numeric values in the relevant field.

Note that numeric values (decimal code) from 0 to 4,294,967,295 can be specified (val-
ues that exceed 4,294,967,295 can be set by using one more line).

The wait time unit can be changed by selecting the [Edit] menu >> [Time unit].

(e) | Data area

Displays the input value input to the pins.
The input value is specified by directly writing numeric value in the relevant field.
Note that the input rules differ as follows according to the pin type.

Digital pins | Any one of the following one character

0 LOW signal

1 HIGH signal

z Hi-Z signal (case insensitive)
Analog pins | A decimal value from 0 to 5000 (unit: mV)

[Dedicated menu (Signal Data Editor window)]

[Edit] menu
Undo Cannot be selected.
Redo Cannot be selected.
Cut Cuts the selected range and saves it to the clipboard.
Copy Copies the selected range and copies it to the clipboard.
Paste Pastes the contents of the clipboard to the selected location.
Delete Deletes the selected range.
Select All Selects all display data.
Find Cannot be selected.
Select Pin... Opens the Select Pin dialog box. The pin(s) for which input signal data is to be cre-
ated or edited is (are) selected in this dialog box.
Time unit Selects the wait time unit.
main clock Main clock (default)
usec Microsecond
msec Millisecond
Pin Status Selects the input status of the selected pin.
Valid Enables data input to the pin (default).
Invalid Disables data input to the pin.
Mark Sets a mark to the selected Mark area.
Loop Start Sets the loop start mark.
Loop End Sets the loop end mark.
Loop Dialog Opens the Loop dialog box. Sets the details of loop information.
Signal Input Inputs signal data to the simulator.
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)

@)

Start Starts signal input.

Stop Stops signal input.

Reset Returns the current signal input line to the beginning.
[View] menu

Information Bar

Selects whether the information bar is displayed or not.

[Option] menu

Customize...

Opens the Customize dialog box.

[Signal Data Editor toolbar]

i Opens the Select Pin dialog box.
The pin(s) for which input signal data is to be created or edited is (are) selected in this dialog
box.

ﬂ If this button is clicked while the program is running, signal input starts.
If this button is clicked while the program is stopped, signal input starts automatically the next
time the program execution is started.

e If this button is clicked while the program is running, signal input is stopped.
If this button is clicked while the program is stopped, signal input does not start automatically
even if the program execution is started.

ﬁ The current signal input line (line highlighted with yellow) is returned to the beginning.

[Context menu]

The following context menus are available at each area in the Client area.

(1) Pinarea
Valid Enables data input to the pin (default).
Invalid Disables data input to the pin.
Select Pin... Opens the Select Pin dialog box. The pin(s) for which input signal data is to be created

or edited is (are) selected in this dialog box.

(2) Line number
Cut Cuts the selected range and saves it to the clipboard.
Copy Copies the selected range and copies it to the clipboard.
Paste Pastes the contents of the clipboard to the selected location.
Delete Deletes the selected range.

(3) Mark area
Cut Cuts the selected cell and saves it to the clipboard.
Copy Copies the selected cell and copies it to the clipboard.
Paste Pastes the contents of the clipboard to the selected location.
Delete Deletes the selected cell.
Loop Start Sets the loop start mark.
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Loop End Sets the loop end mark.

Loop Dialog Opens the Loop dialog box. Sets the details of loop information.

(4) Wait area

Cut Cuts the data in the selected cell and saves it to the clipboard. The data in the selected
cell becomes 0.

Copy Copies the data in the selected cell and copies it to the clipboard.
Paste Pastes the contents of the clipboard to the selected location.
Delete Deletes the data in the selected cell. The data in the selected cell becomes 0.

(5) Dataarea

Cut Cuts the data in the selected cell and saves it to the clipboard. The data in the selected
cell becomes "Z" (Hi-Z).

Copy Copies the data in the selected cell and copies it to the clipboard.
Paste Pastes the contents of the clipboard to the selected location.
Delete Deletes the data in the selected cell. The data in the selected cell becomes "Z" (Hi-Z).
Start Signal Input Starts signal input.
Stop Signal Input Stops signal input.
Reset Signal Input Returns the current signal input line to the beginning.
[Operation]

(1) Pin selection
(2) Creating signal data
(3) Data copy and paste
(4) Single-line editing
(5) Signal input
(6) Operation at CPU reset
1) Pin selection
To create the signal data, it is first necessary to select the pin to be used.
Open the Select Pin dialog box by clicking the |%| button on the toolbar or selecting the [Edit] menu >> [Select
Pin...], and select the pin to be used. Once a pin is selected, its name is displayed in Pin area.

(

(2) Creating signal data
Create the signal data input to each pin.

(@) Setting of input value
In the Data area, specify the value that is input to each pin (see "Data area").

(b) Setting of input timing
In the Wait area, specify the timing at which the input value is input to each pin as "wait time" (see "Wait area").

(c) Setting of the loop information
When loop processing for the signal data specified in step (a) and (b) is needed, specify the loop information.
To specify the loop information, select [Loop Start] from the context menu on the loop start position in the Mark
area, and select [Loop End] on the loop stop position.
At this time, the loop count can be specified. In this case, specify the loop count via the Loop dialog box that is
opened by selecting [Loop Dialog...] from the context menu.
The corresponding loop information marks are displayed if the setting of the loop information is completed (see
"Mark area").

(3) Data copy and paste
The set values in Mark area/Wait area/Data area can be copied and pasted.
However, copied data can be pasted only in the same area.
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Copy When one or more (a range of) cells are selected, these cells can be copied by selecting the
[Edit] menu >> [Copy] (or pressing the [Ctrl] + [C] key).

Paste When one or more (a range of) cells are selected, these cells can be pasted by selecting the
[Edit] menu >> [Paste] (or pressing the [Ctrl] + [V] key).
When multiple (a range of) cells are selected, the copied data is pasted to the cells repeatedly.

(4) Single-line editing
Single lines can be edited by selecting Line number area.
The method is the same as that described in "(3) Data copy and paste".
Data pasted during line paste (insertion) is inserted immediately before the selected line.

(5) Signal input
Input the created signal data to the input pins of the simulator while simulation is executed.
At this time, the line whose signal is currently being input (current line) is highlighted in yellow during program
breaks (this can be changed via [Inputted current line] item in the Customize dialog box), in order to display signal
input progress.
There are the following types of signal data input operations:

Signal input start | Click the X | button, or select the [Edit] menu >> [Signal Input] >> [Start].

nnn

As a result, signal input starts from the current signal input line (highlighted line).

Signal input stop | Click the |Z%| button, or select the [Edit] menu >> [Signal Input] >> [Stop].

nnn

This stops signal input.

Signal reset Click the ﬁ button, or select the [Edit] menu >> [Signal Input] >> [Reset].
This returns the current signal input line to the beginning. If signal reset was performed dur-
ing signal input, input continues from the beginning.

Remark The signal data input to the selected pin can be controlled by selecting the [Edit] menu >> [Pin Sta-
tus] >> [Valid)/[Invalid].

(6) Operation at CPU reset
When CPU reset occurs, the current signal input line returns to the beginning.
If a CPU reset occurs during signal input, input continues from the beginning (same operation as the ﬂ button).

R20UT5301EJ0100 Rev.1.00 ENESAS Page 342 of 413
Jun 01, 2023



CS+V8.10.00

A. WINDOW REFERENCE

Loop dialog box

This dialog box is used to perform detailed settings (loop start/stop and loop count) related to the loop information in the
Signal Data Editor window.

Figure A.62 Loop Dialog Box
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This section describes the following.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

On the Signal Data Editor window, any one of the following:

- Double-click the Mark area.

- Select the Mark area, then select [Mark] >> [Loop Dialog...] from the [Edit] menu.

[Description of each area]

(1) Loop information setting area

Start of Loop Select this check box to set the Start of Loop.
Endless loop | Select this option button to set the Endless Loop.
Loop count Select this option button to set the Loop Count.
Sets the count value by spin button.
0 Skip loop
1t0 99 Perform loop the specified count.
End of Loop Select this check box to set the End of Loop.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
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Select Pin dialog box

This dialog box is used when selecting pins displayed in the Signal Data Editor window and the Timing Chart window.
The pin information set in this dialog box can be saved as a pin information file (*.pin) by clicking the [Save] button.
Moreover, the saved file contents can be restored by clicking the [Load] button.

Figure A.63 Select Pin Dialog Box
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

On the Signal Data Editor window/Timing Chart window, any one of the following:
- Click the |7/ button.

- Select [Select Pin...] from the [Edit] menu.

[Description of each area]

(1) Connection pins setting area
Up to 256 pins can be selected by using the scrollbar located on the right side of the pin name setting area.

Pin Name This area is used to specify the pin name to be connected.
The connection pins can be specified either via direct input or through selection from
the drop-down list.

Analog Select this check box to use the specified pin as an analog pin.

Function Name This area is used to set a function name for the pin name.
When a character string is input in this area, this character string is displayed as a
function name in the pin name part. If nothing is specified, the pin name is displayed.

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.
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[Function buttons]

Button Function

OK Validates the settings and closes this dialog box.

The pin name (or display name) is applied in the Pin field of the window from where this
dialog box was called up.

Save Saves the display contents to the pin information file (*.pin).
Load Loads the pin setting information of the specified file (*.pin).
Clear Deletes the settings.
Cancel Cancels the settings and closes this dialog box.
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Timing Chart window

This window is used to display the output signals and input signals for pins in the form of a timing chart.

This window allows time measurement in main clock units.

The browsed signal data can be saved to the timing chart file (*.wvo) by selecting the [File] menu >> [Save]/[Save As...].
Moreover, the saved file contents can be restored by selecting [File] menu >> [Open...].

If the project file is saved, signal data is not saved but information of the set pins is saved. (Solely saving the project file
is sufficient if saving of the measurement result is unnecessary.)

Caution 1.

If the saved timing chart file is opened or the project file is opened while Simulator GUI is running with a

microcontroller different from the one used when the timing chart file was created, the settings of pins
that are not provided in the microcontroller will not be restored.

Caution 2.

The main clock and sub clock waveforms cannot be displayed in this window. In addition, when using the

external bus interface function, the waveforms of pins used for the external bus interface function cannot

be displayed.

Figure A.64 Timing Chart Window
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This section describes the following.

- [How to open]

- [Description of each area]

- [Dedicated menu (Timing Chart window)]
- [Timing Chart toolbar]

- [Context menu]

- [Operation]

[How to open]

- Click the ML button.

- Select [Timing Chart] from the [Simulator] menu.

[Description of each area]
(1)

Information bar

It can be specified whether this area is displayed or not, by selecting the [View] menu >> [Information Bar].

T 320000 Clock/time count from simulation start until marker A location.
T 4 736.00 Clock/time count from simulation start until marker B location.
H 1536.00 Clock/time count between markers A and B. (Displayed as absolute value.)

R20UT5301EJ0100 Rev.1.00
Jun 01, 2023

RENESAS

Page

346 of 413



CS+V8.10.00 A. WINDOW REFERENCE

ﬁ%l |r-1.=.i.—.|3|h = | | Select from the drop-down list the time unit for the location information of markers A

" | and B.

This item can also be set by using [Time unit] in the [Edit] menu or [Time unit] from the
context menu.

[xl — Selects the waveform data display magnification ratio from the drop-down list.
: - If a part of waveform data may be lost as a result of changing the display magnification
ratio, the confirmation dialog box is displayed.

Remark 1. Up to 4,294,967,262 clocks can be counted from the simulation start up to the marker position.
When the count reaches the maximum value, the counter is cleared to 0 and starts counting again.

Remark 2. The menu for setting the magnify ratio appears dimmed during program execution, so changing the
ratio is unavailable.

(2) Client area

Marker area
|

[F“in Nane IL . .Ti. .' . J

oD FEpEpEgEpEpgEpEpEpEpgEpEgEn
01 [ L1 1| L LI 11
1} [ 1 [ [ 1 [
ANTE —— N
Pin area Waveform area
Pin Name area Displays the names of the pins for which timing chart display is performed. Pin

selection is performed by selecting the [Edit] menu >> [Select Pin...] to open the
Select Pin dialog box.

Marker area Displays the 2 marker headers. These markers can be moved by dragging them
with the mouse over this area.
Y Maker A
? Maker B

Waveform area Performs timing chart display for the data of the pins specified in the Pin area.

The following color distinctions are used according to the signal by default.

Green The HIGH and LOW signals of the pins
Red High-impedance signals
Blue Unsampled signals
Remark 1. When the buffer is full, the data will be overwritten by the latest data starting from the oldest data

because the buffer storing the pin data is in a ring buffer format.
The upper limit of the buffer size is one of the following.

- The number of pin change points: 4,096
- The number of clocks: 2,147,483,631
- Horizontal draw width: 134,217,711 pixels

Remark 2. The colors and fonts can be changed via the Customize dialog box that is opened by selecting the
[Option] menu >> [Customize...].
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[Dedicated menu (Timing Chart window)]

(1) [Edit] menu

Clear

Deletes all the waveform data.

Find...

Opens the Search Data dialog box.
Waveform data search is performed in this dialog box.

Search backward

Searches for the change point of the selected pin in the backward direction (toward

the left).
Search forward Searches for the change point of the selected pin in the forward direction (toward the
right).
Select Pin... Opens the Select Pin dialog box. The pin for which the waveform data is to be dis-
played is selected in this dialog box.
Time unit Selects the time unit.
main clock Main clock (default)
usec Microsecond
msec Millisecond

(2) [View] menu

Waveform

Switches on/off display of the Maker area and Waveform area.

Information Bar

Switches on/off display of the information bar.

Zoom Selects the waveform data display magnification ratio from a cascade menu.
If a part of waveform data may be lost as a result of changing the display magnifica-
tion ratio, the confirmation dialog box is displayed.

x 1/32 Sets the magnification ratio to 1/32.
x 1/16 Sets the magnification ratio to 1/16.
x 1/8 Sets the magnification ratio to 1/8.
x 1/4 Sets the magnification ratio to 1/4.
x 1/2 Sets the magnification ratio to 1/2.
x 1 Sets the magnification ratio to 1.
X2 Sets the magnification ratio to 2.
x4 Sets the magnification ratio to 4.

x 8 Sets the magnification ratio to 8.

x 16 Sets the magnification ratio to 16.
x 32 Sets the magnification ratio to 32.

(3) [Option] menu

Customize...

Opens the Customize dialog box.

[Timing Chart toolbar]

éZ"

Deletes all the waveform data.

L

Searches for the change point of the selected pin in the backward direction (toward the
left).

R20UT5301EJ0100 Rev.1.00 ENESAS Page 348 of 413

Jun 01, 2023



CS+V8.10.00 A. WINDOW REFERENCE

ﬂ Searches for the change point of the selected pin in the forward direction (toward the
right).
Ty Opens the Select Pin dialog box. The pin for which the waveform data is to be displayed is

selected in this dialog box.

x 1 5 Selects the waveform data display magnification ratio from the drop-down list.
If a part of waveform data may be lost as a result of changing the display magnification
ratio, the confirmation dialog box is displayed.

[Context menu]

The following context menus are available in the Client area.

Clear Deletes all the waveform data.

Find... Opens the Search Data dialog box.
Waveform data search is performed in this dialog box.

Search backward Searches for the change point of the selected pin in the backward direction (toward the
left).

Search forward Searches for the change point of the selected pin in the forward direction (toward the
right).

Select Pin... Opens the Select Pin dialog box. The pin for which the waveform data is to be displayed is

selected in this dialog box.

Waveform Switches on/off display of the Maker area and Waveform area.
Time unit Selects the time unit.
Zoom Selects the waveform data display magnification ratio.

If a part of waveform data may be lost as a result of changing the display magnification
ratio, the confirmation dialog box is displayed.

Move MakerA Moves marker A to the cursor location. The same action can be accomplished by pressing
the [Shift] key + left-clicking.

Move MakerB Moves market B to the cursor location. The same action can be accomplished by pressing
the [Ctrl] key + left-clicking.

[Operation]

(1) Pin selection
(2) Display of timing chart
(3) Clearing of timing chart
(4) Timing measurement for timing chart
(5) Data search function
(6) Operation at reset
)

Pin selection

To display the timing chart, it is first necessary to select the pin to be displayed.

Open the Select Pin dialog box by selecting the [Edit] menu >> [Select Pin...] and select the pin to be edited. Once
a pin is selected, its name is displayed in the Pin Name area.

(1

(2) Display of timing chart
The waveforms of the selected pins are displayed in timing chart form through execution of the program.

Remark The simulation speed can be increased by hiding the timing chart.
To hide the timing chart, select the [View] menu >> [Waveform] (deselect this item).
When the timing chart is hidden, the Maker area and Waveform area appear dimmed and "Display
OFF" is displayed in the center.

(3) Clearing of timing chart
Timing chart display is cleared by selecting the [Edit] menu >> [Clear].
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(4) Timing measurement for timing chart
The timing between two points can be measured by marking 2 locations using markers A and B.
The time of each marker and the time between markers are displayed in the information bar.
Each marker can be placed at the target position by dragging the marker head. Moreover, it can also be placed at
the position of the current mouse cursor by selecting [Move MarkerA]/[Move MarkerB] from the context menu.
The marker that is clicked last becomes the selected marker and can be subjected to the Data search function.

Figure A.65 Maker A And Maker B

A B A B
Selected markers Unselected makers

(5) Data search function
There are two data search functions for timing charts.

(a) Simple search
Simple search is a function used to search change points for one pin.
Select the name of the pin for which the search is to be performed in the Pin area and then select the [Edit]
menu >> [Search backward] or [Search forward].
As a result, the selected marker moves to the data position at which the change point was detected.

(b) Detailed search
In the case of detailed search, search using a combination of data of multiple pins can be executed.
The search data is set in theSearch Data dialog box displayed by selecting the [Edit] menu >> [Find...].
The selected marker moves to the data position that was hit, similarly to simple search results.

(6) Operation at reset
If CPU reset or Simulator GUI reset occurs, the displayed waveforms of the timing chart are all cleared.
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Search Data dialog box

This dialog box is used to search the signal data displayed in the Timing Chart window in detail.
Caution 1.  Analog I/O signals cannot be searched.

Caution 2.  This dialog box cannot be opened during program execution.

Figure A.66 Search Data Dialog Box

Search Data [
B Fir Parme: Search Data: Direction [ |
2 Bscloasrd — (1)
1 RESET - |High LA e
_ Forazrd
(1 o - | |
a - Mexk
— [Function buttons]
L 4 - - Ciapo=| |

This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

On the Timing Chart window, any one of the following:
- Click the |k button.
- Select [Find...] from the [Edit] menu.

[Description of each area]

(1) Search pin setting area
When multiple search conditions have been specified, the signal data that meets all these search conditions is
searched.
Up to 48 search conditions can be specified by using the scrollbar located on the right side.

Pin Name This area is used to specify the pin name to be searched.
The pins can be specified either via direct input or through selection from the drop-down
:I::)'utting noting makes an area off-limit to data search and input in the corresponding
[Search Data] is disabled.
Search Data Selects the data from drop-down list. The data is searched for the pin to be specified.
------ Don't care
Rising Edge Searches the rising edge of signal data.
Falling Edge Searches the falling edge of signal data.
Rise/Fall Edge Searches the rising/falling edge of the signal data.
High Searches the signal data that is HIGH.
Low Searches the signal data that is LOW.
Hi Z Searches the signal data that is high impedance.
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Direction Selects the data search direction by selecting one of the exclusive option buttons. When
the [Next] button is clicked, the search is performed in the direction specified in this area.
Backward Searches the data backward (data older than the current location).
Forward Searches the data forward (data newer than the current location).
(default)
[Function buttons]
Button Function

Next Searches in the direction specified. When this button is clicked again following search
completion, the next data is searched.

Cancel Stops the data search and closes the dialog box.
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I/0O Panel window

This window is used to configure a dummy target system, and manipulate created connected parts.

A dummy target system can be constructed by creating and setting connected parts (figure objects and part objects) in
this window. The connected parts for which settings have been performed can be moved to any location within the win-
dow, and you can manipulate them during simulation to control signal processing.

Information about parts that are placed in the window can be saved to the I/O panel file (*.pnl) by selecting the [File]
menu >> [Save]/[Save As...] or by saving the project file.

The saved file contents can be restored by selecting the [File] menu >> [Open...] or by loading the project file.

Caution 1.  If the saved I/O panel file is opened while Simulator GUI is running with a microcontroller different from
the one used when the file was created, information of the parts connected to the pins that are not pro-
vided in the microcontroller will not be restored (the [Pin Name] item in the property dialog boxes for parts
remains blank).

Caution 2.  [f inputting of signals is started (by an event such as clicking a button) during program break, the signal
level will change in actuality when the program is resumed from the break.

Remark On the titlebar of this window, "Project file name + Serial number (from 0).pnl" is displayed when the proj-
ect file has been loaded. However, after having loaded a project file of PM+, then if you save a file as the
project file of CS+, "Project file name + CS+ Serial number (from 0).pnl" is displayed on the titlebar.

Figure A.67 1/0 Panel Window
22 1/0 Panel1 =] - ]

(1] -l

Do) ][] <

This section describes the following.

- [How to open]

- [Description of each area]

- [Dedicated menu/toolbar (I/O Panel window)]
- [Context menu]

- [Operation]

[How to open]

- Click the [== button.

- Select [I/0 Panel...] from the [Simulator] menu.

[Description of each area]

(1) Client area
This area is used to create and set connected parts (figure objects and part objects) in order to construct a dummy
target system (see "[Operation]").
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[Dedicated menu/toolbar (/0O Panel window)]

The menu items and buttons on the toolbar, which are used to perform operations related to this window, are described

below.

(1)

(2)

@)

[Edit] menu

Select this menu to perform basic editing actions on created objects.

Undo Undoes the immediately preceding operation, such as object move.
Undo can restore up to 5 previous changes.

Redo Restores the status undone by the [Undo] command.

Cut Cuts the selected range and saves it to the clipboard.

Copy Pastes the contents of the clipboard.

Paste Pastes the contents of the clipboard.

Delete Deletes the selected range.

Select All Selects all the objects in the window.

Group Groups the selected objects.

UnGroup Ungroups the selected objects.

Bring to Front

Brings the selected object to the front.

Send to Back

Sends the selected object to the back.

Bring Forward

Brings the selected object one panel forward.

Send Backward

Sends the selected object one panel backward.

[View] menu

Select this menu to switch the toolbar/status bar display status in this window, or to show/hide various types of

information in this window.

ToolBar Switches on and off the display of two toolbars (Figure/Object).
StatusBar Switches on and off display of the statusbar.
Parts List... Opens the Parts List dialog box.

A list of all the figure/part objects in this window is displayed.
Grid Shows/hides the window grid.
Properties Opens the property dialog box of the selected figure/part object.

[Parts] menu/[Parts] toolbar
This menu and toolbar are used to select connected parts (part objects) provided by Simulator GUI when newly
creating or placing parts (see "(3) Creating part objects").

In this menus, similar operations can be performed using the buttons on the [Parts] toolbar.

Menu ltem But- Function
ton

Button = Digital input switch

A button can be connected to any pin. A digital input value can be given to
eg)| poo the connected pin by clicking the displayed button.
Analog Button = Analog input switches

A button can be connected to any pin. An analog input value can be given
e.g.) _ to the connected pin by clicking the displayed button.
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Menu Item But- Function
ton
Key Matrix 3 A key matrix consists of multiple pins connected in a matrix array, wherein
each contact represents a key, and clicking a key results in a specific
e.g.) | i ¥ i state.
[ : S - A key matrix can be connected to any pin, and data can be input using
multiple keys.
(B E :
| if T i
Level Gauge o, Used for inputting analog data such as power supply voltage. Any data

within a given range can be set.
Any value within a specified range can be assigned to a pin connected to
an A/D converter.

e.g.)

G Light Emitting Diode
An LED can be connected to any pin, and the output from the pin can be

LED
e.g.) m D indicated by switching the LED on or off.

7-Segment LED = A product that consists of 7 LEDs configured to represent a numeric fig-
ure.

e.g.) When the output from the pin assigned to the digit signal is active, the cor-
responding 7-segment LED switches on or off.

14-Segment LED @ A product that consists of 14 LEDs configured to represent an alphabetic

character. When the output from the pin assigned to the digit signal is
active, the corresponding 14-segment LED switches on or off.

s A product that consists of multiple LEDs arranged in a matrix array.
When the output from an assigned pin is active, the corresponding 14-
segment LED switches on or off.

e.g.)

Buzzer '@' A buzzer connected to a pin indicates the output information from the con-

nected pin with a bitmap.
eg) - i rl r'-r

Pull up / Pull down...

Opens the Pull up/Pull down dialog box.
Whether a pin is connected to a pull-up/down resistor can be specified via
this dialog box.

|

(4) [Figure] menu/[Figure] toolbar
This menu and toolbar are used to set the operation mode of this window, and select connected parts (figure
objects) when newly creating or placing parts (see "(2) Creating figure objects").
In this menus, similar operations can be performed using the buttons on the [Figure] toolbar.

Menu Item Button Function

Select [23 Changes this window's operation mode to the Edit mode.
The cursor shape changes into an arrow, enabling the edit of objects.
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Menu Item Button Function
Simulation Mode @ Changes this window's operation mode to the Simulation mode.
The cursor shape changes into a hand, enabling simulation of input to con-
nected parts (part objects).
Line Ry Changes the cursor shape into a cross (+), enabling the drawing of lines.
Rectangle ] Changes the cursor shape into a cross (+), enabling the drawing of rectangles.
Rounded Rectan- ] Changes the cursor shape into a cross (+), enabling the drawing of rectangles
gle with rounded corners.
Ellipse - Changes the cursor shape into a cross (+), enabling the drawing of ellipses.
Polygon .f}; Changes the cursor shape into a cross (+), enabling the drawing of polygons.
Fan-shaped > Changes the cursor shape into a cross (+), enabling the drawing of fan shapes.
Text A Changes the cursor shape into a cross (+), enabling the drawing of text.
Paste Bitmap... - Pastes the selected bitmap file in this window
Color of Line... i Opens the Color dialog box.
The color of the lines of the selected object can be changed to the selected
color in this dialog box.
Color of Fill... ﬂ Opens the Color dialog box.
The color used for the selected object can be changed to the selected color in
this dialog box.
Font... - Opens the Font dialog box.
The font of the selected object can be changed to the selected font in this dialog
box.
Style of Line — Selects the line style from a cascade menu. The lines of the selected object are
changed.
16pt Sets the line thickness to 16 pt.
12pt Sets the line thickness to 12 pt.
8pt Sets the line thickness to 8 pt.
4pt Sets the line thickness to 4 pt.
2pt Sets the line thickness to 2 pt.
1pt Sets the line thickness to 1 pt.
No line Does not draw lines.

Selects the dotted line style from a cascade menu. The lines of the selected
object are changed.

Solid Line Draw solid lines.
Dash Line Draw dashed lines.
Dotted Line Draw dotted lines.

DashDot Line

Draw DashDot lines.

DashDotDot Line

Draw DashDotDot lines.

[Context menu]

In the Edit mode, the following context menus are available.
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Copy Copies the selected objects.
Paste Pastes the contents of the clipboard.
Delete Deletes the selected objects.
Group Selects from a cascade menu.
Group Groups the selected objects.
Ungroup Ungroups the selected objects.
Order Selects from a cascade menu.
Bring to Front Brings the selected object to the front.
Send to Back Sends the selected object to the back.
Bring Forward Brings the selected object one panel forward.
Send Backward Sends the selected object one panel backward.
Properties Opens the property dialog box of the selected figure/part object.
[Operation]
How to create objects (figure objects and part objects) to construct a dummy target system, and manipulate them is as
follows:
Edit mode

Creating figure objects
Creating part objects
Placing objects

List display of objects
The detailed setting for objects
Simulation mode

(

)
(a)

(b)

(1)
(2)
(3)
4)
(5) Inputting text
(6)
(7)
(8)
1)

Edit mode
Change the operation mode of this window to "edit mode" to create objects.
The edit mode can be set by any one of the following methods.

- Select the [Figure] menu >> [Select].
- Click the |[3; | button on the toolbar.
- Select the [Edit] menu >> [Select All].

Creating figure objects

Line

Select the [Figure] menu >> [Line] or click the |™. | button on the toolbar.
-> The mouse cursor changes to a cross (+) shape and line drawing becomes possible.

Drag the cursor from the line start position to the end position.
-> The line start position and the line end position are connected by a straight line. (The line thickness and
shape are the default settings.)

Rectangle/Rounded rectangle/Fan shape

Select the [Figure] menu >> [Rectangle]/[Rounded Rectangle)/[Ellipse]/[Fan-shaped] or click the [ _]/ [}/

/'™ button on the toolbar.

-> The mouse cursor changes to a cross (+) shape and each drawings becomes possible.

Drag the mouse cursor from the top left corner to the bottom right corner of the drawing area (rectangular area).
-> The corresponding figure is displayed in the drawing area, with the mouse position forming the lower right
corner.

Drop the figure to fix its size.

-> Rectangles are drawn in the same size as the rectangular area, and other figure shapes are drawn in a
size that fits in the rectangular area. (The line thickness and shape are the default settings.)
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(c) Polygon
Select the [Figure] menu >> [Polygon] or click the L’:}p button on the toolbar.
-> The mouse cursor changes to a cross (+) shape and polygon drawing becomes possible.
Click at each position marking an apex of the polygon.
-> The apexes are linked by a straight line in the order in which they were clicked.
Drawing of the polygon is completed by double-clicking.
-> The line thickness and shape are the default settings.

(d) Pasting a bitmap
You can use an arbitrary bitmap file as a figure object.
Select the [Figure] menu >> [Paste Bitmap], and then select the bitmap file (*.bmp) to be pasted.
-> The corresponding bitmap file is pasted in the default position in this window.

(e) Changing the figure object style
The color or line style of the created figure object can be changed by any one of the following methods.

- Specify with the [Style] tab of the Object Properties dialog box that is opened by double-clicking the figure
object.

(3) Creating part objects
You can create part objects by using connected parts provided by Simulator GUI.

(a) Selecting a part object
Select the part object to be created from the [Parts] menu or the toolbar.
-> The mouse cursor changes to a cross (+) shape.
Click any location.
-> The corresponding part object is created and placed with the clicked location as the top left corner (default
size).

(b) Changing the part object style
The style of the created part object can be changed via the [Style] tab of the corresponding property dialog box
that is opened by double-clicking the part object.
For details on the modifiable items, see the section of the property dialog box which is corresponding to the part
object (the items differ depending on the part object).

(4) Placing objects

(@) Grid display
A grid is displayed by selecting the [View] menu >> [Grid].

(b) Selecting objects
The selected types and methods are indicated below.
The selected object(s) is displayed surrounded by a tracker indicating its selected status.

- Single selection
Click the object to be selected.

- Multiple selections
Click the objects to be selected while pressing the [Shift] key.

- Range selection
Drag from the top left corner of the area including the object to be selected, and drop at the lower right corner.

- Select all
Select [Edit] menu>> [Select All].
(c) Moving objects
After selecting the object to be moved (multiple selections possible), then drag and drop it at the move destina-

tion.
Remark Objects can be moved using the arrow keys on the keyboard.
If more than half of the part bitmap is hidden when the window size is reduced, however, the
selected part cannot be moved by using the arrow keys.
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(d) Changing object size
After selecting the object whose size is to be changed, then drag the tracker displayed.

(e) Cut/Copy/Paste/Delete/Group/UnGroup an object
After selecting the object, select the corresponding item from the [Edit] menu.

(f)  Changing object sequence (Bring to Front/Send to Back/Bring Forward/Send Backward)
After selecting the object, select the corresponding item from the [Edit] menu.

(5) Inputting text
Select [Figure] menu >> [Text] or click the | & | button on the toolbar.
-> The mouse cursor changes to a cross (+) shape.
Drag the mouse cursor from the top left corner of the character drawing area (rectangular area) to the lower right
corner.
-> This rectangular area serves as the character drawing area.
Click in the character drawing area.
-> The cursor is displayed and character input becomes possible.

(6) List display of objects
Figure objects and part objects created in this window can be displayed as a list by selecting the [View] menu >>
[Parts List], in addition to display in this window.

(7) The detailed setting for objects
Each created object requires the detailed setting (pin connection information, etc.) in accordance with the target
system to be used.

(a) Figure objects
The detailed setting can be performed via the [Object Connection] tab of the Object Properties dialog box that is
opened by double-clicking the target figure object.
By connecting a object to an output pin, show/hide of the object can be switched depending on the output status
of the connected pin.

(b) Part objects
The detailed setting can be performed via the [xxx Connection] tab of the property dialog box that is opened by
double-clicking the target part object.
For details on the settable items, see the section of the property dialog box which is corresponding to the part
object (the items differ depending on the part object).

(8) Simulation mode
The part objects whose settings have been completed can be manipulated during simulation (input values can be
fed to the simulator). Accordingly you can check the 1/O results from these displayed part objects in this window.
Change the operation mode of this window to "simulation mode" to manipulate part objects.
The simulation mode can be set by any one of the following methods (the mouse cursor changes to a hand
shape).

- Select the [Figure] menu >> [Simulation Mode].
- Click the @ button on the toolbar.

Remark For details on input operation, see the section of the property dialog box which is corresponding to
the part object
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Parts Button Properties dialog box

This property dialog box is used to set or change the pin connection information of buttons, which are one of the con-

nection parts in the I/O Panel window.
Input to the simulator can be done from pin-connected buttons in the Simulation mode.
There are two types of button display styles, figure and bitmap. These styles can be changed on the [[Style] tab].

Figure A.68 Parts Button Properties Dialog Box: [Button Connection] Tab

' Parts Button Properties =
Button Gonnection | Style |
Label :
Fin Mame : -
Acive Level o LAY @ HIGH
Type @ Push O Toggle () Group
. Ciraup Hame
Hold Time - 05 S
detanli: inactive -]
[Function buttons]{ [ 0 | [ cancel | Apply Help

Figure A.69 Parts Button Properties Dialog Box: [Style] Tab
Parts Button roperties

Button Conrection  otvle

71 Figure Prawiew
Shaps :  Rectzngle shiadaw
Lne Fill up
Thickress: | :

Ative : | - | Active - | "I
(1 )_ hﬂ":‘l (1 | i | I,I'sﬂl,'.‘l i'-.l: : | - I Helive | (2)

@ Bitmap

H = Deleta Inactive
[Function buttons]{ | Ok | | cancel | Apply

This section describes the following.

- [How to open]

R20UT5301EJ0100 Rev.1.00 :{ENESAS Page 360 of 413
Jun 01, 2023



CS+V8.10.00 A. WINDOW REFERENCE

- [[Button Connection] tab]
- [[Style] tab]
- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:
- Double-click a part object "Button".
- Select [Properties...] form the context menu on a part object "Button".

- Select a part object "Button", and then select [Properties...] form the [View] menu.

[[Button Connection] tab]

(1) Pin connection information setting area

Label This area is used to specify the part name. The part name input here is displayed on
the button. Moreover, it is also displayed in the Parts List dialog box as the label.

Pin Name This area is used to specify the pin name to be connected. The connection pins can
be specified either via direct input or through selection from the drop-down list.

Active Level The active state is selected with a option button, as follows:
LOW Sets the active level to LOW.
HIGH Sets the active level to HIGH (default).
Type Button types are selected using option buttons, as follows:
Push Makes the button a Push button (default).
The [Hold Time] item must be specified.
Toggle Makes the button a Toggle button.
Group Makes the button a Group button.

The [Group Name] item must be specified.

Group Name This area is used to input the button's group name. Input to this area is possible only
when [Group] has been selected in [Type].

Hold Time Specify the time (hold time) for which the input value is to be held (default: 0.5msec).
The settable range is from 0.001 to 999 (msec).
Input to this area is possible only when [Push] has been selected in [Type].

default Specify the button status after CPU reset.
Not change at Maintains the button status after CPU reset.
reset.
inactive Buttons are non-depressed after CPU reset (default).
active Buttons are depressed after CPU reset.
Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.
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[[Style] tab]
(1) Style information setting area
Figure Select this option button to display the button with the following specified figure.
Shape Select the figure shape. Two shapes can be selected: rectangle and ellipse.
shadow Cannot be selected.
Line Specify and change the figure line, as follows.

You can change the color of figure line by clicking the pull-down button.

Thickness | Specifies the line thickness.

Specification is made either using a spin button or through direct
input.

A value from 1 to 100 can be specified.

Active Specifies the color of the line during active display.
Inactive Specifies the color of the line during inactive display.
Fill up Specify and change the figure filling, as follows.

You can change the color of figure filling by clicking the pull-down button.

Active Specifies the fill color during active display.
Inactive Specifies the fill color during inactive display.
Bitmap Select this option button to display the button with the following specified bitmap (default).
Selection list Select a bitmap to be used from the selection list.

The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection
list.

The bitmap file to be added can be specified either through file selection using
the [...] button, or through direct input.

[ Entry Bitmap =

fctive Bibmap ©

st Bitrrap

__

e« | [ cacel |

[Delete] button | Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

(2) Preview area
This area displays the style of the button currently being specified.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
Apply Cannot be selected.
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Button Function

Help Displays the help for this dialog box.

[Operation]

In the Simulation mode, by clicking the displayed button, data can be input to the pin connected to the button.
The input format differs depending on the button type (push, toggle, group).

Figure A.70 Connected Parts Display Example (Button)

| Button 1

Push button Clicking this button causes the active value to be loaded to the connected pin.
The active value is held during the hold time, after which it changes to the original value.

Toggle button Clicking this button loads the active value to the connected pin.
The active value is held during the hold time, after which it changes to the original value.

Group button Clicking this button loads the active value to the connected pin.
The value of the Group button having the same group name returns to the original value.
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Analog Button Properties dialog box

This property dialog box is used to set or change the pin connection information of analog buttons, which are one of the

connection parts in the 1/0 Panel window.
Input to the simulator can be done from pin-connected analog buttons in the Simulation mode.
There are two types of analog button display styles, figure and bitmap. These styles can be changed on the [[Style] tab].

Figure A.71 Analog Button Properties Dialog Box: [Analog Button Connection] Tab
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Figure A.72 Analog Button Properties Dialog Box: [Style] Tab
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This section describes the following.

- [How to open]
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- [[Analog Button Connection] tab]
- [[Style] tab]
- [Function buttons]

- [Operation]

[How to open]

On the I/0O Panel window, any one of the following:
- Double-click a part object "Analog Button".
- Select [Properties...] form the context menu on a part object "Analog Button".

- Select a part object "Analog Button", and then select [Properties...] form the [View] menu.

[[Analog Button Connection] tab]

(1) Pin connection information setting area

Label This area is used to specify the part name. The part name input here is displayed on the
button. Moreover, it is also displayed in the Parts List dialog box as the label.

Pin Name This area is used to specify the pin name to be connected. The connection pins can be
specified either via direct input or through selection from the drop-down list.

Active Specify the active state.
Check box Analog buttons are created by the number of selected check
boxes.
Label Directly input the name to be displayed on each analog button.
Voltage(mV) Directly input the voltage to be input when each analog button is
clicked, in mV units.
Arrange Specify the button arrangement using the option button.

This setting is available if two or more analog buttons have been created in the Active area.
This setting is ignored if there is only one analog button or no analog buttons have been cre-

ated.
Row Analog buttons will be arranged horizontally (default).
Column Analog buttons will be arranged vertically.
default Maintains the analog button operation after CPU reset.
Not change at reset. Maintains the analog button status immediately before CPU reset,
after CPU reset.
inactive All of the analog buttons are non-depressed after CPU reset
(default).
Active is 'xxx'yyy(mV) | The analog button specified with "'xxx'(yyymV) " is depressed after
CPU reset.
Inactive Specify the input level when no analog buttons are depressed.
Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.
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[[Style] tab]
(1) Style information setting area
Figure Select this option button to display the analog button with the following specified figure.
Shape Select the figure shape. Two shapes can be selected: rectangle and ellipse.
shadow Cannot be selected.
Line Specify and change the figure line, as follows.

You can change the color of figure line by clicking the pull-down button.

Thickness | Specifies the line thickness.

Specification is made either using a spin button or through direct
input.

A value from 1 to 100 can be specified.

Active Specifies the color of the line during active display.
Inactive Specifies the color of the line during inactive display.
Fill up Specify and change the figure filling, as follows.

You can change the color of figure filling by clicking the pull-down button.

Active Specifies the fill color during active display.
Inactive Specifies the fill color during inactive display.
Bitmap Select this option button to display the analog button with the following specified bitmap (default).

Selection list | Select a bitmap to be used from the selection list.
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection
list.

The bitmap file to be added can be specified either through file selection using
the [...] button, or through direct input.

Entry Bitmap ]

fctive Bibmap :

st Bitmrep

—_—

ok | [ cace |

[Delete] but- Deletes the currently selected bitmap from the selection list.
ton Note that only the bitmap that have been added by user can be deleted.

(2) Preview area
This area displays the style of the analog button currently being specified.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
Apply Cannot be selected.
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Button

Function

Help

Displays the help for this dialog box.

[Operation]

In the Simulation mode, while an analog button is depressed, the specified analog voltage value is input to the specified

pin.

Clicking the depressed analog button again restores the button to its original state.

Figure A.73 Connected Parts Display Example (Analog Button)

R20UT5301EJ0100 Rev.1.00

Jun 01, 2023

RENESAS

Page 367 of 413



CS+V8.10.00

A. WINDOW REFERENCE

Parts Key Properties dialog box

This property dialog box is used to set or change the pin connection information of a key matrix, which is one of the con-

nection parts in the I/O Panel window.

Input to the simulator can be done from pin-connected keys in the Simulation mode.
A key matrix consisting of input pins and output pins of up to 16 x 16 can be set.
Either figure or bitmap can be selected as the key matrix display style. These styles can be changed on the [[Style] tab].

Caution When connecting a key matrix to pins, also perform the Pull up/Pull down settings for the connection
pins. When a key is pressed, the output value of the output pin connected to that key is input to the input
pin connected to that key. The value when the key is not pressed is the value specified in the Pull up/Pull

down dialog box.

If the Pull up/Pull down settings are not performed, the input pin becomes the high-impedance state.
Consequently, the operation of the function that is connected to the input pin becomes undefined.

Figure A.74 Parts Key Properties Dialog Box: [Key Matrix Connection] Tab

Parts Key Properties [t
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Figure A.75 Parts Key Properties Dialog Box: [Style] Tab
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This section describes the following.
- [How to open]

- [[Key Matrix Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:
- Double-click a part object "Key matrix".
- Select [Properties...] form the context menu on a part object "Key matrix".

- Select a part object "Key matrix", and then select [Properties...] form the [View] menu.

[[Key Matrix Connection] tab]

(1) Pin connection information setting area

Label This area is used to specify the part name. The part name input here is also displayed in the
Parts List dialog box as the label.
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Pin Name This area is used to specify the pin name to be connected (input pins and output pins). The
connection pins can be specified either via direct input or through selection from the drop-
down list.

This area can be used to set 16 x 16 pins using the scrollbar.

In0 - In15 Specify input pins.
Out0 - Out15 Specify output pins.
NOO - Nff This area is where the text strings displayed on the keys of the key

matrix are specified. Text strings of any length can be specified.
The default description string (N number) is not displayed on the keys.

Hold Time Specify the time (hold time) for which the input value is to be held (default: 0.5msec). The set-
table range is from 0.001 to 999 (msec).
Moreover, when multiple keys for input to the same input pin are pressed during the hold time,
only the key that was clicked last is valid.

default Specify the key matrix operation after CPU reset.
Not change at The key matrix status does not change after CPU reset.
reset.
inactive No key matrix buttons are depressed after CPU reset (default).
Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.
[[Style] tab]
(1) Style information setting area
Figure Select this option button to display the key matrix with the following specified figure.
Shape Select the figure shape. Two shapes can be selected: rectangle and ellipse.
shadow Cannot be selected.
Line Specify and change the figure line, as follows.

You can change the color of figure line by clicking the pull-down button.

Thickness | Specifies the line thickness.

Specification is made either using a spin button or through direct
input.

A value from 1 to 100 can be specified.

Active Specifies the color of the line during active display.
Inactive Specifies the color of the line during inactive display.
Fill up Specify and change the figure filling, as follows.
You can change the color of figure filling by clicking the pull-down button.
Active Specifies the fill color during active display.
Inactive Specifies the fill color during inactive display.
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Bitmap Select this option button to display the key matrix with the following specified bitmap (default).

Selection list | Select a bitmap to be used from the selection list.
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection
list.

The bitmap file to be added can be specified either through file selection using
the [...] button, or through direct input.

| Entry Bitmap =

Actire Bibrmap ©

L. |

Inacthe= Bitrep

—_—

| oo || Caee |

[Delete] but- Deletes the currently selected bitmap from the selection list.
ton Note that only the bitmap that have been added by user can be deleted.

(2) Preview area
This area displays the style of the key matrix currently being specified.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
Apply Cannot be selected.
Help Displays the help for this dialog box.
[Operation]

In the Simulation mode, the following operation can be done.

(1) Inputting multiple keys simultaneously
(2) Locking the key input value

(1) Inputting multiple keys simultaneously
To enter two keys, simultaneously press the key to be input and right-click the mouse to enter the wait status.
Then, click the other key. This releases the wait status and enables simultaneous input of both keys. Multiple keys
can be simultaneously input by setting the wait status for multiple keys, but if input is to be performed to the same
input pin, the key that was input last is valid.

(2) Locking the key input value
To enter two keys, simultaneously press the key to be input and right-click the mouse to enter the wait status.
Then, click the other key. This releases the wait status and enables simultaneous input of both keys. Multiple keys
can be simultaneously input by setting the wait status for multiple keys, but if input is to be performed to the same
input pin, the key that was input last is valid
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Figure A.76 Connected Parts Display Example (Key Matrix)
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Parts Level Gauge Properties dialog box

This property dialog box is used to set or change the pin connection information of level gauge, which are one of the
connection parts in the 1/0 Panel window.

Input to the simulator can be done from pin-connected level gauge in the Simulation mode.

Note that the connection pin must be an analog input pin.
There are two types of level gauge display styles, slide and dial. These styles can be changed on the [[Style] tab].

Figure A.77 Parts Level Gauge Properties Dialog Box: [Level Gauge Connection] Tab
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Figure A.78 Parts Level Gauge Properties Dialog Box: [Style] Tab
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This section describes the following.
R20UT5301EJ0100 Rev.1.00 ENESAS Page 373 of 413

Jun 01, 2023



CS+V8.10.00

A. WINDOW REFERENCE

- [How to open]

- [Level Gauge Connection] tab]

- [[Style] tab]
- [Function buttons]

- [Operation]

[How to open]

On the I/0O Panel window, any one of the following:

- Double-click a part object "Level Gauge".

- Select [Properties...] form the context menu on a part object "Level Gauge".

- Select a part object "Level Gauge", and then select [Properties...] form the [View] menu.

[Level Gauge Connection] tab]

(1) Pin connection information setting area

Label This area is used to specify the part name. The part name input here is also dis-
played in the Parts List dialog box as the label.
Pin Name This area is used to specify the pin name to be connected. The connection pins can

be specified either via direct input or through selection from the drop-down list.

Maximum input

This area is used to set the maximum level gauge input value (default: 5000mV).
The settable range is from 0 to 65535.

The operation range of the level gauge displayed in the /O Panel window is deter-
mined by this specified value.

When CPU reset

Specify the level gauge operation after CPU reset.

before CPU Reset | Maintains the level gauge status of immediately before CPU
reset, after CPU reset.

Set default voltage | The level gauge is set to the specified value after CPU reset
(default).

Specify the value in mV units.

Input a value from 0 to "Maximum input:". (default: 0 mV)

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.

[[Style] tab]

(1) Style information setting area

Slide

Select this option button to display the level gauge with the side-type.

Form

Select the slide direction (vertical or horizontal) from the drop-down list.

Color

This area is used to specify or change the slide color.
You can change the color by clicking the pull-down button.
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Dial Select this option button to display the level gauge with the dial-type (default).

Color of Mark This area is used to specify or change the color of the mark indicating the
operating point.
You can change the color by clicking the pull-down button.

Selection list Select a bitmap to be used from the selection list.
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selec-
tion list.

The bitmap file to be added can be specified either through file selection
using the [...] button, or through direct input.

[ Entry Bitmap =

fctivs Bibrmap :

L. |

Inacthee Bitrrep

—_—

Lo | [ ceel |

[Delete] button | Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

(2) Preview area
This area displays the style of the level gauge currently being specified.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
Apply Cannot be selected.
Help Displays the help for this dialog box.
[Operation]

In the Simulation mode, analog input from the level gauge is performed through manipulation of the displayed slider or
dial.

The value specified in [Maximum input] is the maximum value that can be input.
Input is enabled by selecting the [Figure] menu >> [Simulation Mode].

Figure A.79 Connected Parts Display Example (Level Gauge)
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Dial-type level gauge The displayed analog value changes as the operating point (red circle) on the dial is
moved by dragging it with the mouse. When this analog value has become the value that
is to be input, release the operating point. As a result, the displayed analog value is input.
The operating point can also be moved by clicking the desired location on the dial.

Slide-type level gauge The displayed analog value changes as the slider button is moved by dragging it with the
mouse. When this analog value has become the value that is to be input, release the but-
ton. As a result, the displayed analog value is input. The button can also be moved by
clicking the desired location on the slider.

Caution If you drag and drop the dial's operation point (red circle) or the slider's knob away from the level gauge,
then the voltage displayed in the level gauge will change, but the voltage actually output by the level
gauge will not change. Make sure to always drag and drop over the level gauge.
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Parts Led Properties dialog box

This property dialog box is used to set or change the pin connection information of LED, which are one of the connection

parts in the /0 Panel window.
A pin-connected LED displays the information output from the simulator through lit/unlit display in the Simulation mode.
There are two types of LED display styles, figure and bitmap. These styles can be changed on the [[Style] tab].

Figure A.80 Parts Led Properties Dialog Box: [LED Connection] Tab
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This section describes the following.
- [How to open]
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- [[LED Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/0O Panel window, any one of the following:

- Double-click a part object "LED".

- Select [Properties...] form the context menu on a part object "LED".

- Select a part object "LED", and then select [Properties...] form the [View] menu.

[[LED Connection] tab]

(1) Pin connection information setting area

Label This area is used to specify the part name. The part name input here is also dis-
played in the Parts List dialog box as the label.

Pin Name This area is used to specify the pin name to be connected (output pin). The connec-
tion pins can be specified either via direct input or through selection from the drop-
down list.

Active Level The active state is selected with a option button, as follows:

LOW Sets the active level to LOW.
HIGH Sets the active level to HIGH (default).
Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.
[Style] tab]

(1) Style information setting area

Figure

Select this option button to display the LED with the following specified figure.

Shape

Select the figure shape. Two shapes can be selected: rectangle and ellipse.

shadow

Cannot be selected.

Line

Specify and change the figure line, as follows.
You can change the color of figure line by clicking the pull-down button.

Thick- Specifies the line thickness.

ness Specification is made either using a spin button or through direct
input.

A value from 1 to 100 can be specified.

Active Specifies the color of the line during active display.

Inactive Specifies the color of the line during inactive display.

Fill up

Specify and change the figure filling, as follows.
You can change the color of figure filling by clicking the pull-down button.

Active Specifies the fill color during active display.

Inactive Specifies the fill color during inactive display.
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Bitmap Select this option button to display the LED with the following specified bitmap (default).

Selection list Select a bitmap to be used from the selection list.
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection
list.

The bitmap file to be added can be specified either through file selection using
the [...] button, or through direct input.

Entry Bitmap ]
fActie Bibmap :

]
=)

Iacthe Bitrep

[ oow || cawel |

[Delete] button | Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

(2) Preview area
This area displays the style of the LED currently being specified.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
Apply Cannot be selected.
Help Displays the help for this dialog box.
[Operation]

In the Simulation mode, the output status (active/inactive) of the connected pins is displayed in real-time using two types
of bitmaps or figures.

Figure A.82 Connected Parts Display Example (LED)
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Parts Segment LED Properties dialog box

This property dialog box is used to set or change the pin connection information of 7-segment LED and 14-segment
LED, which are one of the connection parts in the 1/0O Panel window.

A LED connected to pins displays the information output from the simulator in the Simulation mode.

The segment LED display styles can be changed on the [[Style] tab].

Figure A.83 Parts Segment LED Properties Dialog Box: [SegmentLED Connection] Tab
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Figure A.84 Parts Segment LED Properties Dialog Box: [Style] Tab
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This section describes the following.

- [How to open]
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- [[SegmentLED Connection] tab]
- [[Style] tab]
- [Function buttons]

- [Operation]

[How to open]

On the I/0O Panel window, any one of the following:
- Double-click a part object "7-segment LED"/"14-segment LED".
- Select [Properties...] form the context menu on a part object "7-segment LED"/"14-segment LED".

- Select a part object "7-segment LED"/"14-segment LED", and then select [Properties...] form the [View] menu.

[[SegmentLED Connection] tab]

(1) Pin connection information setting area

Label This area is used to specify the part name. The part name input here is also dis-
played in the Parts List dialog box as the label.

Grid type Select the grid signal allocation method from the following.
As a result of the selection, the setting in the Digit signal setting area changes.

Digit Connects each segment LED to 1 grid pin. Digit signal settings are
performed in the Digit signal setting area (default).

16 digits can be specified for the digit signal. A segment LED of up
to 16 digits can be created with 1 segment LED part.

Customize Cannot be selected.

(2) Segment signal setting area

Segment Signal This area is used to specify the pins (output pins) to be connected to the
segment signals of the 7-segment LED/14-segment LED, as well as their active
level.

Figure This area displays the bitmap of the 7-segment LED/14-segment LED
at the top left. When "Pin Name:" is input, the corresponding location
is indicated.

Pin Name The connection pins can be specified either via direct input or through
selection from the drop-down list.

The number of segment pins to be connected is 8 in the case of a 7-
segment LED, and 15 in the case of a 14-segment LED. Connection to
all the segment pins is possible by using the scroll bar on the right

side.
Active The active status can be selected with a option button, as follows:
Level
LOW Sets the active level to LOW.
HIGH Sets the active level to HIGH (default).
Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.
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(3) Digit signal setting area

Digit Signal This area is used to specify 7-segment LED/14-segment LED digits, grid signal con-
nection pins (output pins), and their active level. The connection method changes as
follows according to what is specified for [Grid type].

When [Digit] selected

Perform digit signal setting. The maximum number of digit pins that can be con-

nected is 16. Connection to all the digit pins can be done by using the scroll bar on

the right side of the area.

When [Customize] selected

Cannot be selected.

Pin Name The connection pins can be specified either via direct input or
through selection from the drop-down list. As the setting signal,
specify the connection pins in a series from the lowermost digit.

Active Level The active status can be selected with a option button, as follows:
LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default).
Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.
[[Style] tab]

(1) Style information setting area

Full up LED

This area is used to set and change related to the filling of each cell of the object are
performed. You can change the color by clicking the pull-down button.

Active Color Specifies the fill color during active display.

Inactive Color Specifies the fill color during inactive display.

Frame Line of LED

This area is used to set and change related to the frame of each cell of the object are
performed.

Color of Line Specifies and changes the line color.
You can change the color by clicking the pull-down button.

Dotted/Solid Line | Specifies and changes the line shape (dotted/solid).

The desired line shape can be selected from the drop-down list.
The line shape can be specified only when the line thickness is
"1" in [Thickness of Line].

Thickness of Line | Specifies and changes the line thickness.

The desired line thickness can be specified either via direct input
or through selection from the spin button.A value in the range of
1 to 100 (decimal) can be specified.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
Apply Cannot be selected.
Help Displays the help for this dialog box.
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[Operation]

In the Simulation mode, as the results of 1 simulation, the output information of the connection pins is received and dis-
play is performed accordingly. When both the digit/grid signals and segment signals are active output, the segment LED of
the corresponding digit/grid light.

Figure A.85 Connected Parts Display Example (7-segment LED)
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Parts Matrix Led Properties dialog box

This property dialog box is used to set or change the pin connection information of matrix LED, which are one of the
connection parts in the 1/0 Panel window.

A pin-connected matrix LED displays the information output from the simulator through lit/unlit display in the Simulation
mode.

There are two types of matrix LED display styles, figure and bitmap. These styles can be changed on the [[Style] tab].

Figure A.86 Parts Matrix Led Properties Dialog Box: [Matrix LED Connection] Tab
Parts Matrix Led Properties [m)
Matriz LED Connection | Style

(1){ Lobed :

R Signal Column Signal
Fin Mame : Fir Mams
1] | ] Ll =
3 ~ |= E miE
@ B - 2 - - 3)
3 - 3 -
1l - _ i v |7
Betive Level : Active Laval
Lo @ HIGH L L @ HIGH

[Function buttons] { | oF | [ Cancel J Apply | Help |

Figure A.87 Parts Matrix Led Properties Dialog Box: [Style] Tab
Parts Matrix Led Properties
Matriz LED Connection | Siyle

B 71 Figure: P ien B
Shape: PRectanglk chizdo
Line Fill up
Thickress: || :

Aotive | 'l'| Bt - | "I
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[Function buttons]{ | 0K H Cancel ] Apply Help

This section describes the following.

- [How to open]
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- [[Matrix LED Connection] tab]
- [[Style] tab]
- [Function buttons]

- [Operation]

[How to open]

On the I/O Panel window, any one of the following:
- Double-click a part object "Matrix LED".
- Select [Properties...] form the context menu on a part object "Matrix LED".

- Select a part object "Matrix LED", and then select [Properties...] form the [View] menu.

[[Matrix LED Connection] tab]
(1) [Label]

Label This area is used to specify the part name. The part name input here is also dis-
played in the Parts List dialog box as the label.

(2) Row direction signals setting area

Row Signal This area is used to specify the output pins connected to the matrix LED row direc-
tion signals and their active level.

Pin Name A maximum of 16 pins can be connected. Connection to all the row
direction signals can be done by using the scrollbar located on the
right side of the pin name input area.

Active Level The active status can be selected with a option button, as follows:

LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default).

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.

(3) Column direction signals setting area

Column Signal This area is used to specify the output pins connected to the matrix LED column
direction signals and their active level.

Pin Name The connection pins can be specified either via direct input or

through selection from the drop-down list. A maximum of 16 pins can
be connected. Connection to all the column direction signals can be
done by using the scrollbar located on the right side of the pin name

input area.
Active Level The active status can be selected with a option button, as follows:
LOW Sets the active level to LOW.
HIGH Sets the active level to HIGH (default).
Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.
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[[Style] tab]
(1) Style information setting area
Figure Select this option button to display the matrix LED with the following specified figure.
Shape Select the figure shape. Two shapes can be selected: rectangle and ellipse.
shadow Cannot be selected.
Line Specify and change the figure line, as follows.

You can change the color of figure line by clicking the pull-down button.

Thickness | Specifies the line thickness.

Specification is made either using a spin button or through direct
input.

A value from 1 to 100 can be specified.

Active Specifies the color of the line during active display.
Inactive Specifies the color of the line during inactive display.
Fill up Specify and change the figure filling, as follows.
You can change the color of figure filling by clicking the pull-down button.
Active Specifies the fill color during active display.
Inactive Specifies the fill color during inactive display.
Bitmap Select this option button to display the matrix LED with the following specified bitmap (default)

Selection list Select a bitmap to be used from the selection list.
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection
list.

The bitmap file to be added can be specified either through file selection using
the [...] button, or through direct input.

| Entry Bitmap =5

fckive Bibmap ©

ot Bitrrep

__

o | [ coocel |

[Delete] button | Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

(2) Preview area
This area displays the style of the matrix LED currently being specified.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
Apply Cannot be selected.
R20UT5301EJ0100 Rev.1.00 -IENESAS Page 386 of 413

Jun 01, 2023



CS+V8.10.00

A. WINDOW REFERENCE

Button

Function

Help

Displays the help for this dialog box.

[Operation]

In the Simulation mode, as the results of 1 simulation, the output information of the connection pins is received and dis-
play is performed accordingly. When the matrix intersection of a row pin and column pin is active, the corresponding LED

lights.

Figure A.88 Connected Parts Display Example (Matrix LED)
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Parts Buzzer Properties dialog box

This property dialog box is used to set or change the pin connection information of a buzzer, which is one of the connec-
tion parts in the I/O Panel window.

The pin-connected buzzer displays the information output from the connected pins as a bitmap in the Simulation mode.

The buzzer output can be checked as "display".

There are two types of buzzer display styles, figure and bitmap. These styles can be changed on the [[Style] tab].

Figure A.89 Parts Buzzer Properties Dialog Box: [Buzzer Connection] Tab

Parts Buzzer Properties

Buzzar Connection |51,-|.= '
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Fin Hame -
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Active Leval o Ly @ HIGH
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[Function buttons] { | QK | [ cancel | Apply

Figure A.90 Parts Buzzer Properties Dialog Box: [Style] Tab

Parts Buzzer Properties i
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Line | Fill ug W H ol
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[Function buttons] {

This section describes the following.

- [How to open]

R20UT5301EJ0100 Rev.1.00 :{ENESAS Page 388 of 413
Jun 01, 2023



CS+V8.10.00

A. WINDOW REFERENCE

- [[Buzzer Connection] tab]

- [[Style] tab]

- [Function buttons]

- [Operation]

[How to open]

On the I/0O Panel window, any one of the following:

- Double-click a part object "Buzzer".

- Select [Properties...] form the context menu on a part object "Buzzer".

- Select a part object "Buzzer", and then select [Properties...] form the [View] menu.

[[Buzzer Connection] tab]

(1) Pin connection information setting area

Label This area is used to specify the part name. The part name input here is also dis-
played in the Parts List dialog box as the label.

Pin Name This area is used to specify the pin name to be connected (output pin). The connec-
tion pins can be specified either via direct input or through selection from the drop-
down list.

Active Level The active state is selected with a option button, as follows:

LOW Sets the active level to LOW.
HIGH Sets the active level to HIGH (default).

Output Form This item is not allowed to change.

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.
[Style] tab]

(1) Style information setting area

Figure

Select this option button to display the buzzer with the following specified figure.

Shape

Select the figure shape. Two shapes can be selected: rectangle and ellipse.

shadow

Cannot be selected.

Line

Specify and change the figure line, as follows.
You can change the color of figure line by clicking the pull-down button.

Thickness | Specifies the line thickness.

Specification is made either using a spin button or through direct
input.

A value from 1 to 100 can be specified.

Active Specifies the color of the line during active display.

Inactive Specifies the color of the line during inactive display.

Fill up

Specify and change the figure filling, as follows.
You can change the color of figure filling by clicking the pull-down button.

Active Specifies the fill color during active display.

Inactive Specifies the fill color during inactive display.
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Bitmap Select this option button to display the buzzer with the following specified bitmap (default).

Selection list Select a bitmap to be used from the selection list.
The selectable bitmaps appear in the selection list.

[Add] button Opens the Entry Bitmap dialog box below to add a new bitmap to the selection
list.

The bitmap file to be added can be specified either through file selection using
the [...] button, or through direct input.

 Entry Bitmap =]

fctae Bitmap ©

L]

Iracthe Bitrrep

_\.

| o | | Cawcel |

[Delete] button | Deletes the currently selected bitmap from the selection list.
Note that only the bitmap that have been added by user can be deleted.

(2) Preview area
This area displays the style of the buzzer currently being specified.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
Apply Cannot be selected.
Help Displays the help for this dialog box.
[Operation]

In the Simulation mode, the active level output of the connected pins can be expressed as a bitmap.
The following bitmaps are displayed according to the pin's output value (active/inactive).

Figure A.91 Connected Parts Display Example (Buzzer)
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Pull up/Pull down dialog box

This dialog box is used to set or change the pin connection information of the pull-up/pull-down resistors, which are one
of the connection parts of the I/O Panel window.

The setting method for these connection parts differs from those for other parts. The connection information of all the
pins is managed as a group in this dialog box.

Figure A.92 Pull up/Pull down Dialog Box

[ Pull up/Pull down
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[Function buttons] {
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This section describes the following.
- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- With the I/O Panel window in focus, click the % button or select [Pull up/Pull down...] from the [Parts] menu.

[Description of each area]

(1) Connection information display area

Pin name Displays the names of the pins that can be connected to pull-up/pull-down resistors.
Pull Up/Pull Down Displays the connected status of the pins.

Pull Up Indicates pull-up resistor is connected.

Pull Down Indicates pull-down resistor connected.

- Indicates no pull-up/pull-down resistor connected.
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Buttons Changes the pin connection information of the pull-up/pull-down resistors.

Pull Up Connects the pins selected to pull-up resistors.
When connection is completed, "Pull Up" is displayed.

Pull Down Connects the pins selected to pull-down resistors.
When connection is completed, "Pull Down" is displayed.

Disconnect Cancels the connected status of the pins selected.
When connection is completed, "-" is displayed.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
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Object Properties dialog box

This property dialog box is used to set or change the connection information fed to the pins of figure object (including
text and bitmap) of the I/O Panel window.

Show/hide can be switched for each pin-connected object by the output status of the connected pins in the Simulation
m(')I'dhet-:: default status of each signal is active HIGH. Display styles can be changed on the [[Style] tab].
Figure A.93 Object Properties Dialog Box: [Object Connection] Tab
Object Properties
Styla | Ubject Conmection

Fin Conrect
@ Mo Coreecton

1 Statie Cornecian

Pin Hame
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Figure A.94 Object Properties Dialog Box: [Style] Tab
Object Properties ===

Stwle | Object Gonnectian
Fill Up
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o || oo —

CuaktedSalid

Thickness : 1
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This section describes the following.
- [How to open]

- [[Object Connection] tab]
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- [[Style] tab]

- [Function buttons]

[How to open]

On the I/O Panel window, any one of the following:
- Double-click a figure object.
- Select [Properties...] form the context menu on a figure object.

- Select a figure object, and then select [Properties...] form the [View] menu.

[[Object Connection] tab]

(1) Pin connection information setting area

Pin Connect Select the method for connecting objects and output pins by clicking the corresponding
option buttons, and specify the output pin name.

As a result of the connection, figure display is switched by the ON/OFF status of the con-
nected output pin.

No Connection The object and pin are not connected (default).
Objects not connected to pins are always in the displayed sta-
tus.

Static Connection Connects the figure to 1 output pin.

The connection pin can be specified in [Pin Name] either via
direct input or through selection from the drop-down list. During
simulation, the object is displayed when the specified output
signal data is active.

Dynamic Connection | Connects the figure to 2 output pins.

The connection pin can be specified in [Pin Name1] and [Pin
Name2] either via direct input or through selection from the
drop-down list. During simulation, the object is displayed when
the specified output signal 1 data and the specified output sig-
nal 2 data are both active.

Active Level The common active status of each output signal can be selected from the option buttons.

LOW Sets the active level to LOW.

HIGH Sets the active level to HIGH (default).

Remark For the pin names that can be specified, see the user's manual of the microcontroller that is used.
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[[Style] tab]

(1) Style information setting area

Fill up

Note

Specifies and changes settings related to each object filling™°*®, as follows:

The area to be filled differs according to the object.
- Line
Not applicable

- Rectangle, Ellipse, Rounded Rectangle
Inside area enclosed by contour lines

- Polygon
Inside area enclosed by lines linking apexes

- Text
Inside text box

- Bitmap
Inside figure drawing area

Color Specifies and changes settings of color
You can change the color by clicking the pull-down button.

Line

This area is used to perform settings and changes related to the lines of objects.
The definition of line for each type of object is provided below.
- Line

All areas of the object

- Rectangle, Ellipse, Rounded Rectangle
Contour line of the figure

- Polygon
Lines that link the apexes of the polygon

- Text
Contour lines of the text box

- Bitmap
Contour lines of figure drawing area

Color Specifies and changes the line color.
You can change the color by clicking the pull-down button.

Dotted/ Specifies and changes line shapes (dotted line/solid line).
Solid The desired line shape can be selected from the drop-down list.
Note that this item can be changed only when [Thickness] is set to "1".

Thickness | Specifies and changes the line thickness.

The desired line thickness can be specified either via direct input or
through selection from the spin button.

A value in the range of 1 to 100 (decimal) can be specified.

Note At this time, if the object that have been pasted from a bitmap file, it becomes invisible.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
Apply Cannot be selected.
Help Displays the help for this dialog box.
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Parts List dialog box

This dialog box displays all the figure objects created in the I/O Panel window as well as the pin connection status of
part objects.

The pin connection settings for each object can be changed in the property dialog box, which can be opened by double-

clicking the relevant object listed in this dialog box, or selecting the relevant object listed in this dialog box and then select-
ing the [View] menu >> [Properties...].

Figure A.95 Parts List Dialog Box

 Parts List |
| Lael Parts Pin Mame  Actie Level
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[Function buttons] {

This section describes the following.

- [How to open]
- [Description of each area]

- [Function buttons]

[How to open]

- With the I/O Panel window in focus, select [Parts List...] form the [View] menu.

[Description of each area]

(1) Pin connection status display area

Label

Displays the label (name) attached to the object. Nothing is displayed for objects that
do not have a label.
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Parts Displays the part category.
rectangle Straight line, rectangle, ellipse, rounded rectangle, fan shape
polygon Polygon
text Text
bitmap Bitmap
button Push button, pull button, group button
analog button Analog button
key Key matrix
level gauge Level gauge
led LED
7segment led 7-segment LED
14segment led | 14-segment LED
matrix led Matrix LED
buzzer Buzzer
groups Grouped part
Pin Name Displays the pins connected to parts.
"-" is displayed for parts that are connected to multiple pins, and a blank is displayed
for parts that are unconnected.
Active Level Displays the active value set for the part.
"-" is displayed for parts that are connected to multiple pins, and a blank is displayed
for parts that are unconnected.

[Function buttons]

Button Function
Close Closes the this dialog box.
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Serial window

This window is used to communicate with the serial interface provided in the CPU.

Since this window operates as the serial interface of the remote node of the CPU, transmission data from CPU turns
into reception data in this window, and transmission data from this window turns into reception data in the CPU.

The following two types of files can be handled in this window.

The transmission/reception data displayed in the top area in this window can be saved to the serial log data file (*.log)
(CSV format) by selecting the [File] menu >> [Save]/[Save As...].

Moreover, the transmission data created in the lower part of this window can be saved to the serial transmission data file
(*.ser) (CSV format) by clicking the [Save] button (the contents can be restored by clicking the [Load] button).

Saving/restoring the created data can also be performed by saving/loading the project file. In this case, however, data is
not saved as a CSV format text file but saved into the project file.

Caution 1.  If the saved serial transmission data file is opened or the project file is opened while Simulator GUI is run-
ning with a microcontroller different from the one used when the file was created, the settings of the serial
interface that are not provided in the microcontroller will not be restored.

Caution 2.  Multiple instances of this window can be opened. After opening this window, select the serial interface to
be verified in the Serial selection area.

Figure A.96 Serial Window
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This section describes the following.
- [How to open]

- [Description of each areal

- [Dedicated menu (Serial window)]

- [Context menu]
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[How to open]
- Click the [E]| button.

- Select [Serial] from the [Simulator] menu.

[Description of each area]

(1) Serial selection area
Selects the serial interface to be used.

(1A 1 Selects the serial interface to be used from the list of provided serial interfaces (drop-
= down list)Note,

\ A meta) Selects the transfer mode (master or slave) when IIC or [ICA has been selected from
the list of serial interfaces.

&

hAminClk = Selects the time information unit applied to [Wait] in the Serial editor area from the
drop-down list.
The time information unit can be changed by selecting the [Edit] menu >> [Time unit].

Note Once selected, the serial interface cannot be changed.
If you wish to change the serial interface, newly open another Serial window.

(2) Log display area
Displays the transmission/reception data.
The display timing is when all the bits constituting the data have been received or sent.
Only data from which the start bit, stop bit, and parity bit have been deleted is displayed in this area.
The notation of data can be changed by selecting the [View] menu>> [Numeric Representation] >> [Binary]/[Hexa-
decimal].
Log display is cleared upon debugger or simulator reset.

Time Displays the time from the completion of reception/transmission of the previous data
until completion of reception/transmission of the current data.
The time information unit is specified by selecting the [Edit] menu >> [Time unit].

Send Data Displays the data sent by this window (data received by the CPU).
Receive Data Displays the data received by this window (data sent by the CPU).
Status Displays the status during data reception.

When an error occurs, one of the following marks is displayed. When everything is
normal, nothing is displayed.

P Parity error (mismatching parity bit)

F Framing error (stop bit not detected)

(38) Serial editor area
This area is where the transmission data is created.
This area can be shown or hidden by selecting the [View] menu >> [Serial Editor].

No. This is a number assigned sequentially from the beginning. It cannot be directly written.
The maximum number is 9,999 lines.

Wait Specifies the time from the completion of transmission or reception of the immediately previous
data until the start of transmission or reception of next data.Valid during transmission using the
[Auto send] button and during reception using the [Auto receive] button.

The time information unit is the unit selected by selecting the [Edit] menu >> [Time unit].

The wait value is input by placing the cursor in the Wait field to be edited and double-clicking.
One wait value can be written per operation.
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Data This area is used to edit transmission data.

Data can be directly input by placing the cursor in the data field and double-clicking.

Data suffixed by "0x" is treated as hexadecimal data, and data suffixed by "Ob" is treated as binary
data. The default code is the hexadecimal code.

If a bit length different from that specified in the Format (UART) dialog box or Format (CSl) dialog
box is specified, data from the lower bit is valid.

One data can be written per operation.

Button Format Opens the Format (UART) dialog box, Format (CSI) dialog box, or Format (lIC) dia-
log box.

All Clear Clears all Serial editor area.

Load Loads the contents of the previously saved serial transmission data file (*.ser) and
restores them in the Serial editor area.
A file created for UART cannot be loaded as a file for CSl| and vice versa.

Save Saves the contents of the Serial editor area to the specified serial transmission data
file (*.ser).
Send Sends one of the data selected in the Serial editor area.

The next data becomes selected upon completion of transmission.
If no data is selected, the first data is sent.

Auto Send | Makes the data selected in the Serial editor area the first data, and automatically
transfers from the data to the bottom of the area. The data transmission time interval
is the time specified for Wait.

Receive The [Send] button is switched to [Receive] when this window is used as the recep-
Note tion side of IICA.
Cancels the wait state and starts data reception.

Auto The [Auto Send] button is switched to [Auto Receive] when this window is used as

Receive the reception side of IICA.

Note Cancels the wait state at time interval specified in the Serial editor area and auto-
matically receives data. The data reception time interval is the time specified for
Wait.

Start This button is activated when IIC or IICA is selected from the list of serial interfaces

in the Serial selection area, and master mode is selected as the transfer mode.
Pressing it generates a start condition, which starts serial transfer.

Stop This button is activated when IIC or IICA is selected from the list of serial interfaces
in the Serial selection area, and master mode is selected as the transfer mode.
Pressing it generates a stop condition, which stops serial transfer.

Send This button is activated when 1IC or IICA is selected from the list of serial interfaces
Address in the Serial selection area, and master mode is selected as the transfer mode.
Pressing it sends the address of the slave which is to be the other party in communi-
cations.
Note These buttons are disabled when IIC is selected from the list of serial interface types in the Serial

selection area.

Caution The help for this window will not be displayed even if the [F1] key on the keyboard is pressed while
the cursor is placed in this area.

Remark When the CSI selected in this window is set to master mode, the clock must be supplied for recep-
tion. To perform reception, transmission of dummy data is therefore required.
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[Dedicated menu (Serial window)]

(1

(2)

©)

[Edit] menu
Insert Inserts a new line immediately before the selected line.
Cut Cuts the selected range and saves it to the clipboard.
Copy Copies the selected range and copies it to the clipboard.
Paste Pastes the contents of the clipboard to the selected location.
Delete Deletes the selected range.
Time unit Selects the time unit.
main clock Main clock (default)
usec Microsecond
msec Millisecond
Format... Opens the Format (UART) dialog box, Format (CSl) dialog box, or Format (lIC) dia-
log box.
[View] menu
Serial Editor Selects whether Serial editor area is displayed or not.

Numeric Representa-
tion

Changes the notation of the Log display area display method.

Binary

Displays binary numbers.

Hexadecimal

Displays hexadecimal numbers.

[Option] menu

Customize...

Opens the Customize dialog box.

[Context menu]

The following context menus are available in the Serial editor area.

Insert Inserts a new line immediately before the selected line.

Cut Cuts the selected range and saves it to the clipboard.

Copy Copies the selected range and copies it to the clipboard.
Paste Pastes the contents of the clipboard to the selected location.
Delete Deletes the selected range.

R20UT5301EJ0100 Rev.1.00

Jun 01, 2023

RENESAS

Page 401 of 413



CS+V8.10.00 A. WINDOW REFERENCE

Format (UART) dialog box

This dialog box is used to set the serial format for the asynchronous serial interface (UART).

Figure A.97 Format (UART) Dialog Box
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This section describes the following.
- [How to open]
- [Description of each areal

- [Function buttons]

[How to open]

On the Serial window with the UART serial interface, any one of the following:
- Click the [Format] button.

- Select [Format...] from the [Edit] menu

[Description of each area]

(1) Serial format setting area

Baud rate Directly input the serial baud rate value as an integer. (Unit: bps) Note

Transfer Direction Select the transfer direction.

MSB first | Sets MSB first as the transfer direction.

LSB first Sets LSB first as the transfer direction (default).

Data bit length Select the bit length of the transmission data from the drop-down list, or specify it through
direct input (default:7).

Stop bit length Select the stop bit length from the drop-down list (default:1).
Parity Select the parity information (none parity (default) /odd parity/even parity/0 parity).
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Repeat

Select this item to repeat data transfer when the [Auto Send] button in the Serial window
has been clicked.

Following transmission of the last data during automatic transmission,
returns to the beginning of the data and performs automatic transmission.

[ Following transmission of the last data during automatic transmission, stops
transmission (default).

Note

Remark

[Function buttons]

Make a baud-rate setting that is no less than 117 bps.

For the selectable range, see the user's manual of the microcontroller that is used.

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
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Format (CSI) dialog box

This dialog box is used to specify the serial format for the 3-wire serial interface (CSl).

Figure A.98 Format (CSl) Dialog Box
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This section describes the following.
- [How to open]

- [Description of each areal

- [Function buttons]

- [Transmission/reception when 3-wire serial interface (CSl) is selected]

[How to open]

On the Serial window with the CSI serial interface, any one of the following:
- Click the [Format] button.

- Select [Format...] from the [Edit] menu

[Description of each area]

(1) Serial format setting area

Master, Slave Select the transfer mode.

Master Operates this window as a master.
Setting of [Transfer Clock] is required for generating the clock during
communication.

Slave Operates this window as a slave (default).
Communication is performed using the clock of the serial interface pro-
vided in the CPU.

Transfer Clock Directly input the transfer clock value (unit: kHz).
Values with decimals can also be set. This item must be set when master is selected.

R20UT5301EJ0100 Rev.1.00 RENESAS Page 404 of 413
Jun 01, 2023



CS+V8.10.00 A. WINDOW REFERENCE

Transfer Direction Select the transfer direction.
MSB first Sets MSB first as the transfer direction (default).
LSB first Sets LSB first as the transfer direction.
Data bit length Select the bit length of the transmission data from the drop-down list, or specify it
through direct input (default: 8).
Data Phase Select the transmission/reception timing to set the data phase. The data clock phase
is set in combination with "Clock Phase" as shown in "Table A.15 Data Clock Phase
Settings".
Normal Transmits/receives data at the normal 3-wire serial transmission/recep-
tion timing (default).
Precede Transmits/receives data at a timing half a clock of the operation clock
earlier than the normal 3-wire serial transmission/reception timing.
Clock Phase Select the transmission/reception clock waveform to set the clock phase. The data
clock phase is set in combination with "Data Phase" as shown in "Table A.15 Data
Clock Phase Settings".
Normal Operates on the normal 3-wire serial clock.
Transfer starts at the falling edge of the clock (default).
Reverse Operates on the reverse clock of the normal 3-wire serial clock. Trans-
fer starts at the rising edge of the clock.
Repeat Select this item to repeat data transfer when the [Auto Send] button in the Serial win-
dow has been clicked.

Following transmission of the last data during automatic transmission,
returns to the beginning of the data and performs automatic transmis-
sion.

[l Following transmission of the last data during automatic transmission,
stops transmission.

Remark For the selectable range, see the user's manual of the microcontroller that is used.

Table A.15 Data Clock Phase Settings

Data Clock Data Clock Phase
Phase Phase
Normal Normal SCK | | | | | | | | | | | | | | | |
S0 CYCOCY COCHCHC L
StopaToog | | | [ | | | |
Precede | Normal SCK | | | I | | | | | | | | | | | |
S CO C D CD ) ) T
StputTmig | || | ] | | |
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Data Clock Data Clock Phase
Phase Phase
Normal Reverse SICK | | | | | | | | | | | | | | | |
50 { D7 X 08 X 05 X Da X 03 02 X 01X Do
StiopotTinog | | | | | | | |
Precede | Reverse SCK | | | | | | | | | | | | | | | |
50 < D7 X 08 % B8 X D4 03 X D2 X D1 Do
stopatoes | | | | | ] | |
[Function buttons]
Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.

[Transmission/reception when 3-wire serial interface (CSl) is selected]

The Serial window when CSI serial interface is selected always operates in the transmission/reception mode regardless
of whether [Master] or [Slave] is selected in this dialog box.

When [Master] is selected

Data is transmitted or received immediately after clicking the [Send] button or the [Auto
Send] button in the Serial editor area.

When [Slave] is selected

Data becomes ready to be transmitted or received after clicking the [Send] button or the
[Auto Send] button in the Serial editor area.

Data starts to be transmitted or received when the CSI clock signal is received in the
data transmission/reception ready status. This ready status is released when data trans-
mission or reception is completed. (Even if the CSI clock is received, data is not trans-
mitted or received in other than the data transmission/reception ready status.)

Accordingly, when only wanting to reception data in the Serial window when "Slave" is selected, execute as follows
(Reception setting when CSI serial slave is selected):

(1) Set [Repeat]

Select the [Repeat] check box in this dialog box

(2) Set Waittime
Set the Wait time to 0 as a dummy setting in the Serial window, and then click the [Auto Send] button
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Format (11C) dialog box

This dialog box is used to set the serial format for the serial interface (1IC, 1ICA).

Figure A.99 Format (IIC master) Dialog Box
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This section describes the following.
- [How to open]
- [Description of each areal

- [Function buttons]

[How to open]

On the Serial window with the IIC serial interface, any one of the following:
- Click the [Format] button.

- Select [Format...] from the [Edit] menu
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[Description of each area]

(1) Format (IIC master) setting area

Transfer Clock Directly inputs the transfer clock value (unit: kHz).
Values may include decimal fractions.
IICWL Directly inputs the width at low level of the serial clock.
IICWH Directly inputs the width at high level of the serial clock.
Slave Addr Directly inputs the address of the slave which is to be the other party.

Transmit / Receive | Selects the direction of transfer.

Transmit This window is to transmit data.
Receive This window is to receive data.
WTIM Selects the time until waiting.
8 clock The state becomes waiting after eight clock cycles.
9 clock The state becomes waiting after nine clock cycles.
Repeat Selects this item to repeat data transfer when the [Auto Send] or [Auto Receive] button in

the Serial window has been clicked.

- In the case of automatic transmission

Following transmission of the last data during automatic transmission,
returns to the beginning of the data and performs automatic transmis-
sion.

- In the case of automatic reception
Following reception of the last data during automatic reception, returns
to the beginning of the Wait time and performs automatic reception.

[](default) - In the case of automatic transmission
Following transmission of the last data during automatic transmission,
stops transmission.

- In the case of automatic reception
Following reception of the last data during automatic reception, stops

reception.
(2) Format (lIC slave) setting area
Match Addr Specifies the local address of this window by direct input.
WTImNote Selects the time until waiting.
8 clock The state becomes waiting after eight clock cycles.
9 clock The state becomes waiting after nine clock cycles.
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Repeat Selects this item to repeat data transfer when the [Auto Send] or [Auto Receive] button in
the Serial window has been clicked.

- In the case of automatic transmission

Following transmission of the last data during automatic transmission,
returns to the beginning of the data and performs automatic transmis-
sion.

- In the case of automatic receptionN°te

Following reception of the last data during automatic reception, returns
to the beginning of the Wait time and performs automatic reception.

[](default) - In the case of automatic transmission
Following transmission of the last data during automatic transmission,
stops transmission.

- In the case of automatic receptionN°te

Following reception of the last data during automatic reception, stops
reception.

Note These items are disabled when IIC is selected from the list of serial interface types in the Serial
selection area. This is because there is no wait state and data are automatically received.

[Function buttons]

Button Function
OK Validates the settings and closes this dialog box.
Cancel Cancels the settings and closes this dialog box.
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